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License Agreements 
 

PORTLAND CEMENT ASSOCIATION  
EVALUATION SOFTWARE LICENSE AGREEMENT 

 
BY CLICKING THE “I AGREE” ICON BELOW, OR BY INSTALLING, COPYING, OR 
OTHERWISE USING THE SOFTWARE OR USER DOCUMENTATION, YOU AGREE TO BE 
BOUND BY THE TERMS OF THIS AGREEMENT, INCLUDING, BUT NOT LIMITED TO, THE 
WARRANTY DISCLAIMERS, LIMITATIONS OF LIABILITY AND TERMINATION 
PROVISIONS BELOW. IF YOU DO NOT AGREE TO THE TERMS OF THIS AGREEMENT, DO 
NOT INSTALL OR USE THE SOFTWARE OR USER DOCUMENTATION, EXIT THIS 
APPLICATION NOW AND RETURN THE SOFTWARE AND USER DOCUMENTATION TO 
PCA.  
PORTLAND CEMENT ASSOCIATION, 5420 OLD ORCHARD ROAD, SKOKIE, ILLINOIS 60077 
(HEREAFTER PCA), GRANTS THE CUSTOMER A PERSONAL, NONEXCLUSIVE, LIMITED, 
NONTRANSFERABLE LICENSE TO USE THIS SOFTWARE AND USER DOCUMENTATION 
SOLELY FOR TRIAL AND EVALUATION PURPOSES ONLY IN ACCORDANCE WITH THE 
TERMS AND CONDITIONS OF THIS AGREEMENT. SOFTWARE AND USER 
DOCUMENTATION IS SUPPLIED TO CUSTOMER EITHER BY PCA DIRECTLY OR 
THROUGH AN AUTHORIZED DEALER OF PCA (HEREAFTER DEALER). 
WHILE PCA HAS TAKEN PRECAUTIONS TO ASSURE THE CORRECTNESS OF THE 
ANALYTICAL SOLUTION AND DESIGN TECHNIQUES USED IN THIS SOFTWARE, IT 
CANNOT AND DOES NOT GUARANTEE ITS PERFORMANCE, NOR CAN IT OR DOES IT 
BEAR ANY RESPONSIBILITY FOR DEFECTS OR FAILURES IN STRUCTURES IN 
CONNECTION WITH WHICH THIS SOFTWARE MAY BE USED. DEALER (IF ANY) HAS NOT 
PARTICIPATED IN THE DESIGN OR DEVELOPMENT OF THIS SOFTWARE AND NEITHER 
GUARANTEES THE PERFORMANCE OF THE SOFTWARE NOR BEARS ANY 
RESPONSIBILITY FOR DEFECTS OR FAILURES IN STRUCTURES IN CONNECTION WITH 
WHICH THIS SOFTWARE IS USED. 
PCA AND DEALER (IF ANY) EXPRESSLY DISCLAIM ANY WARRANTY THAT: (A) THE 
FUNCTIONS CONTAINED IN THE SOFTWARE WILL MEET THE REQUIREMENTS OF 
CUSTOMER OR OPERATE IN COMBINATIONS THAT MAY BE SELECTED FOR USE BY 
CUSTOMER; (B) THE OPERATION OF THE SOFTWARE WILL BE FREE OF ALL "BUGS" OR 
PROGRAM ERRORS; OR (C) THE SOFTWARE CONFORMS TO ANY PERFORMANCE 
SPECIFICATIONS. CUSTOMER ACKNOWLEDGES THAT PCA IS UNDER NO OBLIGATION 
TO PROVIDE ANY SUPPORT, UPDATES, BUG FIXES OR ERROR CORRECTIONS TO OR FOR 
THE SOFTWARE OR USER DOCUMENTATION.  
THE LIMITED WARRANTIES IN SECTION 6 HEREOF ARE IN LIEU OF ALL OTHER 
WARRANTIES, EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, ANY 
IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FIT NESS 
FOR A PARTICULAR PURPOSE, EACH OF WHICH IS HEREBY DISCLAIMED. EXCEPT 
AS SET FORTH IN SECTION 6, THE SOFTWARE AND USER DOCUMENTATION ARE 
PROVIDED ON AN "AS-IS" BASIS.  
IN NO EVENT SHALL PCA OR DEALER (IF ANY) BE LIABLE FOR: (A) LOSS OF PROFITS, 
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, PUNITIVE, CONSEQUENTIAL 
OR OTHER DAMAGES, EVEN IF PCA OR DEALER (IF ANY) HAS BEEN ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGES; (B) ANY CLAIM AGAINST CUSTOMER BY ANY THIRD 
PARTY; OR (C) ANY DAMAGES CAUSED BY (1) DELAY IN DELIVERY OF THE SOFTWARE 
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OR USER DOCUMENTATION UNDER THIS AGREEMENT; (2) THE PERFORMANCE OR NON 
PERFORMANCE OF THE SOFTWARE; (3) RESULTS FROM USE OF THE SOFTWARE OR 
USER DOCUMENTATION, INCLUDING, WITHOUT LIMITATION, MISTAKES, ERRORS, 
INAC CURACIES, FAILURES OR CUSTOMER'S INABILITY TO PROVIDE SERVICES TO 
THIRD PARTIES THROUGH USE OF THE SOFTWARE OR USER DOCUMENTATION; 
(4) CUSTOMER'S FAILURE TO PERFORM CUSTOMER'S RESPONSIBILI TIES; (5) PCA NOT 
PROVIDING UPDATES, BUG FIXES OR CORRECTIONS TO OR FOR ANY OF THE 
SOFTWARE OR USER DOCUMENTATION; (6) LABOR, EXPENSE OR MATERIALS 
NECESSARY TO REPAIR DAMAGE TO THE SOFTWARE OR USER DOCUMENTATION 
CAUSED BY (a) ACCIDENT, (b) NEGLI GENCE OR ABUSE BY CUSTOMER, (c) ACTS OF 
THIRD PERSONS INCLUDING, BUT NOT LIMITED TO, INSTALLATION, REPAIR, 
MAINTENANCE OR OTHER CORRECTIVE WORK RELATED TO ANY EQUIPMENT BEING 
USED, (d) CAUSES EXTERNAL TO THE SOFTWARE SUCH AS POWER FLUCTUATION AND 
FAILURES, OR (e) FLOODS, WINDSTORMS OR OTHER ACTS OF GOD. MOREOVER, IN NO 
EVENT SHALL PCA BE LIABLE FOR WARRANTIES, GUARANTEES, REPRESENTATIONS 
OR ANY OTHER UNDERSTAN DINGS BETWEEN CUSTOMER AND DEALER (IF ANY) 
RELATING TO THE SOFTWARE OR USER DOCUMENTATION. 
THIS AGREEMENT CONSTITUTES THE ENTIRE AND EXCLUSIVE AGREEMENT BETWEEN 
CUSTOMER AND PCA AND DEALER (IF ANY) WITH RESPECT TO THE SOFTWARE AND 
USER DOCUMENTATION TO BE FURNISHED HEREUNDER. IT IS A FINAL EXPRESSION OF 
THAT AGREEMENT AND UNDERSTANDING. IT SUPER SEDES ALL PRIOR 
COMMUNICATIONS BETWEEN THE PARTIES (INCLUDING ANY EVALUATION LICENSE 
AND ALL ORAL AND WRITTEN PROPOSALS). ORAL STATEMENTS MADE BY PCA'S OR 
DEALER'S (IF ANY) REPRESENTATIVES ABOUT THE SOFTWARE OR USER DOCUMEN 
TATION DO NOT CONSTITUTE REPRESENTATIONS OR WARRANTIES, SHALL NOT BE 
RELIED ON BY CUSTOMER, AND ARE NOT PART OF THIS AGREEMENT. 
 
1. LICENSE RESTRICTIONS  

(a) Except as expressly provided in this Agreement or as otherwise authorized in writing by PCA, 
Customer has no right to: (1) use, print, copy, display, reverse assemble, reverse engineer, 
translate or decompile the Software or User Documentation in whole or in part; (2) disclose, 
publish, release, sublicense or transfer to another person any Software or User Documentation; 
(3) reproduce the Software or User Documentation for the use or benefit of anyone other than 
Customer; or (4) modify any Software or User Documentation. All rights to the Software and 
User Documentation not expressly granted to Customer hereunder are retained by PCA. All 
copyrights and other proprietary rights except as expressed elsewhere in the Software or User 
Documentation and legal title thereto shall remain in PCA. Customer may use the Software at 
only one designated workstation at Customer's site at any given time. Customer may not transmit 
the Software electronically to any other workstation, computer, node or terminal device whether 
via a local area network, a wide area network, telecommunications transmission, the Internet or 
other means now known or hereafter created without prior written permission by PCA.  

(b) Customer acknowledges that this is a limited license for trial and evaluation purposes only. This 
limited license shall automatically terminate upon the earlier of: (1) ten executions of the 
Software on the computer on which it is installed; or (2) fifteen days after the installation of the 
Software. Thereafter, Customer may only use the Software and Documentation if it acquires a 
production license for the same.  

 
2. TERM AND TERMINATION  
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(a) This Agreement shall be in effect from the date Customer clicks the “I AGREE” icon below or 
installs, copies or otherwise uses the Software or User Documentation until: (1) it is terminated by 
Customer, by Dealer (if any) on behalf of Customer or PCA or by PCA as set forth herein; or 
(2) the limited trial and evaluation license terminates.  

(b) This Agreement may be terminated by PCA without cause upon 30 days' written notice or 
immediately upon notice to Customer if Customer breaches this Agreement or fails to comply 
with any of its terms or conditions. This Agreement may be terminated by Customer without 
cause at any time upon written notice to PCA.  

 
3. BACKUP AND REPLACEMENT COPIES  

Customer may make one copy of the Software for back-up and archival purposes only, provided 
PCA's copyright and other proprietary rights notices are included on such copy.  

 
4. PROTECTION AND SECURITY  

(a) Customer shall not provide or otherwise make available any of the Software or User 
Documentation in any form to any person other than employees of Customer with the need to 
know, without PCA's written permission. 

(b) All Software and User Documentation in Customer's possession including, without limitation, 
translations, compilations, back-up, and partial copies is the property of PCA. Upon termination 
of this Agreement for any reason, Customer shall immediately destroy all Software and User 
Documentation, including all media, and destroy any Software that has been copied onto other 
magnetic storage devices. Upon PCA’s request, Customer shall certify its compliance in writing 
with the foregoing to PCA. 

(c) Customer shall take appropriate action, by instruction, agreement or otherwise, with any persons 
permitted access to the Software or User Documentation, to enable Customer to satisfy its 
obligations under this Agreement with respect to use, copying, protection, and security of the 
same. 

(d) If PCA prevails in an action against Customer for breach of the provisions of this Section 4, 
Customer shall pay the reasonable attorneys' fees, costs, and expenses incurred by PCA in 
connection with such action in addition to any award of damages. 

 
5. CUSTOMER'S RESPONSIBILITIES  

The essential purpose of this Agreement is to provide Customer with limited use rights to the 
Software and User Documentation. Customer accepts full responsibility for: (a) selection of the 
Software and User Documentation to satisfy Customer's business needs and achieve Customer's 
intended results; (b) the use, set-up and installation of the Software and User Documentation; 
(c) all results obtained from use of the Software and User Documentation; and (d) the selection, 
use of, and results obtained from any other software, programming equipment or services used 
with the Software or User Documentation. 

 
6. LIMITED WARRANTIES  

PCA and Dealer (if any) warrants to Customer that: (a) PCA and Dealer (if any) has title to the 
Software and User Documentation and/or the right to grant Customer the rights granted 
hereunder; (b) the Software and User Documentation provided hereunder is PCA's most current 
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production version thereof; and (c) the copy of the Software provided hereunder is an accurate 
reproduction of the original from which it was made.  

 
7. LIMITATION OF REMEDY  

(a) PCA AND DEALER (IF ANY) HAS NO LIABILITY UNDER THIS AGREEMENT. 
CUSTOMER'S EXCLUSIVE REMEDY FOR DAMAGES DUE TO PERFORMANCE OR 
NONPERFORMANCE OF ANY SOFTWARE OR USER DOCUMENTATION, PCA, 
DEALER (IF ANY), OR ANY OTHER CAUSE WHATSO EVER, AND REGARDLESS 
OF THE FORM OF ACTION, WHETHER IN CONTRACT OR IN TORT, INCLUDING 
NEGLIGENCE, SHALL BE LIMITED TO CUSTOMER STOPPING ALL USE OF THE 
SOFTWARE AND USER DOCUMENTATION AND RETURNING THE SAME TO PCA.  

(b) NEITHER PCA NOR DEALER (IF ANY) IS AN INSURER WITH REGARD TO THE 
PERFORMANCE OF THE SOFTWARE OR USER DOCUMENTATION. THE TERMS 
OF THIS AGREEMENT, INCLUDING, BUT NOT LIMITED TO, THE LIMITED 
WARRANTIES, AND THE LIMITATION OF LIABILITY AND REMEDY, ARE A 
REFLECTION OF THE RISKS ASSUMED BY THE PARTIES. IN ORDER TO OBTAIN 
THE SOFTWARE AND USER DOCUMENTATION FROM PCA OR DEALER (IF ANY), 
CUSTOMER HEREBY ASSUMES THE RISKS FOR (1) ALL LIABILITIES 
DISCLAIMED BY PCA AND DEALER (IF ANY) ON THE FACE HEREOF; AND 
(2) ALL ACTUAL OR ALLEGED DAMAGES IN CONNECTION WITH THE USE OF 
THE SOFTWARE AND USER DOCUMENTATION. THE ESSENTIAL PURPOSE OF 
THE LIMITED REMEDY PROVIDED CUSTOMER HEREUNDER IS TO ALLOCATE 
THE RISKS AS PROVIDED ABOVE. 

 
8. U.S. GOVERNMENT RESTRICTED RIGHTS  

This commercial computer software and commercial computer software documentation were 
developed exclusively at private expense by Portland Cement Association, 5420 Old Orchard 
Road, Skokie, Illinois, 60077. U.S. Government rights to use, modify, release, reproduce, 
perform, display or disclose this computer software and computer software documentation are 
subject to the restrictions of DFARS 227.7202-1(a) (June 1995) and DFARS 227.7202-3(a) (June 
1995), or the Restricted Rights provisions of FAR 52.227-14 (June 1987) and FAR 52.227-19 
(June 1987), as applicable. 

 
9. GENERAL  

(a) No action arising out of any claimed breach of this Agreement or transactions under this 
Agreement may be brought by Customer more than two years after the cause of such action has 
arisen. 

(b) Customer may not assign, sell, sublicense or otherwise transfer this Agreement, the license granted 
herein or the Software or User Documentation by operation of law or otherwise without the prior 
written consent of PCA. Any attempt to do any of the foregoing without PCA’s consent is void.  

(c) Customer acknowledges that the Software, User Documentation and other proprietary information 
and materials of PCA are unique and that, if Customer breaches this Agreement, PCA may not 
have an adequate remedy at law and PCA may enforce its rights hereunder by an action for 
damages and/or injunctive or other equitable relief without the necessity of proving actual damage 
or posting a bond therefor. 
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(D) THE RIGHTS AND OBLIGATIONS UNDER THIS AGREEMENT SHALL NOT BE 
GOVERNED BY THE UNITED NATIONS CONVENTION ON CONTRACTS FOR THE 
INTERNATIONAL SALE OF GOODS, THE APPLICATION OF WHICH IS EXPRESSLY 
EXCLUDED, BUT SUCH RIGHTS AND OBLIGATIONS SHALL INSTEAD BE GOVERNED 
BY THE LAWS OF THE STATE OF ILLINOIS, APPLICABLE TO CONTRACTS ENTERED 
INTO AND PERFORMED ENTIRELY WITHIN THE STATE OF ILLINOIS AND 
APPLICABLE FEDERAL (U.S.) LAWS. UCITA SHALL NOT APPLY TO THIS 
AGREEMENT.  

(E) THIS AGREEMENT SHALL BE TREATED AS THOUGH IT WERE EXECUTED IN THE 
COUNTY OF COOK, STATE OF ILLINOIS, AND WAS TO HAVE BEEN PERFORMED IN 
THE COUNTY OF COOK, STATE OF ILLINOIS. ANY ACTION RE LATING TO THIS 
AGREEMENT SHALL BE INSTITUTED AND PROSECUTED IN A COURT LOCATED IN 
COOK COUNTY, ILLINOIS. CUSTOMER SPECIFICALLY CONSENTS TO 
EXTRATERRITORIAL SERVICE OF PROCESS.  

(f) Except as prohibited elsewhere in this Agreement, this Agreement shall be binding upon and inure 
to the benefit of the personal and legal representatives, permitted successors, and permitted 
assigns of the parties hereto.  

(g) All notices, demands, consents or requests that may be or are required to be given by any party to 
another party shall be in writing. All notices, demands, consents or requests given by the parties 
hereto shall be sent either by U.S. certified mail, postage prepaid or by an overnight international 
delivery service, addressed to the respective parties. Notices, demands, consents or requests 
served as set forth herein shall be deemed sufficiently served or given at the time of receipt 
thereof.  

(h) The various rights, options, elections, powers, and remedies of a party or parties to this Agreement 
shall be construed as cumulative and no one of them exclusive of any others or of any other legal 
or equitable remedy that said party or parties might otherwise have in the event of breach or 
default in the terms hereof. The exercise of one right or remedy by a party or parties shall not in 
any way impair its rights to any other right or remedy until all obligations imposed on a party or 
parties have been fully performed. 

(i) No waiver by Customer, PCA or Dealer (if any) of any breach, provision, or default by the other 
shall be deemed a waiver of any other breach, provision or default.  

(j) The parties hereto, and each of them, agree that the terms of this Agreement shall be given 
a neutral interpretation and any ambiguity or uncertainty herein should not be construed against 
any party hereto. 

(k) If any provision of this Agreement or portion thereof is held to be unenforceable or invalid by any 
court or competent jurisdiction, such decision shall not have the effect of invalidating or voiding 
the remainder of this Agreement, it being the intent and agreement of the parties that this 
Agreement shall be deemed amended by modifying such provision to the extent necessary to 
render it enforceable and valid while preserving its intent or, if such modification is not possible, 
by substituting therefor another provision that is enforceable and valid so as to materially 
effectuate the parties’ intent.  

(l) Except as set forth herein, this Agreement may be modified or amended only by a written 
instrument signed by a duly authorized representative of PCA and Customer. 
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PORTLAND CEMENT ASSOCIATION 
SOFTWARE LICENSE AGREEMENT 

 
BY CLICKING THE “I AGREE” BELOW, OR BY INSTALLING, COPYING, OR OTHERWISE 
USING THE SOFTWARE OR USER DOCUMENTATION, YOU AGREE TO BE BOUND BY THE 
TERMS OF THIS AGREEMENT, INCLUDING, BUT NOT LIMITED TO, THE WARRANTY 
DISCLAIMERS, LIMITATIONS OF LIABILITY AND TERMINATION PROVISIONS BELOW. IF 
YOU DO NOT AGREE TO THE TERMS OF THIS AGREEMENT, DO NOT INSTALL OR USE 
THE SOFTWARE OR USER DOCUMENTATION, EXIT THIS APPLICATION NOW AND 
RETURN THE SOFTWARE AND USER DOCUMENTATION TO PCA FOR A FULL REFUND 
WITHIN THIRTY DAYS AFTER YOUR RECEIPT OF THE SOFTWARE AND USER 
DOCUMENTATION. 
PORTLAND CEMENT ASSOCIATION, 5420 OLD ORCHARD ROAD, SKOKIE, ILLINOIS 60077 
(HEREAFTER PCA), GRANTS THE CUSTOMER A PERSONAL, NONEXCLUSIVE, LIMITED, 
NONTRANSFERABLE LICENSE TO USE THIS SOFTWARE AND USER DOCUMENTATION 
IN ACCORDANCE WITH THE TERMS AND CONDITIONS OF THIS AGREEMENT. 
SOFTWARE AND USER DOCUMENTATION IS SUPPLIED TO CUSTOMER EITHER BY PCA 
DIRECTLY OR THROUGH AN AUTHORIZED DEALER OF PCA (HEREAFTER DEALER). 
WHILE PCA HAS TAKEN PRECAUTIONS TO ASSURE THE CORRECTNESS OF THE 
ANALYTICAL SOLUTION AND DESIGN TECHNIQUES USED IN THIS SOFTWARE, IT 
CANNOT AND DOES NOT GUARANTEE ITS PERFORMANCE, NOR CAN IT OR DOES IT 
BEAR ANY RESPONSIBILITY FOR DEFECTS OR FAILURES IN STRUCTURES IN 
CONNECTION WITH WHICH THIS SOFTWARE IS USED. DEALER (IF ANY) HAS NOT 
PARTICIPATED IN THE DESIGN OR DEVELOPMENT OF THIS SOFTWARE AND NEITHER 
GUARANTEES THE PERFORMANCE OF THE SOFTWARE NOR BEARS ANY 
RESPONSIBILITY FOR DEFECTS OR FAILURES IN STRUCTURES IN CONNECTION WITH 
WHICH THIS SOFTWARE IS USED. 
PCA AND DEALER (IF ANY) EXPRESSLY DISCLAIM ANY WARRANTY THAT: (A) THE 
FUNCTIONS CONTAINED IN THE SOFTWARE WILL MEET THE REQUIREMENTS OF 
CUSTOMER OR OPERATE IN COMBINATIONS THAT MAY BE SELECTED FOR USE BY 
CUSTOMER; (B) THE OPERATION OF THE SOFTWARE WILL BE FREE OF ALL "BUGS" OR 
PROGRAM ERRORS; OR (C) THE SOFTWARE CONFORMS TO ANY PERFORMANCE 
SPECIFICATIONS. CUSTOMER ACKNOWLEDGES THAT PCA IS UNDER NO OBLIGATION 
TO PROVIDE ANY SUPPORT, UPDATES, BUG FIXES OR ERROR CORRECTIONS TO OR FOR 
THE SOFTWARE OR USER DOCUMENTATION.  
THE LIMITED WARRANTIES IN SECTION 7 HEREOF ARE IN LIEU OF ALL OTHER 
WARRANTIES, EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, ANY 
IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS 
FOR A PARTICULAR PURPOSE, EACH OF WHICH IS HEREBY DISCLAIMED. EXCEPT 
AS SET FORTH IN SECTION 7, THE SOFTWARE AND USER DOCUMENTATION ARE 
PROVIDED ON AN "AS-IS" BASIS.  
IN NO EVENT SHALL PCA OR DEALER (IF ANY) BE LIABLE FOR: (A) LOSS OF 
PROFITS, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, PUNITIVE, 
CONSEQUENTIAL OR OTHER DAMAGES, EVEN IF PCA OR DEALER (IF ANY) HAS 
BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES; (B) ANY CLAIM AGAINST 
CUSTOMER BY ANY THIRD PARTY EXCEPT AS PROVIDED IN SECTION 8 ENTITLED 
"INFRINGEMENT"; OR (C) ANY DAMAGES CAUSED BY (1) DELAY IN DELIVERY OF 
THE SOFTWARE OR USER DOCUMENTATION UNDER THIS AGREEMENT; (2) THE 
PERFORMANCE OR NONPERFORMANCE OF THE SOFTWARE; (3) RESULTS FROM 
USE OF THE SOFTWARE OR USER DOCUMENTATION, INCLUDING, WITHOUT 
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LIMITATION, MISTAKES, ERRORS, INACCURACIES, FAILURES OR CUSTOMER'S 
INABILITY TO PROVIDE SERVICES TO THIRD PARTIES THROUGH USE OF THE 
SOFTWARE OR USER DOCUMENTATION; (4) CUSTOMER'S FAILURE TO PERFORM 
CUSTOMER'S RESPONSIBILITIES; (5) PCA NOT PROVIDING UPDATES, BUG FIXES OR 
CORRECTIONS TO OR FOR ANY OF THE SOFTWARE OR USER DOCUMENTATION; (6) 
LABOR, EXPENSE OR MATERIALS NECESSARY TO REPAIR DAMAGE TO THE 
SOFTWARE OR USER DOCUMENTATION CAUSED BY (a) ACCIDENT, (b) NEGLIGENCE 
OR ABUSE BY CUSTOMER, (c) ACTS OF THIRD PERSONS INCLUDING, BUT NOT 
LIMITED TO, INSTALLATION, REPAIR, MAINTENANCE OR OTHER CORRECTIVE 
WORK RELATED TO ANY EQUIPMENT BEING USED, (d) CAUSES EXTERNAL TO THE 
SOFTWARE SUCH AS POWER FLUCTUATION AND FAILURES, OR (e) FLOODS, 
WINDSTORMS OR OTHER ACTS OF GOD. MOREOVER, IN NO EVENT SHALL PCA BE 
LIABLE FOR WARRANTIES, GUARANTEES, REPRESENTATIONS OR ANY OTHER 
UNDERSTANDINGS BETWEEN CUSTOMER AND DEALER (IF ANY) RELATING TO THE 
SOFTWARE OR USER DOCUMENTATION. 
THIS AGREEMENT CONSTITUTES THE ENTIRE AND EXCLUSIVE AGREEMENT BETWEEN 
CUSTOMER AND PCA AND DEALER (IF ANY) WITH RESPECT TO THE SOFTWARE AND 
USER DOCUMENTATION TO BE FURNISHED HEREUNDER. IT IS A FINAL EXPRESSION OF 
THAT AGREEMENT AND UNDERSTANDING. IT SUPERSEDES ALL PRIOR 
COMMUNICATIONS BETWEEN THE PARTIES (INCLUDING ANY EVALUATION LICENSE 
AND ALL ORAL AND WRITTEN PROPOSALS). ORAL STATEMENTS MADE BY PCA'S OR 
DEALER'S (IF ANY) REPRESENTATIVES ABOUT THE SOFTWARE OR USER 
DOCUMENTATION DO NOT CONSTITUTE REPRESENTATIONS OR WARRANTIES, SHALL 
NOT BE RELIED ON BY CUSTOMER, AND ARE NOT PART OF THIS AGREEMENT. 
 
1. LICENSE RESTRICTIONS  

(a) Except as expressly provided in this Agreement or as otherwise authorized in writing by PCA, 
Customer has no right to: (1) use, print, copy, display, reverse assemble, reverse engineer, 
translate or decompile the Software or User Documentation in whole or in part; (2) disclose, 
publish, release, sublicense or transfer to another person any Software or User Documentation; (3) 
reproduce the Software or User Documentation for the use or benefit of anyone other than 
Customer; or (4) modify any Software or User Documentation. All rights to the Software and 
User Documentation not expressly granted to Customer hereunder are retained by PCA. All 
copyrights and other proprietary rights except as expressed elsewhere in the Software or User 
Documentation and legal title thereto shall remain in PCA. Customer may use the Software at 
only one designated workstation at Customer's site at any given time. Customer may not transmit 
the Software electronically to any other workstation, computer, node or terminal device whether 
via a local area network, a wide area network, telecommunications transmission, the Internet or 
other means now known or hereafter created without prior written permission by PCA.  

(B) CUSTOMER ACKNOWLEDGES THAT THE REGISTRATION PROCESS FOR THE 
SOFTWARE RESULTS IN THE GENERATION OF A UNIQUE LICENSE KEY AND 
ACTIVATION CODE PAIR. ONCE THE LICENSE KEY AND ACTIVATION CODE 
ARE ENTERED DURING THE INSTALLATION PROCESS, THE SOFTWARE WILL 
ONLY WORK ON THE COMPUTER ON WHICH THE SOFTWARE IS INITIALLY 
INSTALLED. IF YOU NEED TO DEINSTALL THE SOFTWARE AND REINSTALL 
THE SOFTWARE ON A DIFFERENT COMPUTER, YOU MUST CONTACT PCA TO 
OBTAIN THE NECESSARY REINSTALLATION PROCEDURES.  
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2. CHARGES AND PAYMENTS  
All payments for the Software and User Documentation shall be made to either PCA or Dealer (if 
any), as appropriate. 

 
3. TERM AND TERMINATION  

(a) This Agreement shall be in effect from the date Customer clicks the “I AGREE” below or installs, 
copies or otherwise uses the Software or User Documentation until it is terminated by Customer, 
by Dealer (if any) on behalf of Customer or PCA or by PCA as set forth herein.  

(b) This Agreement may be terminated by PCA without cause upon 30 days' written notice or 
immediately upon notice to Customer if Customer breaches this Agreement or fails to comply 
with any of its terms or conditions. This Agreement may be terminated by Customer without 
cause at any time upon written notice to PCA.  

 
4. BACKUP AND REPLACEMENT COPIES  

Customer may make one copy of the Software for back-up and archival purposes only, provided 
PCA's copyright and other proprietary rights notices are included on such copy.  

 
5. PROTECTION AND SECURITY  

(a) Customer shall not provide or otherwise make available any of the Software or User Documentation 
in any form to any person other than employees of Customer with the need to know, without 
PCA's written permission. 

(b) All Software and User Documentation in Customer's possession including, without limitation, 
translations, compilations, back-up, and partial copies is the property of PCA. Upon termination 
of this Agreement for any reason, Customer shall immediately destroy all Software and User 
Documentation, including all media, and destroy any Software that has been copied onto other 
magnetic storage devices. Upon PCA’s request, Customer shall certify its compliance in writing 
with the foregoing to PCA. 

(c) Customer shall take appropriate action, by instruction, agreement or otherwise, with any persons 
permitted access to the Software or User Documentation, to enable Customer to satisfy its 
obligations under this Agreement with respect to use, copying, protection, and security of the 
same. 

(d) If PCA prevails in an action against Customer for breach of the provisions of this Section 5, 
Customer shall pay the reasonable attorneys' fees, costs, and expenses incurred by PCA in 
connection with such action in addition to any award of damages. 

 
6. CUSTOMER'S RESPONSIBILITIES  

The essential purpose of this Agreement is to provide Customer with limited use rights to the 
Software and User Documentation. Customer accepts full responsibility for: (a) selection of the 
Software and User Documentation to satisfy Customer's business needs and achieve Customer's 
intended results; (b) the use, set-up and installation of the Software and User Documentation; (c) 
all results obtained from use of the Software and User Documentation; and (d) the selection, use 
of, and results obtained from any other software, programming equipment or services used with 
the Software or User Documentation. 
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7. LIMITED WARRANTIES  
PCA and Dealer (if any) warrants to Customer that: (a) PCA and Dealer (if any) has title to the 
Software and User Documentation and/or the right to grant Customer the rights granted 
hereunder; (b) the Software and User Documentation provided hereunder is PCA's most current 
production version thereof; and (c) the copy of the Software provided hereunder is an accurate 
reproduction of the original from which it was made.  

 
8. INFRINGEMENT  
(a) PCA shall defend Customer against a claim that the Software or User Documentation furnished and 
used within the scope of the license granted hereunder infringes a U.S. patent or U.S. registered 
copyright of any third party that was issued or registered, as applicable, as of the date Customer clicked 
the “I AGREE” below or installed, copied or otherwise began using the Software or User 
Documentation, and PCA shall pay resulting costs, damages, and attorneys' fees finally awarded, 
subject to the limitation of liability set forth in Section 9 entitled "Limitation of Remedy," provided 
that: 

1. Customer promptly notifies PCA in writing of the claim. 
2. PCA has sole control of the defense and all related settlement negotiations.  
3. If such claim has occurred or in PCA's opinion is likely to occur, Customer shall permit PCA at its 
sole option and expense either to procure for Customer the right to continue using the Software or 
User Documentation or to replace or modify the same so that it becomes noninfringing. If neither of 
the foregoing alternatives is reasonably available in PCA's sole judgment, Customer shall, on one 
month's written notice from PCA, return to PCA the Software and User Documentation and all 
copies thereof.  

(b) PCA shall have no obligation to defend Customer or to pay costs, damages or attorneys' fees for any 
claim based upon (1) use of other than a current unaltered release of the Software or User 
Documentation, or (2) the combination, operation or use of any Software or User Documentation 
furnished hereunder with any other software, documentation or data if such infringement would have 
been avoided but for the combination, operation or use of the Software or User Documentation with 
other software, documentation or data. 
(c) The foregoing states the entire obligation of PCA and Customer’s sole remedy with respect to 
infringement matters relating to the Software and User Documentation. 
 
9. LIMITATION OF REMEDY  

(a) PCA'S AND DEALER'S (IF ANY) ENTIRE LIABILITY AND CUSTOMER'S EXCLUSIVE 
REMEDY FOR DAMAGES DUE TO PERFORMANCE OR NONPERFORMANCE OF 
ANY SOFTWARE OR USER DOCUMENTATION, PCA, DEALER (IF ANY), OR ANY 
OTHER CAUSE WHATSOEVER, AND REGARDLESS OF THE FORM OF ACTION, 
WHETHER IN CONTRACT OR IN TORT, INCLUDING NEGLIGENCE, SHALL BE 
LIMITED TO THE AMOUNT PAID TO PCA OR DEALER (IF ANY) FOR THE 
SOFTWARE AND USER DOCUMENTATION.  

(b) NEITHER PCA NOR DEALER (IF ANY) IS AN INSURER WITH REGARD TO THE 
PERFORMANCE OF THE SOFTWARE OR USER DOCUMENTATION. THE TERMS OF 
THIS AGREEMENT, INCLUDING, BUT NOT LIMITED TO, THE LIMITED 
WARRANTIES, AND THE LIMITATION OF LIABILITY AND REMEDY, ARE A 
REFLECTION OF THE RISKS ASSUMED BY THE PARTIES. IN ORDER TO OBTAIN 
THE SOFTWARE AND USER DOCUMENTATION FROM PCA OR DEALER (IF ANY), 
CUSTOMER HEREBY ASSUMES THE RISKS FOR (1) ALL LIABILITIES DISCLAIMED 
BY PCA AND DEALER (IF ANY) ON THE FACE HEREOF; AND (2) ALL ACTUAL OR 
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ALLEGED DAMAGES IN EXCESS OF THE AMOUNT OF THE LIMITED REMEDY 
PROVIDED HEREUNDER. THE ESSENTIAL PURPOSE OF THE LIMITED REMEDY 
PROVIDED CUSTOMER HEREUNDER IS TO ALLOCATE THE RISKS AS PROVIDED 
ABOVE. 

 
10. U.S. GOVERNMENT RESTRICTED RIGHTS  

This commercial computer software and commercial computer software documentation were 
developed exclusively at private expense by Portland Cement Association, 5420 Old Orchard 
Road, Skokie, Illinois 60077. U.S. Government rights to use, modify, release, reproduce, 
perform, display or disclose this computer software and computer software documentation are 
subject to the restrictions of DFARS 227.7202-1(a) (June 1995) and DFARS 227.7202-3(a) 
(June 1995), or the Restricted Rights provisions of FAR 52.227-14 (June 1987) and FAR 
52.227-19 (June 1987), as applicable. 

 
11. GENERAL  

(a) No action arising out of any claimed breach of this Agreement or transactions under this Agreement 
may be brought by Customer more than two years after the cause of such action has arisen. 

(b) Customer may not assign, sell, sublicense or otherwise transfer this Agreement, the license 
granted herein or the Software or User Documentation by operation of law or otherwise without 
the prior written consent of PCA. Any attempt to do any of the foregoing without PCA’s consent 
is void.  

(c) Customer acknowledges that the Software, User Documentation and other proprietary information 
and materials of PCA are unique and that, if Customer breaches this Agreement, PCA may not 
have an adequate remedy at law and PCA may enforce its rights hereunder by an action for 
damages and/or injunctive or other equitable relief without the necessity of proving actual damage 
or posting a bond therefor. 

(D) THE RIGHTS AND OBLIGATIONS UNDER THIS AGREEMENT SHALL NOT BE 
GOVERNED BY THE UNITED NATIONS CONVENTION ON CONTRACTS FOR THE 
INTERNATIONAL SALE OF GOODS, THE APPLICATION OF WHICH IS EXPRESSLY 
EXCLUDED, BUT SUCH RIGHTS AND OBLIGATIONS SHALL INSTEAD BE GOVERNED 
BY THE LAWS OF THE STATE OF ILLINOIS, APPLICABLE TO CONTRACTS ENTERED 
INTO AND PERFORMED ENTIRELY WITHIN THE STATE OF ILLINOIS AND 
APPLICABLE FEDERAL (U.S.) LAWS. UCITA SHALL NOT APPLY TO THIS 
AGREEMENT.  

(E) THIS AGREEMENT SHALL BE TREATED AS THOUGH IT WERE EXECUTED IN THE 
COUNTY OF COOK, STATE OF ILLINOIS, AND WAS TO HAVE BEEN PERFORMED IN 
THE COUNTY OF COOK, STATE OF ILLINOIS. ANY ACTION RELATING TO THIS 
AGREEMENT SHALL BE INSTITUTED AND PROSECUTED IN A COURT LOCATED IN 
COOK COUNTY, ILLINOIS. CUSTOMER SPECIFICALLY CONSENTS TO 
EXTRATERRITORIAL SERVICE OF PROCESS.  

(f) Except as prohibited elsewhere in this Agreement, this Agreement shall be binding upon and inure to 
the benefit of the personal and legal representatives, permitted successors, and permitted assigns 
of the parties hereto.  
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(g) All notices, demands, consents or requests that may be or are required to be given by any party to 
another party shall be in writing. All notices, demands, consents or requests given by the parties 
hereto shall be sent either by U.S. certified mail, postage prepaid or by an overnight international 
delivery service, addressed to the respective parties. Notices, demands, consents or requests 
served as set forth herein shall be deemed sufficiently served or given at the time of receipt 
thereof.  

(h) The various rights, options, elections, powers, and remedies of a party or parties to this 
Agreement shall be construed as cumulative and no one of them exclusive of any others or of any 
other legal or equitable remedy that said party or parties might otherwise have in the event of 
breach or default in the terms hereof. The exercise of one right or remedy by a party or parties 
shall not in any way impair its rights to any other right or remedy until all obligations imposed on 
a party or parties have been fully performed. 

(i) No waiver by Customer, PCA or Dealer (if any) of any breach, provision, or default by the other 
shall be deemed a waiver of any other breach, provision or default.  

(j) The parties hereto, and each of them, agree that the terms of this Agreement shall be given a neutral 
interpretation and any ambiguity or uncertainty herein should not be construed against any party 
hereto. 

(k) If any provision of this Agreement or portion thereof is held to be unenforceable or invalid by any 
court or competent jurisdiction, such decision shall not have the effect of invalidating or voiding 
the remainder of this Agreement, it being the intent and agreement of the parties that this 
Agreement shall be deemed amended by modifying such provision to the extent necessary to 
render it enforceable and valid while preserving its intent or, if such modification is not possible, 
by substituting therefor another provision that is enforceable and valid so as to materially 
effectuate the parties’ intent.  

Except as set forth herein, this Agreement may be modified or amended only by a written instrument 
signed by a duly authorized representative of PCA and Customer. 

 





 

Chapter 1 Introduction 
Introduction 

pcaSlab is a computer program for the analysis and design of reinforced concrete 
beams and slab systems. Two-way slab systems are analyzed using the Equivalent 
Frame Method. Beams and frames of up to 22 spans can be analyzed and designed. 
In addition to the design option pcaSlab has the capability of investigating existing 
beams and slab systems. pcaSlab includes such features as punching shear check 
and cracked-section or gross-section deflections. For beams, moment 
redistribution as well as combined shear and torsion design are available. Material 
quantity take-offs are computed. In addition to the required area of reinforcing 
steel at the critical sections, pcaSlab provides a complete bar schedule that 
includes number of bars and bar sizes and lengths. pcaSlab checks all applicable 
provisions of the relevant code. 

pcaBeam is a limited version of pcaSlab. It includes all elements that apply to 
beams and one-way slab systems. Topics describing these elements are denoted 
with  icon because they are included in both pcaSlab and pcaBeam. 
Two-way slab systems are available in pcaSlab only and topics related to two-way 
slab systems are denoted with  icon. 

Program Features  
• ACI 318-02, ACI 318-99 and CSA A23.3-94 

• English and SI units 

• Beams/one-way slab and two-way slab systems design and investigation 

• Flexure and shear design and investigation 

• Torsion design and investigation for beams/one-way slab systems 

• Moment redistribution for beams/one-way slab systems 

• Mixed slab system types (pcaSlab only) 

• Auto-input feature that walks you through the input process 
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• Checking of data as they are input 

• Graphical display of geometry and loads as they are input 

• Print preview of graphical screen 

• User-controlled screen color settings 

• Ability to save defaults and settings for future input sessions 

• Customizable results report 

• Import input data from ADOSS v6.0x/7.0x and PCA-Beam v1.0x 

• Online help 

Program Capacity  
• 21 supports (22 spans including left and right cantilevers)  

• 6 load cases 

• 20 load combinations 

• 999 partial dead loads per case 

• 999 partial live loads per case 

• 2 top bar layers (Design mode) 

• 2 bottom bar layers (Design mode) 

• 15 bar sets per span 

System Requirements  

Operating systems  
• Windows 98 SE 

• Windows ME 

• Windows NT4 

• Windows 2000 

• Windows XP 
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Minimum Requirements  
• 100 MHz processor 

• 32 MB of RAM memory 

• 50 MB of free hard disk space for program installation 

Recommended Options  
•  Most recent OS service pack installed 

Terms  
The following terms are used throughout this manual. A brief explanation is given 
to help familiarize you with them. 

Windows refers to the Microsoft Windows environment version 98 or 
higher. 
 

[ ] indicates metric equivalent 
 

Click on means to position the cursor on top of a designated item or 
location and press and release the left-mouse button (unless 
instructed to use the right-mouse button). 
 

Double-click on means to position the cursor on top of a designated item or 
location and press and release the left-mouse button twice in 
quick succession. 
 

Marquee select  means to depress the mouse button and continue to hold it 
down while moving the mouse. As you drag the mouse, a 
rectangle (known as a marquee) follows the cursor. Release 
the mouse button and the area inside the marquee is 
selected. 
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Conventions  
Various styles of text and layout have been used in this manual to help 
differentiate between different kinds of information. The styles and layout are 
explained below… 

 
placed in a topic header means that the topic applies to both 
pcaSlab and pcaBeam 
 

 
placed in a topic header means that the topic applies to 
pcaSlab only 
 

Italic indicates a glossary item, or emphasizes a given word or 
phrase. 

Bold All bold typeface makes reference to either a menu or a 
menu item command such as File or Save, or a tab such as 
General Information or Columns 

Mono-space indicates something you should enter with the keyboard. For 
example type “c:\*.txt”. 

KEY + KEY indicates a key combination. The plus sign indicates that you 
should press and hold the first key while pressing the second 
key, then release both keys. For example, “ALT + F” 
indicates that you should press the “ALT” key and hold it 
while you press the “F” key. Then release both keys. 

SMALL CAPS Indicates the name of an object such as a dialog box or a 
dialog box component. For example, the OPEN dialog box or 
the CANCEL or MODIFY buttons. 
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Installing pcaSlab/pcaBeam  
In the installation procedure described below, pcaSlab is used as an example. 
Installation steps for pcaBeam program are identical 

1. If you have the installation disk please insert it into the CD drive and proceed 
to step 2. If you do not have the installation disk but downloaded the 
installation file from our website, please run the file and proceed to step 11. 

2.  If the auto-run functionality of Windows is enabled on your computer (which 
is the default setting) and a web browser (Internet Explorer, Netscape, etc.) is 
installed, the start page (Figure 1-1) is shown automatically. If the start page 
does not show up automatically, please go to step 7. 

 
Figure 1-1 Start Page 

3.  If you are going to evaluate PCA software, please click the Evaluation 
Software License Agreement link and read through the agreement carefully. 
If you are going to use a commercial copy of PCA software, please click the 
Software License Agreement link and read through the agreement carefully. 
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4.  Click pcaSlab logo to start the installation. A second page will be shown as in 
Figure 1-2. 

 
Figure 1-2. Second Installation Page 

5.  Click the Install the program, then a dialog box will be shown as Figure 1 3. 

 
Figure 1-3 Click Open to Continue 

6. To continue, click the RUN button as shown in Figure 1-3. Press YES or RUN 
button if you see any security warning messages. 

7.  If the start page doesn’t show up automatically, open the Windows Explorer. 
In Windows 95, 98, ME, NT, 2000 use Start/Programs/Accessories/ 
Windows Explorer. In Windows XP go to Start/All Programs/Accessories/ 
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Windows Explorer. You may also start the Windows Explorer by pressing 
the keyboard shortcut WIN+E. A window similar to Figure 1-4 appears. 

 
Figure 1-4 Windows Explorer 

8.  Select the CD drive from the left pane of Windows Explorer (e.g. E drive as in 
Figure 1-4). 

9.  Select the pcaSlab folder from the left pane. The contents of this folder are 
shown in the right pane. 

10. Double click the install.exe in the right pane of the Windows Explorer. 
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Figure 1-5 Beginning of the installation 

11. The installation process starts by displaying the following window (Figure 1-
5). Please read all the information. Then press the NEXT button. This will 
continue the installation process by installing license manager, an evaluation 
license, and the application software. 

12. The first step of the application installation process is to review the software 
license agreement as shown in Figure 1-6. Please read all the information 
carefully. Press the I AGREE button to confirm that you have read and agreed 
with it. This will continue the installation. If you do not agree with the license 
agreement press the I DO NOT AGREE button. This will stop the installation. 

 
Figure 1-6 License agreement 
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13. If you continue the installation then please read the latest information of the 
software included in the readme file (Figure 1-3). Having read all the 
information press the NEXT button. 

 
Figure 1-7 Readme file 

14. In the next step please provide the user’s name and company. Press NEXT 
when you are ready to proceed. 

 
Figure 1-8 Registration information 

15. The next setup is to decide the directory where pcaSlab is to be installed as 
shown in Figure 1-9. The default one is C:\Program Files\PCA\pcaSlab. 
You may press the BROWSE button to locate the directory. If the directory 
does not exist, the setup program will create it. Press the NEXT button to go to 
the next step. 
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Figure 1-9 Choose Destination Location 

16. The next step is to enter the group name as shown in Figure 1-10. Windows 
will use this name in the Start/Programs menu. Press the NEXT button to go 
to the next step. 

 
Figure 1-10 Select Program Manager Group 

17. After all the previous steps are completed, press the NEXT button as shown in 
Figure 1-11 to start the installation. 
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Figure 1-11 Start Installation 

18. During the installation a window as in Fig. 1-12 shows the progress as files 
are copied to your hard drive. 

 
Figure 1-12 Installation progress 

19. After the installation is completed, a dialog box similar to Figure 1-13 is 
shown. Press the FINISH button to finish the installation. 
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Figure 1-13 Installation Complete 

Purchasing and Licensing Process  
The following information is for stand-alone license only. Please refer to the 
License Server Quick Start Guide in the License Server directory on CD regarding 
the procedures to install networking license. 

Licensing Model  
By default, each pcaStructurePoint software application comes in an Evaluation 
mode. This means that initially our products can be used for a limited time of 15 
days. If the user decides to purchase the software license, and completes the 
purchase, pcaStructurePoint will provide a License Code. By entering this code, 
user will activate the software license. Once the software license is activated the 
application will no longer have restrictions limiting the time of operation. 

Evaluation Mode  
This is the default mode of the license. In this licensing scheme, users are granted 
limited rights to use our full-featured software. The only visible difference 
between the evaluation version and the licensed version is an additional start-up 
dialog box as shown in Figure 1-14. It gives a choice of buying the software, 
entering the activation code or running the application in the evaluation mode by 
pressing the EVALUATE button. Evaluation mode is available for a limited time 
only. By default, pcaStructurePoint software applications come with 15 days. That 
means, from the day of installation, a user can evaluate the software for the next 15 
days. After this time, user will either obtain a License, or uninstall the application. 
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Note: Any tampering with system clock or evaluation license file will render 
the software useless. 

 
Figure 1-14 Start-up dialog box 

How to Purchase  
You may purchase the license on-line at www.pcaStructurePoint.com or by calling 
our Sales Team at 847-972-9042. To buy on-line you may press BUY NOW button, 
which will run your default web browser and open the product web page where 
you will be able to complete the transaction. 

License Activation  
After the purchase is completed, pcaStructurePoint will generate a unique 
Activation Code based on the product ID and the locking code, which is derived 
from the unique hardware-id of the user’s computer. Each License is associated 
with the particular PC in which user has installed the pcaStructurePoint software. 
This implies that the activation-code will not work on any other PC. You can 
transfer the license to another PC by contacting pcaStructurePoint for the transfer 
procedures. 

To activate the license press the LICENSE ACTIVATION button in the start-up dialog 
box. This will bring a window as in Figure 1-15, which shows three license 
activation methods.  

http://www.pcastructurepoint.com/
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Figure 1-15 License activation methods 

If you have already received the license code you may choose ENTER LICENSE 
CODE and then press the NEXT button. A window (Figure 1-16) will pop up where 
you will be able to type in the license code. However, in order to avoid mistyping 
we advise to use copy and paste feature instead of typing the code. 

 
Figure 1-16 Enter license code 

The license code can also be extracted from a file. To do that press the BROWSE 
button  and open the file in which the license code is stored using the open 
window (Figure 1-17). 
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Figure 1-17 Open activation file 

If the entered code is correct the license will be activated and window as in Figure 
1-18 will show. When you press the FINISH button the license activation will be 
completed. 

 
Figure 1-18 Activation completion 

If you do not have the license code you may chose either TELEPHONE or E-MAIL 
method, whichever is more convenient for you. Please note that for E-MAIL 
method you need to have the Internet connection and a default mailer configured 
in your system. 

Activation by Phone  
If the telephone method was chosen to activate the license the following screen 
appears (Figure 1-19). It shows the product ID and the Locking Code.  
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Figure 1-19 Activation by phone 

This information is needed when you make a phone call at 847-966-4357 (HELP) 
to obtain the license. You will be asked to provide information about yourself in 
order to verify that you have purchased the license. 

Activation by E-mail  
If the e-mail method was chosen to activate the license a screen (Figure 1-20) will 
show prompting you to provide information about yourself. When you type in all 
the information press the SEND E-MAIL button and it will be automatically e-
mailed to us together with the product ID and the Locking Code. After the 
information is verified the license code will be generated and e-mailed back to 
you.  
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Figure 1-20 Activation by e-mail 

After you receive it you may enter it by pressing the LICENSE ACTIVATION button 
in the start up dialog box (Figure 1-14) and choosing ENTER LICENSE CODE option. 
If the entered code is correct, the license will be activated and window as in Figure 
1-18 will show. When you press the FINISH button the license activation will be 
completed. 

If you experience any problems registering or licensing the software, contact our 
Technical Support team. 

Running the Program  
To execute pcaSlab select the START button located in your Windows taskbar. In 
Windows 98, ME, NT, 2000 follow the path of Programs/PCA Programs/ 
pcaSlab/. In Windows XP follow the path of All Programs/PCA Programs/ 
pcaSlab/. Then select the "pcaSlab" icon. 

 Removing the Program  
To remove the program from your computer: 

1. Click START button located in your Windows taskbar. 
2. In Windows 98, ME, NT, 2000, select Programs/PCA Programs/pcaSlab/; In 

Windows XP, select All Programs/PCA Programs/pcaSlab/. 
3. Select Uninstall pcaSlab. 
4. Follow the steps shown by the un-installation wizard to remove the program. 
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Chapter 2 Method of Solution 
Method of Solution 

The user should be aware of the assumptions made by the program during the 
design stage. These include details regarding loading, strip widths, reinforcement 
selection, deflection computations, material quantities, etc. 

Geometric checks  
The pcaSlab program provides geometric checks to avoid an analysis with an 
inconsistent system. The dimensions of the slabs, drops and column capitals are 
checked and modified to produce a legitimate system. 

If the slab cantilever length is less than one-half the column dimension in the 
direction of analysis, c1, or less than the lateral extension of the transverse beam 
into the cantilever, the cantilever length will be increased to the larger of these two 
lengths. If the slab width is less than one-half the column dimension transverse to 
the direction of analysis, c2, or less than one-half the longitudinal beam width, the 
slab width will be increased to the larger of these two widths. 

If the drop panel lengths extend beyond the end of the slab cantilevers, the drop 
panel lengths will be reduced so that they extend only to the cantilever tip. The 
drop panel edges will be shifted forward or backward in the transverse direction 
when the slab strip width on either side of the column is less than one-half the 
drop panel width. 

If a column capital contains a depth/extension ratio less than 1, the extension will 
be limited to the capital depth. The upper limit for the depth/extension ratio is 50. 
If, by drawing lines extending the column capital through the drop or beam to the 
underside of the slab, the column capital extension falls outside the edge of the 
drop or beam at the slab soffit, the extension will be modified such that these lines 
extend only up to the edge of the drop or beam at the slab soffit (Figure 2-1). The 
modified column capital dimensions will be used when computing column 
stiffness. 
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Figure 2-1 Maximum capital width 

Code Checks  
Prior to an analysis, pcaSlab checks that the input values for the drop panel 
dimensions, column capital dimensions, T-beam flange widths, waffle slab rib 
dimensions and slab and beam depths meet the applicable code values. 

Drop Panel Dimensions  
A valid drop must extend in each direction at least one-sixth the center-to-center 
span length in that direction (Figure 2-2) and have a drop depth below the slab of 
at least one-quarter the input slab depth. ACI slabs that contain valid drops are 
allowed a 10% decrease in minimum slab depth1. The drop depth of an invalid 
drop will not be used in the calculation of the depth used to reduce the amount of 
reinforcement required at a column2,and will not be used in the calculation of 
moment of inertia for deflection computations. 

If the valid drop depth is greater than one-quarter the distance from the edge of the 
drop panel to the face of the column (x) the excess depth exceeding ¼x will not be 
considered in the calculation of the effective depth used to reduce the amount of 
reinforcement required at a column (Figure 2-3)3. 

                                                           
1 ACI 318-99, 9.5.3.2; ACI 318-02, 9.5.3.2 
2 ACI 318-99, 13.3.7; ACI 318-02, 13.3.7 
3 ACI 318-99, 13.3.7.3; ACI 318-02, 13.3.7.3; CSA A23.3-94, 13.11.6 
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Figure 2-2 Valid drop dimensions 

 
Figure 2-3 Excess drop depth 

The input drop dimensions will be used for self-weight computations, when 
computing slab stiffness and to determine moments and shears when computing 
punching shear around a column. 
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Minimum Slab Thickness  
For ACI 318 Code, the minimum thickness of slabs with or without interior beams 
spanning between supports and having a ratio of long to short span not exceeding 
2 is4:  
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where  

ln  = clear span in the direction of analysis, 
β = ratio of the clear spans in long to short direction, 
fy   = yield stress of reinforcing steel, 
αm  = average value of α, the ratio of flexural stiffness of a beam 

section to the flexural stiffness of a width of slab bounded 
laterally by centerlines of adjacent panels on either side of the 
beam, for all beams supporting the edges of a slab panel. 

For the design of ACI slabs without beams (αm ≤ 0.2) spanning between supports 
the minimum thickness shall conform to ACI 318 Table 9.5(c). For flat slabs that 
contain valid drops, Table 9.5(c) reduces the minimum thickness by approximately 
10%.5 (See Figure 2-2). 

The minimum thickness in a span that contains a discontinuous edge will be 
increased by 10%, if the edge beam provided has a stiffness ratio, α, of less than 

                                                           
4 ACI 318-99, 9.5.3.3; ACI 318-02, 9.5.3.3; CSA A23.3-94, 13.3.5 
5 ACI 318-99, 9.5.3.2; ACI 318-02, 9.5.3.2 
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0.80.6 The first and last spans are considered to contain a discontinuous edge as 
well as a span that contains an exterior edge. 

For the CSA Standard the minimum thickness is: 

• for flat plates and slabs with column capitals 
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• for slabs with drop panels 
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where nd l/x2  is the smaller of the values determined in the two directions, dx  
shall not be taken greater than 4/ln , and ( )sd hh −  shall not be greater than sh . 

For flat plate systems, the minimum allowable thickness can in no case be less 
than 5.0 in. For two-way flat slab systems with drops, described above, the 
minimum allowable thickness can in no case be less than 4.0 in.7 For supported 
slab systems supported by beams with an αm greater than or equal to 2.0, the 
minimum allowable thickness can in no case be less than 3.5 in.8 

A message will be printed with the output showing the required slab depth for any 
span where the depth does not meet or exceed code requirements. 

Minimum Thickness for Waffle Slab Systems  
The minimum slab thickness allowed for waffle slabs is one-twelfth the clear rib 
spacing, or 2 in.9 

A message will be printed with the output showing the required slab depth for the 
system if the depth does not meet or exceed code requirements. 

                                                           
6 ACI 318-99, 9.5.3.3 (d); ACI 318-02, 9.5.3.3 (d) 
7 ACI 318-99, 9.5.3.2; ACI 318-02, 9.5.3.2 
8 ACI 318-99, 9.5.3.3; ACI 318-02, 9.5.3.3 
9 ACI 318-99, 8.11.6.1; ACI 318-02, 8.11.6.1 



 

2-6  Method of Solution 

Waffle Rib Dimensions  
Waffle slab rib dimensions will be considered valid if the rib width is at least 4 in. 
(or 100 mm), the depth is no more than 3-1/2 times the rib width, and the clear 
spacing between ribs does not exceed 30 in. (or 750 mm) (Figure 2-4). When valid 
ribs exist, the ACI code permits the nominal concrete shear strength, Vc, to be 
increased by 10%.10 

h

30 in.
b  4 in.

3.5b

 
Figure 2-4 Valid rib dimensions 

Special Considerations for Waffle Slabs  
For the purposes of analysis and design, pcaSlab replaces the waffle with solid 
slabs of equivalent moment of inertia, weight, and punching shear resistance. 

The equivalent thickness based on system weight is used to compute the system 
self-weight. This thickness, hw, is given by: 

 
mod

mod
w A

Vh = , Eq. 2-6 

where: 

Vmod= the volume of one waffle module, 
Amod= the plan area of one waffle module. 

The equivalent thickness based on moment of inertia is used to compute slab 
stiffness. The ribs spanning in the transverse direction are not considered in the 
stiffness computations. This thickness, hMI, is given by: 

                                                           
10 ACI 318-99, 8.11.8;  ACI 318-02, 8.11.8 
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where: 

Irib = moment of inertia of one waffle section between centerlines of 
ribs. 

brib = the center-to-center distance of two ribs (clear rib spacing plus 
rib width). 

The drop depth for waffle slab systems is set equal to the rib depth. The equivalent 
drop depth based on moment of inertia, dMI, is given by: 

 ribMIMI hhd +=  Eq. 2-8 

where: 

hrib = rib depth below slab, 
hMI = equivalent slab thickness based on moment of inertia. 

A drop depth entered for a waffle slab system other than 0 will be added to dMV, 
thus extending below the ribs. 

The equivalent thickness based on shear area is used to compute the area of 
concrete section resisting shear transfer, Ac around the drop. The equivalent slab 
thickness, hV, used to compute Ac, is given by: 

 infre
rib

rib
v d

b
Ah +=  Eq. 2-9 

where: 

Arib = the entire rib area below the slab plus the slab thickness minus 
the distance to the reinforcement centroid, dreinf, within the rib 
width, i.e., the slab depth between the ribs is not considered as 
contributing to shear resistance, 

brib = the center-to-center distance of two ribs (clear rib spacing plus 
rib width), 

dreinf = the distance to reinforcement centriod from the slab top at the 
support. 
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Material Properties  
By entering the concrete density and compressive strength of the members, default 
values for the other concrete properties are determined. The slab, column, and 
beam members may have different concrete properties. 

The density of concrete is used to determine the type of concrete, modulus of 
elasticity, and self-weight. 

For the ACI 318 code, the concrete type is used to determine the default value of 
fct, the average split tensile strength of concrete. The concrete type is determined in 
accordance with Table 2-1. 

Note: The CSA Standard does not use fct. 

Density (w) 

Pcf kg/m3 
Type 

w ≥ 130 w ≥ 2000 Normal 

105 < w < 130 1700 < w < 2000 Sand-Lightweight 

w ≤ 105 w ≤ 1700 All-Lightweight 

Table 2-1 Default Concrete Types 

Once the compressive strength of concrete '
cf  is input, various parameters are set 

to their default values. 

The modulus of elasticity is computed as:11 

 '
c

5.1
c fw33E = , Eq. 2-10 

where: 

w = is the density of the concrete. 

For CSA A23.3 standard 

 
5.1

'
cc 2300

  6900f3300E ⎟
⎠
⎞

⎜
⎝
⎛ γ

⎟
⎠
⎞⎜

⎝
⎛ +=   Eq. 2-11 

where: 
                                                           
11 ACI 318-99, 8.5.1; ACI 318-02, 8.5.1; CSA A23.3-94, 8.6.2.2 
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γ = the unit weight of concrete. 

The square root of '
cf  is limited to 100 psi for the computation of shear strength 

provided by concrete, Vc, and development lengths.12 

 psi100f '
c ≤ . Eq. 2-12 Equations 2-10 and 2-12 are used internally and 

cannot be modified. 

The average split tensile strength is used to compute the modulus of rupture and 
reinforcement development lengths. For normal weight concrete, the default value 
of fct used by pcaSlab is set equal to:13 

 '
cct f7.6f =   Eq. 2-13 

In no case will fct/6.7 exceed 100 psi. The value fct will be modified according to 
the concrete type. Table 2-3 shows the default values for fct for different concrete 
types. No interpolation is performed for partial sand replacement. 

Type fct 

Normal '
cf7.6  

Sand-Lightweight ( ) '
cf7.685.0  

All-Lightweight ( ) '
cf7.675.0  

Table 2-2 Default Average Splitting Tensile Strength 

The modulus of rupture is used to determine the cracking moment when 
computing the effective moment of inertia for deflection computations. The default 
value of modulus of rupture, fr, is for ACI 318 code set equal to: 

 ctr f12.1f = . Eq. 2-14 

If fct is that given in . 2-13, . 2-14 becomes:14 

 '
cr f5.7f = . Eq. 2-15 

                                                           
12 ACI 318-99, 11.1.2; ACI 318-02, 11.1.2 
13 ACI 318-99, 9.5.2.3; ACI 318-02, 9.5.2.3 
14 ACI 318-99, 9.5.2.3; ACI 318-02, 9.5.2.3; CSA A23.3-94, 8.6.4 & 13.3.6 
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For CSA A23.3 standard, the default value of modulus of rupture, fr, is 

 '
cr f6.0f = , Eq. 2-16 

for beams and columns and 

 
2

f6.0
f

'
c

r = , Eq. 2-17 

for slabs. 

There is no limit imposed on fr. Entering a large value of fr will produce 
deflections based on gross properties, (i.e., uncracked sections). 

The default values for the longitudinal reinforcement yield strength, fy, and shear 
reinforcement yield strength, fyv, if applicable, are set equal to 60 ksi (413 MPa) 
for ACI and 400 MPa for CSA. 

The Equivalent Frame Method  
The equivalent frame method, as described in the Code15, is used by pcaSlab for 
both analysis and design. The Code specifies procedures for the analysis and 
design of slab systems reinforced for flexure in more than one direction, with or 
without beams between the supports. A two-way slab16 system, including the slab 
and its supporting beams, columns, and walls may be designed by either of the 
following procedures: 

• The Direct Design Method 

• The Equivalent Frame Method 
pcaSlab uses the Equivalent Frame Method of analysis. It should be noted that this 
method is based on extensive analytical and experimental studies conducted at the 
University of Illinois. Note also that there are no restrictions on the number of slab 
spans or on dead-to-live load ratios in this method of analysis. 

The first step in the frame analysis is to divide the three-dimensional building into 
a series of two-dimensional frames extending to the full height of the building. 
Horizontal members for each frame are formed by slab strips as shown in Fig. 2-5. 

                                                           
15 ACI 318-99, Chapter 13; ACI 318-02, Chapter 13; CSA A23.3-94, Clause 13 
16 Implies a slab supported by isolated supports which permits the slab to bend in two orthogonal 
directions. 
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For vertical loads, each storey (floor and/or roof) may be analyzed separately with 
the supporting columns being considered fixed at their remote ends. (Figure 2-6). 

 
Figure 2-5 Design strips 

 
Figure 2-6 Analytical model for vertical loads for a typical storey 
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Stiffness Characteristics  
The stiffness factors for the horizontal members (the slab beams) and the vertical 
members (the equivalent columns) are determined using segmental approach. 

Slab Beams  
The moment of inertia of the slab beam elements between the faces of the columns 
(or column capitals) is based on the uncracked section of the concrete including 
beams or drop panels. The moment of inertia from the face of the column (or 
capital) to the centerline of the column (or capital) is considered finite and is 
dependent on the transverse dimensions of the panel and support. This reduced 
stiffness (as compared to the infinite stiffness assumed in previous codes) is 
intended to soften the slab at the joint to account for the flexibility of the slab away 
from the support. This is consistent with provisions of the Code.17 

Figure 2-7 shows the changes in stiffness between a slab, and a drop panel, and a 
column (or capital). 

Columns  
The computation of the column stiffness is more complicated as it utilizes the 
concept of an equivalent column. Theoretical slab studies have shown that the 
positive moment in a slab may increase under pattern loads, even if rigid columns 
are used, because of the flexibility of the slab away from the column. However, if 
a two-dimensional frame analysis is applied to a structure with rigid columns, 
pattern loads will have little effect. To account for this difference in behavior 
between slab structures and frames, the equivalent column torsional member, as 
shown in Figure 2-8, runs transverse to the direction in which the moments are 
being determined. The transverse slab beam can rotate even though the column 
may be infinitely stiff, thus permitting moment distribution between adjacent 
panels. It is seen that the stiffness of the equivalent column is affected by both the 
flexural stiffness of the columns and the torsional stiffness of the slabs or beams 
framing into the columns. Note that the method of computation of column stiffness 
is in accordance with the requirements of the Code18. Figure 2-9 shows 
a schematic representation of the stiffness of typical columns. 

                                                           
17 ACI 318-99, 13.7.3; ACI 318-02, 13.7.3; CSA A23.3-94, 13.9.2.3 
18 ACI 318-99, 13.7.4; ACI 318-02, 13.7.4; CSA A23.3-94, 13.9 



 

Method of Solution  2-13 

 
Figure 2-7 Sections for calculating slab-beam stiffness, Ksb 
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Figure 2-7 continued 

The column stiffness is based on the column height, lc, measured from mid-depth 
of the slab above, to the mid-depth of the slab below. pcaSlab calculates the 
stiffness of the column below the design slab, taking into account the design slab 
system at its top end. pcaSlab calculates the stiffness of the column above the 
design slab taking only the slab depth into account at its top end; column capitals, 
beams, or drops are ignored. 

The computation of the torsional stiffness of the member requires several 
simplifying assumptions. The first step is to assume dimensions of the transverse 
torsional slab-beam members. Assumptions for dimensions of typical torsional 
members are shown in Figure 2-10. 
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Figure 2-8 The equivalent column 

The stiffness, Kt, of the torsional member is given by the following expression19:  
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where: 
Ecs = modulus of elasticity for slab concrete, 
C = cross-sectional constant defining torsional properties; see . 2-19 

(it is a conservatively low approximation of the torsional rigidity 
of rectangular sections when assuming elastic behavior), for the 
CSA Standard l2 is taken as the smaller of l2 or l1, 

c2 = size of rectangular column or capital measured transverse to the 
direction in which moments are being determined, 

l2 = for ACI 318, length of span transverse to l1, measured on each 
side of the column, for CSA A23.3-94 l2 is taken as the smaller 
of l2 or l1. 

                                                           
19 ACI 318-99, 13.7.5; ACI 318-02, 13.7.5; CSA A23.3-94, Eq. 13.13 
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The constant C is evaluated for the cross section by dividing it into separate 
rectangular parts and by carrying out the following summation20:  
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where: 
x = short overall dimension of the rectangular part of a cross section, 
y = long overall dimension of the rectangular part of a cross section. 
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CE9K , Eq. 2-18, walls21 running the full width of a 

slab (c2 = l2) cannot be modeled by the Equivalent Frame Method. 

 
Figure 2-9 Sections for calculating the stiffness (Kc) of the column below 

the design floor ( lc-input, lc*-computed) 

                                                           
20 ACI 318-99, 13.0; ACI 318-02, 13.0; CSA A23.3-94, Eq. 13-14 
21 Instead walls can be modeled as long supports less than the full design width of the slab. To obtain a 
uniform distribution of the end moment along the column and middle strips, the width of the wall must 
be greater than 75% of the design strip. 
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When beams frame into the column in the direction of analysis, the value of Kt as 
computed in . 2-18 is multiplied by the ratio of the moment of inertia of the slab 
with the beam (Isb) to the moment of inertia of the slab without the beam (Is), as 
shown: 

 
s

sb
tta I

IKK =  Eq. 2-20 

With reference to Figure 2-8, Is is computed from part A (slab without beam), 
whereas Isb is computed from both parts A and B (slab with beam). 

C = 1-0.63
x1
y1

x13y1
3

+ 1- 0.63
x2
y2

x23y2
3  

Figure 2-10 Section of the attached torsional members 
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Knowing the column stiffness, Kc, and the stiffness of the attached torsional 
member, Kt, the stiffness of the equivalent column, Kec, is computed from the 
equation: 

 

tata

cbct
cbct

ec

KK
KK1

KKK

+
+

+

+
= , Eq. 2-21 

where: 

Kct = top column stiffness, 
Kcb = bottom column stiffness, 
Kta = the stiffness of the left and right torsional member. 

Loading  
All applied loads are input as unfactored loads. There are no limitations imposed 
on the ratio of dead to live loads in the Equivalent Frame Method. Results of 
gravity load and lateral load analyses may be combined, however, the effects of 
cracking and reinforcement on stiffness must be accounted for in the lateral load 
analysis. 

Self-Weight  
The self-weight of the floor system is computed internally by pcaSlab. The 
weights of the slabs, drops, and longitudinal and transverse beams are considered 
in the self weight computations. Only the concrete weight is considered, the 
reinforcement weight is ignored. The weight of longitudinal beams is ignored 
starting at the column centerline, for a length equal to one-half c1, the column 
dimension in the direction of analysis. This will produce slightly less self-weight 
than actually present for beams wider than c2, the column’s transverse dimension. 

Superimposed Loading  
All superimposed vertical loading is considered to act over the entire transverse 
width of the slab. For slab systems with beams, loads supported directly by the 
beam (such as the weight of the beam stem or a wall supported directly by the 
beams) are also assumed to be distributed over the entire transverse width of the 
strip. An additional analysis may be required, with the beam section designed to 
carry these loads in addition to the portion of the slab moments assigned to the 
beam. 
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Lateral Loading  
For lateral loads, each frame should be analyzed as a unit for the entire height of 
the building (Figure 2-11). Computer programs, such as pcaFrame, are available 
for performing such analyses. It should be realized that, for lateral load analysis, 
slab-beam elements may have a reduced stiffness due to cracking as well as other 
assumptions made for the effective slab width used for the lateral analysis. The 
moments obtained from such an analysis may then be input into the equivalent 
frame model using pcaSlab to determine the appropriate design moments under 
combined vertical and lateral loads. 

 
Figure 2-11 Analytical model for lateral loads 

By default, pcaSlab distributes the effect of lateral load moment, the difference 
between the total load moments, vertical plus lateral, and the vertical only moment 
envelopes, to the column strip and middle strip according to the code distribution 
factors computed for vertical loads (see Table 2-3 through Table 2-5 later in this 
chapter). 

Loading Patterns  
The analysis of floor systems requires the consideration of several loading 
configurations. For example, the two adjacent spans loaded may produce the 
maximum shear stress around a column, while the alternate spans loaded may 
produce the maximum flexural moments. To cover different loading scenarios 
pcaSlab generates live load case based on the following load patterns (Figure 
2-12): 

• loading Pattern No. l: All spans loaded with live load (LALL), 

• loading Pattern No. 2: Alternate (odd) spans loaded with live load (LODD), 

• loading Pattern No. 3: Alternate (even) spans loaded with live load (LEVEN), 
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• loading Pattern No. 4: Two adjacent spans loaded with live load (LSUPP). 

 
Figure 2-12 Basic pattern live loads 

pcaSlab reduces the magnitude of live load patterns No.2 through No.4 by 
a predefined ratio. For two-way systems, the default live load pattern ratio selected 
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by the program equals 75% as permitted by the code22. The user has the ability to 
select different value for the pattern ratio within the range 0-100%. If 0% is 
selected than no load patterning is considered. However, the pattern No.1 with all 
spans loaded (as specified by the user) is always considered with full unreduced 
magnitude.  

Load Combinations  
pcaSlab allows defining up to 20 load combinations. The user has full control over 
the combinations. The program contains predefined (build into the program) 
default primary load combinations for the supported codes. These default 
combinations are created when starting a new project. 

For the ACI 318-99 Code, the default combinations of the Dead (D), Live (L), 
Wind (W) and Earthquake (E) loads considered by the program are:  

U1 = 1.4D + 1.7L, 
U2 = 0.75(1.4D + 1.7L + 1.7W), 
U3 = 0.75(1.4D + 1.7L – 1.7W), 
U4 = 0.75(1.4D + 1.7W), 
U5 = 0.75(1.4D – 1.7W), 
U6 = 0.9D + 1.3W, 
U7 = 0.9D – 1.3W, 
U8 = 0.75(1.4D + 1.7L + 1.7*1.1E), 
U9 = 0.75(1.4D + 1.7L – 1.7*1.1E), 
U10 = 0.75(1.4D + 1.7*1.1E), 
U11 = 0.75(1.4D – 1.7*1.1E), 
U12 = 0.9D + 1.43E, 
U13 = 0.9D – 1.43E. 

For the ACI 318-02 Code, the default combinations of the Dead (D), Live (L), 
Wind (W) and Earthquake (E) loads considered by the program are:  

U1 = 1.4D, 
U2 = 1.2D + 1.6L, 
U3 = 1.2D + 1.6L + 0.8W, 
U4 = 1.2D + 1.6L – 0.8W, 
U5 = 1.2D + 1.0L + 1.6W, 
U6 = 1.2D + 1.0L – 1.6W, 
U7 = 0.9D + 1.6W, 
U8 = 0.9D – 1.6W, 

                                                           
22 ACI 318-99, 13.7.6.3; ACI 318-02, 13.7.6.3; CSA A23.3-94, 13.9.4 
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U9 = 1.2D + 1.0L + 1.0W, 
U10 = 1.2D + 1.0L – 1.0W, 
U11 = 0.9D + 1.0W, 
U12 = 0.9D – 1.0W. 

For the CSA A23.3 Code, the default combinations of the Dead (D), Live (L), 
Wind (W) and Earthquake (E) loads considered by the program are:  

U1 = 1.25D + 1.5L, 
U2 = 1.25D + 0.7(1.5L + 1.5W), 
U3 = 1.25D + 0.7(1.5L – 1.5W), 
U4 = 0.85D + 1.5W, 
U5 = 0.85D – 1.5W, 
U6 = 1.0D + 0.5L + 1.0E, 
U7 = 1.0D + 0.5L – 1.0E, 
U8 = 1.0D + 1.0E, 
U9 = 1.0D – 1.0E. 

Column and Middle Strip Widths  
The Code23 defines the width of the column strip on each side of the column 
centerline as being one-fourth of the smaller of either the transverse or the 
longitudinal span. These widths are printed as part of the echo of input data. 

The strip widths at a support are computed by (see Figure 2-13) 

• column strip 
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• middle strip 

 { } CS1i,2i,2MS Wl,lminW −= + . Eq. 2-23 

                                                           
23 ACI 318-99, 13.2.1; ACI 318-02, 13.2.1; CSA A23.3-94, 13.1 
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 Figure 2-13 Strips widths at support 

The strip widths in the span are defined as (see Figure 2-14): 

• column strip 
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• middle strip 

 CS2MS WlW −= , Eq. 2-25 
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where: 
l1 = span length in the direction of analysis, 
l2 = the total input transverse strip width, 
l2,l = the input transverse strip widths on the left of column centerline, 
l2,r = the input transverse strip widths on the right of column centerline, 
i = span left and right of column centerline, 
i+1 = span left and right of column centerline.  

 
Figure 2-14 Strip widths in span 

If a beam exists 

 bCSCS WWW −= . Eq. 2-26 

where: 

Wb = beam width. 

If the beam width, Wb, is greater than the column strip width, Wcs, then an error 
message is displayed and the solution is aborted. This usually happens when 
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modeling a banded-beam system as a two-way slab with a wide beam. In this case, 
it is suggested that wide beams are modeled separately in one direction, and in the 
other direction one-way slab supported by beams is modeled. 

For exterior frames, the edge width should be specified to the edge of the slab 
from the column centerline. 

Strip Design Moments  
pcaSlab considers negative moments for design purposes as those producing 
tension at the top of the slab. The negative design moment is taken at a section 
located at the face of the column, or column capital, but in no case is it considered 
at a location greater than 0.175 of the longitudinal span length, l1, away from the 
center of the column.24 This imposes a limit on long narrow supports, in order to 
prevent undue reduction in the design moment. For slab systems with transverse 
beams, the face of a beam is not considered as the face of support. For end 
columns with capitals, the moments are taken at the midpoint of the capital 
extension.25 The column and middle strip moments correspond to the moments 
assigned to the slab element only. 

The column strips are proportioned to resist the portions in percent of interior 
negative factored moments according to Table 2-3.26 

L2/l1 0.5 1.0 2.0 

(α1 l2/l1) = 0 75 75 75 

(α1 l2/l1) ≥ 1.0 90 75 45 

Table 2-3 Column Strip Percent of Interior Negative Factored Moments at 
Supports 

The column strips are proportioned to resist the portions in percent of exterior 
negative factored moments according to Table 2-4.27 

                                                           
24 ACI 318-99, 13.7.7.1; ACI 318-02, 13.7.7.1; CSA3-A23.3-94, 13.9.5.1 
25 ACI 318-99, 13.7.7.2; ACI 318-02, 13.7.7.2; CSA3-A23.3-94, 13.9.5.2 
26 ACI 318-99, 13.6.4.1; ACI 318-02, 13.6.4.1; CSA3-A23.3-94, 13.9.5.1 
27 ACI 318-99, 13.6.4.2; ACI 318-02, 13.6.4.2 
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l2/l1 0.5 1.0 2.0 
βt = 0 100 100 100 (α1 l2/l1) = 0 βt ≥ 2.5 75 75 75 
βt = 0 100 100 100 (α1 l2/l1) ≥ 1.0 βt ≥ 2.5 90 75 45 

Table 2-4 Column Strip Percent of Exterior Negative Factored Moments at 
Supports 

The values α1 in Table 2-3 and Table 2-4 and βt in Table 2-4 are defined as: 

α1 = ratio of flexural stiffness of the beam section to flexural stiffness 
of a width of slab bounded by centerlines of adjacent panels (if 
any) on each side of the beam in the direction of analysis. For 
flat plates, flat slabs, and waffle α1l2/l1 = 0 

βt = ratio of torsional stiffness of an edge beam section to flexural 
stiffness of a width of slab equal to the span length of the beam, 
center-to-center of supports.28 When no transverse beams are 
present, βt = 0, otherwise 

 
scs

cb
t IE2

CE
=β , Eq. 2-27 

where: 
Ecb = modulus of elasticity of beam concrete, 
Ecs = modulus of elasticity of slab concrete, 
C = cross-sectional constant to define torsional properties; see . 2-19, 
Is = moment of inertia of the gross section of the slab about its 

centroidal axis. 

For intermediate values of (l2/l1), (α1l2/l1) and βt the values in Table 2-3 and Table 
2-4 are interpolated using equations . 2-28 and . 2-29. 

Percentage of negative factored moment at interior support to be resisted by 
column strip: 
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Percentage of negative factored moment at exterior support to be resisted by 
column strip: 
                                                           
28 ACI 318-99, 13.0; ACI 318-02, 13.0; CSA3-A23.3-94, 13.0 
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When a column width, c2, is equal to or greater than 75 percent of the strip width, 
l2 the negative moment is uniformly distributed across l2.29 

When designing by the CSA A23.3-94 Code, a portion of the total positive or 
interior negative moment equivalent to: 
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is resisted by the beam. For exterior supports the beam is proportioned to resist 
100% of the negative moment. 

That portion of the moment not resisted by the beam is resisted by the slab. The 
reinforcement required to resist this moment is distributed evenly across the slab. 

For ACI designs the longitudinal beams are proportioned to resist 85 percent of the 
column strip moments if α1l2/l1 is equal to or greater than 1.0. For values of α1l2/l1 
between 0 and 1.0, the beam is designed to resist a proportionate percentage of the 
column strip moment between 0 and 85.30 

When lateral loads are present, pcaSlab, by default, distributes the effects of lateral 
loads according to Table 2-1 and Table 2-4. 

The middle strips are proportioned to resist the portion of the total factored 
moments that is not resisted by the column strips. 

For design purposes, pcaSlab computes the amount of reinforcement for the 
moments on the left and right sides of the support. The negative design moment is 
the moment which requires the most area of reinforcement to be resisted. The 
location, left or right of the support, of the maximum moment may vary when 
systems differ on each side of the support (for example, a system with beams on 
one side only). pcaSlab considers positive moments for design purposes as those 
producing tension at the bottom of the slab. The column strips are proportioned to 

                                                           
29 ACI 318-99, 13.6.4.3; ACI 318-02, 13.6.4.3 
30 ACI 318-99, 13.6.5;  ACI 318-02, 13.6.5 
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resist the portions in percent of positive factored moments according to Table 
2-5.31 

l2/l1 0.5 1.0 2.0 
(α1l2/l1) = 0 60 60 60 

(α1l2/l1) ≥ 1.0 90 75 45 

Table 2-5 Column Strip Percent of Positive Factored Moments 

For intermediate values of (l2/l1) and (α1l2/l1) the values in Table 2-5 are 
interpolated using . 2-31 as follows: 
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The middle strips are proportioned to resist the remainder of the total factored 
moments. 

Note: For flat plates, flat slabs, and waffle slabs, α1l2/l1 = 0. 

Moment Redistribution  
Redistribution of negative moments applies to one-way and beam systems only. It 
can be engaged using the Input Redistribution radio button on the Solve Options 
tab in the General Information dialog box. 

pcaSlab allows for redistribution of negative moments at supports. Only reduction 
in negative moments is considered. Increase of negative moments at the support is 
not taken into account even though it is allowed by the code32. Static equilibrium is 
maintained meaning that bending moments and shear forces along the span are 
adjusted in accordance with the reduction of moments applied at the supports. The 
following procedure is followed to obtain moment redistribution factors at the 
supports. 

From elastic static analysis, the largest moments from all load combinations and 
load patterns are determined at support faces on both ends of each span except 
cantilevers. These moments are used to calculate the maximum percentage 
adjustment of moments, δ , allowed by the codes. 

For ACI 318-02: 

                                                           
31 ACI 318-99, 13.6.4.4; ACI 318-02, 13.6.4.4 
32 ACI 318-99, 8.4.1; ACI 318-02, 8.4.1; CSA A23.3-94, 9.2.4 
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where tε  is net tensile strain in extreme tension steel at nominal strength. 

For ACI 318-99: 
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where: 
ρ  = tension reinforcement ratio, 

'ρ  = compression reinforcement ratio, 

bρ  = balanced reinforcement ratio. 

For CSA A23.3-94: 

 
d
c5030 −=δ , Eq. 2-34 

where: 
c = distance from extreme compression fiber to neutral axis, 
d = distance from extreme compression fiber to centroid of tension 

reinforcement. 

In the investigation mode, program uses the area of provided reinforcement to 
obtain redistribution factors. In the design mode the required reinforcement area is 
used. Additionally, δ  is checked not to exceed 20% and not to exceed the 
maximum values specified by the user. Negative moments at span ends are 
reduced by the amount of redistribution factors and new moment values are 
iteratively used to obtain new redistribution factors. This iterative procedure is 
repeated until the change in distribution factor does not exceed 0.01% but no more 
than 10 times. 

Shear Analysis of Slabs  
Three types of shear can occur on slab systems: wide beam shear, punching shear, 
and moment transfer shear. pcaSlab checks wide beam shear at a critical section 
located at a distance equal to the effective depth away from the face of the 
supports. The tributary area for wide beam shear calculations extends from the 
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critical section to the center of the span. For punching shear including moment 
transfer shear it is assumed that both types of shear act on the same critical section. 
The critical section for shear is defined in the Code.33 

Figure 2-15 shows the general punching shear area used by pcaSlab. Note that the 
shaded area represents the general case and is modified for special considerations 
as explained below. 

Shallow beams are considered in the unbalanced moment transfer as indicated in 
Figure 2-15 by areas B1, B2, B3, B4, B5, and B6. Ordinarily, transverse beams 
transfer unbalanced moment to the column through torsion along the beam and not 
through shear between the slab and column. However, the Code leaves the transfer 
method to the engineer’s judgment concerning the point at which punching shear 
is no longer applicable and beam shear becomes the dominate element in shear 
transfer to the column. pcaSlab makes no such distinction and computes 
unbalanced moment transfer stress without regard to any beams framing into the 
column. Although the depth of the beam is considered in the critical section 
surfaces, the distances to the critical section are not increased at the intersection 
with any beams. This approach is conservative. pcaSlab does not compute 
torsional stresses in the slab. If in the engineer’s judgment this may control, it must 
be computed manually. 

 
Figure 2-15 Critical section for shear at column 

                                                           
33 ACI 318-99, 11.12.1.2; ACI 318-02, 11.12.1.2; CSA A23.3-94, 13.4.3 
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For a circular column or column capital, a square shape with an equivalent area is 
assumed as shown in Figure 2-16. Critical section area for punching, Ac, is then 
multiplied by )d4D2/()dD( +π+π  to account for the difference between 
circular and square critical sections, where D is the diameter of a column or 
a column capital and d is the effective depth of the slab. 

The critical section is considered closed if the concrete slab around a column 
extends to a distance greater than or equal to the specified threshold value. In 
pcaSlab the user may define the distance extended beyond the column face in 
order to consider the section closed. The default value for this distance is ten times 
the slab thickness (10h) as required by ACI code. If the critical section does not 
meet the distance requirement it is considered open. 

 
Figure 2-16 Critical section area for circular column 

Critical Section for Interior Supports of Interior Frames  
The critical section (Figure 2-17) consists of four vertical surfaces through the 
slab, located at distances of d/2 beyond the support faces. 
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Figure 2-17 Interior supports of interior frames 

The critical section for interior supports of interior frames is always closed. 
A closed section will have all its faces defined in Figure 2-15 resisting shear as 
indicated by . 2-35: 

 ∑
=

=
8

1i
iC AA . Eq. 2-35 

If beams frame34 into the column, then the critical section includes the dimensions 
of the beams (B1 through B6 in Figure 2-15). 

Critical Section for Exterior Supports of Interior Frames  
The critical section for exterior supports of interior frames (Figure 2-18) will be 
either closed (full A7 and A6 for the first column or A1 and A2 for the last column 
in Figure 2-15) or open, depending upon the length of the cantilever in relation to 
slab thickness. The critical section will be considered closed when the clear 
cantilever span, lc, is greater than or equal to the distance defined by the user 
beyond the column face (the default value is 10 h). If beams frame into the 
column, then the critical section includes the contributions from the beam 
dimensions (B1 through B6 in Figure 2-16). 

                                                           
34 A beam is considered as framing into the column if the beam is within a face of the column. 
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Figure 2-18 Exterior supports of interior frames 

Critical Section for Interior Supports of Exterior Frames  
Figure 2-19 shows the critical section for shear for an interior support of an 
exterior frame. Note that the section is considered as U-shaped (A5 = 0, A8 = 0, 
B3 = 0, B4 = 0 in Figure 2-15) and it extends up to the edge of the exterior face of 
the support. If beams frame into the column, then the critical section includes the 
contribution from the beam dimensions (B1 through B6 in Figure 2-15). If the 
exterior cantilever span is greater than or equal to the distance defined by the user 
beyond the column face (the default value is 10 h), the section is treated as closed, 
that is, the support is treated as an interior support of an interior frame. 

 
Figure 2-19 Interior supports of exterior frames 
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Critical Section for Exterior Supports of Exterior Frames  
The critical section for an exterior support of an exterior frame will typically be L-
shaped (A5 =0, A6 =0, A7 =0, A8 =0, B1 = 0, B3 =0, and B4 = 0 in Figure 2-15). 

If the cantilever span lc (in the direction of analysis) is greater than or equal to the 
distance defined by the user beyond the column face (the default value is 10h), 
then the section is treated as a U-shaped interior support. If, in addition, the 
cantilever span in transverse direction is greater than or equal to the distance 
defined by the user beyond the column face (the default value is 10h), the section 
is treated as closed. If beams frame into the column, then the critical section 
includes the contributions from the beam dimensions. 

Computation of Allowable Shear Stress at Critical Section  

One-way shear strength of slabs is limited35 to '
cf2 . Two-way shear strength of 

slabs is affected by concrete strength, relationship between size of loaded area and 
slab thickness, loaded area aspect ratio, and shear-to-moment ratio at slab-column 
connections. 

For the ACI 318-99, ACI 318-02 and CSA A23.3-94 Code, these variables are 
taken into account in the allowable shear stress Eqs. 2-36 through 2-39. The 
allowable shear stress used by pcaSlab is computed at distances of d/2 around the 
columns and drops (if applicable) and taken as the smallest of the 3 quantities:36 
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where 

βc = the ratio of the long to the short side of the column. 

                                                           
35 ACI 318-99, 11.3.1.1; ACI 318-02, 11.3.1.1 
36 ACI 318-99, 11.12.2.1; ACI 318-02, 11.12.2.1; CSA A23.3-94, 13.4.4 
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αs = a constant dependent of the column location, (40 for an interior 
4-sided effective critical area, 30 for an exterior 3-sided critical 
area, 20 for a corner 2-sided effective critical area.) 

d = distance from the slab bottom to centroid of the slab tension 
reinforcement at support. 

b0 = the perimeter of the critical section. 

The allowable shear stress around drops when waffle slabs are used is computed 
as: 
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where: 

cφ  = resistance factor for concrete. 

For waffle slab systems with valid ribs defined earlier in this chapter, the 
allowable shear stress is increased by 10% for ACI designs.37  

Computation of Factored Shear Force at Critical Section  
The factored shear force Vu on the critical section, is by default computed as the 
reaction at the centroid of the critical section (e.g., column centerline for interior 
columns) minus the self-weight and any superimposed surface dead and live load 
acting within the critical section. If the section is considered open, two 45 degree 
lines are drawn from the column corners to the nearest slab edge (lines AF and DE 
in Figure 2-19) and the self-weight and superimposed surface dead and live loads 
acting on the area ADEF are omitted from Vu. 

Computation of Unbalanced Moment at Critical Section  
The factored unbalanced moment used for shear transfer, Munbal, by default is 
computed as the sum of the joint moments to the left and right, taken to the 
centroidal axis of the critical section. 

Computation of Shear Stresses at Critical Section  
The punching shear stress printed by the program is based on the following:38 

                                                           
37 ACI 318-99, 8.11.8; ACI 318-02, 8.11.8 
38 ACI 318-99, 11.12.6.2; ACI 318-02, 11.12.6.2; CSA A23.3-94, 13.4.5 
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Vv = , Eq. 2-40 

where: 

Vu = factored shear force on the critical section described above, 
Ac = area of concrete, including beam if any, resisting shear transfer.  

Under conditions of combined shear, Vu, and an unbalanced moment, Munbal, 
γvMunbal is assumed to be transferred by eccentricity of shear about the centroidal 
axis of the critical section. The shear stresses printed by the program for this 
condition correspond to:39 
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+= , Eq. 2-41 
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−= , Eq. 2-42 

where: 

Munbal= factored unbalanced moment transferred directly from slab to column, 
as described above, 

γv = )1( fγ− , Eq. 2-43 
  is a fraction of unbalanced moment considered transferred by the 

eccentricity of shear about the centroid of the assumed critical 
section,40  

c = distance from centroid of critical section to the face of section 
where stress is being computed, 

Jc = property of the assumed critical section analogous to polar 
moment of inertia. 

Factor fγ  in . 2-43 is calculated as 

 
21

f b/b)3/2(1
1

+
=γ , Eq. 2-44 

where: 

                                                           
39 ACI 318-99, 11.12.6.2; ACI 318-02, 11.12.6.2; CSA A23.3-94, 13.4.5.5 
40 ACI 318-99, 11.12.6.2; ACI 318-02, 11.12.6.2; CSA A23.3-94, Eq, 13-8 
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b1 = width of critical section in the direction of analysis, 
b2 = width of the critical section in the transverse direction. 

pcaSlab calculates vu as the absolute maximum of vAB and vCD. Local effects of 
concentrated loads are not computed by pcaSlab and must be calculated manually. 

Shear Resistance at Corner Columns  
For CSA A23.3-94 Code the program performs one-way shear resistance check in 
the vicinity of corner columns. A critical shear section is located d/2 from the 
column corner. The minimum length section is selected using an optimization 
algorithm which analyzes sections at different angles. The extension to the 
cantilevered portion is considered by a length not to exceed effective slab 
thickness d. For slabs with edge beams or drop panels the check including the 
contribution of these components should be preformed manually. 

Shear Analysis of Longitudinal Beams  
When longitudinal beams are present in a span, pcaSlab will compute the shear 
reinforcement requirements for the beams. Table “Longitudinal Beam Shear 
Reinforcement Required” in the program output provides values of Vu, Vc, and 
Av/s for selected segment locations of each span. Segment lengths are chosen not 
to exceed the beam section depth. The beginning of first segment and the end of 
last segment correspond to the locations of critical sections on the left and right 
support respectively. The critical sections are located at a distance d, the effective 
beam depth, away from the column face at both the left and the right ends of the 
beam. However, if concentrated loads are present within distance d from the 
column face, critical section is selected at the column face.  

Vu is computed from the load acting over the entire width of the design strip. The 
program makes no distinction between shallow beams (α1l2/l1 less than 1) and 
deeper beams (α1l2/l1 greater than 1). 

For ACI 318 Code the shear strength provided by concrete, Vc, is computed by:41 

 dbf2V w
'
cc = . Eq. 2-45 

In CSA design, for beams without minimum stirrup reinforcement and greater than 
300 mm deep, Vc is calculated from the following equation: 

                                                           
41 ACI 318-99, 11.3.1.1; ACI 318-02, 11.3.1.1; CSA A23.3-94, 11.3.5.1 
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When 2/VV cu ϕ> , the beam must be provided with at least a minimum shear 
reinforcement of:42 
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A
= , Eq. 2-47 

where 

Av = area of two legs of stirrups, 
s = stirrups spacing, 
bw = longitudinal beam width, 
fyv = yield strength of the shear reinforcement. 

When cu VV ϕ> , shear reinforcement must be provided so that: 
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cuv
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= , Eq. 2-48 

where: 

Vu = factored shear force at the section being considered 
d = effective depth of the beam at the same location 

For the ACI 318-99 Code the strength reduction factor for shear calculations is 
specified as φ=0.85. For the ACI 318-02 Code the strength reduction factor for 
shear calculations is equal φ=0.75.  

When Vu exceeds φ5Vc, the beam section dimensions must be increased or 

a higher concrete strength must be provided.43 When dbf10V w
'
cu ϕ≤ , the 

spacing is computed as: 

 sb
v

A

s
A
1s = , Eq. 2-49 

where 

                                                           
42 ACI 318-99, 11.5.5.2; ACI 318-02, 11.5.5.2; CSA A23.3-94, 11.2.8.4 
43 ACI 318-99, 11.5.6.9; ACI 318-02, 11.5.6.9; CSA A23.3-94, 11.3.4 
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Asb =  total bar area of the two legged stirrup. 

The maximum stirrup spacing must not exceed d/2 nor 24 in when 

dbf6V w
'
cu ϕ≤ . When dbf6V w

'
cu ϕ> , the maximum stirrup spacing must be 

reduced by half, to d/4 or 12 in.44 When dbf10V w
'
cu ϕ> , the beam section 

dimensions must be increased or a higher concrete strength must be provided. 

When no ribs are present the program proportions the slab and beam share of one-
way shear according to the following ratios: 

 121121 l/l1,l/l α−α , Eq. 2-50 

When ribs are present (waffle) the program proportions the slab and beam share of 
one-way shear according to the following ratios of cross-section areas: 

 
beamribs

beam

beamribs

ribs
AA

A,
AA

A
++

. Eq. 2-51 

Torsion and Shear  
Torsion analysis can be engaged for beam and one way systems using the Torsion 
Analysis and Design check box located on the Solve Options tab in the Input | 
General Information dialog box. 

As far as torsional analysis is concerned, it is assumed that columns provide 
perfectly rigid supports so there is no transfer of torsional moments between spans. 
Within a span, torsional moments are considered only if a longitudinal beam is 
present. Torsion can be induced by concentrated and redistributed torsional loads 
and also, in the case of a beam with unsymmetrical cross sections, by self weight 
and area loads. A T-section with different flange widths is an example of a cross 
section which is not symmetrical. It can be obtained if a beam and a slab with 
different left and right widths are combined in the same span. However, in order 
for a flange to be considered in the torsional analysis its thickness has to be greater 
than twice the cover. If a flange is wider than the effective width then only the 
effective width is taken into account. 

The design for torsion is based on a thin-walled tube, space truss analogy. For the 
Canadian code the simplified method is used. Program allows both equilibrium 
and compatibility torsion conditions. In the equilibrium mode, which is assumed 

                                                           
44 ACI 318-99, 11.5.4; ACI 318-02, 11.5.4; CSA A23.3-94, 11.2.11 
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by default, unreduced total value of the torsional design moment is used in the 
design. In the compatibility mode45, factored torsional moments that exceed 

cracking moment crT (
cp

cp'
ccr p

A
f4T Φ= , Eq. 2-52) (0.67 crT for CSA) are 

reduced to the value of crT  (0.67 crT  for CSA). However, it is user’s 
responsibility to determine which mode is appropriate and pcaSlab does not 
perform any internal force redistribution if compatibility torsion is selected.  

If torsion analysis is engaged then both torsion and shear actions contribute to the 
amount of required transverse (stirrup) reinforcement. However, additional 
longitudinal bars distributed along the perimeter of a cross-section are also 
required to provide torsional resistance. 

For torsion design a span is divided into segments in the same way as for shear 
design. Governing values within a segment are used to design the whole segment. 
For stirrups, the governing values of torsional moment and shear force (acting 
simultaneously) will be these that produce the highest intensity of required stirrup 
area intensity. On the other hand, the required area of longitudinal bars depends 
only on the torsional moment so the highest absolute value of torsional moment 
will govern. Please note that since stirrup area depends both on shear and torsion 
whereas longitudinal bar area depends only on torsion so the governing values for 
stirrups and longitudinal bars can occur at different locations within a segment and 
for different load combinations. These governing values along with their location 
and associated load combination are output in the design results report. 

Effect of torsion within a segment will be neglected if the factored torsional 
moment, uT , at every segment location is less than one fourth of the torsion 
cracking moment, crT , which equals 

 
cp

cp'
ccr p

A
f4T Φ= , Eq. 2-52 

for ACI code and  
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cp'
cccr p

A
f4.0T λΦ= ,  Eq. 2-53 

                                                           
45 ACI 318-99, 11.6.2.2; ACI 318-02, 11.6.2.2; CSA A23.3-94, 11.2.9.2 
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for CSA standard where cpA  denotes the area enclosed by outside perimeter of 

concrete section and cpp  equals the outside perimeter of concrete section. To be 
adequate for torsion design, a section has to be proportioned in such a way that 
combined shear stress due to shear and torsion does not exceed the limit value 
specified by the code. In ACI code this condition reads as: 
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The simplified method of CSA standard defines this relation as: 
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pT
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V
Φ≤+ . Eq. 2-55 

In both relations, ohA  is the area enclosed by centerline of the outermost closed 
transverse reinforcement and hp  is the perimeter of that area. By default, flanges 
do not contribute to ohA  and hp . For sections with flanges, flanges will only be 
taken into account for ohA  and hp  if the option to include stirrups in flanges is 
engaged in the torsion design. In the program output, the combined stress (left 
hand side of the above inequalities) is denoted as fv and the limit value as vtsΦ . 

The required intensity of stirrup area to provide required torsional resistance is 
calculated from the following formula: 
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= , Eq. 2-56 

where the gross area enclosed by the shear path, oA , is taken as ohA85.0 . s/A t  
is the quantity per stirrup leg so the total requirement for stirrup intensity 
combining shear and torsion equals 
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A tvt2v +=+ . Eq. 2-57 

This value cannot be taken less than minimum stirrup area required by the codes. 
The minimum code requirements can be written in the following form: 
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In addition to stirrup spacing requirement defined for shear, program imposes one 
more torsion specific requirement for all codes which limits the spacing to the 
smaller of 8/ph  and 12 in [300 mm]. Based on the total required stirrup area 
intensity and spacing requirements, program attempts to select stirrups taking also 
into account that if stirrups with more than two legs have to be used than the area 
of an outer leg must not be less than tA . 

 
The area of additional longitudinal reinforcement, lA , is calculated from 
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For ACI code it is also checked against the following minimum value: 
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where s/A t  is calculated from Eq. 2-54 but is not taken less than yvw f/b25 . 
Longitudinal bars are selected in such a way that their area is not less than 

min,ll AA ≥  and that number of longitudinal bars in a section is enough to provide 
a bar in every corner of a stirrup and preserve spacing between bars not higher 
than 12 in [300 mm]. Also, bar sizes are selected not to have diameter less than 
No. 3 bar and not less than 1/24 of stirrup spacing for ACI codes and 1/16 for CSA 
standard. 

In the investigation mode when transverse and longitudinal reinforcement is input 
by the user, program checks the combined shear and torsional capacity of the 
system in terms of required and provided reinforcement area i.e. the provided area 
of reinforcement is compared with to the area of reinforcement required to resist 
applied loads. This is different approach than for flexure and shear actions with no 
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coupling where internal design forces are compared to capacity. In case where 
torsion and shear stirrup requirements are combined, the approach of comparing 
total reinforcement area is more convenient since it does not require dividing 
stirrup area into a part that resists torsion only and a part resisting shear only. For 
consistency, longitudinal reinforcement is also checked in terms of provided and 
required area. Other requirements like bar or stirrup spacing, number of 
longitudinal bars, area of stirrup outer leg, and combined stresses in concrete due 
to shear and torsion are checked also. Exceeded capacity and other conditions are 
flagged in the Design Results section of the report. 

Area of Reinforcement  
The program calculates the required area of reinforcement (top and bottom) based 
on the values of bending moment envelope within the clear span. For rectangular 
sections with no compression reinforcement, the design flexural strength of the 
column strip, middle strip and beam must equal the factored design moment: 
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The reinforcement can therefore be computed from: 
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For CSA A23.3-94 
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The effective depth of the section is taken as the overall section depth minus the 
distance from the extreme tension fiber to the tension reinforcement centroid. The 
column strip depth may include all or part of the drop panel depth. The drop depth 
will not be included in the effective depth of the column strip when the drop does 
not extend at least one-sixth the center-to-center span length in all directions, or 
when the drop depth below the slab is less than one-quarter the slab depth. If the 
drop does extend at least one-sixth the center-to-center span length and the drop 
depth is greater than one-quarter the distance from the edge of the drop panel to 
the face of the column or column capital, the excess depth will not be included in 
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the column strip effective depth. If the drop width is less than the column strip 
width, the drop width will be used in the computation of the required 
reinforcement. 

For the ACI 318-99 Code the strength reduction factor for flexure calculations is 
specified as φ=0.90.46 For the ACI 318-02 Code the strength reduction factor for 
tension-controlled sections ( 005.0t ≥ε ) is equal φ=0.90. For transition sections 
( 005.0002.0 t ≤ε≤ ) the strength reduction factor is specified by the formula: 

 t8348.0 ε⋅+=φ . Eq. 2-64 

ACI 318-02 Code specifies the strength reduction factor for compression 
controlled sections ( 002.0t <ε ) as equal φ=0.65. The reduction factors for 
transition or compression controlled sections have application primarily in 
investigation mode of the program. In design mode the program performs the 
calculations assuming tension controlled section or section with compressive 
reinforcement (if enabled). 

The ACI 318-99 Code requires keeping the steel ratio below 75 percent bρ , 
where:47 
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For CSA code the value of ρb is calculated as follows: 

 
yy

'
c

11b f700
700

f
f

+
βα=ρ , Eq. 2-66 

where 

                                                           
46 ACI 318-99, 9.3.2 
47 ACI 318-99, 8.4.3; CSA A23.3-94, 10.5.2 
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α1 = 67.0f 0015.085.0 '
c ≥− , 

β1 = 67.0f 0025.097.0 '
c ≥− . 

The ACI 318-02 Code controls the amount of reinforcement by limiting the value 
of net tensile strain ( 005.0t ≥ε )48 (tensioned controlled section). From this 
condition the equivalent maximum reinforcement ratio for rectangular section can 
be written as: 
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=ρ  Eq. 2-67 

If the calculated reinforcement exceeds the maximum allowed, a message will 
appear in the output. In such cases, it is recommended that the engineer review the 
slab thickness to ensure a more satisfactory design. If compression reinforcement 
calculations are enabled, pcaSlab will attempt to add compression reinforcement to 
the section. The program is capable to design compressive reinforcement for any 
design strip (column, middle, and beam) including also unbalanced moment strip. 

The amount of reinforcement provided will not be less than the code prescribed 
minimum. For the ACI 318 Code, the minimum ratio of reinforcement area to the 
gross sectional area of the slab strip using Grade 60 reinforcement is taken as 
0.0018. When reinforcement yield strength exceeds 60 ksi, the minimum ratio is 
set to yf/600015.0 ⋅ . For reinforcement with yield strength less than 60 ksi, the 
minimum ratio is set to 0.0020. In no case will this ratio be less than 0.0014 (See 
Table 2-6)49. The CSA Standard requires a minimum ratio of slab reinforcement 
area to gross sectional area of the slab strip equal to 0.002 for all grades of 
reinforcement50. 

fy (ksi) As/Ag 

< 60 0.0020 

≥ 60 0014.0
f

600018.0

y
≥

×  

Table 2-6. Minimum Ratios of Reinforcement to Gross Concrete Area 

                                                           
48 ACI 318-02, 10.3.5 
49 ACI 318-99, 7.12.2.1; ACI 318-02, 7.12.2.1 
50 CSA A23.3-94, 7.8.1 
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According to ACI code for beams and positive moment regions of waffle slabs, 
minimum reinforcement provided will not be less than:51 

 db
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c

min,s =  Eq. 2-68 

and not less than yw f/db200 . 

Similar equation prescribed by CSA code has the form52: 
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In calculating required amounts of negative support steel for CSA A23.3-94 Code, 
the program performs the adjustment for banded and distributed reinforcement. 
The code requires concentrating one-third of the negative reinforcement at interior 
supports in the band region extending 1.5 hs from the sides of the columns. At 
exterior supports the total negative reinforcement is placed in the band region. The 
remaining portion of the negative reinforcement needs to be placed in the 
distributed strip. The reinforcement in banded and distributed strip is also checked 
for compliance with the minimum reinforcement requirement. 

Reinforcement Selection  
The default minimum clear spacing of reinforcement considered in pcaSlab is the 
Code prescribed minima for both slabs and beams of one bar diameter, db, or 
1 in.53 The user may select clear spacing greater than the default value. 

For two-way systems, the maximum spacing of reinforcement is kept at two times 
the slab thickness for the ACI code54 and three times the slab thickness for the 
CSA code55 but no more than 18 in. or 500 mm respectively. For waffle slabs the 
limit is increased to 5 times the slab thickness56. When calculating negative 
support reinforcement for the CSA code57, the program assumes that banded 

                                                           
51 ACI 318-99, 10.5.1; ACI 318-02, 10.5.1 
52 CSA A23.3-94, 10.5.1.2(b) 
53 ACI 318-99, 7.6.1; ACI 318-02, 7.6.1 
54 ACI 318-99, 13.3.2; ACI 318-02, 13.3.2 
55 CSA A23.3-94, 13.11.3(b) 
56 ACI 318-02, 7.12.2.2; ACI 318-02, 7.12.2.2; CSA A23.3-94, 7.8.3 
57 CSA A23.3-94, 13.11.3(a) 
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reinforcement over supports is spaced at a maximum of 1.5 hs and no more than 
250 mm. 

In case of beams and one-way systems the maximum spacing of reinforcement is 
selected so that the crack control requirements of the ACI and the CSA codes58 are 
met. 

An iterative process is performed to determine the number of bars and bar size. 
The initial number of bars is determined by dividing the total reinforcement area 
required, As, by the area of one bar, Asb, of the input minimum bar size. Next, the 
spacing is determined. If the minimum spacing limitations are violated, the bar 
size is increased and the iterative process continues until all bars sizes have been 
checked. If the maximum spacing limitations are not met, the number of bars 
required to satisfy these limitations is computed and the iteration process 
terminates. 

For beams, layered reinforcement is provided if sufficient beam width is not 
available. pcaSlab assumes a 1.5 in cover to stirrup for width calculations. pcaSlab 
also assumes that the longitudinal bar makes contact at the middle of the stirrup 
bend where the minimum inside diameter of the bend is 4db. Therefore, an 
additional width is added to the cover for longitudinal bars less than #14 (an SI N-
45) in size (Figure 2-20 – Figure 2-21). This additional width due to the bend, 
wbend, is equal to: 

 ⎟
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⎛ −=

2
d0.1 293.0w b

bend , Eq. 2-70 

where 

db = bar diameter of the longitudinal bar. 

The clear distance between layers is assumed 1.0 in. Hooks and bends are not 
included in bar length figures. 

                                                           
58 ACI 318-99, 10.6.4; ACI 318-02, 10.6.4; CSA A23.3-94, 10.6.1 
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Figure 2-20 Width due to strip bend 

 
Figure 2-21 Detail reinforcement in longitudinal beams 

Bar-length computations are performed for two-way slabs and longitudinal beams. 
For top reinforcement at the supports, the length for long bars is given by: 
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and the length for short bars is given by: 
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where: 

max(l50%) = maximum distance to the points of 50% demand, 
max(lpi) = maximum distance to the points of inflection (P.I.), 
ld = bar development length59, 
d = effective depth, 
db = bar diameter, 
ln = clear span length, 
lfos = distance to the face of support (column), 
lcr = minimum code prescribed extension. 

These bar lengths are then compared and adjusted if necessary to the minimum 
requirements specified by the code.60 Additionally the program may select 
continuous top bars in those spans where steel is required by calculation in mid-
span at top. 

If the computed bar lengths overlap, it is recommended that such reinforcement be 
run continuously. The printed bar lengths do not include hooks or portions of bars 
bent down into spandrel beams or other bar-bend configurations.  

The selection of bar lengths for positive reinforcement for flat plates, flat slabs, 
and beam-supported slabs, is based strictly on the minimum values of the Code. 
For waffle slabs, however, the positive reinforcement selection is based on an 
additional assumption of two bars per joist. For purposes of output, one bar is 
treated as a long bar and the other as a short bar. 

The development length depends on the following factors: concrete cover, 
minimum transverse reinforcement, special transverse reinforcement, layer 

                                                           
59 ACI 318-99, Chapter 12; ACI 318-02, Chapter 12; CSA A23.3-94, Clause 12.2 
60 ACI 318-99, Figure 13.3.8; ACI 318-02, Figure 13.3.8; CSA A23.3-94, Figure 13.1 
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location bar size and bar clear spacing. The computation of tension development 
lengths in terms of db is given by the general expression: 
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where: 

α = reinforcement location factor (1 or 1.3), 
β = coating factor (1.2 or 1.5), 
γ = reinforcement size factor (1 or 0.8), 
λ = light weight aggregate concrete factor (1 or 1.3), 
Ktr = transverse reinforcement index, 
C = spacing or cover dimension. 

Additional Reinforcement at Support  
pcaSlab computes the fraction of the unbalanced moment, γf Mu, that must be 
transferred by flexure within an effective slab width (a band) equal to the column 
width plus one and one-half the slab or drop panel depth (1.5h) on either side of 
the column where:61 
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The amount of reinforcement required to resist this moment is computed. The 
amount of reinforcement already provided for negative flexure is then computed 
from the bar schedule (i.e. the number of bars that fall within the effective slab 
width multiplied by the area of each bar). If the reinforcement area provided for 
flexure is greater than or equal to the reinforcement requirements to resist moment 
transfer by flexure, no additional reinforcement is provided, and the number of 
additional bars will be set to 0. If the amount of reinforcement provided for flexure 
is less than that required for moment transfer by flexure, additional reinforcement 
is required. The additional reinforcement is the difference between that required 
for unbalanced moment transfer by flexure and that provided for design bending 
moment in the slab, and it is selected based on the bar size already provided at the 
support. 

                                                           
61 ACI 318-99, 13.5.3.2; ACI 318-02, 13.5.3.2; CSA A23.3-94, 13.11.2 and 13.4.5.3 
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It should be noted that the ACI Code62 requires either concentration of 
reinforcement over column beam joint by closer spacing, or additional 
reinforcement, to resist the transfer moment within the effective slab width. Thus 
for the ACI code, pcaSlab only provides additional reinforcement and does not 
concentrate existing reinforcement. The CSA Code, however, requires 
concentration of column strip reinforcement within the bands over supports63, 
which is done in pcaSlab first and then additional reinforcement is provided, if 
necessary. 

Integrity Reinforcement  
For the ACI Code, all bottom bars in the column strip should extend continuously 
(or with splices) in the entire span and at least two of these bars should pass within 
the column core and should be anchored at exterior supports64.  

For the CSA Code, the program performs calculation of the amount of integrity 
reinforcement at slab column connections. The integrity reinforcement is required 
for slabs without beams. Integrity reinforcement is not required if there are beams 
containing shear reinforcement in all spans framing into the column. Otherwise, 
the sum of all bottom reinforcement connecting the slab to the column on all faces 
of the periphery should meet the condition: 

 
y

se
sb f

V2A ≥∑  Eq. 2-75 

and should consist of at least two bars65. 

Corner Reinforcement  
The program performs calculation of the amount of reinforcement in exterior 
corners of slabs with stiff edge beams (α greater than 1.0)66. This reinforcement is 
required within a region equal to 1/5 of the shorter span. The amount of corner 
reinforcement is calculated from the moment per unit width intensity 
corresponding to the maximum positive moment in span. The Code requires the 
corner reinforcement to be placed at top and bottom of the slab in bands parallel to 
the sides of the slab edges. 
                                                           
62 ACI 318-99, 13.5.3.4, ACI 318-02, 13.5.3.4 
63 CSA A23.3-94, 13.12.2.1 and 13.12.2.2 
64 ACI 318-99, 13.3.8.5, ACI 318-02, 13.3.8.5 
65 CSA A23.3-94, 13.11.5.1 and 13.11.5.2 
66 ACI 318-99, 13.3.6; ACI 318-02, 13.3.6; CSA A23.3-94, 13.13.5 
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Deflections  

Deflections of two-ways systems  
Calculation of deflections of reinforced concrete two-way slabs is complicated by 
a large number of significant parameters such as: the aspect ratio of the panels, the 
vertical and torsional deflection of supporting beams, the stiffening effect of drop 
panels and column capitals, cracking, and the time-dependent nature of the 
material response. Based on studies (Ref. [22–24]), an approximate method 
consistent with the equivalent frame method was developed (Ref. [25]) to estimate 
the column and middle strip deflections. 

Calculation of the midspan deflection of the column strip or the middle strip is 
based on the M/EI ratio of the strip to that of the full-width panel: 
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where af,ref is taken from the equivalent frame analysis assuming gross section (un-
cracked) or effective (cracked) section properties. 

The ratio (Mstrip/Mframe) can be considered as a lateral distribution factor, LDF. The 
lateral distribution factor, LDF, at an exterior negative moment region is:  
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The LDF at an interior negative moment region is: 
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The LDF at a positive moment region is: 
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where: 

α1 = the ratio of flexure stiffness of a beam section to the flexural 
stiffness of a width of slab bounded laterally by centerlines of 
adjacent panels on either side of the beam, 
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βt = ratio of torsional stiffness of an edge beam section to the flexural 
stiffness of a width of slab equal to the span length of the beam, 
center-to-center of the supports (see Eq. 2-27). 

When αll2/l1 is greater than 1.0, αll2/l1 will be set equal to 1.0. 

The column and middle strip LDF’s can be computed by: 
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 cm LDF100LDF −= , Eq. 2-81 

where: 

LDFneg,l = LDF for the negative moment region at the left end of the span 
LDFneg,r = LDF for the negative moment region at the right end of the span 

The deflections should be used in conjunction with the deflections obtained from 
an analysis in the transverse direction. For square panels (l1 = l2), the midpanel 
deflection is obtained by . 2-82 as shown in Figure 2-22: 

 mycxmxcy aaaaa +=+= . Eq. 2-82 

For rectangular panels, (l1 ≠ l2), the mid panel deflection is obtained by . 2-83: 
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= . Eq. 2-83 

When calculating the deflections for effective (cracked) section properties, the 
equivalent frame solution is obtained for two load levels: 

• dead load only, 

• dead load and live load combined. 

The effective section properties are assumed corresponding to the load level. 

Deflections of beam and one-way systems  
Continuous beam and one-way slab deflections are computed based on simply 
supported deflections less the deflection due to the end support rotations. The 
effects of support settlement or shear deformations are not considered. When 
segmental moments and shears are requested, the segmental deflections printed are 
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at 20 equally spaced sections along the span. Concentrated loads occurring at other 
locations will give rise to larger deflections. These must be checked manually. 

Cracking  
If gross section properties option is selected for deflection calculations in the input, 
the deflection calculations will be based on the gross section Ig. If cracked section 
properties option is selected the effect of cracking on the deflection calculations is 
considered. The effect of cracking in slabs, as in beams, is a reduction in the 
flexural stiffness. The effect of cracking is generally an increase in deflections, 
although the tensile concrete between cracks continues to have a stiffening 
influence. A detailed review of several methods of deflection analyses can be 
found in Ref. [24]. 
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Figure 2-22 Deflection computation for a square panel 

To apply the Code-specified effective moment of inertia to slab systems, a value of 
Ia,frame is used instead. The value of Ia,frame is given by: 
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where: 

+
eI  = effective moment of inertia for the positive moment region, 
−

1,eI  = effective moment of inertia for the negative moment region at 
the left support, 

−
r,eI  = effective moment of inertia for the negative moment region at 

the right support, 
β  = an empirical constant based on experimental data, whose value 

is less than 1.0. 

For flat plates, flat slabs, and waffle slabs, the appropriate value of β appears to be 
0.5. pcaSlab uses a value of 0.5 for flat plates, flat slabs, and waffle slab systems 
and 0.7 for beam-supported slabs.  

The value of Ia,frame for cantilever spans is given by: 

 ( ) −− β−+β= end.esup,eframe,a I1II , Eq. 2-85 

where: 

−
end,eI  = effective moment of inertia for the negative moment region at 

the cantilever end, 
−

sup,eI  = effective moment of inertia for the negative moment region at 
support. 

For flat plates, flat slabs, and waffle slabs, the appropriate value of β appears to be 
1.0. pcaSlab uses a value of 1.0 for flat plates, flat slabs, waffle slabs, and beam-
supported slabs. 
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The value of Ie corresponds to the effective moment of inertia as developed by 
Branson (Ref. [26]) and incorporated into the Code as follows:67 
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where 

Ig = moment of inertia of the gross uncracked concrete section for the 
full width of the equivalent frame, 

Icr = moment of inertia of the cracked transformed concrete section 
for the full width of the equivalent frame, 

Mcr = cracking moment for the full width of the equivalent frame, 
Mmax = maximum bending moment for the full width of the equivalent 

frame at the load stage at which the deflection is computed. 

It should be noted that the use of the full slab width in determining Ie in . 2-86 is 
intended to average the effects of cracking of the column and middle strips. 

Instantaneous Deflections  
Two values of mid-span deflections are computed by the program for each span. 
The first corresponds to dead load on all spans, while the second corresponds to 
dead load plus live load on all spans. Note that the live load deflection is always 
computed as total load deflection minus the dead load defection. This is consistent 
with the Ieff method outlined in the Code. 

Long Time Deflections  
Long term deflection calculations are beyond the scope of the program. Users need 
to calculate long term deflection manually. The total mid-panel deflection 
(including long-time effects) consists of the following: 

 shcreepetotal aaaa ++= , Eq. 2-87 

where 

ae = elastic deflection, 
acreep = additional deflection due to creap, 
ash = additional deflection due to shrinkage, 
atotal = total deflection. 

                                                           
67 ACI 318-99, 9.5.2.3; ACI 318-02, 9.5.2.3 
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Data reported in the literature, although limited in quantity, indicate that the 
additional deflection due to creep and shrinkage, acreep + ash, may be as much as 
two to eight times the elastic deflection, ae (Ref. [27-30, 43]). Such a factor times 
the dead load deflection may be used for an estimate of required slab camber. 

For a crude approximation to a complex problem, the total instantaneous plus 
long-time deflections may be computed as three times the instantaneous 
deflections ( i∆ ). This approximation results from conservative estimation of code 
specified68 multiplier, λ , for additional long-term deflections caused by the 
sustained load. Assuming no tension reinforcement ( 0' =ρ ), the maximum value 
of the time-dependant factor ( 2=ξ ) and that all load is sustained, we arrive at 
total deflection 

 iii 3)
'501

1()1( ∆≤∆
ρ+

ξ
+=∆λ+ . Eq. 2-88 

For a more detailed method of analysis of long-time deflection the user is referred 
to a study by Rangan (Ref. [30]). 

Material Quantities  
The program computes concrete and reinforcing steel quantities. The quantity of 
concrete is based on an average of the slab, drop, and beam sizes. The total 
quantity of reinforcing steel computed by the program corresponds to the actual 
bar sizes and lengths required by design. No allowance is made for bar hooks, 
anchorage embedment, and so forth. It should be noted that the quantity of 
reinforcement printed by the program pertains to bending in one direction only. In 
practice, the total amount of reinforcement for the structure should also include the 
quantities obtained for the appropriate transverse equivalent frames. 

                                                           
68 ACI 318-99, 9.5.2.5; ACI 318-02, 9.5.2.5; CSA A.23.3-94, 9.8.2.5 
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Chapter 3 pcaSlab/pcaBeam Interface 
pcaSlab/pcaBeam Interface 

User Interface Components  

Check Boxes  
A check box is a toggle used in a dialog box 
that enables or disables an option. To enable 
a check box, toggle the switch so that a  
sign is placed in the box. Removing the  
sign from the check box disables the 
command. Click once in the check box with 
the mouse to enable or disable the command 
or use the keyboard keys to tab to the check 
box and press the space bar to activate the 
option.  

Checked Menu Commands  
If the menu commands are checked with a  
sign on the left, the menu commands are 
enabled in the current project. To disable the 
command, single click the left mouse button 
on the command to clear the  sign. For 
example, since the Toolbar and Status bar 
commands are checked in the image above, 
both the toolbar and status bar will appear in 
the main window of pcaSlab. 

Command Buttons  
Command buttons such as OK and CANCEL buttons that are located inside dialog 
boxes, are labeled to do exactly what they say. After you have completed your 
input within a dialog box, click once with the left mouse button on Ok (all 
Windows) or press ALT + O with the keyboard keys (Windows 95, 98, ME) to 
save the changes. If, while working in a dialog box, you want to disregard the data 
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you have input, select CANCEL (all Windows) to exit and discard any new data. 
When using the keyboard keys select ALT + C (Windows 95, 98, ME). 

Control Menu  
Each window has a control menu located 
to the left of the title bar, in the upper 
left corner of the window. This menu 
contains commands that allow you to 
manipulate that particular window. To 
access the control menu using the 
mouse, click the left mouse button on 
pcaSlab icon in the upper left corner. To 
access the control menu using the 
keyboard, press CTRL + F6 to cycle 
through the windows until you reach the 
desired window and press ALT + – (hyphen). 

Dialog Boxes  
Dialog boxes are used to request information or provide you with information. By 
selecting a command from a menu, a dialog box may be displayed requesting data 
to complete the command. A dialog box will follow any command that contains 
three trailing periods, "...". After entering the required data, press the OK button so 
that the data associated with that dialog box will be acted upon. 

Drop-down List  
A drop-down list is a list box that appears initially as a rectangular box with the 
current selection marked. To see a list of available choices, click the arrow to the 
right of the box or press ALT + DOWN ARROW to open the box. You can now 
select another item in a similar way as you would use a list box. 

Usually there are some items in a drop-down list. You may click the left mouse 
button on the  button on the right side of the list to extend the list. Then select the 
item you need by single clicking the left mouse button on the item. The selected 
item will appear in the text box on the top of the drop-down list. If there are too 
many items in a drop-down list, a vertical scroll bar will appear automatically so 
that you can use it to scroll up and down. 
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Drop-down Menu  
A drop-down menu is the menu that is shown directly beneath the menu line when 
you click one of the menu items on the menu line using the left mouse button.  

For example, the File menu appears directly 
beneath the "File" menu item when you click 
the "File" on the menu line or press ALT + F 
using keyboard.  

Enable/Disable Options  
Some commands in the pop-up menus or 
input controls in the dialog boxes are black 
while others are gray. Commands that are 
black are available for use at that time. 
Commands that are grey are not available 
but may become available depending on the 
data you enter.  

For example, in the Input menu, the 
Reinforcing Bars command is gray at the 
start of a new file. When you change the Run 
Mode from Design to Investigation in the 
General Information dialog box you will 
notice that the Reinforcing Bar command 
becomes black and is now ready for your 
input. 

Frame Boxes  
A frame box groups some related objects 
together, such as text boxes or option 
buttons.  

List Boxes  
A list box displays a list of choices or items. If there are more choices than can fit 
in the box, scroll bars are provided so you can move quickly through the list. 

The scroll bar is usually located to the right (vertical scroll bar) or at the bottom 
(horizontal scroll bar) of a list box. It has two directional arrows at either end (up 
and down, or left and right) in addition to a small rectangle called the scroll box. 
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The location of the scroll box with respect to the length of the bar indicates the 
proportion of the amount of the information in view to the whole list. 

To scroll through information displayed in a list box one line at a time, click the up 
or down scroll arrow or, using the keyboard, press the arrow key that points in the 
direction you want to scroll. Another way is to click inside the scroll bar above or 
below the scroll box. This scrolls 
the list one screen at a time (the 
keyboard equivalent is pressing 
the PAGE UP or PAGE DOWN 
key). If you drag the scroll box in 
the scroll bar, the section of the 
list that moves into view depends 
on where you position the scroll 
box. 

To select a single item from a list 
box click the scroll arrows until 
the item you want to select 
appears in the list box. Click the 
item. Using the keyboard, use the 
directional arrow keys to scroll to 
the item you want. 

To select multiple sequential items in a list click the first item you want to select 
and then drag the cursor to the last item you want to select. Alternatively, click on 
the first item you want to select, press and hold down the SHIFT key, and click on 
the last item you want to select. Both items, and all items in between, are selected. 
To cancel the selections, release the SHIFT key and click any item. 

Using the keyboard, use the UP ARROW or DOWN ARROW key to move the 
cursor to the first item you want to select. Press and hold down the SHIFT key. 
Continue to press the ARROW key repeatedly until all the items you want are 
selected. To cancel the selections, release the SHIFT key and press one of the 
ARROW keys. 

To select multiple non-sequential items in a list press and hold down the CTRL 
key, and click each item you want to select. To cancel a selection, press and hold 
down the CTRL key, and click the item again. There are no keyboard equivalents 
for this procedure. 

Selected items in a list box can be copied to the clipboard by simply pressing F3 
after you make your selection. You will be able to view the contents of the 
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clipboard by opening the Clipboard Viewer in the Program Manager. Furthermore, 
the copied information can be transferred to other Windows applications (such as 
Microsoft Excel) using the application's Edit/Paste command. The transferred 
information will be indented and tabulated. 

Option Buttons  
An option button is used in a group of 
options from which you may select only one. 
A group of option buttons is a type of toggle 
(on/off) switch that when one option button 
is chosen, its state is toggled on and all other 
option buttons are toggled off. For example, 
in the General Information dialog box you 
will see option buttons. When using a 
mouse, place the cursor over the option 
desired and click the left button once to 
toggle the switch on. When using the keyboard keys, tab to the group of options 
and choose one by using the up and down arrow keys to toggle the switch. 

Pop-up Menu  
A pop-up menu is the menu that is shown when 
you click the right mouse button on a view 
window. The commands on a pop-up menu are 
usually the commonly used commands 
associated with the view window that you right 
click on.  

Tabs  
Tabs are different dialog boxes that are 
integrated together in a more compact 
interface. Each tab is actually a dialog box 
itself and each tab has a tab title. For example, 
there are three tabs in the image shown above 
and the titles for them are Slabs, Longitudinal 
Beams, and Ribs, respectively. You may see 
different text boxes, option buttons, etc. on 

different tabs. To push a tab to the top or to activate a tab, single click the left 
mouse button on the title of the tab that you want to access. Once a tab is activated 
(on the top), other tabs are covered by the activated one and cannot be accessed.  
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Text Boxes  
Text Boxes are rectangular boxes inside dialog boxes that require text to be 
completed. In some cases, the edit box will contain only a flashing cursor located 
at the left side of the box prompting you to enter text. In other cases there may 
already be text in the text boxes. This text can be overwritten when you begin 
typing. To erase the text, use the backspace or the delete keys.  

Main Window  

 
The main screen will appear after the pcaSlab is started as shown above. The main 
screen consists of a title bar, menu line, tool bar, five view windows and status bar. 
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The pcaSlab name and current data file name is shown in the title bar. All the 
menu commands can be accessed from the menu line and some frequently used 
commands also can be accessed from the buttons in the tool bar. The four view 
windows show the geometry of a floor system and the loads on it. Plan view, side 
view, elevated view and isometric view are available. The status bar shows the 
current states of pcaSlab. 

Title Bar  

 
The title bar displays the pcaSlab name, and following the hyphen, displays the 
name of the current data file you are using. If the data you are currently working 
on has not been saved into a file, the word pcaSlab1 is displayed in the title bar. If 
you start an other new data file by clicking the NEW button on the most left of the 
tool bar, the next data file is named as pcaSlab2, and so on.  

Menu Bar  

 
Located directly below the title bar is the menu line. pcaSlab commands are listed 
in the pop-up menus located in the menu line. These menu commands allow you to 
perform functions that create, view, and ultimately design the floor system. 

In the pcaSlab program there are seven main pull-down menus: File, Input, Solve, 
View, Options, Windows, and Help. To access a menu item using the mouse, 
place the arrow cursor on the menu item you want and click the left mouse button. 
Each menu item can also be selected with the keyboard keys by simultaneously 
pressing the ALT key and the underlined letter of the menu you want to open. For 
example, to open the File menu, press ALT + F. To close a menu without selecting 
a command, move the cursor to any blank area on the screen and click the left 
mouse button. Press ESC key to close a menu using the keyboard keys. 

To select a command from a menu with the mouse, place the arrow on the item 
you want, and click the left mouse button. In some cases, you will be told to 
double click on a selection, that is, press the mouse button twice, quickly. Anytime 
you have to wait, for example, when loading the program or designing the system, 
the mouse cursor becomes an hourglass cursor. It will return to its original state 
when the task is completed. 

To select a command from a menu using the keyboard, use the down arrow key to 
highlight your choice and press ENTER key or press the keyboard key of the 
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command’s underlined letter. The space bar is also equivalent to pressing the left 
mouse button. 

Special instructions for inputting with the keyboard keys are given wherever 
necessary. 

Tool Bar  

 
Located directly below the menu line is the tool bar. Some frequently used buttons 
can be found in the tool bar. A description of the corresponding button is shown in 
the status bar (on the bottom of the window) when the mouse cursor is moving 
over this button. In addition to the description in the status bar, a brief tip is shown 
in a light yellow colored pop-up window close to the corresponding button when a 
mouse cursor is hanging over the button for a short period of time. Exactly the 
same functions or features can be accessed from either the menu items or tool bar 
buttons.  

The tool bar can be changed from docking status to floating status by single 
clicking the left mouse button on the tool bar and dragging it away from the 
docking position to any other positions on the screen. A floating tool bar can be 
resized by clicking and dragging its borders.  

To restore the tool bar to the docking status, single click the left mouse button on 
the tool bar and drag it to the location that is directly below the menu line and 
release the mouse button. 

View Windows  
A total of 10 view windows can be used to show Plan, Elevated, Side and 
Isometric views of the geometry, as well as Loads, Shear and Moment, Moment 
Capacity, Shear Capacity, Deflection, and Reinforcement. 
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Status Bar  
Status bar is always on the bottom of the main window. The status bar shows the 
current status of the data file and the coordinate values of the mouse cursor 
position. 

For example, the figure above shows that pcaSlab is ready to take user input and 
the current view window is Deflection View. The "x=9.044 ft" is the horizontal 
coordinate of the mouse cursor (shown as "+" symbol) and the "Dz=-0.055 in" 
shows the current vertical value of the mouse cursor. Depending on the active 
view window, different information of the mouse cursor will appear in the status 
bar. 
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File Menu  
The File menu is used for saving or retrieving data, 
printing, and exiting. The File menu contains the 
following commands: New, Open, Close, Save, 
Save As, Print Preview, Print Results, Print Setup, 
Recent Files and Exit.  

New  
The New command clears any data input and returns to the default values. Thus, 
you are able to create a new data file. However, before you can begin a new data 
file, pcaSlab will ask whether you want to save the current data. Answering YES 
will save the old data and begin a new data file. 
Answering NO will discard any changes to the 
data and begin a new data file. Answering 
CANCEL will return you to pcaSlab so that you 
can continue to work with the current data.  

Open  
The Open command allows you to load an existing pcaSlab data file. The dialog 
box that appears shows you a listing of all the files with the extension contained in 



 

pcaSlab/pcaBeam Interface  3-11 

the default data directory or in the current directory (if a default data directory was 
not specified). This box also enables you to change the current drive and directory. 
If you are currently working on a data file and select the Open command, pcaSlab 
will ask whether you want to save the current data. Answering YES will save the 
old data and display the Open dialog box. Answering NO will discard any changes 
to the data and display the Open dialog box. Answering CANCEL will return you to 
pcaSlab so that you can continue to work with the current data.  

Close  
The Close command allows you to close the current pcaSlab data file. If you are 
currently working on a data file and select the Open command, pcaSlab will ask 
whether you want to save the current data. Answering YES will save the old data 
and display the Open dialog box. Answering NO will discard any changes to the 
data and display the Open dialog box. Answering CANCEL will return you to 
pcaSlab so that you can continue to work with the current data.  

Save  
The Save command saves the changes you’ve made to the current data under that 
same filename. The new data overwrites the old data, and you cannot retrieve the 
old data. It is a good practice to periodically save while inputting data. If a data file 
is untitled, the Save As dialog box will appear. 

Save As  
The Save As command allows you to 
name or rename a data file. Use Save As 
when you want to save both the original 
data and any changes you’ve currently 
made to the data. The original data 
remains under the old filename. If a file 
of the same name exists, the program 
will ask if you would like to overwrite 
the file. 

Print Preview  
The Print Preview command allows you to preview and print the current view 
window (floor system geometry in the plan, elevated, and isometric views, prints 
the shear and moment diagrams, and prints the deflected shapes). To obtain a view 
window you must first perform the design, then select what you want to view from 
the View menu. You may have more than one view windows opened. The current 
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view window is the one activated and on top of the others on your screen. 
Selecting this command closes the pcaSlab main window and opens the print 
preview window as shown below. On the print preview window, press the ZOOM 
IN or ZOOM OUT buttons or simply click the left mouse button on the preview 
window to magnify or reduce the size of the preview paper. Press the NEXT PAGE 
button if more than one page needs to be printed. Press the PRINT button to print 
the view. The printer could be a local printer, which is connected to your computer 
directly, or a network printer. Press the CLOSE button to close the preview window 
and go back to pcaSlab. 

 

Print Results  
The Print Results command allows you to send the analysis and/or design results 
to the printer. Selecting this command will show the Results Report Setup dialog 
box. By selecting items in the Selection group prior to performing the print, you 
can print selected sections of the data instead of the entire analysis. Option 
Include Non-redistributed Internal Forces is available only for beams/one-way 
slab systems if moment redistribution is engaged. It allows including in the report 
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non-redistributed internal forces in addition to redistributed values which are 
printed by default. 

   

Printer Setup  
The Printer Setup command brings up the Windows printer setup box which 
allows the user to select the printer to send the output to and to change the settings 
of the printer. 

Recent Files  
This list contains the data files that are used recently and can be accessed quickly 
from the menu by a single click. The most recently used one is on the top of the 
list. Up to four files can be listed.  

Exit  
The Exit command ends the pcaSlab session and returns you to Windows. If you 
have made any changes to your data and have not saved them, pcaSlab will first 
ask whether you want to save or abandon any changes you’ve made before you 
exit.  

Input Menu  
The Input menu allows you to enter and modify data for 
the floor system. The Input menu contains the following 
commands: Data Input Wizard, General Information, 
Material Properties, Spans, Supports, Reinforcement 
Criteria, Reinforcing Bars, Load Cases, Load 
Combinations, Span Loads, Support Loads and 
Displacements, and Lateral Effects.  
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Data Input Wizard   
The Data Input Wizard command is designed to make the inputting process 
easier. By selecting Data Input Wizard, a logical sequence of dialog boxes will 
automatically be displayed allowing you to enter data for your floor system.  

General Information  
The General Information consists of three 
tabs: General Information, Solve Options, 
and Span Control. 

The General Information tab will allow 
you to enter the project name, frame name, 
engineer name, design code, rebar database, 
run mode, and number of supports. You 
must always use the General Information 
tab before doing any further inputting since 
it affects the availability of other commands 
in this menu. 

The Solve Options command allows you to 
specify design options and deflection 
calculations options. Please note that design 
options for two-way systems are different 
from beams/one-way slab systems. To take 
effect, this command must be used prior to Execute. 
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The Span Control tab provides commands for span manipulation such as inserting 
new spans, copying spans, moving spans, and deleting spans. 

Material Properties  
The Material Properties command enables you to input material property 
requirements for concrete and reinforcement. Concrete density, compressive 
strength, Young’s modulus, rapture modulus, as well as the longitudinal and shear 
reinforcement yield levels, are required. 

  

Spans  
The Spans menu allows you to input geometric dimensions for slabs, longitudinal 
beams, and ribs. 
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Supports  
The Supports menu allows you to input geometric dimensions for columns, drop 
panels, column capitals, and transverse beams. The percentage of the actual 
column joint stiffness to be used in the analysis to determine the joint moments 
and shears can be modified on the Columns tab. The Drop Panels tab is available 
if two-way system is selected and the Moment Redistribution tab is available 
only for beams/one-way slab systems if moment redistribution is engaged in the 
General Information window. 
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Reinforcement Criteria  
The Reinforcement Criteria menu allows you to specify the distance to 
reinforcement, reinforcement bar sizes, bar spacing, and reinforcing ratio for both 
slabs and beams.  

 

Reinforcement Bars  
For two-way floor systems, the Reinforcement Bars menu allows you to specify 
the longitudinal reinforcement arrangement information for column strip, middle 
strip, and beam, as well as shear reinforcing information for beams.  
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For beams/one-way slab systems, flexural bars, stirrups, and torsional longitudinal 
reinforcement can be specified. The Reinforcement Bars menu is disabled if Run 
Mode of Design is selected from the General Information dialog box. Select the 
Run Mode of Investigation from the General Information dialog box to enable 
it. 

 

Load Cases  
The Load Cases menu allows you to specify load cases. Up to six load cases can 
be added and only one live load case is allowed. 
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Load Combinations  
The Load Combinations menu allows you to specify load combinations as shown 
in Figure 3-34. Up to twenty load combinations can be added. 

 

Span Loads  
The Span Loads menu allows you to enter superimposed area loads, line loads, 
point loads, and moments.  
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Support Loads and Displacements  
The Support Loads and Displacements menu allows you to enter prescribed 
displacements and rotations of supports as well as concentrated loads applied 
directly at support locations. 

 

Lateral Effects  
The Lateral Effects menu allows you to enter the lateral loads as moments acting 
on the two ends of each span.  
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Solve Menu  
The Solve menu contains commands that enable you to perform the 
analysis and/or design of the floor system and view the results. The 
Solve menu contains the following commands: Execute and Report.   

Execute  
The Execute command executes the solver 
portion of pcaSlab. If some data is still 
required when this command is executed, 
pcaSlab will respond with an "Invalid 
Model!" error message. The missing data 
must be completed before execution. A status 
window pops up and shows 
the status during the 
execution. If the execution is 
not successful, an error 
message will be shown and 
the execution is terminated.  

Results Report  
The Results Report command brings up a window with text results of the analysis 
and/or design as shown below. From this window, results can be copied to 
clipboard or printed using Copy and Print command buttons. 
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To change the content of report, select items [1] through [7] from the combo box. 
Item Customize brings up the Results Report Setup window described earlier 
(Print Results, page 3-12). It will allow you to generate a report with multiple item 
selected. 

View Menu  
The View menu commands enable you to modify 
the floor system’s appearance on the screen to 
suit your viewing needs and enable you to view 
the result diagrams. The View menu contains the 
following commands: Zoom, Pan, Restore, Plan 
View, Elevated View, Side View, Isometric 
View, Change View Angles, View Options, 
Loads, Internal Forces, Moment Capacity, 
Shear Capacity, Reinforcement, Deflection and 
Duplicate Active View.  

Zoom  
The Zoom menu contains a cascade sub-menu, which enables you to zoom in and 
out on any portion of your floor system. Select Window from the sub-menu and 
use the mouse to specify a zooming region; the program will enlarge the portion 
you select. Select the In(2x) or Out(0.5x) to enlarge or reduce the model by two 
times, respectively. 

Pan  
The Pan command allows you to move your model on the plane of the screen. 
You may move the model in any direction. The mouse cursor is changed to a palm 
shape once the Pan command is selected. Press and hold the left mouse button on 
the view window and drag to the new location. After the mouse button is released, 
the model is moved in the same distance and direction as the mouse cursor from 
the original position. 

Restore  
The Restore command will redraw the floor system in full size. If you have altered 
your screen view using the Zoom command, select Restore to restore the figure’s 
original proportions. 
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Plan View  
Select Plan View command to show the plan view window. 

Elevated View  
Select Elevated View command to show the elevated view window. 

Side View  
Select Side View command to show the side view window. 

Isometric View  
Select Isometric View command to show the isometric view window. 

Change View Angles  
The Change View Angle command allows you to modify the angle at which the 
floor system is displayed in the Isometric View. The default angles are set at -45 
about the X axis and 45 about the Z axis. A more convenient way to change the 
view angle is to use the keyboard short cut CTRL + ARROW KEYS. To rotate 
around Z axis, press CTRL +  or CTRL + . To rotate around 
X axis, press CTRL +  or CTRL + .  

View Options  
The View Options command allows you to view selected 
members of the floor system in the view windows. Clicking the 
left mouse button on the check boxes next to the items in the 
dialog box, or tabbing to the member type and pressing the 
space bar will toggle the selection. pcaSlab will draw any members that contain a 

 in the box.  

Loads  
Select Loads command to show the load view window. 

Internal Forces  
Select Internal Forces command to show the 
shear, moment, and torsion (for beams/one-way 
slab systems only) diagram view window. The 
analysis and/or design must be performed before 
selecting this command. Otherwise “Problem Not 
Solved” message will be shown instead.  
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Moment Capacity  
Select Moment Capacity command to show the moment capacity diagram view 
window. The analysis and/or design must be performed before selecting this 
command. Otherwise “Problem Not Solved” will be shown instead. 

Shear Capacity  
Select Shear Capacity command to show the shear capacity diagram view 
window. The analysis and/or design must be performed before selecting this 
command. Otherwise “Problem Not Solved” will be shown instead. 

Reinforcement  
Select Reinforcement command to show the reinforcement view window. The 
analysis and/or design must be performed before selecting this command. 
Otherwise “Problem Not Solved” will be shown instead. 

Deflection  
Select Deflection command to show the deflection diagram view window. The 
analysis and/or design must be performed before selecting this command. 
Otherwise “Problem Not Solved” will be shown instead. 

Duplicate Active View  
Select Duplicate Active View to make a copy of the current active view window. 

Options Menu  
The Options menu allows you to change the startup 
options of the pcaSlab program to suit your needs. The 
Options menu contains the following commands: Colors, 
Startup Defaults, Rebar Database, Toolbar, and Status 
Bar.  

Colors  
The Colors command allows you to change the background color, member color, 
load color, text color, diagram color, etc. You may save the new colors as default 
setting, which will be used when pcaSlab is executed in the future.  
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Fonts  
The Fonts command allows you to select properties of the font that will be used in 
the graphical output window and printout, Graphical Output, as well as in the 
text result window and output, Text Output. Please note that for the Text Output 
only nonproportional (fixed width) fonts can be used. 

  

Startup Defaults  
The Startup Defaults command allows you 
to enter engineer name, change the default 
design code, reinforcement database, and the 
data directory, a directory where the 
program looks for data when it is executed.  
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Reinforcement Database  
The Rebar Database command allows you to 
view the pre-defined rebar information and 
define your own database. The user-defined 
database can be selected from the General 
Information dialog box.  

Toolbar  
Check the Toolbar command with a  sign to 
show the tool bar. Select the command again to 
clear the  sign to hide the tool bar. The tool bar 
is shown by default. 

Status Bar  
Check the Status Bar command with a  sign to show the status bar. Select the 
command again to clear the  sign to hide the status bar. The status bar is shown 
by default. 

Window Menu  
This menu enables you to arrange view windows shown on screen. The Window 
menu contains the following commands: Cascade, Tile Horizontal and Tile 
Vertical.  

Cascade  
The Cascade command 
displays all the open 
windows in the same size, 
arranging them on top of 
each other so that the title bar 
of each is visible. The 
current active view widow 
will be on the top after the 
execution of the Cascade command. 

Tile Horizontal  
The Tile Horizontal command arranges all open windows horizontally so that no 
window overlaps another. The current active view widow will be on the most left 
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or on the upper-left corner of the screen after the execution of the Tile Horizontal 
command. 

Tile Vertical  
The Tile Vertical command arranges all open windows vertically so that no 
window overlaps another. The current active view widow will be on the most left 
or on the upper-left corner of the screen after the execution of the Tile Vertical 
command. 

Window List  
The remaining menu items are in a list of the windows that are available for 
viewing. Selecting any window from this menu will bring up or restore the 
window to its previous size and position if it was minimized. 

Help Menu  
The Help menu includes commands that enable you to obtain online 
help for the program and show the copyright and registration 
information about your software. The Help menu contains three 
commands: Help Topics, Context Help and About pcaSlab.  

Help Topics  
The Help Topics command shows the Windows Help window with a table of 
contents. Select a topic of your interest to display information about that item. 
More information on the help system can be obtained from the Microsoft 
Windows manual. 

Context Help  
The Context Help command enters the program into the context-sensitive help 
mode which is indicated by a question mark  attached to the mouse cursor. In 
this mode, the user can click the element for which information is needed and the 
program will display the help topic associated with this element. More information 
on the help system can be obtained from the Microsoft Windows manual. 

About pcaSlab/pcaBeam  
The About pcaSlab command shows the version number of the program, the 
licensing information, and the copyright information. In the case of a trial license, 
the expiration date is given as well as the locking code which is needed to obtain 
a standalone license. 
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The Control Menu  
All the view windows have one pull-down 
menu located in the upper left hand corner 
of the open window. This is the Control 
menu. To access the Control menu, press 
CTRL + F6 to cycle through the windows 
and press ALT + – (hyphen), to open the 
Control menu of the desired window. The 
following is a list and a brief description of 
the commands in this menu. 

Restore  
The Restore command will restore a window or an icon to its previous size and 
position. This menu item is available when the window is iconized or maximized. 

Move  
The Move command moves the window to a new location. Select Move and use 
the ARROW KEYS to move the window in the desired direction and select 
ENTER to accept the new location. 

Size  
The Size command resizes a window. Select Size and use the ARROW KEYS to 
move the border of the window in the desired direction and select ENTER to 
accept the new size. 
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Minimize  
The Minimize command reduces a window to an icon and positions it at the 
bottom of the screen. 

Maximize  
The Maximize command enlarges a window to fit your entire screen. 

Close  
The Close command is used to close a window and return it to an icon and the 
bottom of the screen. 

Next  
The Next command switches among open windows and icons. 

Program Toolbar  

 
  Close the current data file if there is one and start a new data 

file. The equivalent menu command is File/New. 
  Open an existing data file on hard disk. The equivalent menu 

command is File/Open. 
  Save the current data file to hard disk. The equivalent menu 

command is File/Save. If you have not changed the default file 
name (pcaSlab1, pcaSlab2, etc.), the equivalent menu command 
is File/Save As. 

  Print view window. The equivalent menu command is File/Print 
View. 

  Print results. The equivalent menu command is File/Print 
Results. 

  Copy Bitmap to clipboard. The bitmap then can be pasted to a 
word processing or presentation software such as Microsoft 
Word or Microsoft PowerPoint. 

  Copy Metafile to clipboard. The metafile then can be pasted to a 
word processing or presentation software such as Microsoft 
Word or Microsoft PowerPoint. 

  Open the Data Input Wizard. The Data Input Wizard will guide 
you to enter the necessary input to your project. The equivalent 
menu command is Input/Data Input Wizard.  
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  Enter general information. The equivalent menu command is 
Input/ General Information.  

  Enter material properties. The equivalent menu command is 
Input/Material Properties.  

  Enter span geometry information for slabs, longitudinal beams, 
and ribs. The equivalent menu command is Input/Spans.  

  Enter support information for columns, drop panels, column 
capitals, and transverse beams. The equivalent menu command 
is Input/Support.  

  Enter reinforcement criteria for slab and ribs, and beams. The 
equivalent menu command is Input/Reinforcement Criteria. 

  Enter reinforcing bar information for column strips, middle 
strips, beams, and beam stirrups. This button is disabled if 
Design run mode is selected from the General Information 
dialog box. The equivalent menu command is Input/
Reinforcing Bars. 

  Enter load cases. The equivalent menu command is Input/Load 
Cases. 

  Enter load combinations. The equivalent menu command is 
Input/Load Combinations.  

  Enter span loads. The equivalent menu command is Input/Span 
Loads. 

  Enter support loads and displacements. The equivalent menu 
command is Input/Support Loads and Displacements. 

  Enter lateral effects. The equivalent menu command is 
Input/Lateral Effects. 

  View plan geometry. The equivalent menu command is 
View/Plan View. 

  View elevated geometry. The equivalent menu command is 
View/Elevated View.  

  View side geometry. The equivalent menu command is 
View/Side View.  

  View isometric geometry. The equivalent menu command is 
View/Isometric View.  

  Execute the analysis and/or design. The equivalent menu 
command is Solve/Execute.  

  View results. The equivalent menu command is Solve/Report.  
  View loads. The equivalent menu command is View/Loads.  
  View internal forces within the whole system or a single span. 

The equivalent menu command is View/Internal Forces.  
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  View moment capacity of the whole geometry or a single span. 
The equivalent menu command is View/Moment Capacity.  

  View shear capacity of the whole geometry or a single span. The 
equivalent menu command is View/Shear Capacity. 

  View deflection of the whole geometry or a single span. The 
equivalent menu command is View/Deflection. 

  View flexure reinforcement for beam strip, middle strips, and 
column strips. View shear reinforcement for beam strips. The 
equivalent menu command is View/Reinforcement.  

  Zoom in view window to magnify the system. The equivalent 
menu command is View/Zoom/In(2x).  

  Zoom out view window to reduce the system. The equivalent 
menu command is View/Zoom/Out(0.5x).  

  Zoom any part of a view window. The equivalent menu 
command is View/Zoom/Window.  

  Move the model in the screen plane. The equivalent menu 
command is View/Pan.  

  Restore a view window. The equivalent menu command is 
View/Redraw.  

 





 

Chapter 4 Operating pcaSlab/pcaBeam 
Operating pcaSlab/pcaBeam 

Working with Data Files (menu File)   

Creating a New Data File  
When you first load pcaSlab you will have a new file ready for input. The data will 
not have a filename associated with it, therefore, "pcaSlab1" will appear in the title 
bar. If a new data file is created after the "pcaSlab1", the new data file will be 
named as "pcaSlab2", and so on. 

To start a new data file: 

1. If you are already in the program and in an existing file, select NEW button  
or New menu command to clear your screen and return you to the default 
settings. If existing data has been changed prior to executing the New 
command, pcaSlab will ask if you would like to save the data. 

2. After New is selected, Auto Input command in the Input menu may be used. 
This command guides you through the inputting process by automatically 
displaying all the dialog boxes necessary to design your floor system. You 
may cancel the auto input mode by selecting CANCEL button from any dialog 
box. 

3. After you enter data through the Input menu, use the Save As command to 
give the file a name. 

Opening Existing Data File  
pcaSlab allows you to open data files that were saved at an earlier time.  

To open an existing data file: 

1. Select Open command from the File menu or click the OPEN button  to 
bring in an existing pcaSlab data file. The dialog box of Figure 4-1 will be 
displayed. All the files with an .slb extension contained in the current drive 
and directory will be displayed in the list box. This dialog box also enables 
you to change the current drive and directory. 
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 Figure 4-1 Open dialog box 

2. Type in the name of the file you want to open. You may also select a file from 
the provided list with the mouse or using the keyboard by tabbing to the list 
and using the up and down arrow keys. 

3. Press OPEN to exit the dialog box and allow pcaSlab to read the data. You 
may combine steps 2 and 3 of this procedure by double clicking the left 
mouse button over the desired file from the provided list. 

Importing ADOSS and PCA-Beam Data File   
pcaSlab and pcaBeam allow you to open ADOSS v6.0x/7.0x and PCA-Beam 
v1.0x data files that were saved at an earlier time.  

To open an existing ADOSS or PCA-Beam data file: 

1. Select Open command from the File menu or click the OPEN button . The 
dialog box of Figure 4-2 will be displayed. Select the type of the file you want 
to open and all files of the selected type contained in the current drive and 
directory will be displayed in the list box. This dialog box also enables you to 
change the current drive and directory. 

 
 Figure 4-2 Importing ADOSS or PCA-Beam data file dialog box 
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2. Type in the name of the file you want to open. You may also select a file from 
the provided list with the mouse or using the keyboard by tabbing to the list 
and using the up and down arrow keys. 

3. Press OPEN to exit the dialog box and allow pcaSlab to read the data. You 
may combine steps 2 and 3 of this procedure by double clicking the left 
mouse button over the desired file from the provided list. 

Note: The extension name of an ADOSS v6.0x/7.0x file is .ADS and the extension 
name of a PCA-Beam v1.01 file is .BMS. Both pcaSlab and pcaBeam v1.5x use 
files with the .SLB extension. 

Saving the Data File  
To save your data with the same filename: 

1. Select the Save command from the File menu or simply click the SAVE button 
. If the data has not been modified since the last save or Save As command 

was executed, this option will not be available. The file will be updated and 
the Save command and button will be shaded gray. 

To give your data a new filename: 

1. If you have not saved your data yet, select the Save or Save As command 
from the File menu. Either command will have the same effect. If you would 
like to save a data file that currently has a filename with a new filename, 
select the Save As command. The dialog box of Figure 4-3 will appear. When 
no filename has been given to the current data, the default filename is 
"pcaSlab1.slb", and it is highlighted in the edit box. 

 
Figure 4-3 Save As dialog box 

2. Type a new name to overwrite the current name. 
3. Press SAVE to exit the dialog box and save the data into the filename 

specified. 
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Most Recently Used Files (MRU)   

 
 Figure 4-4 Most Recently Used File List (MRU) 

The Most Recently Used Files (MRU) list shows the four data files that were 
opened most recently. Selecting a data file from this list makes it easier and faster 
to open the file. The list is empty when the program is executed for the first time. 

Specifying the Model Data (menu Input)   

Data Input Wizard  
The Data Input Wizard is designed to make the inputting process easier. By 
selecting the Data Input Wizard from Input menu or selecting  from the tool 
bar, a logical sequence of dialog boxes will automatically be displayed allowing 
you to enter data for your floor system. 

Defining General Information  
The General Information command allows you to enter labels, design code, rebar 
database, run mode, and the frame information needed by pcaSlab to proceed with 
the input process. You must choose this command before doing any further 
inputting since this command affects the availability of the commands in the Input 
menu. 

To enter general information: 

1. Select the General Information command from the Input menu or click the 
 button from the tool bar. The dialog box of Figure 4-5 will appear. 

2. Enter the project name, frame name, and engineer name in the Label frame 
box. 

3. Select the building standard you want your floor system to be designed to 
(ACI 318-02, ACI 318M-02, ACI 318-99, ACI 318M-99, CSA A23.3-94, 
CSA A23.3-94E) from the Option frame box. 
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Figure 4-5 General Information dialog box 

4. Select the Design or Investigation from the Run mode frame box. 
5. In the Frame frame box, enter the Number of supports of the frame. The 

default number of supports is 2. The minimum and maximum number of 
spans is 1 and 20 spans, respectively. Therefore the minimum number of 
supports is 2 and the maximum number of supports is 21. 

6. Check the Left cantilever and/or Right cantilever check boxes if left cantilever 
and/or right cantilever exist in the frame respectively. 

7. In the Floor System frame box, select Two-Way or Beams/one-way slab 
option. 

8. Check the Distance location as ratio of span if the locations of loads need to 
be entered as a ratio of the length of a span. 

9. Press OK button to exit the dialog box and allow pcaSlab to use the new data. 
If using the Auto Input, click the NEXT button to the next dialog box. 

Defining Solve Option  
The Solve Options command allows you to select options and specify parameters 
that affect the analysis and design results. Please be advised that changing these 
settings involves engineering judgment and it has to be done cautiously. To take 
effect, this command must be used prior to the Execute command. The set of 
parameters is different for two-way and one-way systems. 
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Two-way systems  
To specify solve options for two-way systems: 

1. Enter the live load pattern ratio. 
2. Check COMPRESSION REINFORCEMENT checkbox if it is to be considered 

when needed. 
3. Enter the multiplier that defines the distance between a column face and a free 

edge of a slab, within which a segment of punching shear critical section is to 
be ignored. 

4. Choose if GROSS (UNCRACKED) or EFFECTIVE (CRACKED) sections are to be 
considered in the deflection calculations. 

5. Choose if in the case of a section with flanges in the negative moment region, 
only the web (RECTANGULAR SECTION) or the whole section (T-SECTION) is 
to be used to calculate the gross moment of inertia (Ig) and the cracking 
moment. 

 
Figure 4-6 Solve Options for two-way systems 

One way/beam systems  
To specify solve options for beams/one-way slab systems: 

1. Enter the live load pattern ratio. The default value for beams/one-way slab 
systems is 100%. 

2. Check COMPRESSION REINFORCEMENT checkbox if it is to be considered 
when needed. 
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3. Check MOMENT REDISTRIBUTION checkbox if it is to be considered in the 
analysis. This option has to be checked for the MOMENT REDISTRIBUTION tab 
to be available in the SUPPORT DATA dialog box. 

4. Check EFFECTIVE FLANGE WIDTH if instead of the full flange width only the 
effective flange width is to be considered in the flexural design. 

5. Check RIGID BEAM-COLUMN JOINT to consider beam-column joint as rigid. 
6. Check TORSION ANALYSIS AND DESIGN if they are to be included in the 

solution. This option has to be checked for the TORSION TYPE and STIRRUPS IN 
FLANGES options to be enabled. Also torsional loads will only be available in 
the TYPE combo box of the SPAN LOADS dialog box if this option is checked. 

7. If TORSION ANALYSIS AND DESIGN is checked then select if EQUILIBRIUM or 
COMPATIBILITY torsion is to be considered and if for sections with flanges 
STIRRUPS IN FLANGES can be considered. 

8. Choose if GROSS (UNCRACKED) or EFFECTIVE (CRACKED) sections are to be 
considered in the deflection calculations. 

9. Choose if in the case of a section with flanges in the negative moment region, 
only the web (RECTANGULAR SECTION) or the whole section (T-SECTION) is 
to be used to calculate the gross moment of inertia (Ig) and the cracking 
moment. 

 
Figure 4-7 Solve Options for one-way systems 
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Using Span Control  
The Span Control tab allows you to perform different operations on the spans that 
your system consists of. These operations include inserting new spans with default 
parameters, creating new spans by copying existing spans, moving spans to change 
span sequence, and deleting spans. The result of an operation depends on the span 
selected as well an on the selected support. Spans can be selected using the Span 
Control List and columns using the Support Selection radio buttons. 

 
Figure 4-8 Span control tab 

Additionally before the Span Control window is closed all changes made to the 
spans can be revoked using the RESET ALL button. The RESTORE button can be 
used to bring back a span removed using the DELETE button. 

To insert a new span with default dimensions: 

1. In the SPAN CONTROL LIST select the span next to which you want to insert 
a new span. 

2. Select whether the LEFT SUPPORT or the RIGHT SUPPORT of the newly created 
span will be inserted. 

3. Press INSERT BEFORE button to insert the new span left to the selected span or 
INSERT AFTER button to insert the new span on the right side of the currently 
selected span. 
Examples of the insert operations are presented in Figure 4-9. Assuming that 
Span 2 is always selected the resulting systems will depend on whether 



 

Operating pcaSlab/pcaBeam  4-9 

INSERT AFTER or INSERT BEFORE was used and whether LEFT COLUMN or 
RIGHT COLUMN was selected. Newly inserted span and column are denoted 
with an “x”. 
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Figure 4-9 Inserting a new span using Span Control 

To copy a span: 

1. In the SPAN CONTROL LIST select the span you want to copy. 
2. Select whether the LEFT SUPPORT or the RIGHT SUPPORT of the copied span 

will be copied with the span. 
3. Press INSERT BEFORE button to place the copied span left to the selected span 

or INSERT AFTER button to place the copied span on the right side of the 
currently selected span. 
Examples of the insert operations are presented in Figure 4-10. Assuming that 
Span 2 is always selected the resulting systems will depend on whether COPY 
AFTER or COPY BEFORE was used and whether LEFT COLUMN or RIGHT 
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COLUMN was selected. Newly created span and column are denoted with the 
prime sign. 
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Figure 4-10 Copying a span using Span Control 

To move a span: 

1. In the SPAN CONTROL LIST select the span you want to move. 
2. Select whether the LEFT SUPPORT or the RIGHT SUPPORT of the moved span 

will be moved with the span. 
3. Press MOVE BEFORE button to move the span to the left or MOVE AFTER 

button to move the span to the right side. 
Examples of the move operations are presented in Figure 4-11. Assuming that 
Span 2 is always selected the resulting systems will depend on whether MOVE 
AFTER or MOVE BEFORE was used and whether LEFT COLUMN or RIGHT 
COLUMN was selected. 
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Figure 4-11 Moving a span using Span Control 

To delete a span: 

1. In the SPAN CONTROL LIST select the span you want to delete. 
2. Select whether the LEFT SUPPORT or the RIGHT SUPPORT of the deleted span 

will be removed with the span. 
3. Press the DELETE button to delete the selected span. 
Examples of the delete operations are presented in Figure 4-12. Assuming that 
Span 2 is always selected the resulting systems will depend on whether LEFT 
COLUMN or RIGHT COLUMN was selected. 
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Figure 4-12 Deleting a span using Span Control 

Defining Material Properties  
The Material Properties command from the Input menu allows you to input 
material properties of the concrete and the reinforcement. There are two tabs in 
this dialog box. One is for concrete and the other is for reinforcing steel. This 
command must be executed in order to perform a design of the floor system. Use 
the tab key to get to each edit box then type in your values, or use your mouse and 
click directly on the desired tab and box, then type in your values. Refer to 
"Material Properties" for a detailed explanation of the default values. 

To define material properties: 

1. Select the Material Properties command from the Input menu or click the 
 button on the tool bar. The dialog box of Figure 4-13 will appear. 

 
Figure 4-13 Concrete Properties dialog box 
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2. Click the Concrete tab and enter the concrete density for the following 
members: Slabs, Beams, and Columns.  

3. Enter the concrete compressive strength. By entering a value for the 
compressive strength, values for Young’s modulus and rupture modulus will 
automatically be computed for the slabs, beams, and columns. Young’s 
modulus and rupture modulus will automatically be shown in the 
corresponding text boxes. 

4. If you have values for the rupture modulus, enter the values in the text boxes 
for the slabs, beams, and columns. Default values are computed based on 
average split tensile strength of concrete, which is calculated internally by the 
program. These values will be used for deflection analysis. A large value for 
the rupture modulus will produce a deflection analysis based on gross, non-
cracked, sections. The CSA A23.3-94 Standard requires69 that for the 
calculation of slab (either one-way or two-way) deflections a rupture modulus 

value equal to 2/f6.0 '
c  be used. pcaSlab defaults to this value of the rupture 

modulus for the slab concrete in CSA design runs. However, for beams 

rapture modulus of '
cf6.0  has to be used and this value needs to entered 

directly by the user overwriting the default value. 
5. Click the Reinforcing Steel tab as shown in Figure 4-14. 

 
Figure 4-14 Reinforcing Steel Properties dialog box 

6. Enter the yield stress of flexure steel.  
7. Enter the yield stress of stirrups. 

                                                           
69 CSA A23.3-94, 13.3.6 
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8. Enter the Young’s modulus for flexural steel and stirrups. 
9. Select whether the main reinforcement is epoxy-coated by clicking the left 

mouse button on the box or tabbing to the box and pressing the SPACE BAR. 
This selection affects development lengths. 

10. Press OK button to exit the dialog box so that pcaSlab will use these material 
properties. If using the Auto Input, click the NEXT button to the next dialog 
box. 

Defining the Slabs/Flanges  
The Spans command from the Input menu is available for all floor systems. Span 
numbers, which are determined from the number of supports entered in the 
General Information box, are automatically filled into the Span drop-down list in 
the Span Data dialog box.  

To input slab geometry: 

1. Select the Spans command from the Input menu or click the  button on the 
tool bar. Click the left mouse button on the Slabs tab. The dialog box of 
Figure 4-15 will appear. 

2. Select the number of the span, for which dimensions will be entered, from the 
Span drop-down list. 

 
Figure 4-15 Defining the Slabs dialog box 

3. Select the span location from the Location drop-down list. Three types of 
locations are available: Interior, Exterior Left, and Exterior Right. The "left" 
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and "right" are defined as you look along the direction of analysis. If a span 
has design strips on both sides it should be an "Interior" span. If a span has 
only a left design strip, it should be an "Exterior Right" span. If a span has 
only a right design strip, it should be an "Exterior Left" span. 

4. Enter the slab thickness of the span.  
5. Enter the span length from column centerline to column centerline or edge to 

column centerline for the two cantilever spans in the Length edit box. If the 
program detects a cantilever span length less than one-half the column 
dimension in the direction of analysis, an error message will pop up when the 
frame is analyzed. If a partial load is affected by the span length, a message 
warns the user of this condition. 

6. Enter the span design width in the transverse direction of analysis on the left 
and right side of the column (see Figure 4-16). These distances are usually 
one-half the distance to the next transverse column or edge of the slab for 
exterior spans. The left and right designations are arbitrary. Both interior and 
exterior spans may be used in a design strip. An exterior width will 
automatically be designated by pcaSlab by entering a width value less than or 
equal to the transverse column dimension. Exterior sides do not contribute to 
the attached torsional stiffness, although they do contribute to loading. 
pcaSlab will use the total width entered for weight and superimposed loading 
but will use code allowed dimensions for flange width and stiffness 
computations. 

 
Figure 4-16 Required Slab Dimensions 

7. Press the MODIFY button to update the slab geometry. 
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8. Repeat steps 2 through 7 until all the spans have been updated. You can use 
the COPY button as a shortcut. 

9. Press OK button to exit the dialog box and allow pcaSlab to use the updated 
slab geometry. 

Defining the Longitudinal Beams  
Longitudinal beam dimensions are required for the beam-supported slab. Span 
numbers, which are determined from the number of supports entered in the 
General Information box, are automatically filled into the Span drop-down list.  

To input geometry for beam-supported slab system: 

1. Select the Spans command from the Input menu or click the  button on the 
tool bar. Click the left mouse button on the Longitudinal Beams tab. The 
dialog box of Figure 4-17 will appear. 

2. Select the span number from the Span drop-down list. 
3. Enter the width of the beam (Figure 4-18). 
4. Enter the depth of the beam from the top of the slab (Figure 4-18)). 
5. Press the MODIFY button to update the longitudinal beam geometry. 

 
Figure 4-17 Longitudinal Beam Geometry dialog box 

6. Repeat steps 2 through 6 until all the beams have been updated. You can use 
the COPY button as a shortcut. 
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7. Press OK button to exit the dialog box so that pcaSlab will use the new beam 
geometry. 

 
Figure 4-18 Required Longitudinal Beam Dimensions 

Defining the Ribs  
For the waffle slab system, you must define the rib geometry. The ribs are 
assumed to be the same throughout the strip. 

To enter rib geometry: 

1. Select the Spans command from the Input menu or click the  button on the 
tool bar. Click the left mouse button on the Ribs tab. The dialog box of Figure 
4-19 will appear. 

 
Figure 4-19 Ribs Geometry dialog box 
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2. Select the span number from the Span drop-down list. 
3. Enter the spacing between ribs at the bottom for clear rib spacing (see Figure 

4-20). 

 
Figure 4-20 Required Rib Dimensions 

4. Enter the width at the bottom for rib width (see Figure 4-20). 
5. Enter the depth of the rib below the slab for Rib depth (see Figure 4-20). 
6. Press OK button to exit the dialog box so that pcaSlab can use the rib 

geometry. 

Defining the Columns  
Column data is optional. If no column is specified at the joints the joint is assumed 
hinged. You will be allowed to enter column dimensions above and below. 

To input column/capital geometry: 

1. Select the Supports command from the Input menu or click the  button on 
the tool bar. The dialog box of Figure 4-21 will appear. Click on the Columns 
tab. 

2. Enter the column height above, which is the distance from the top of the 
design floor to the top of the floor above (see Figure 4-21). pcaSlab obtains 
the clear column height above by subtracting the average slab depth from the 
height given. Only the slab is considered for the floor system above. A zero 
dimension for the column heights above and below will create a pin condition. 
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Figure 4-21 Column Geometry dialog box 

3. Enter the column height below, which is the distance from the design floor to 
the top of the floor below (see Figure 4-22). To obtain a clear column height 
below, the slab/drop/beam depth is subtracted from the height given. A zero 
dimension for the column heights above and below will create a pin condition. 

 
Figure 4-22 Required Column Dimensions 
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4. Enter a value for c1, the column dimension in the direction of analysis (see 
Figure 4-22). 

5. Enter a value for c2, the column dimension perpendicular to the direction of 
analysis (see Figure 4-22). Round columns are specified with a zero input for 
c2; c1 is then taken as the diameter. Zero value for Stiffness Share will create 
a pin condition. 

6. Press the MODIFY button to update the slab geometry. 
7. Check the Check punching shear around column if the punching shear needs 

to be checked. 
8. Repeat steps 2 through 7 until all the columns and capitals have been updated. 

You can use the COPY button as a shortcut. 
9. Press OK button to exit the dialog box so that pcaSlab will use the new data. 

Defining the Drop Panels  
Drops are only available for the flat slab or waffle slab systems and can be defined 
at all the support locations. The drop length and width dimensions are computed 
by pcaSlab, based on slab span dimensions, when the "Standard" is selected in the 
Type drop-down list. 

To input drop geometry 

1. Select the Supports command from the Input menu or click the  button 
then click on the Drop Panels tab. The dialog box of Figure 4-23 will appear. 

 
Figure 4-23 Drop Geometry dialog box 
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2. Select whether pcaSlab should compute the drop dimensions or the 
dimensions will be user specified. If pcaSlab is to compute the dimensions, 
the "Standard" option should be selected from the Type drop-down list and 
then only the drop depth will be available. When the "Standard drop" option is 
selected pcaSlab will calculate drop panel dimensions in accordance with ACI 
318 Clause 13.3.7. Similar requirements contained in previous editions of the 
CSA A23.3 Standard have been removed from the 1994 edition. As a result, 
the ACI minimum specifications for drop panels are also used in CSA A23.3 
runs when the "Standard Drops" option is selected. If you would like to 
specify drop dimensions other than those computed by pcaSlab, you must 
select "User-defined" from the Type drop-down list.  

3. Enter the dimension in the direction of analysis from the column centerline to 
the edge of the drop left of the column (see Figure 4-24). If this is a standard 
drop, this dimension will not be available and the length left is set equal to the 
slab span length left/6 for interior columns or the left cantilever length for the 
first column. 
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Figure 4-24 Required Drop Dimensions 

4. Enter the width dimension in the transverse direction (see Figure 4-24). If this 
is a standard drop, this dimension will not be available and the width is set 
equal to slab width/3. 

5. In order for pcaSlab to recognize drops, drop depths are required for the flat 
slab systems even if Standard Drop is selected. Enter the depth of the drop 
from the span with the smaller slab depth (see Figure 4-24). For waffle slab 
systems, the depth is automatically assumed to be equal to the rib depth below 
the slab and is not displayed. A value entered will be considered to exist 
below the rib depth during calculations. 

6. Press the MODIFY button to update the drop geometry. 
7. Repeat steps 2 through 6 until all the drop dimensions have been updated. 

You can use the COPY button as a shortcut. 
8. Press OK button to exit the dialog box so that pcaSlab will use the new drop 

geometry. 

Defining the Column Capitals  
To input column capital geometry: 

1. Select the Supports command from the Input menu or click the  button on 
the tool bar. Click left mouse button on the Column Capitals tab to activate 
it. The dialog box of Figure 4-25 will appear. 

 
Figure 4-25 Capital Dimensions 
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2. Select the support number from the Support drop-down list. 
3. Enter the capital depth which is the distance from the bottom of the soffit 

(slab, drop, or beam), to the bottom of the capital.  
4. The Side slope is the rate of depth to extension of the capital and it must be 

greater than 1 and smaller than 50 (see Figure 4-26). 
5. Enter the capital extension which is the distance from the edge of the column 

to the end of the capital (see Figure 4-26). 

 
Figure 4-26 Required Capital Dimensions 

Defining the Transverse Beams  
The Transverse Beam command allows you to input the width, depth, and offset 
(eccentricity) of transverse beams at each column. This command is optional. 

To input transverse beam geometry: 

1. Select the Support command from the Input menu. Select Transverse 
Beams tab from the Support Data dialog box. The dialog box of Figure 4-27 
will appear. 

2. Enter the width of the transverse beam (see Figure 4-28) 
3. Enter the depth of the transverse beam which is taken from the top of the slab 

to the bottom of the beam (see Figure 4-28) 
4. Enter the eccentricity, which is measured from the joint centerline, positive to 

the right, and negative to the left of the joint (See Figure 4-28). 
5. Press the MODIFY button to update the transverse beam dimensions. 
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6. Repeat steps 2 through 5 until all the beams have been updated. You can use 
the COPY button as a shortcut (see "Entering the Structure Geometry" earlier 
in this chapter for help on the COPY button). 

 
Figure 4-27 Transverse Beam Geometry dialog box 

7. Press OK button to exit the dialog box so that pcaSlab will use the new beam 
geometry. 

Top of Slab
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Figure 4-28 Required Transverse Beam Dimensions 
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Defining the Boundary Conditions  
By default pcaSlab assumes that column-slab/beam joints can only rotate and that 
they do not undergo any translational displacements. Rotation of a joint is affected 
by the stiffness of elements it connects i.e. slabs/beams, transverse beams, and 
columns. Columns are assumed by default to be fixed at their far ends as shown in 
Figure 2-6. These default assumptions can be altered using the Boundary 
Conditions command. 

 
Figure 4-29 Boundary Conditions dialog box 

By specifying vertical spring support constant with Kz value other than 0, you can 
allow the joint to displace vertically. This movement is then controlled by the 
stiffness of the spring Kz in addition to the stiffness of the column below. The 
column above is assumed not to constrain the vertical movement of the joint. 
Additional rotational spring support can be applied to the joint by specifying the 
value of Kry. Also the far end column conditions can be selected as either fixed or 
pinned as shown in Figure 4-30 (b). All elements controlling the displacements of 
a joint are shown in Figure 4-30 (a). 
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b) Pinned Fixed

Fixed Pinned  
Figure 4-30 (a) Elements controlling joint displacement (b) Far End Column 

Boundary Conditions 

To input boundary conditions: 

1. Select the Support command from the Input menu. Select Boundary 
Conditions tab from the Support Data dialog box. The dialog box of Figure 
4-29 will appear. 

2. Select support number 
3. Enter value of Kz to allow vertical displacement of the support and to add 

translational spring support (see Figure 4-30 (a)) 
4. Enter value of Kry to add rotational spring support (see Figure 4-30 (a)) 
5. Select far end support conditions for the column above and below the joint 

(see Figure 4-30 (b)) 
6. Press the MODIFY button to update the boundary conditions. 
7. Repeat steps 2 through 5 until all the joints have been updated. You can use 

the COPY button as a shortcut (see "Entering the Structure Geometry" earlier 
in this chapter for help on the COPY button). 

8. Press OK button to exit the dialog box so that pcaSlab will use the new 
boundary condtions. 

Defining the Moment Redistribution Factors  
This command is only available for beams/one-way slab systems when MOMENT 
REDISTRIBUTION option is checked in the General Information dialog box. 
To input boundary conditions: 

1. Select the Support command from the Input menu. Select Moment 
Redistribution tab from the Support Data dialog box. The dialog box of 
Figure 4-31 will appear. 
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2. Select support number 
3. Enter the maximum value of the redistribution factors you want to allow on 

the left and the right side of the support. Please note that actual value used is 
determined by the program when the problem is being solved and that the 
check against the code specified limit is also performed. 

4. Press the MODIFY button to update the redistribution factor limits. 
5. Repeat steps 2 through 5 until all the supports have been updated. Please note 

that supports connecting to cantilevers will not be available since moment 
redistribution is not allowed there. You can use the COPY button as a shortcut 
(see "Entering the Structure Geometry" earlier in this chapter for help on the 
COPY button). 

6. Press OK button to exit the dialog box so that pcaSlab will use the new 
moment redistribution limits. 

 
Figure 4-31 Moment Redistribution dialog box 

Defining the Reinforcement Criteria for Slabs and Ribs  
In order for pcaSlab to select the reinforcement, you must define the slab and rib 
reinforcement, bar sizes, location, and minimum spacing dimensions. See "Area of 
Reinforcement" and "Reinforcement Selection" in Method of Solution for 
a discussion of the reinforcement computations.  

To define reinforcement Criteria for Slabs and Ribs: 
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1. Select the Reinforcement Criteria command from the Input menu or click 
the  button on the tool bar. Select Slabs and Ribs tab by clicking the left 
mouse button on the tab title. The dialog boxes of Figure 4-32 will appear. 

 
Figure 4-32 Slab and Rib Reinforcement dialog boxes 

2. For slabs and ribs, enter the clear covers for top and bottom reinforcing bars. 
For the top reinforcement, this distance is from the top of the slab to the top of 
the top bars. For the bottom reinforcement, this distance is from the bottom of 
the slab to the bottom of the bottom bars (see Figure 4-33). The default value 
is 1.5 in. (40mm) for both input items. 

3. Enter the minimum bar size to start the iteration for determining flexural 
reinforcement. 

4. Enter the maximum bar size. This number will be used as a stop in the 
iteration for determining flexural bars in beams. 

5. Enter minimum bar spacing for slab and rib flexural reinforcement. This 
number should be based on aggregate size or detailing considerations. Default 
spacing is 6 in. (150mm) for slabs and ribs. 

6. Enter maximum bar spacing for slab and rib flexural reinforcement. Default 
spacing is 18 in. for slabs and ribs. 

7. Enter minimum Reinforcement Ratio for slab and rib flexural reinforcement. 
Default ratio is 0.2% for slabs and ribs. If the user specified value is smaller 
than 0.18, 0.18 is used by pcaSlab. If the user specified value is greater than 
0.18, the specified value is used by pcaSlab. 
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Figure 4-33 Distance to Reinforcement Edges 

8. Enter maximum Reinforcement Ratio for slab and rib flexural reinforcement. 
Default ratio is 2% for slabs and ribs. 

9. If the top bars have more than 12 in. of concrete below them, check the 
corresponding check box. 

10. Press OK button to exit the dialog box and allow pcaSlab to use the new data. 

Defining the Reinforcement Criteria for Beams  
In order for pcaSlab to select the reinforcement, you must define the beam 
reinforcement, bar sizes, location, and minimum spacing dimensions. See "Area of 
Reinforcement" and "Reinforcement Selection" in the Method of Solution for a 
discussion of the reinforcement computations.  

To define reinforcement criteria for beams: 

1. Select the Reinforcement Criteria command from the Input menu or click 
the  button on the tool bar. Select Beams tab by clicking the left mouse 
button on the tab title. The dialog boxes of Figure 4-34 will appear. 

2. Enter the covers for top and bottom reinforcing bars for beams. For the top 
reinforcement, this distance is from the top of the slab to the centroid of the 
top bars; and for the bottom reinforcement, this distance is from the bottom of 
the slab to the bottom of the bottom bars (see Figure 4-35). The default value 
is 1.5 in. (40mm) for both input items. 

3. Enter the minimum bar size for top and bottom bars and stirrups to start the 
iteration for determining flexural reinforcement. 

4. Enter the maximum bar size for top and bottom bars and stirrups. This number 
will be used as a stop in the iteration for determining flexural bars in beams. 

5. Enter the minimum bar spacing for beam flexural reinforcement and stirrups. 
This number should be based on aggregate size or detailing considerations. 
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The default minimum reinforcement bar spacing is 2 in. and the default stirrup 
spacing is 6 in. 

 
Figure 4-34 Reinforcement dialog boxes 

6. Enter the maximum bar spacing for beam flexural reinforcement and stirrups. 
The default maximum reinforcement spacing is 18 in. and the default 
maximum stirrup spacing is 18 in. 

7. Enter the minimum Reinforcement Ratio for beam flexural reinforcement. 
Default ratio is 0.2% for beams. If the user specified value is smaller than 0.2, 
0.2 is used by pcaSlab. If the user specified value is greater than 0.2, the 
specified value is used by pcaSlab. 

 
Figure 4-35. Distance to Reinforcement 

8. Enter the maximum Reinforcement Ratio for beam flexural reinforcement. 
Default ratio is 2% for slabs and ribs. 
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9. If the top bars have more than 12 in. of concrete below them, check the 
corresponding check box. 

10. Press OK button to exit the dialog box and allow pcaSlab to use the new data. 

Defining Column Strip Bars for Two-Way Slab Systems  
The reinforcing bar size, number of bars, bar length, etc. can be defined by users if 
the Run Mode of Investigation and two-way floor system are selected in the 
General Information dialog box. This menu item is not available if Run Mode of 
Design is selected in the General Information dialog box. 

To define column strip bars: 

1. Select Reinforcing Bars from the Input menu or click the  button on the 
tool bar. Select the Column Strip Bars tab by clicking the tab title or use the 
tab key on the keyboard to toggle to the tab title then select the Column Strip 
Bars tab using the arrow keys. The dialog boxes of Figure 4-36 will appear. 

 
Figure 4-36 Defining Column Strip Bars 

2. Select the span for which reinforcing bars will be defined from the Span list 
box on the upper left corner. The length of the selected span will be shown 
right above the ADD button. 

3. Select bar size from the Bar Size drop-down list.  
4. Define the number of reinforcing bars in the selected span by entering the 

number in the Number of Bars input box. 
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5. Define the length of the reinforcing bars by entering the length in the Length 
input box. The unit of the length is foot [m]. 

6. Define the types of the reinforcing bars in the selected span by selecting from 
the Type drop-down list, which is right below the Bar Size drop-down list. 
Five types are available: Top Left, Top Right, Top Continuous, Bottom 
Continuous and Bottom Discontinuous.  

7. Define the cover by entering the number in the Cover input box. The unit of 
cover is inch [mm]. 

8. Press ADD button to add the new data into the list box below the buttons. 
9. Repeat steps 2 to 8 to define reinforcing bars for all the spans. You may use 

the SPAN COPY button below the Span list to simply copy the data of one span 
to other spans. 

10. If the reinforcing data of a span needs to be modified, select the data from the 
data list box on the lower part of the dialog box then modify the data as 
mentioned above. Press MODIFY button when finished to update the 
corresponding data in the data list box. 

11. To delete the reinforcing data for a span, select the data of the span from the 
data list box then press the DELETE button. 

12. Press OK button to exit the dialog box so that pcaSlab will use these 
reinforcing bar properties. 

Defining Middle Strip Bars for Two-Way Slab Systems  
The reinforcing bar size, number of bars, bar length, etc., can be defined by users 
if the Run Mode of Investigation and two-way floor system are selected in the 
General Information dialog box. This menu item is not available if Run Mode of 
Design is selected in the General Information dialog box. 

To define middle strip bars: 

1. Select Reinforcing Bars from the Input menu or click the  button on the 
tool bar. Select the Middle Strip Bars tab by clicking the tab title or use the 
tab key on the keyboard to toggle to the tab title then select the Middle Strip 
Bars tab using the arrow keys. The dialog boxes of Figure 4-37 will appear. 
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Figure 4-37 Defining Middle Strip Bars 

2. Select the span for which reinforcing bars will be defined from the Span list 
box on the upper left corner. The length of the selected span will be shown 
right above the ADD button. 

3. Select bar size from the Bar Size drop-down list. 
4. Define the number of reinforcing bars in the selected span by entering the 

number in the Number of Bars input box. 
5. Define the length of the reinforcing bars by entering the length in the Length 

input box. The unit of the length is foot [m]. 
6. Define the Types of the reinforcing bars in the selected span by selecting from 

the drop-down list, which is right below the Bar Size drop-down list. Five 
types are available: Top Left, Top Right, Top Continuous, Bottom Continuous 
and Bottom Discontinuous.  

7. Define the cover by entering the number in the Cover input box. The unit of 
cover is inch [mm]. 

8. Press ADD button to add the new data into the list box below the buttons. 
9. Repeat steps 2 to 8 to define reinforcing bars for all the spans. You may use 

the SPAN COPY button below the Span list to simply copy the data of one span 
to other spans. 

10. If the reinforcing data of a span needs to be modified, select the data from the 
data list box on the lower part of the dialog box then modify the data as 
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mentioned above. Press MODIFY button when finished to update the 
corresponding data in the data list. 

11. To delete the reinforcing data for a span, select the data of the span from the 
data list box then press the DELETE button. 

12. Press OK button to exit the dialog box so that pcaSlab will use these 
reinforcing bar properties.  

Defining Beam Bars for Two-Way Slab Systems  
The reinforcing bar size, number of bars, bar length, etc. can be defined by users if 
the Run Mode of Investigation and two-way floor system are selected in the 
General Information dialog box. This menu item is not available if Run Mode of 
Design is selected in the General Information dialog box. 

To define beam bars: 

1. Select Reinforcing Bars from the Input menu or click the  button from the 
tool bar. Select the Beam Bars tab by clicking the tab title or use the tab key 
on the keyboard to toggle to the tab title then select the Beam Bars tab using 
the arrow keys. The dialog boxes of Figure 4-38 will appear. 

 
Figure 4-38 Defining Beam Bars 

2. Select the span for which reinforcing bars will be defined from the Span list 
box on the upper left corner. The length of the selected span will be shown 
right above the ADD button. 

3. Select bar size from the Bar Size drop-down list.  
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4. Define the number of reinforcing bars in the selected span by entering the 
number in the Number of Bars input box. 

5. Define the length of the reinforcing bars by entering the length in the Length 
input box. The unit of the length is foot [m]. 

6. Define the types of the reinforcing bars in the selected span by selecting from 
the Type drop-down list, which is right below the Bar Size drop-down list. 
Five types are available: Top Left, Top Right, Top Continuous, Bottom 
Continuous and Bottom Discontinuous.  

7. Define the cover by entering the number in the Cover input box. The unit of 
cover is inch [mm]. 

8. Press ADD button to add the new data into the list box below the buttons. 
9. Repeat steps 2 to 8 to define reinforcing bars for all the spans. You may use 

the SPAN COPY button below the Span list to simply copy the data of one span 
to other spans. 

10. If the reinforcing data of a span needs to be modified, select the data from the 
data list box on the lower part of the dialog box then modify the data as 
mentioned above. Press MODIFY button when finished to update the 
corresponding data in the data list. 

11. To delete the reinforcing data for a span, select the data of the span from the 
data list box then press the DELETE button. 

12. Press OK button to exit the dialog box so that pcaSlab will use these 
reinforcing bar properties. 

Defining Beam Stirrups for Two-Way Slab Systems  
The stirrup size, number of stirrups, etc. can be defined by users if the Run Mode 
of Investigation and two-way floor system are selected in the General 
Information dialog box. This menu item is not available if Run Mode of Design 
is selected in the General Information dialog box. 

To define beam stirrups: 

1. Select Reinforcing Bars from the Input menu or click the  button from the 
tool bar. Select the Beam Stirrups tab by clicking the tab title or use the tab 
key on the keyboard to toggle to the tab title then select the Beam Stirrups 
tab using the arrow keys. The dialog boxes of Figure 4-39 will appear. 
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Figure 4-39 Defining Beam Stirrups 

2. Select the span for which stirrups will be defined from the Span list box on 
the upper left corner. The length of the selected span will be shown right 
above the ADD button. 

3. Enter the amount of stirrups of the selected span in the Count input box. (see 
Note) 

4. Select stirrup size from the Size drop-down list.  
5. Enter the spacing of the stirrups of the selected span in the Spacing input box. 

The unit of spacing is inch [mm]. 
6. Enter the number of legs in the Leg input box. 
7. Press ADD button to add the new data into the list box below the buttons. 
8. Repeat steps 2 to 8 to define stirrups for all the spans. You may use the Span 

COPY button below the Span list to simply copy the data of one span to other 
spans. 

9. If the stirrup data of a span needs to be modified, select the data from the data 
list box on the lower part of the dialog box then modify the data as mentioned 
above. Press MODIFY button when finished to update the corresponding data 
in the data list. 

10. To delete the stirrup data for a span, select the data of the span from the data 
list box then press the DELETE button. 

11. Press OK button to exit the dialog box so that pcaSlab will use these 
reinforcing bar properties. 
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Note: If stirrups do not apply in a part of a span, the Count should be set to 0 
(zero) and the Spacing should be the length of the part of the span where no 
stirrups are defined. For example, the following configuration shows stirrups in the 
left and right ends of a span with an empty space (46.0 in. long, no stirrups) in the 
middle part of the span. 

Count Bar Size Spacing Legs 

32 #5 4.50 2 

0 #5 46.0 2 

32 #5 4.50 2 

Defining Flexure Bars for Beams and One-WaySlab Systems  
The reinforcing bar size, number of bars, bar length, etc. for one-way beam 
systems can be defined by users if the Run Mode of Investigation and beams/one-
way slab floor system are selected in the General Information dialog box. This 
menu item is not available if Run Mode of Design is selected in the General 
Information dialog box. 

 
Figure 4-40 Defining Flexure Bars for Beams/One-Way slab Systems 

To define flexure bars for beam in beams/one-way slab systems follow the steps 
described in section Defining Beam Bars. 



 

4-38  Operating pcaSlab/pcaBeam 

Defining Stirrups for Beams and One-Way Slab Systems  
The stirrup size, number of stirrups, etc. for beams/one-way slab systems can be 
defined by users if the Run Mode of Investigation and beams/one-way slab floor 
system are selected in the General Information dialog box. This menu item is not 
available if Run Mode of Design is selected in the General Information dialog 
box. 

 
Figure 4-41 Defining Beams Stirrups in Beams/One-Way Slab Systems 

To define beam stirrups in beams/one-way slab systems follow the steps described 
in section Defining Beam Stirrups. 

Defining Torsional Longitudinal Bars for Beams  
The torsional longitudinal reinforcement bars are distributed along the perimeter of 
the section in addition to the flexure bars. They can be defined by users if the Run 
Mode of Investigation, beams/one-way slab floor system, and torsional analysis 
and design are selected in the General Information dialog box. This menu item is 
not available if Run Mode of Design is selected in the General Information 
dialog box. 

To define torsional longitudinal bars for beams in beams/one-way slab systems: 

1. Select Reinforcing Bars from the Input menu or click the  button from the 
tool bar. Select the Torsion Bars tab by clicking the tab title or use the tab 
key on the keyboard to toggle to the tab title then select the Torsion Bars tab 
using the arrow keys. The dialog boxes of Figure 4-42 will appear. 
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Figure 4-42 Defining Torsion Bars for Beams in Beams/One-Way Slab 

Systems 

2. Select the span for which reinforcing bars will be defined from the Span list 
box on the upper left corner. The length of the selected span will be shown 
right above the ADD button. 

3. Select bar size from the Bar Size drop-down list.  
4. Define the type of the reinforcing bars in the selected span by selecting from 

the Type drop-down list, which is right below the Bar Size drop-down list. 
Two types are available: Continuous and Discontinuous.  

5. Define the number of reinforcing bars in the selected span by entering the 
number in the Number of Bars input box. 

6. Define the cover by entering the number in the Cover input box. The unit of 
cover is inch [mm]. 

7. For discontinued bars, define the length and the starting point of the 
reinforcing bars by entering the values in the Start and Length input boxes. 
The unit of both is foot [m]. 

8. Press ADD button to add the new data into the list box below the buttons. 
9. Repeat steps 2 to 8 to define reinforcing bars for all the spans. You may use 

the SPAN COPY button below the Span list to simply copy the data of one span 
to other spans. 

10. If the reinforcing data of a span needs to be modified, select the data from the 
data list box on the lower part of the dialog box then modify the data as 
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mentioned above. Press MODIFY button when finished to update the 
corresponding data in the data list. 

11. To delete the reinforcing data for a span, select the data of the span from the 
data list box then press the DELETE button. 

12. Press OK button to exit the dialog box so that pcaSlab will use these 
reinforcing bar properties. 

Defining Load Cases  
Up to 6 load cases of dead load, live load or lateral load can be defined in the 
Load Cases dialog box. The default five load case labels (types) are SELF (dead 
load), Dead (dead load), Live (live load), Wind (wind load), and EQ (seismic 
load). 

To define load cases: 

1. Select Load Cases command from the Input menu or click the  button on 
the tool bar. Dialog box as in Figure 4-43 will appear. 

 
Figure 4-43 Defining Load Cases 

2. Enter a name for the new load case in the Label edit box. The name could be 
any character string defined by the user. 

3. Select the type of the new load case from the Type drop-down list. The 
available types are Dead Load, Live Load and Lateral Load. 

4. Press ADD button to add the new load case into the load case list box on the 
lower part of the dialog box. 
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5. Repeat steps 2 to 4 to define all the load cases. The maximum number of load 
cases is 6. Once the maximum number is reached, the ADD button will be 
disabled. 

6. To modify an existing load case, select the load case from the load case list 
box then change the label or type the selected load case as mentioned above 
and press the MODIFY button. 

7. To delete an existing load case, select the load case from the load case list box 
then press the DELETE button. 

8. Press OK button to exit the dialog box so that pcaSlab will use these load 
cases. 

Note: Only one case of live load can be defined. Load case label must be unique 
for each of the load cases. 

Defining Load Combinations  
pcaSlab allows you to change the magnification factors applied to the load cases. 
The default values depend on the code selected with the General Information 
command. 

To define load factors: 

1. Select Load Combinations from the Input menu or click the  button from 
the tool bar. The dialog box of Figure 4-44 will appear if the ACI code was 
selected in the GENERAL INFORMATION dialog box. 

 
Figure 4-44 Define Load Combinations 
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2. The load cases and the corresponding factors that are defined in the Load 
Cases dialog box are shown on the top of the Load Combinations dialog box. 

3. Enter the load factors for each of the load cases in the input box below the 
corresponding load case label.  

4. Press the ADD button to add the combination defined above into the big list 
box in the lower part of the dialog box. 

5. Repeat steps 2 to 4 to define all the load combinations. Up to twenty load 
combinations may be defined. All the combinations are indexed automatically 
from U1 to U20. 

6. To change the factors of an existing combination, select the load combination 
from the load combination list box on the lower part of the dialog box then 
change the factors as mentioned above. Press the MODIFY button when 
finished to update the data in the load combination list box. 

7. To delete an existing combination, select the load combination from the load 
combination list box then press the DELETE button. 

8. Select OK button when all the desired load factors have been modified to exit 
so that pcaSlab will use the new data. 

Span Loads  
pcaSlab computes the self weight of the floor system. Other loads applied to the 
structure have to be specified by the user. There are several types of applied loads 
that may be entered. They are found in the Input menu. Surface loads are placed 
over the entire strip. Partial loads consist of uniform or trapezoidal loads, 
concentrated loads, and concentrated moments that may exist anywhere within the 
span length. For beams/one-way slab systems torsional loads can be defined either 
as concentrated or distributed torques. 

  
Concentrated

Torque
Distributed

Torque

Centerline of Support or
Left End of Cantilever

Trapezoidal

Concentrated Force
or Moment

Uniform

M

 
Figure 4-45 Span Load Types 
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Note: The loads shown in the Figure 4-45 are all positive and may not match the 
typical sign conventions. 

The following table describes input for the span load types shown in Figure 4-45. 

Wa For uniformly distributed loads, Wa is the intensity of the load 
in units of lbs/ft [kN/m], positive Wa is downward. For 
trapezoidal loads, Wa is the intensity at the left end in units of 
lbs/ft [kN/m], positive Wa is downward. For concentrated 
force, Wa is the force P in units of kips [kN], positive Wa is 
downward. For concentrated moments, Wa is the moment M 
in units of ft-kips [kN-m], positive Wa is clockwise. For 
concentrated torque, Wa is the external torque T in units of ft-
kips [kN-m], positive Wa is such that applying the right hand 
screw rule the torque vector points to the right. For distributed 
torque, Wa is the external torque intensity Ta in units of ft-
kips/ft [kN-m/m], positive Wa is such that applying the right 
hand screw rule the torque vector points to the right. 

Wb For trapezoidal loads, Wb is the intensity at the right end in 
units of lbs/ft [kN/m], positive Wb is downward. For 
distributed torque, Wb is the external torque intensity Tb in 
units of ft-kips/ft [kN-m/m], positive Wa is such that applying 
the right hand screw rule the torque vector points to the right. 
For all the other partial load types, Wb is not available. 

La For distributed loads, La is the distance where the load begins 
from the centerline of the column at the left of the span, in 
units of ft [m]. For concentrated loads and moments, La is the 
distance where the load exists from the centerline of the 
column at the left of the span in units of ft [m]. 

Lb For distributed loads, Lb is the distance where the load ends 
from the centerline of the column at the left of the span, in 
units of ft [m]. For concentrated loads and moments, Lb is 
unavailable.  
Note: Although the particular loading may not actually act 
over the entire transverse width, all line loading is converted 
internally by pcaSlab to act over the full width of the slab. In 
the design direction, partial loads given as acting over less 
than 1/20 of the span length will be averaged over 1/20 by the 
program. 
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Defining Area Load on Span  
Area loads are uniform loads acting over the entire strip. These loads have units of 
lb/ft2 [kN/m2].  

To input area loads: 

1. Select the Span Loads command from the Input menu or click the  button 
on the tool bar. Select the AREA LOAD from the TYPE drop-down list on the 
SPAN LOADS dialog box. The dialog box of Figure 4-46 will appear. 

 
Figure 4-46 Defining Area Load on Span 

2. Select the load case from the CURRENT CASE list box on the upper left corner 
as shown in the dialog above. 

3. Select the span on which the area loads will be applied from the SPAN drop-
down list. 

4. Enter the un-factored superimposed area load magnitude acting over the entire 
area of the strip in the Magnitude edit box. Positive surface loads act 
downward.  

5. Press the ADD button to update the area loads in the area load list box on the 
lower part of the dialog box. 

6. Repeat steps 2 through 5 until the loads have been updated. You can use the 
COPY button as a shortcut. 

7. To change the data of an existing area load, select the area load from the area 
load list box then change the magnitude as mentioned above. Press the 
MODIFY button when finished to update the data in the area load list box. 
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8. To delete an existing area load, select the load from the area load list box then 
press the DELETE button. 

9. Press OK button to exit the dialog box so that pcaSlab will use the new data. 

Defining Line Load on Span  
You may enter uniform or trapezoidal loads that do not span from column 
centerline to column centerline in the direction of analysis. These loads are called 
line loads and are input through the SPAN LOADS dialog of the Input menu. Partial 
loads are assumed to act over the entire strip width. 

To input line loads: 

1. Select the Span Loads command from the Input menu or click the  button 
on the tool bar. Select the LINE LOAD from the TYPE drop-down list. The 
dialog box of Figure 4-47 will appear. 

 
Figure 4-47 Defining Line Load on Span 

2. Select the load case of the line load that will be defined from the Current 
Case list box. 

3. From the Span drop-down list, select the span number of the span whose line 
loads you would like to input. 

4. Define un-factored load values and their locations in the corresponding text 
boxes.  

5. Select Add to add the line load defined into the line load list box. 
6. Repeat steps 2 through 5 until all the line loads have been entered then press 

OK button to exit the dialog box so that pcaSlab will use the new loads. 
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To change line loads data: 

1. Select the line load you want to change from the line load list box on the 
lower part of the dialog box by clicking the left mouse button on the load or 
tabbing to the list box and using the arrow up and down keys. 

2. Make your changes to the load by modifying the load type, the load 
magnitude, and/or location. 

3. Select Modify to replace the old data with the new data. 
To delete line load data: 

1. Select the line load you want to delete from the line load list box by clicking 
the left mouse button on the load or tabbing to the list box and using the arrow 
up and down keys. 

2. Press the DELETE button. 

Defining Point Force on Span  
You may enter concentrated vertical loads. These loads are input through the Span 
Load command of the Input menu. Point loads are assumed to act over the entire 
strip width. 

To input point loads: 

1. Select the Span Loads command from the Input menu or click the  button 
on the tool bar. Select the Point Force from the Type drop-down list. The 
dialog box of Figure 4-48 will appear. 

 
Figure 4-48 Defining Point Forces on Span 
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2. Select the load case of the point force that will be defined from the Current 
Case list box. 

3. From the Span drop-down list, select the span number of the span whose 
point loads you would like to input. 

4. Define un-factored load values and their locations in the corresponding text 
boxes.  

5. Select Add to add the point load defined into the point load list box on the 
lower part of the dialog box. 

6. Repeat steps 2 through 5 until all the point loads have been entered then press 
OK button to exit the dialog box so that pcaSlab will use the new loads. 

To change point load data: 

1. Select the point force you want to change from the point load list box by 
clicking the left mouse button on the load or tabbing to the list box and using 
the arrow up and down keys. 

2. Make your changes to the load by modifying the load type, the load 
magnitude, and/or location. 

3. Select Modify to replace the old data with the new data. 
To delete point load data: 

1. Select the point force you want to delete from the point load list box to the 
right by clicking the left mouse button on the load or tabbing to the list box 
and using the arrow up and down keys. 

2. Press the DELETE button. 

Defining Point Moment on Span  
You may enter concentrated moment. This load is input through the Span Load 
command of the Input menu. Point moments are assumed to act over the entire 
strip width. 

To input point moments: 

1. Select the Span Loads command from the Input menu or click the  button 
on the tool bar. Select the Point Moment from the Type drop-down list. The 
dialog box of Figure 4-49 will appear. 
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Figure 4-49 Defining Point Moments on Span 

2. Select the load case of the point moment that will be defined from the 
Current Case list box. 

3. From the Span drop-down list, select the span number of the span whose 
point moments you would like to input. 

4. Define un-factored moment values and their locations in the corresponding 
text boxes.  

5. Select Add to add the point moment defined into the point moment list box on 
the lower part of the dialog box. 

6. Repeat steps 2 through 5 until all the point moments have been entered then 
press OK button to exit the dialog box so that pcaSlab will use the new 
moments. 

To change point load data: 

1. Select the point moment you want to change from the point moment list box 
by clicking the left mouse button on the load or tabbing to the list box and 
using the arrow up and down keys. 

2. Make your changes to the moment by modifying the moment type, the 
moment magnitude, and/or location. 

3. Select Modify to replace the old data with the new data. 
To delete point load data: 
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1. Select the point moment you want to delete from the point moment list box to 
the right by clicking the left mouse button on the load or tabbing to the list 
box and using the arrow up and down keys. 

2. Press the DELETE button. 

Defining Line Torque on Span  
You may enter line torque for beams/one-way slab systems if Torsion Analysis 
and Design is selected in the GENERAL INFORMATION dialog box. This load is 
input through the Span Load command of the Input menu. 

To input line loads: 

1. Select the Span Loads command from the Input menu or click the  button 
on the tool bar. Select the LINE TORQUE from the TYPE drop-down list. The 
dialog box of Figure 4-50 will appear. 

 
Figure 4-50 Defining Line Torque on Span 

2. Select the load case of the line load that will be defined from the CURRENT 
CASE list box. 

3. From the SPAN drop-down list, select the span number of the span whose line 
loads you would like to input. 

4. Define un-factored torque values and their locations in the corresponding text 
boxes.  

5. Select Add to add the line torque defined into the list box. 
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6. Repeat steps 2 through 5 until all the line torques have been entered. Then 
press OK button to exit the dialog box so that pcaSlab will use the new loads. 

To change line torque data: 

1. Select the line torque you want to change from the load list box on the lower 
part of the dialog box by clicking the left mouse button on the load or tabbing 
to the list box and using the arrow up and down keys. 

2. Make your changes to the load by modifying the load type, the load 
magnitude, and/or location. 

3. Select Modify to replace the old data with the new data. 
To delete line torque data: 

1. Select the line torque you want to delete from the load list box by clicking the 
left mouse button on the load or tabbing to the list box and using the arrow up 
and down keys. 

2. Press the DELETE button. 

Defining Point Torque on Span  
You may enter point torque for beams/one-way slab systems if Torsion Analysis 
and Design is selected in the GENERAL INFORMATION dialog box. This load is 
input through the Span Load command of the Input menu. 

To input point torque: 

1. Select the Span Loads command from the Input menu or click the  button 
on the tool bar. Select the POINT TORQUE from the TYPE drop-down list. The 
dialog box of Figure 4-51 will appear. 

2. Select the load case of the point torque that will be defined from the CURRENT 
CASE list box. 

3. From the SPAN drop-down list, select the span number of the span whose 
point moments you would like to input. 

4. Define un-factored torque values and their locations in the corresponding text 
boxes.  

5. Select ADD to add the point torque defined into the list box on the lower part 
of the dialog box. 

6. Repeat steps 2 through 5 until all the point torques have been entered. Then 
press OK button to exit the dialog box so that pcaSlab will use the new 
torques. 
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Figure 4-51 Defining Point Torque on Span 

To change point torque data: 

1. Select the point torque you want to change from the list box by clicking the 
left mouse button on the load or tabbing to the list box and using the arrow up 
and down keys. 

2. Make your changes to the moment by modifying the torque magnitude, and/or 
location. 

3. Select MODIFY to replace the old data with the new data. 
To delete point load data: 

1. Select the point moment you want to delete from the point moment list box by 
clicking the left mouse button on the load or tabbing to the list box and using 
the arrow up and down keys. 

2. Press the DELETE button. 

Defining Support Loads and Displacements  
You may enter prescribed support displacements and rotations as well as apply 
concentrated forces and moments to the system at support locations. These loads 
are input through the Support Loads and Displacements command of the Input 
menu. 

To input support loads and displacements: 



 

4-52  Operating pcaSlab/pcaBeam 

1. Select the Support Loads and Displacements command from the Input 
menu or click the  button on the tool bar. The dialog box of Figure 4-52 will 
appear. 

 
Figure 4-52 Defining Support Loads and Displacements 

2. Select the load case of the support loads and displacements that will be 
defined from the CURRENT CASE list box. 

3. From the SUPPORT drop-down list, select the support number of the support 
whose loads you would like to input. 

4. Define un-factored values of the displacement, rotation, forces, and moment.  
5. Select Add to add the support loads and displacements defined into the load 

list box on the lower part of the dialog box. 
6. Repeat steps 2 through 5 until all the support loads and displacements have 

been entered then press OK button to exit the dialog box so that pcaSlab will 
use the new moments. 

To change support and displacement loads data: 

1. Select the entry you want to change from the load list box by clicking the left 
mouse button on the load or tabbing to the list box and using the arrow up and 
down keys. 

2. Make your changes to the values. 
3. Select Modify to replace the old data with the new data. 
To delete support and displacement load data: 
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1. Select the entry you want to delete from the load list box by clicking the left 
mouse button on the load or tabbing to the list box and using the arrow up and 
down keys. 

2. Press the DELETE button. 

Defining Lateral Effects  
pcaSlab can combine the gravity load analysis with a lateral load analysis. Lateral 
loads are entered as joint moments obtained elsewhere by a frame analysis. The 
joint moments are combined with the gravity load moments to produce load 
patterns 5 through 8. 

To input lateral load moments: 

1. Define at least one lateral load case from the Load Cases dialog box.  
2. Select Lateral Effects from the Input menu. If no lateral case is defined this 

command is disabled. Once selected, Figure 4-53 will appear. 

 
Figure 4-53 Lateral Moment dialog box 

3. Select load cases from the CURRENT CASE list box. At least one lateral load 
case must be defined in the LOAD CASES dialog box before you can see the 
load case in the CURRENT CASE list box. 

4. Select span number on which lateral loads will be defined from the SPAN 
drop-down list. 

5. Enter the moments at the left end and right end of the span in the Moment at 
Left and Moment at Right input boxes, respectively. 
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6. Press the ADD button to add the lateral load defined above into the lateral load 
list box in the lower part of the dialog box. 

7. Repeat steps 2 through 5 to define all the lateral loads.  
8. To change an existing lateral load, select the load from the lateral load list box 

then change the moments as mentioned above. Press the MODIFY button when 
finished to update the data in the lateral load list box. 

9. To delete an existing lateral load, select the load from the lateral load list box 
then press the DELETE button. 

10. Select OK button when all the desired lateral loads have been modified to exit 
so that pcaSlab will use the new data. 

Executing the Calculations (menu Solve)   

Execute  
The Execute command starts the design portion of pcaSlab after you have finished 
inputting all the data.  

To design the system: 

Select the Execute command from the Solve menu or click the  button on the 
tool bar. If any data required to analyze and design the system has not been input 
prior to executing this command, pcaSlab will display an "Invalid model!" 
message. You must complete the data before execution.  

An analysis status window shows the current state of the execution as shown in. If 
the state of each of the computations is OK, the analysis is successful. If any error 
is encountered ERROR will be shown and the computation is terminated. 

 
Figure 4-54 Analysis Status Window 
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Viewing Results Report  
Once the analysis and/or design is performed, you can view the results, shear and 
moment diagrams, and deflected shapes. This section provides procedures 
performing these functions. 

To view the analysis and design results: 

1. Select Report command from the Solve menu or click the  button from the 
tool bar. A dialog box similar to Figure 4-55 will appear. 

 
Figure 4-55 View and Print Results dialog box 

2. Select the results you want to view from the drop-down list. The contents of 
the results box will be changed based on your selection. The Customize 
option allows for more than one result selection to be viewed in the results 
report. 

3. Press the COPY button to copy the current results into the Windows clipboard. 
Then you may use CTRL + V to paste the contents of the clipboard to any 
other editors such as Word or Notepad. 

4. Press the CLOSE button to close the result dialog box. 

Saving Results Report  
Analysis and design results are automatically saved to a text file named 
"projectname.out" in the same folder as the project data file (.slb file). The 
contents of the .out file depends on which option is selected from the drop-down 
list on the Results Report dialog box.  
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For example, if the project name is "Example 1 - FlatPlate (ACI Note)" and Input 
Echo is selected from the Results Report dialog box as shown in Figure 4-56, 
a text file named "Example 1 - FlatPlate (ACI Note).out" is generated 
automatically in the same directory as "Example 1 - FlatPlate (ACI Note).slb". 

 
Figure 4-56 Input Echo is selected from Results Report dialog box 

The file "Example 1 - FlatPlate (ACI Note).out" is a pure text file and can be 
opened, edited and printed using Word or Wordpad as shown in Figure 4-57. 

 
Figure 4-57 Output file is opened using Wordpad 
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Note: Once another option is selected from the Results Report dialog box, the 
contents of the .out file is changed based on the selection. 

Output files (.out file) may not be in proper format if opened using Microsoft 
Notepad. Please use Word or Wordpad. 

View Program Output (menu View)   

Zooming in on the Floor System  
In order to view the floor system in greater detail, pcaSlab allows you to magnify 
a portion of the floor system for closer analysis. 

Using zoom with a magnifier: 

1. Select Zoom from the View menu then a sub menu appears beside the View 
menu. 

2. Select Window from the sub menu. Notice that the Window command is 
checked and the cursor is changed to a magnifier. The other way to magnify 
window is to click the  button on the tool bar. 

3. Move the cross cursor to the upper left corner of the portion of the system you 
want to enlarge. 

4. Press and hold down the left mouse button while dragging the cursor to the 
lower right portion of the system enclosing the desired area within the dashed 
box.  

5. Release the mouse to enlarge that portion. 
Using Zoom In and Zoom Out command: 

1. Select Zoom from the View menu and a sub menu appears. 
2. Select the In(2x) menu command from the sub menu. The current active 

window will be magnified by two times. The other way to do this is to click 
the  button on the tool bar. 

3. Select the Out(0.5x) menu command from the sub menu. The current active 
window will be reduced by two times. The other way to do this is to click the 

 button on the tool bar. 
Note: To return to original (default) zoom, select Restore from the View menu, or 
select  from tool bar. To move model in a view window, use Pan from the View 
menu, or select  from tool bar. 
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Change the Isometric View Angle  
You can modify the X and Z angles at which the floor system is displayed in the 
isometric view window. By default, the floor system is viewed at -45° about the X 
axis and 45° about the Z axis. The right hand rule is used to determine the angle of 
rotation about the X and Z axes and the X axis is always rotated first. 

To change angles: 

1. Select Change View Angle from the View menu. The dialog box of Figure 
4-58 appears displaying the currently set angles. 

 
Figure 4-58 Isometric View dialog box 

2. Change the angles of rotation about the X and Z axes. The X axis is rotated 
first then the Z axis is rotated. The floor system is rotated about the axis using 
the right hand rule. 

3. Select OK button to accept the new angles and to modify the isometric view. 
Note: A more convenient way to change the view angles instantly without entering 
angles in the dialog box is to use the keyboard shortcut CTRL + ARROW Keys. 
For example, press CTRL +  and CTRL +  to rotate the floor system around Z 
axis and press CTRL +  or CTRL +  to rotate around X axis. 

Viewing the Specific Member Type  
In order to see the floor system members in greater detail, you can select specific 
member types to view by enabling and disabling them. 

To select member type: 

1. Select the View Options command from the View menu. The dialog box of 
Figure 4-59 will appear showing the currently displayed member types. 
Depending on the floor system, some of the member types will be shaded gray 
and unavailable. 
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Figure 4-59 View Options dialog box 

2. To hide a member type from a view of the floor system you must remove the 
 sign from the check box. Click the left mouse button on the check box of 

the member type you would like to hide. To view a previously hidden member 
type, click the left mouse button on the check box to add the  sign to the 
check box. 

3. Select OK button to view only the selected member types. 

Plan View  
To switch to plan view: 

1. Select the Plan View command from the View menu or click  button on the 
tool bar. The dialog box of Figure 4-60 will appear.  

 
Figure 4-60 Plan View Window 

2. Right click on the view window to show the pop-up menu. You may save the 
current view window as bitmap (BMP) file or metafile (EMF) on the 
Windows clipboard by selecting Copy Bitmap or Copy Metafile, respectively. 
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You may also select the commands from the pop-up menu to zoom in or zoom 
out the view window and preview it before printing it out.  

 
Figure 4-61 Pop-up Menu of View Window 

3. Select the Options command from the pop-up menu, and then you may 
decide what geometry members need to be shown on the view window as 
shown in Figure 4-62. To hide a member type from a view of the floor system 
you must remove the  sign from the check box. Click the left mouse button 
on the check box of the member type you would like to hide. To view a 
previously hidden member type, click the left mouse button on the check box 
to add the  sign to the check box. 

 
Figure 4-62 Geometry Options of Plan View 

4. Select OK button to view only the selected member types. 

Elevated View  
To switch to elevated view: 

1. Select the Elevated View command from the View menu or click  button 
from the tool bar. The dialog box of Figure 4-63 will appear.  
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Figure 4-63 Elevated View Window 

2. Right click on the view window to show the pop-up menu. You may save the 
current view window as bitmap (BMP) file or metafile (EMF) onto the 
Windows clipboard by selecting Copy Bitmap or Copy Metafile, respectively. 
You may also select the commands from the pop-up menu to zoom in or zoom 
out the view window and preview it before printing it out.  

 
Figure 4-64. Pop-up Menu of View Window 

3. Select the Options command from the pop-up menu, and then you may 
decide what geometry members need to be shown on the view window as 
shown in Figure 4-65. To hide a member type from a view of the floor system 
you must remove the  sign from the check box. Click the left mouse button 
on the check box of the member type you would like to hide. To view a 
previously hidden member type, click the left mouse button on the check box 
to add the  sign to the check box. 
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Figure 4-65 Geometry Options of Elevated View 

4. Select OK button to view only the selected member types. 

Side View  
To switch to side view: 

1. Select the Elevated View command from the View menu or click  button 
from the tool bar. The dialog box of Figure 4-66 will appear.  

 
Figure 4-66 Side View Window 

2. Right click on the view window to show the pop-up menu. You may save the 
current view window as bitmap (BMP) file or metafile (EMF) onto the 
Windows clipboard by selecting Copy Bitmap or Copy Metafile, respectively. 
You may also select the commands from the pop-up menu to zoom in or zoom 
out the view window and preview it before printing it out.  
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Figure 4-67 Pop-up Menu of View Window 

3. Select the Options command from the pop-up menu, and then you may 
decide what geometry members need to be shown on the view window as 
shown in Figure 4-68. To hide a member type from a view of the floor system 
you must remove the  sign from the check box. Click the left mouse button 
on the check box of the member type you would like to hide. To view a 
previously hidden member type, click the left mouse button on the check box 
to add the  sign to the check box. 

 
Figure 4-68 Geometry Options of Side View 

4. Select OK button to view only the selected member types. 

Isometric View  
To switch to isometric view: 

1. Select the Isometric View command from the View menu or click  button 
on the tool bar. The dialog box of Figure 4-69 will appear.  
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Figure 4-69 Isometric View Window 

2. Right click on the view window to show the pop-up menu. You may save the 
current view window as bitmap (BMP) file or metafile (EMF) onto the 
Windows clipboard by selecting Copy Bitmap or Copy Metafile, respectively. 
You may also select the commands from the pop-up menu to zoom in or zoom 
out the view window and preview it before printing it out.  

 
Figure 4-70 Pop-up Menu of View Window 

3. Select the Options command from the pop-up menu, and then you may 
decide what geometry members need to be shown on the view window as 
shown in Figure 4-71. To hide a member type from a view of the floor system 
you must remove the  sign from the check box. Click the left mouse button 
on the check box of the member type you would like to hide. To view a 
previously hidden member type, click the left mouse button on the check box 
to add the  sign to the check box. 
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Figure 4-71 Geometry Options of Isometric View 

4. Select OK button to view only the selected member types. 

Loads  
To show the loads: 

1. Select the Loads command from the View menu or click  button from the 
tool bar. The dialog box of Figure 4-72 will appear.  

 
Figure 4-72 Loads View Window 

2. Right click on the view window to show the pop-up menu. You may save the 
current view window as bitmap (BMP) file or metafile (EMF) onto the 
Windows clipboard by selecting Copy Bitmap or Copy Metafile, respectively. 
You may also select the commands from the pop-up menu to zoom in or zoom 
out the view window and preview it before printing it out.  
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Figure 4-73 Pop-up menu of View Window 

3. Select the Options command from the pop-up menu, and then you may 
decide what kind of loads need to be shown on the view window as shown in 
Figure 4-74. To hide a load case or type you must remove the  sign from the 
check box. Click the left mouse button on the check box of the member type 
you would like to hide. To view a previously hidden load type, click the left 
mouse button on the check box to add the  sign to the check box. 

 
Figure 4-74 Loads Options 

4. If you want to hide the load values, remove the  sign before Show values 
check box.  

5. Select OK button to view only the selected member types. 

View Graphical Results  

Viewing the Internal Forces Diagrams  
Once the design has been performed, you may view the shear, moment, and 
internal torque (beams/one-way slab systems with torsion) diagrams for any span 
at any available load combination.. 

To view shears and moments diagram: 

1. Select the Internal Forces command from the View menu or click the  
button on the tool bar. A view window similar to Figure 4-75 will appear. The 
upper half view window shows the shear diagram and the lower half the view 
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window shows the moment diagram. If torsion is enabled for beams/one-way 
slab systems than internal torque diagram will also be shown in this window. 

 
Figure 4-75 View Internal Forces Diagram 

2. The current coordinate values can be captured based on the position of the 
mouse cursor. The status bar in Figure 4-76 shows the name of the diagram, 
two coordinate values of the current mouse cursor position, and the current 
design code used in the project. 

 
Figure 4-76. Coordinate Value Shown in Status Bar 

3. Click the right mouse button anywhere on the view window to show the pop-
up menu. You may Restore, Zoom, Pan or Print View directly by selecting 
commands from this pop-up menu. 

4. Click the Options command from the pop-up menu to change the span for 
which the internal forces diagrams will be shown and to choose if legend will 
be displayed or not. Figure 4-77 shows the OPTIONS dialog box. Select a span 
number from the SHOW DIAGRAM FOR drop-down list and select a load 
Envelope or combination from the SELECT LOAD COMBINATIONS check list 
box. Use DRAW LEGEND checkbox to control whether legend is drawn or not. 
Press the OK button to close the dialog box and redraw the view windows. 
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Figure 4-77 View Internal Forces Diagram Options 

Note: The pop-up menu can be accessed from each of the view windows of 
pcaSlab. 

The Restore command cannot be executed in the pop-up menu until the Zoom or 
Pan command is stopped by pressing the ESC key. Without stopping the 
Zoom/Pan command, one can only restore a view using the Restore command in 
View menu or  button in the tool bar. This occurs in all pcaSlab view windows. 

Viewing the Moment Capacity  
Once the design has been performed, you may view the moment capacity diagrams 
for any span at any available loading pattern. The moment capacity window will 
be split in half horizontally. The middle strip moment capacity will occupy the 
upper half and the column strip moment capacity will occupy the lower half where 
each diagram will be scaled to fill the entire half of the window.  

To view moment capacity: 

1. Select the Moment Capacity command from the View menu or click the  
button on the tool bar. A view window similar to Figure 4-78 will appear. 

2. Right click on the Moment Capacity view window and select Options 
command from the pop-up menu. A dialog box similar to Figure 4-79 will 
appear. 

3. The current coordinate values can be captured based on the position of the 
mouse cursor. The status bar shows the name of the diagram, two coordinate 
values of the current mouse cursor position, and the current design code used 
in the project. 

4. Click the right mouse button anywhere on the view window to show the pop-
up menu. You may Restore, Zoom, Pan or Print View directly by selecting 
commands from this pop-up menu. 
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Figure 4-78 View Moment Capacity Diagram 

5. Click the Options command from the pop-up menu to change the span for 
which the moment capacity will be shown. Select which span will be shown 
in the SHOW DIAGRAM FOR drop-down list. Use DRAW LEGEND checkbox to 
control whether legend is drawn or not. Select which part of the selected span 
will be shown in the Show frame box. 

6. Press the OK button to close the dialog box and redraw the view windows. 

 
Figure 4-79 View Moment Capacity Option dialog box 

Viewing the Shear Capacity  
Once the design has been performed, you may view the slab shear capacity 
diagrams for any span at any available loading pattern.  

To view shear capacity: 

1. Select the Shear Capacity command from the View menu or click the  
button on the tool bar. A view window similar to Figure 4-80 will appear. 
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Figure 4-80 View Shear Capacity 

2. Right click on the Shear Capacity view window and select Options command 
from the pop-up menu. A dialog box similar to Figure 4-81 will appear. 

 
Figure 4-81 View Shear Capacity Option dialog box 

3. The current coordinate values can be captured based on the position of the 
mouse cursor. The status bar shows the name of the diagram, two coordinate 
values of the current mouse cursor position, and the current design code used 
in the project. 

4. Click the right mouse button anywhere on the view window to show the pop-
up menu. You may Restore, Zoom, Pan or Print View directly by selecting 
commands from this pop-up menu. 

5. Click the Options command from the pop-up menu to change the span for 
which the shear capacity will be shown. Select which span will be shown in 
the SHOW DIAGRAM FOR drop-down list. Use DRAW LEGEND checkbox and 
CRITICAL SECTION checkbox to control if the legend and critical sections are 
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drawn or not. Select which part of the selected span will be shown in the 
SHOW frame box. 

6. Press the OK button to close the dialog box and redraw the view windows. 

Viewing the Reinforcement  
Once the design has been performed, you may view the reinforcement diagrams 
for any span at any available loading pattern. The reinforcement window will be 
split in half horizontally. The middle strip reinforcement will occupy the upper 
half, and the column strip reinforcement will occupy the lower half where each 
diagram will be scaled to fill the entire half of the window.  

To view reinforcement: 

1. Select the Reinforcement command from the View menu or click the  
button on the tool bar. A view window similar to Figure 4-82 will appear. 

 
Figure 4-82 View Reinforcement 

2. Right click on the Reinforcements view window and select Options command 
from the pop-up menu. A dialog box similar to Figure 4-83 will appear. 

3. The current coordinate values can be captured based on the position of the 
mouse cursor. The status bar shows the name of the diagram, coordinate value 
of the current mouse cursor position in the design direction, and the current 
design code used in the project. 

4. Click the right mouse button anywhere on the view window to show the pop-
up menu. You may Restore, Zoom, Pan or Print View directly by selecting 
commands from this pop-up menu. 
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Figure 4-83 View Reinforcement Options dialog box 

5. Click the Options command from the pop-up menu to change the span for 
which the shear capacity will be shown. Select the span you want to show 
from the Show diagram for drop-down list. Select which part of the selected 
span will be shown from the Show frame box. Checking the SHOW REBAR 
LABELS will show labels beside each rebar on the view. Similarly bar length 
can be included by checking INCLUDE BAR LENGTH. Bar labels can also be 
arranged vertically if ROTATE BAR LABELS is checked. Set the vertical scale 
(relative to the horizontal scale which is set automatically) to which members 
are drawn in the SLAB THICKNESS SCALE edit box. 

6. Press the OK button to close the dialog box and redraw the view windows. 

Viewing the Deflected Shapes  
Once the design has been performed, you may view the deflection shapes for any 
span at any available loading pattern.  

To view the deflection shapes: 

1. Select the Deflection command from the View menu or click the  button on 
the tool bar. A view window similar to Figure 4-84 will appear. 

2. Right click on the deflection view window and select Options command from 
the pop-up menu. A dialog box similar to Figure 4-85 will appear. 

3. The current coordinate values can be captured based on the position of the 
mouse cursor. The status bar shows the name of the diagram, two coordinate 
values of the current mouse cursor position, and the current design code used 
in the project. 
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Figure 4-84 View Deflection Diagram 

4. Click the right mouse button anywhere on the view window to show the pop-
up menu. You may Restore, Zoom, Pan or Print View directly by selecting 
commands from this pop-up menu. 

 
Figure 4-85 View Deflection Option dialog box 

5. Click the Options command from the pop-up menu to change the span for 
which the deflection will be shown. Select the span you want to show from 
the SHOW DIAGRAM FOR drop-down list. Check the Draw Legend checkbox to 
include the legend in the drawing. Enter the scale factor in the SCALE FACTOR 
edit box. The bigger the scale factor, the more apparent the deflections will be 
on the diagram.  

6. Press the OK button to close the dialog box and redraw the view windows. 

Print Results  

Printing the Analysis and Design Results  
Once the analysis and/or design is performed, you can print the results. This 
section provides procedures for performing these functions. 
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To print the analysis and design results: 

1. Select Report command from the Solve menu or click the  button from the 
tool bar. A dialog box similar to Figure 4-86 will appear. 

 
Figure 4-86 View and Print Results dialog box 

2. Select the results you want to view from the drop-down list. The contents of 
the results list box will be changed based on your selection. 

3. Press the PRINT button on the dialog box to print the results through a printer. 
The printer could be a local printer which is connected to your computer 
directly, or a network printer. 

4. Press the CLOSE button to close the result dialog box. 

Printing the Current View Window  
Once the design has been performed, you may print the diagrams and views for 
any span at any available loading pattern by selecting the Print View command 
from the File menu. 

To print a displaying window: 

1. To select the diagram or view you want to print, single click the left mouse 
button on the diagram or view window. 

2. Select the Print View command from the File menu. A print preview window 
similar to Figure 4-87 will be shown. 
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Figure 4-87 Print Preview of a View Window 

3. Press the ZOOM IN or ZOOM OUT buttons or simply click the left mouse button 
on the preview to magnify or reduce the size of the preview paper.  

4. Press the NEXT PAGE button if more than one page need to be printed. 
5. Press the PRINT button to print the view. The printer could be a local printer 

which is connected to your computer directly, or a network printer. 
6. Press the CLOSE button to close the preview window and go back to pcaSlab. 

Print Preview  
The Print Preview command allows you to preview and print the current view 
window (floor system geometry in the plan, elevated and isometric views, prints 
the shear and moment diagrams, and the deflected shapes).  

1. To obtain a view window you must first perform the design, then select what 
you want to view from the View menu. You may have more than one view 
window opened. The current view window is the one activated and on top of 
the others on your screen.  

2. Selecting this command closes the pcaSlab main window and opens the print 
preview window as shown in Figure 4-87.  
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3. On the print preview window, press the ZOOM IN or ZOOM OUT buttons or 
simply click the left mouse button on the preview window to magnify or 
reduce the size of the preview paper.  

4. Press the NEXT PAGE button if more than one page needs to be printed.  
5. Press the PRINT button to print the view. The printer could be a local printer 

which is connected to your computer directly, or a network printer.  
6. Press the CLOSE button to close the preview window and go back to pcaSlab. 

 
Figure 4-88 Print Preview Window 

Copy Graphs to Clipboard  

Copy Bitmap (BMP format)   
pcaSlab can copy any of the ten view windows onto Windows clipboard as bitmap. 
The bitmap on clipboard can then be pasted into Microsoft Word or other 
Windows applications including presentation software such as Microsoft 
PowerPoint. 

To copy view window to clipboard as bitmap: 

1. Select the view window that will be copied by single clicking left mouse 
button on it. 
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2. Select  from the tool bar to copy the selected view window to clipboard. 
3. Switch to other word processing software, such as Microsoft Word, then press 

the CTRL + V to paste the bitmap on clipboard to a Word file. 

Copy Metafile (EMF format)   
Since bitmap files cannot easily be resized or re-proportioned without significant 
distortion to the image, metafiles are generally used for situations requiring 
scalability of the image. 

Advantages of metafiles are: 

• Large, simply structured images require less memory than bitmaps for display 
and make optimal use of the resolution of the output device. 

• Metafiles can be resized with none of the distortion which normally 
accompanies resizing of bitmaps. 

• A metafile can contain SelectPalette statements, allowing custom palettes to 
be displayed in applications such as Microsoft Word. 

The Enhanced MetaFile (EMF) format is an extension of the Windows metafiles 
format developed for use with 32 bit Windows applications. It is only available to 
native 32 bit applications. 

To copy view window to clipboard as Enhanced MetaFile (EMF): 

1. Select the view window that will be copied by single clicking left mouse 
button on it. 

2. Select  from the tool bar to copy the selected view window to clipboard. 
3. Switch to other word processing software, such as Microsoft Word, then press 

the CTRL + V to paste the bitmap on clipboard to a Word file. 

Customizing Program (menu Options)   

Changing Colors  
Colors can be changed for background of views, geometry items such as slabs and 
beams, text on views, result diagrams, etc. 

To change colors: 

1. Select Colors command from the Options menu. Figure 4-89 will appear. 
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Figure 4-89 Changing Colors dialog box 

2. From the General frame box on the left side, select the item whose color 
needs to be changed from the list box. 

3. Select a color from the Change color to drop-down list. Once a new color is 
selected from the drop-down list the color in the list box above the drop-down 
list is updated instantly. 

4. From the Results category box on the right side, select the item whose color 
needs to be changed from the list box. 

5. Select a color from the Change color to drop-down list. Once a new color is 
selected from the drop-down list the color in the list box above the drop-down 
list is updated instantly. 

6. If you want to print views in black and white, select the Print Black and 
White check box. 

7. If you want to save the settings as default, select the Save setting for future 
use check box. 

8. Input the line thickness in the Printed Line Thickness edit box. The diagram 
line thickness will be based on the number you input. 

9. Press the OK button to save the settings and close the dialog box. 

Changing Fonts  
Fonts can be selected separately for both the graphical output and the text output 
via Options|Font command. 

To change the graphical output font: 
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1. Select the Font|Graphical Output command from the Options menu. 
A view window similar to Figure 4-90 will appear. 

 
Figure 4-90 Changing Graphical Output Font dialog box 

2. Select the font, font style and size from the lists. Font sizes different from 
those on the list can be typed in. 

3. In the EFFECT frame select if strikeout and/or underline effect have to be 
applied. Alternatively to the COLOR dialog box, the font color can be chosen 
in this dialog box too. 

4. The script of the font by default is Western and should not be changed. 
5. Press the OK button to save the new setting and close the dialog box. 

 
Figure 4-91 Changing Text Output Font dialog box 

To change the text output font follow the same procedure as for the graphical 
output font except that font effects are not available for text output and the list of 
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fonts only contains non-proportional fonts which are suitable for tabulated text 
output (Figure 4-91). 

Changing Startup Defaults  
To change the startup defaults: 

1. Select the Startup Defaults command from the Options menu. A view 
window similar to Figure 4-92 will appear. 

 
Figure 4-92 Changing Startup Defaults dialog box 

2. Input the name of the engineer in the Engineer edit box. The name of the 
engineer will be shown on the view print. 

3. Select the design code from the Design code drop-down list. Four design 
codes are available: ACI 318-99, ACI 318M-99, CSA A23.3-94 and CSA 
A23.3-94E. 

4. Select the rebar database from the Rebar database drop-down list. Four 
defined databases are available: ASTM A615, ASTM A615M, CSA G30.18 
and prEN 10080. If you would like to use rebar defined by yourself, select the 
User Defined from the drop-down list. You may define your own rebar 
database by selecting the Rebar Database from the Options menu. 

5. Press the OK button to save the new setting and close the dialog box. 

Changing the Rebar Database  
User can define his own rebar database. The defined database, such as ASTM 
A615M, cannot be changed. 

To change the rebar database: 

1. Select the Rebar Database from the Options menu. Figure 4-93 will appear. 
2. Select User-defined from the Current Bar Set drop-down list. Rebar data of 

the other databases can only be viewed and cannot be changed. 
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Figure 4-93 Changing Rebar Database 

3. To select the rebar that needs to be changed from the rebar list box, single 
click the left mouse button on it. The size, diameter, area, and weight of the 
selected rebar are shown in the corresponding text boxes, respectively.  

4. Enter the new values of bar size, diameter, area, and weight. 
5. Press the ADD button to add the bar as a new bar into the rebar list box on the 

lower part of the dialog box. If any data inconsistency is found by pcaSlab, an 
error of "Inconsistent bar data" will be shown.  

6. Press the MODIFY button to update an existing rebar. 
7. To delete a rebar, select the rebar from the rebar list box then click the 

DELETE button.  
8. After finishing the definitions of your own rebar database, you may save them 

into a file on the hard drive by pressing the SAVE TO FILE button and 
specifying a file name for your database. This file can be imported into 
pcaSlab by pressing the READ FROM FILE button. 

Working with View Windows (menu Window)   

Cascade  
The Cascade command displays all the open windows in the same size, arranging 
them on top of each other so that the title bar of each is visible. The current active 
view widow will be on the top after the execution of the Cascade command. 
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Tile Horizontal  
The Tile Horizontal command arranges all open windows horizontally so that no 
window overlaps another. The current active view widow will be on the most left 
or on the upper-left corner of the screen after the execution of the Tile Horizontal 
command. 

Tile Vertical  
The Tile Vertical command arranges all open windows vertically so that no 
window overlaps another. The current active view widow will be on the most left 
or on the upper-left corner of the screen after the execution of the Tile Vertical 
command. 

Remaining Commands  
The remaining menu items are in a list of the windows that are available for 
viewing. Selecting any window from this menu will restore the window to its 
previous size and position from an icon.  

Obtaining Help Information (menu Help)   

Opening Table of Contents of the Help System  
To open table of contents of the Help system: 

1. Select Help Topics from the Help menu. 
2. Select the chapter you need from the content tree view in the left pane of the 

Help window. The contents of the selected chapter appear in the right pane of 
the Help window. 

Displaying Help Topic Associated with Selected Element  
To display the topic associated with the selected element: 

1. Select Context Help from the Help menu. The mouse cursor changes to  
2. Click the element for which you need information about. The program will 

display the topic which is associated with the element you clicked. 

Obtaining Information about the Program  
The following information about the program is displayed in the ABOUT PCASLAB 
dialog box: 

• program version and short description 
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• licensing information 

• the copyright information 

The licensing information depends on the type of license being used. If it is a trial 
license then the LICENSE EXP field shows when the trial period expires and the 
LOCKING CODE field displays a unique fingerprint of the computer on which the 
program is running. This locking code (also displayed in the license activator 
window, see License Activation) needs to be provided to pcaStructurePoint in 
order to generate a permanent license. For other, non-trial licenses, license ID is 
displayed. You may be asked to provide this ID when you contact 
pcaStructurePoint for technical support. 

To open the obtain the information about the program: 

1. Select the About pcaSlab command from the Help menu. A dialog box of 
Figure 4-94 will appear.  

a)

  

b)

  
Figure 4-94 About pcaSlab dialog boxes with 

(a) a trial license (b) a network license 

2. Press OK button to exit the dialog box. 
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Output Description 

Output Elements  
pcaSlab generates the text and graphical output of the input data and the results of 
the calculations. The text output is generated when user opens the Results Report 
dialog window. An ASCII text file is generated in the same sub-folder as the input 
data file. The name of the output file is created by adding the extension ".OUT" to 
the name of the input data file. Depending on the report options selected, the text 
output will contain a selection of the following sections (see the illustrated 
examples in the following chapter): 

• Program Information 

• [1] Input Echo 

• [2] Design Results 

• [3] Column Axial Forces And Moments 

• [4] Internal Forces – Load Cases 

• [5] Internal Forces – Load Combinations 

• [6] Internal Forces – Envelopes 

• [7] Deflections 

Program Version  
The program version number appears at the top of each report page along with the 
licensing and copyright information. Additionally, legal disclaimer is displayed on 
the first page of the text output. 

Input Echo  
Section Input Echo reports the data used in the analysis. pcaSlab defaults common 
data; all other data must be input. Carefully check the contents of the section and 
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compare it with the intended design model. The following paragraphs describe the 
blocks included in the section. 

General Information   
This block is similar in its content to the dialog window General Information. It 
contains the information on project input data file name, project description, 
selected design code and units, selected rebar database, calculation mode (design 
or investigation), number of supports, cantilevers. The selections available in the 
SOLVE OPTIONS dialog box are also listed in this block. 

Material Properties  
This block contains the information on concrete properties for slabs, beams and 
columns. It also contains the information on reinforcing steel properties for slabs 
and beams. 

Rebar Database   
This block lists the properties of the bars from the bar table selected for the 
project. Bar diameter, cross-section area and unit weight for each bar are reported. 
The values reported are consistent with the units used in particular model. 

Span Data   
This block is similar in its content to the dialog window Span Data. The block is 
divided into two parts. First part reports the span-by-span geometry of the concrete 
slab (length, left and right side width, depth and code required minimum 
thickness). The second part contains the span-by-span geometry of longitudinal 
beams and ribs (for waffle slabs). 

Support Data  
This block is similar in its content to the dialog window Support Data. The block 
is divided into four parts. The first part reports the geometry of top and bottom 
columns and the stiffness share factor. For circular column the transverse 
dimension C2 is reported as zero. The second part contains the geometry of drop 
panels: thickness, lengths, widths. If dimensions of a drop panel are invalid it will 
be marked. Invalid or excessive drop panel geometry is not used in the analysis. 
The third part contains the geometry of column capitals: depth, slope 
(depth/extension ratio), extensions. The fourth part contains the geometry of 
transverse beams: width depth, eccentricity (offset) from column centroid. 
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Load Data   
This block contains the complete information on load input. The block is divided 
into three parts. The first part reports the defined load cases, load combinations 
and corresponding load factors. This part summarizes the contents of the dialog 
windows Load Cases and Load Combinations. The second part reports the 
magnitudes of defined span loads. It summarizes the contents of the dialog 
window Span Loads. The third part reports the magnitudes of lateral actions (joint 
moments) if defined in the model. It summarizes the contents of the dialog 
window Lateral Load Effects. 

Reinforcement Criteria   
This block is similar in its content to the dialog window Reinforcement Criteria. 
The block is divided into three parts. The first part reports the requirements for 
slab and rib bars. The second part reports the requirements for longitudinal beams. 
Both parts contain the information on bar sizes, covers, spacings and user selected 
allowable steel percentages. The requirements for top and bottom bars are given. 
For longitudinal beams additionally the criteria for transverse bars (stirrups) are 
listed. 

Reinforcing Bars  
This block is available only when Investigation Mode is selected. This block is 
similar in its content to the dialog window Reinforcing Bars. The block is divided 
into three parts. The first part reports the span-by span user selected top bars for 
column, middle and beam strips accordingly. Similarly, the second part reports the 
user selected bottom bars for column, middle and beam. For longitudinal bars the 
program reports bar sizes, lengths and concrete cover. The third part presents the 
beam transverse reinforcement (stirrups) defined by the user. 

Note: When switching from Design Mode to Investigation Mode, pcaSlab 
automatically assumes the results of the Design Mode as an input for Investigation 
Mode. 

Design Results  
Section Design Results presents the summary of the design results of the slab 
system. The following paragraphs describe the blocks included in the section. 

Top Reinforcement   
This block is available only when Design Mode is selected. It reports the negative 
reinforcement requirements. The block contains the values of corresponding 
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design strip widths (column, middle, and beam), maximum factored design 
moments per strip and critical location, minimum and maximum steel areas, bar 
spacings, steel areas required by ultimate condition, selected bar sizes and 
numbers. The quantities are given for left, center and right location of each span. 
For a detailed discussion, see Chapter 2, "Area of Reinforcement".  

Note: This block does not include reinforcement quantities necessary to transfer 
negative unbalanced moment at supports. 

Top Bar Details   
The block contains a span-by-span listing of the longitudinal bars selected in 
column, middle and beam strips. This reinforcement schedule is intended as a 
guide for bar placement. In more complex cases the bar schedule selected by the 
program may have to be adjusted by the user for constructability reasons. The 
selected bar sizes are limited by user specified minimum and maximum sizes. Bar 
sizes and numbers are selected to satisfy the minimum and required steel areas in 
conjunction with the bar spacing requirements of the Code. The program 
calculates the bar lengths based on the computed inflection points and the 
recommended minimums of the Code. The bar lengths are adjusted by appropriate 
development lengths. Hooks and bends are not included in bar length tables and 
figures. For beams bars are placed in single a layer (see Figure 2-21), provided 
there is sufficient beam width. For a detailed discussion, see Chapter 4, 
"Reinforcement Selection". 

Note: This block does not include additional reinforcement bars necessary to 
transfer negative unbalanced moment at supports. 

Band Reinforcement at Supports  
This section is available only when the CSA code is selected. It describes how the 
negative reinforcement in column strips should be concentrated over supports. 
This section reports the width of the column strip and the widths of the band strip 
and the remaining strip that the column strip is subdivided into. It also gives the 
area of reinforcement as well as the number of bars required in each strip. The sum 
of number of bars in the band strip and in the remaining strip should be equal to 
the total number of bars in the column strip over each support. The number of bars 
in the column strip should be consistent with the number of bars listed in the Top 
Bar Details table. 

Note: This block does not include additional reinforcement bars necessary to 
transfer negative unbalanced moment at supports. 
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Bottom Reinforcement   
This block is available only when Design Mode is selected. It reports the positive 
reinforcement requirements. The block contains the values of corresponding 
design strip widths (column, middle, and beam), maximum factored design 
moments per strip and critical location, minimum and maximum steel areas, bar 
spacings, steel areas required by ultimate condition, selected bar sizes and 
numbers. The quantities are given for mid-span regions of each span. For 
a detailed discussion, see Chapter 2, "Area of Reinforcement". 

Bottom Bar Details  
This block contains a span-by-span listing of the longitudinal bars selected in 
column, middle and beam strips. The reinforcement schedule is intended as a 
guide for bar placement. In more complex cases the bar schedule selected by the 
program may have to be adjusted by the user for constructability reasons. The 
selected bar sizes are limited by user specified minimum and maximum sizes. Bar 
sizes and numbers are selected to satisfy the minimum and required steel areas in 
conjunction with the bar spacing requirements of the Code. The program 
calculates the bar lengths based on the computed inflection points and the 
recommended minimums of the Code. The bar lengths are adjusted by appropriate 
development lengths. Hooks and bends are not included in bar length tables and 
figures. For beams bars are placed in single a layer (see Figure 2-21), provided 
there is sufficient beam width. For a detailed discussion, see Chapter 2, 
"Reinforcement Selection". 

Flexural Capacity   
This block lists the selected top and bottom steel areas and corresponding negative 
and positive moment capacity values in each span. The data is subdivided between 
column, middle and beam strips. Each span is subdivided into segments reflecting 
the changes in geometry and bar placement. 

Longitudinal Beam Shear Reinforcement Required   
This block is available only when Design Mode is selected. It reports the 
requirements of transverse reinforcement for each longitudinal beam. The capacity 
of concrete cross-section φVc in each span is shown. The table contains the 
segmental values of the factored shear force Vu and required intensity of stirrups 
(Av/s). The segmental values cover the distance between left and right critical 
sections, and include locations where there is change of geometry of loading. 
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Longitudinal Beam Shear Reinforcement Details  
This block is available only when Design Mode is selected. It is intended as a 
guide for stirrup placement. The output presents the program selected stirrup sizes, 
numbers and spacings. Distances between groups of stirrups are also reported.  

Beam Shear (and Torsion) Capacity  
If torsion is not considered then this block lists the concrete section shear capacity 
φVc, selected stirrup intensities and spacings and corresponding beam shear 
capacity φVn values in each span. The maximum factored shear forces Vmax in 
beam strip along the span also reported. 

In the case of combined shear and torsion analysis (beams/one-way slab systems 
only), this block lists section properties, shear and torsion transverse reinforcement 
capacity, and longitudinal torsional reinforcement capacity. The provided and 
required capacities are expressed in terms of the provided and required areas of 
reinforcement. 

Slab Shear Capacity   
This block lists the values of one-way slab shear capacity φVc in each span. The 
maximum factored shear force Vu and the location of the critical section Xu are 
also reported. 

Flexural Transfer of Negative Unbalanced Moment at Supports   
This block reports the design values for additional negative reinforcement 
necessary to transfer unbalanced support moments. The block contains the results 
for critical (effective) section width as per the Code, the maximum unbalanced 
moment, the corresponding load combination and governing load pattern, the 
reinforcing steel areas provided and additional steel required. The provided 
reinforcement area (main longitudinal bars) is reduced by the ratio of critical 
(effective) strip width to total strip width and does not include the required area 
due to unbalanced moments. The additional reinforcement is the difference 
between that required by unbalanced moment transfer by flexure and that provided 
for design bending moment. When additional reinforcement is required, it is 
selected based on the bar sizes already provided at the support. For a detailed 
discussion, see Chapter 2, "Area of Reinforcement" and "Additional 
Reinforcement at Support". 
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Punching Shear Around Columns  
The block contains the values pertaining to punching shear check in critical 
sections around the columns. The table lists two sets of punching shear 
calculations – direct shear alone and direct shear with moment transfer. The output 
contains the values of the allowable shear stress φvc, reactions Vu, unbalanced 
moments Munb, governing load pattern, fraction of unbalanced moment φv, 
punching shear stress vu. The calculation for moment transfer adjusts the 
unbalanced moment to the centroid of the critical section. The "shear transfer" is 
the unbalanced moment multiplied by γv. When calculated shear stress vu exceeds 
the allowable value φvc, the program prints a warning flags for this support. For a 
detailed discussion, see Chapter 2, "Shear Analysis of Slabs". 

Punching Shear Around Drops  
The block contains the values pertaining to punching shear check in a critical 
section around the drop panels. The table displays the reactions Vu, governing load 
pattern, the punching shear stress around the drop vu, and the allowable shear 
stress φvc. When calculated shear stress vu exceeds the allowable value φvc, the 
program prints a warning flags for this drop panel. For a detailed discussion, see 
Chapter 2, "Shear Analysis of Slabs". 

Integrity Reinforcement at Supports  
This section is available only when the CSA code is selected. It lists the shear 
transferred to the column and the minimum area of bottom reinforcement crossing 
one face of the periphery of a column and connecting slab to the column to provide 
structural integrity. For a detailed discussion, see Chapter 2, "Integrity 
Reinforcement". 

Corner Reinforcement  
This block refers to the reinforcement required in the exterior corners of a slab 
with beams between columns. The ratio of flexural stiffness of beam section to 
flexural stiffness of slab is listed as well as the area of reinforcement and the 
distance over which the reinforcement is required. The area applies to each layer 
of reinforcement in each direction. For a detailed discussion, see Chapter 2, "Slab 
Corners". 

Shear Resistance at Corner Columns  
This section is available only when the CSA code is selected. It reports results of 
one-way shear check at corner columns. The results include the factored shear 
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resistance and the factored shear force at the column. Also, the minimum length of 
the critical shear section and the angle at which the minimum length is obtained 
are listed. For a detailed discussion, see Chapter 2, "Shear Resistance at Corner 
Columns" in “Shear Analysis of Slabs”. 

Maximum Deflections  
This block lists the summary of dead load (DL), live load (LL) and total (DL+LL) 
short-time deflections for the entire equivalent frame, column and middle strips. If 
solution option "Gross (uncracked) sections" is selected, the values of deflections 
reported are based on gross section properties. If solution option "Effective 
(cracked) sections" is used, the values of deflections reported are based on 
substitute effective moment of inertia of the section. For a detailed discussion, see 
Chapter 2, "Deflection Calculation".  

Material Takeoff   
This block lists the approximate total and unit quantities of concrete, and 
reinforcement. Note that the reinforcement estimate is for one direction only and 
ignores items such as hooks, bends, and waste. For a detailed discussion, see 
Chapter 2, "Material Quantities".  

Column Axial Forces and Moments  
Section Column Axial Forces and Moments presents the summary of unfactored 
axial forces (reactions) and bending moments in bottom and top columns in the 
column-slab joints. If moment redistribution is selected (beams/one-way slab 
systems only) both redistributed and un-redistributed values can be included. The 
values reported represent the loading of a single floor only. Any actions on the 
columns from the floors above must be added to this story’s actions to properly 
analyze/design the columns. The output contains column actions due to 
Selfweight, Dead Load, Live Load, and Total Combination. The Live Load values 
for all four load patterns are presented. The values for Live Load pattern No.4 are 
not combined because this load pattern is not singular (each support has is 
individual load configuration). 

Internal Forces - Load Cases  
This section presents the summary of unfactored bending moments and shear 
forces for individual load cases including selfweight, dead load, live load and 
lateral cases. The reported values are presented using span-by-span segmental 
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approach. If moment redistribution is selected (beams/one-way slab systems only) 
both redistributed and un-redistributed values can be included. 

Internal Forces - Load Combinations  
This section presents the summary of bending moments and shear forces for each 
load combination. The reported values for each load combination are presented 
using span-by-span segmental approach. The negative and positive values of 
bending moments and shear forces are presented in separate columns in order to 
provide consistent format with enveloped output. If moment redistribution is 
selected (beams/one-way slab systems only) both redistributed and un-
redistributed values can be included. 

Internal Forces - Envelopes  
This section presents the summary of bending moments and shear forces for 
envelope of all load combinations. The reported values are presented using span-
by-span segmental approach. The negative and positive values of bending 
moments and shear forces are presented in separate columns for user convenience. 
The factored values presented in this section are used for design purposes 
(longitudinal and transverse reinforcement). If moment redistribution is selected 
(beams/one-way slab systems only) both redistributed and un-redistributed values 
can be included. 

Deflections  
This section presents the summary of deflections for unfactored (service) load 
cases including selfweight and dead load (DL), live load (LL) and combined 
(DL+LL) load cases. The reported values are presented using span-by-span 
segmental approach. If solution option "Gross (uncracked) sections" is selected, 
the values of deflections reported are based on gross section properties. If solution 
option "Effective (cracked) sections" is used, the values of deflections reported are 
based on substitute effective moment of inertia of the section. For a detailed 
discussion, see Chapter 2, "Deflection Calculation".  

Graphical Output  
pcaSlab provides the following graphical output features: 

• Diagrams of Internal Forces, 
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• Moment Capacity Diagram, 

• Shear (and Torsion) Capacity Diagram, 

• Deflection Diagram, 

• Reinforcement Diagram. 

These diagram windows can be customized. The Options dialog allows selecting 
either a single span or all spans. Other elements of the graphs can also be 
modified. pcaSlab print preview of the current graphical window. The user has 
also the choice to export the graphics to a metafile or bitmap file. 

Detailed information on using the graphical output features is included in chapter 
"Operating the Program". 

 



 

Chapter 6 Examples 
Examples 

In this chapter several examples are presented to demonstrate capabilities of the 
program. These examples refer to problems solved in PCA Notes on ACI 318-02 
and other established text books. Generally program results match closely the 
results found in the references. When discrepancies are observed, they result from 
variations in assumptions and solutions methods, and numerical accuracy. 

Both beams/one-way slab systems as well as two-way slab systems are presented 
in the examples. The output of beams/one-way slab examples shows that pcaBeam 
program was used to solve them. This is to illustrate that pcaBeam program is 
available as a limited version of pcaSlab including only beams/one-way slab 
capabilities. 

Example 1 Spandrel beam with moment redistribution  

Problem description   
Determine the required reinforcement for the spandrel beam at an intermediate 
floor level as shown, using moment redistribution to reduce total reinforcement 
required. (Note: the self weight is already included in the specified dead load 
below.) This example refers to Example 8-2 from PCA Notes on ACI 318-02 
Building Code Requirements for Structural Concrete, Portland Cement 
Association, 2002. 

Columns:  16 × 16 in. 
Story height: 10 ft 
Spandrel beam: 12 × 16 in. 
f′c = 4000 psi 
fy  = 60,000 psi 
DL = 1167 lb/ft 
LL = 450 lb/ft 
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25' - 0" 15' - 0" 20' - 0"

A B C D

Columns 16" × 16" (typ.)

Spandrel beam
12" × 16" (typ.)

 
Figure 6-1 Example spandrel beam problem 

Prepering the input 
1. From the Input menu, select General Information. A dialog box appears. 

• In the LABELS section, input the names of the project, frame, and 
engineer.  

• In the FRAME section, input 4 for NO OF SUPPORTS.  

• In the FLOOR SYSTEM section, click the radial button next to ONE WAY / 
BEAM.  

• Leave all other options in the General Information tab to their default 
settings of ACI 318-02 design code, ASTM A615 reinforcement, and 
DESIGN run mode option.  

• In the Solve Options tab, click the check box next to MOMENT 
REDISTRIBUTION. Press OK. 
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2. Nothing needs to be changed in the Material Properties menu.  

 

 
3. From the Input menu, select Spans. A dialog box appears. 

• Under the Slabs/Flanges tab, input 25 for LENGTH, 0 for THICKNESS, 
and 0 for WIDTH LEFT and WIDTH RIGHT. Press MODIFY.  

• Press the drop down arrow next to SPAN and select Span 2. Input 15 for 
LENGTH, 0 for THICKNESS, and 0 for WIDTH LEFT and WIDTH RIGHT. 
Press MODIFY.  
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• Press the drop down arrow next to SPAN and select Span 3. Input 20 for 
LENGTH, 0 for THICKNESS, and 0 for WIDTH LEFT and WIDTH RIGHT. 
Press MODIFY.  

• Select the Longitudinal Beams tab. Input 12 for WIDTH and 16 for 
DEPTH. Press MODIFY. 

• Press COPY. Press the CHECK ALL button. Press OK. 

• Press OK again. 
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4. From the Input menu, select Supports. A dialog box appears. 

• Under the Columns tab, input 16 for both the C1 and C2 values in both 
the ABOVE and BELOW rows. Press MODIFY. (Note: the default HEIGHT 
ABOVE and HEIGHT BELOW values of 10 are correct.) 

• Press COPY. Press the CHECK ALL button. Press OK. 

• Under the Moment Redistribution tab, click on SUPPORT 2 in the list in 
the bottom half of the SUPPORT DATA dialog box. 

• Input 20 for both the LEFT and RIGHT REDISTRIBUTION LIMITS. Press 
MODIFY. 

• Press COPY. Click the check box next to SPAN 3. Press OK.  

• Press OK again. 
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5. Nothing needs to be changed in the Reinforcement menu.  
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6. From the Input menu, select Load Cases. A dialog box appears. 

• Since we are not considering lateral forces, click on WIND in the LABEL 
column on the list in the bottom half of the LOAD CASES dialog box and 
press the DELETE button. 

• Click on EQ in the LABEL column and press the DELETE button. Press 
OK. 

 
7. From the Input menu, select Load Combinations. A dialog box appears.  

• Delete all the load combinations by clicking anywhere on the list in the 
bottom half of the LOAD COMBINATIONS dialog box and pressing the 
DELETE button. Repeat this procedure until all the load combinations are 
gone.  
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• Input 0 in the SELF field, 1.2 in the DEAD field, and 1.6 in the LIVE 
field. Press ADD. 

• Press OK. 

 
8. From the Input menu, select Span Loads. A dialog box appears. 

• Press the drop down arrow next to TYPE, and select LINE LOAD. 

• Input 1167 for both the START and END MAGNITUDE.  

• Input 25 for the END LOCATION. Press ADD. 

• Use the drop down arrow next to SPAN to select SPAN 2. Keep the START 
and END MAGNITUDES of 1167 lb/ft but change the END LOCATION to 
15. Click the ADD button. 

• Again use the drop down arrow next to SPAN to select SPAN 3. Keep the 
START and END MAGNITUDES of 1167 lb/ft but change the END 
LOCATION to 20. Click the ADD button 
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9. In the top left corner of the SPAN LOADS dialog box, there is a section called 

CURRENT CASE. Click on LIVE. 
• Use the drop down arrow next to SPAN to select SPAN 1. 

• Making sure that LINE LOAD is still the selected LOAD TYPE, input 450 
for both the START and END MAGNITUDE. 

• Input 25 for the END LOCATION. Press ADD. 

• Use the drop down arrow next to SPAN to select SPAN 2. Keep the START 
and END MAGNITUDES of 450 lb/ft but change the END LOCATION to 15. 
Click the ADD button. 

• Again use the drop down arrow next to SPAN to select SPAN 3. Keep the 
START and END MAGNITUDES of 1167 lb/ft but change the END 
LOCATION to 20. Click the ADD button 

• Press OK. 
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10. From the Solve menu, select Execute. Press CLOSE. 
11. From the Solve menu, select Results Report. 

• Use the scroll bars to scroll through the results file.  

• Use the ARROW keys or the mouse wheel to browse through different 
parts of the results quickly. Press the CLOSE button to close the RESULTS 
REPORT dialog box and return to pcaBeam. 

12. To view diagrams, select Loads, Internal Forces, Moment Capacity, Shear 
Capacity, Deflection, or Reinforcement from the View menu. Right click in 
any of these diagrams to get new copy, printing, or display options.  

13. You may print the results file by selecting Print Results from the File menu. 
To print any of the diagrams you selected to view, use the Print Preview 
command found by right clicking in the diagram’s window. After viewing the 
results, you may decide to investigate the input beams under the same loads 
but with a modified reinforcement configuration.  

14. From the Input menu, select General Information. In the General 
Information dialog box change the RUN MODE option to INVESTIGATION. Do 
not change any of the other options. Press OK 

15. From the Input menu, select the different commands under Reinforcement 
Criteria and Reinforcing Bars to modify the reinforcement configuration 
computed by the program. 

16. Repeat steps 10 and subsequent to perform the investigation and view the 
results.  
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Text Output (abbreviated) 
                         ooooooo      oooooo      ooooo               
                         oooooooo    oooooooo    ooooooo              
                         oo    oo    oo    oo    oo   oo              
                         oo    oo    oo          oo   oo              
                         oooooooo    oo          ooooooo   ooooo      
                         ooooooo     oo    oo    ooooooo   ooooo      
                         oo          oo    oo    oo   oo              
                         oo          oooooooo    oo   oo              
                         oo           oooooo     oo   oo              
  
  
                      OOOOO    OOOOOO   OOOOO   OO       OO           
                      OO   OO  OO      OO   OO  OOO     OOO           
                      OO   OO  OO      OO   OO  OO O   O OO           
                      OO   OO  OO      OO   OO  OO  O O  OO           
                      OOOOO    OOOOO   OOOOOOO  OO   O   OO           
                      OO   OO  OO      OO   OO  OO       OO           
                      OO   OO  OO      OO   OO  OO       OO           
                      OO   OO  OO      OO   OO  OO       OO           
                      OOOOO    OOOOOO  OO   OO  OO       OO           
  
      =============================================================================  
                                  pcaBeam v1.50 (TM) 
              A Computer Program for Analysis, Design, and Investigation of 
              Reinforced Concrete Continuous Beam and One-Way Slab Systems  
      =============================================================================  
                  Copyright © 1992-2005, Portland Cement Association  
                                  All rights reserved  
  
             Licensee stated above acknowledges that Portland Cement Association  
         (PCA) is not and  cannot  be  responsible for  either the  accuracy  or  
         adequacy of  the material supplied  as input  for  processing   by  the  
         pcaBeam  computer program.  Furthermore, PCA neither makes any warranty  
         expressed nor implied with respect  to  the  correctness of the  output  
         prepared by the  pcaBeam   program.  Although  PCA  has  endeavored  to  
         produce pcaBeam  error free the  program is not and cannot be certified  
         infallible.  The final and only responsibility for analysis, design and  
         engineering documents is the licensees. Accordingly, PCA disclaims  all  
         responsibility in contract, negligence or other tort for any  analysis,  
         design  or engineering documents prepared in connection with the use of  
         the pcaBeam  program.  
  
  
============================================================================================= 
[1] INPUT ECHO  
============================================================================================= 
  
General Information: 
==================== 
   File name: C:\Data\pcaBeam\PCA Notes on ACI 318-02 Example 8-2.slb 
   Project: PCA Notes on ACI 318-02 
   Frame: Example 8-2                              Engineer: pcaStructurePoint 
   Code: ACI 318-02       Mode: Design             Reinforcement Database: ASTM A615 
   Number of supports = 4 
   Floor System: One-Way/Beam 
  
   Live load pattern ratio = 100% 
   Deflections are based on cracked section properties. 
   In negative moment regions, Igr and Mcr DO NOT include flange/slab contribution (if available) 
   Compression reinforcement calculations NOT selected. 
   Moment redistribution selected. 
   Effective flange width calculations NOT selected. 
   Rigid beam-column joint NOT selected. 
   Torsion analysis and design NOT selected. 
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Material Properties: 
==================== 
            Slabs|Beams       Columns 
           ------------   ------------ 
   wc    =          150            150 lb/ft3 
   f'c   =            4              4 ksi 
   Ec    =       3834.3         3834.3 ksi 
   fr    =      0.47434        0.47434 ksi 
  
   fy    =           60 ksi, Bars are not epoxy-coated 
   fyv   =           60 ksi 
   Es    =        29000 ksi 
  
Reinforcement Database: 
=============== 
   Units: Db (in), Ab (in^2), Wb (lb/ft) 
   Size       Db      Ab        Wb    Size       Db      Ab        Wb 
   ---- -------- -------- --------    ---- -------- -------- -------- 
     #3     0.38     0.11     0.38      #4     0.50     0.20     0.67     
     #5     0.63     0.31     1.04      #6     0.75     0.44     1.50     
     #7     0.88     0.60     2.04      #8     1.00     0.79     2.67     
     #9     1.13     1.00     3.40     #10     1.27     1.27     4.30     
    #11     1.41     1.56     5.31     #14     1.69     2.25     7.65     
    #18     2.26     4.00    13.60     
  
Span Data: 
========== 
   Slabs: L1, wL, wR (ft); t, Hmin (in) 
   Span Loc        L1        t       wL       wR     Hmin 
   ---- ---- -------- -------- -------- -------- --------  
      1 Int    25.000     0.00    0.500    0.500     0.00     
      2 Int    15.000     0.00    0.500    0.500     0.00     
      3 Int    20.000     0.00    0.500    0.500     0.00     
  
   Ribs and Longitudinal Beams: b, h, Sp (in) 
        __________Ribs____________    _______Beams_____    __Span__ 
   Span        b        h       Sp           b        h        Hmin 
   ---- -------- -------- --------    -------- --------    -------- 
      1     0.00     0.00     0.00       12.00    16.00       16.22 *b  
      2     0.00     0.00     0.00       12.00    16.00        8.57 
      3     0.00     0.00     0.00       12.00    16.00       12.97 
   NOTES: 
   *b- Span depth is less than minimum.  
  
Support Data: 
============= 
   Columns: c1a, c2a, c1b, c2b (in); Ha, Hb (ft) 
   Supp      c1a      c2a       Ha        c1b      c2b       Hb  Red% 
   ---- -------- -------- --------   -------- -------- --------  ---- 
      1    16.00    16.00   10.000      16.00    16.00   10.000   100  
      2    16.00    16.00   10.000      16.00    16.00   10.000   100  
      3    16.00    16.00   10.000      16.00    16.00   10.000   100  
      4    16.00    16.00   10.000      16.00    16.00   10.000   100  
  
   Moment Redistribution Limits 
   Supp  Left[%] Right[%] 
   ---- -------- -------- 
      1        0        0 
      2       20       20 
      3       20       20 
      4        0        0 
  
   Boundary Conditions: Kz (kip/in); Kry (kip-in/rad) 
   Supp    Spring Kz   Spring Kry Far End A Far End B 
   ---- ------------ ------------ --------- --------- 
      1            0            0     Fixed     Fixed 
      2            0            0     Fixed     Fixed 
      3            0            0     Fixed     Fixed 
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      4            0            0     Fixed     Fixed 
  
Load Data: 
========== 
   Load Cases and Combinations: 
   Case     SELF     Dead     Live  
   Type     DEAD     DEAD     LIVE  
   U1      0.000    1.200    1.600  
  
   Span Loads: 
   Span Case               Wa           La           Wb           Lb 
   ---- -------- ------------ ------------ ------------ ------------ 
   Line Loads - Wa | Wb (lb/ft), La | Lb (ft): 
      1 Dead             1167            0         1167           25 
      2 Dead             1167            0         1167           15 
      3 Dead             1167            0         1167           20 
      1 Live              450            0          450           25 
      2 Live              450            0          450           15 
      3 Live              450            0          450           20 
  
   Support Loads:   --- NONE --- 
  
   Support Displacements:   --- NONE --- 
  
Reinforcement Criteria: 
======================= 
                 _____Top bars___  ___Bottom bars__  ____Stirrups____ 
                   Min      Max      Min      Max      Min      Max   
                 -------  -------  -------  -------  -------  ------- 
   Slabs and Ribs: 
     Bar Size         #5       #8       #5       #8 
     Bar spacing    1.00    18.00     1.00    18.00 in 
     Reinf ratio    0.14     5.00     0.14     5.00 % 
     Cover          1.50              1.50          in 
  
   Beams: 
     Bar Size         #5       #8       #5       #8       #3       #5 
     Bar spacing    1.00    18.00     1.00    18.00     6.00    18.00 in 
     Reinf ratio    0.14     5.00     0.14     5.00 % 
     Cover          1.50              1.50          in 
  
 
============================================================================================= 
[2] DESIGN RESULTS 
============================================================================================= 
  
Moment Redistribution Factors: 
============================== 
   Units: Org.Mu (k-ft) 
                ____________Calculated_____________   __User__   _Applied_ 
   Supp   Side    Org.Mu  Iter.# EpsilonT Factor[%]   Limit[%]   Factor[%] 
   ---- ------  --------  ------ -------- ---------   --------   --------- 
      1  Right     83.53       7  0.01796     17.96       0.00        0.00 
      2   Left     91.92       6  0.01526     15.26      20.00       15.26 
      2  Right     41.57       2  0.04168     20.00      20.00       20.00 
      3   Left     32.97       2  0.05368     20.00      20.00       20.00 
      3  Right     57.21       2  0.02909     20.00      20.00       20.00 
      4   Left     49.30       2  0.03446     20.00       0.00        0.00 
  
Top Reinforcement: 
================== 
   Units: Width (ft), Mmax (k-ft), Xmax (ft), As (in^2), Sp (in) 
   Span Zone      Width         Mmax     Xmax    AsMin    AsMax    SpReq    AsReq    Bars 
   ---- ------ -------- ------------ -------- -------- -------- -------- -------- ------- 
      1 Left       1.00        83.10    0.667    0.568    3.075    1.993    1.404    5-#5  
        Middle     1.00         0.00   12.500    0.000    3.075    0.000    0.000     ---  
        Right      1.00        75.67   24.333    0.568    3.075    1.993    1.269    5-#5  
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      2 Left       1.00        31.23    0.667    0.568    3.075    1.993    0.502    5-#5  
        Middle     1.00         0.00    7.500    0.000    3.075    0.000    0.000     ---  
        Right      1.00        24.35   14.333    0.518    3.075    3.986    0.389    3-#5  
 
      3 Left       1.00        43.45    0.667    0.568    3.075    3.986    0.706    3-#5  
        Middle     1.00         0.00   10.000    0.000    3.075    0.000    0.000     ---  
        Right      1.00        48.84   19.333    0.568    3.075    3.986    0.798    3-#5  
 
Top Bar Details: 
================ 
   Units: Length (ft) 
        _____________Left______________  ___Continuous__  _____________Right_____________ 
   Span    Bars  Length    Bars  Length     Bars  Length     Bars  Length    Bars  Length 
   ---- ------- ------- ------- -------  ------- -------  ------- ------- ------- ------- 
      1    3-#5    8.48    2-#5    5.40      ---             3-#5    8.48    2-#5    5.40 
 
      2    3-#5    5.18    2-#5    3.40      ---             2-#5    5.18    1-#5    3.40 
 
      3    2-#5    6.83    1-#5    4.40      ---             2-#5    6.83    1-#5    4.40 
 
Bottom Reinforcement: 
===================== 
   Units: Width (ft), Mmax (k-ft), Xmax (ft), As (in^2), Sp (in)  
   Span    Width         Mmax     Xmax    AsMin    AsMax    SpReq    AsReq    Bars 
   ---- -------- ------------ -------- -------- -------- -------- -------- ------- 
      1     1.00        69.82   12.625    0.568    3.075    2.657    1.164    4-#5  
 
      2     1.00        25.96    7.624    0.553    3.075    7.972    0.416    2-#5  
 
      3     1.00        47.12    9.876    0.568    3.075    3.986    0.769    3-#5  
 
Bottom Bar Details: 
=================== 
   Units: Start (ft), Length (ft) 
        _______Long Bars_______ ______Short Bars_______ 
   Span    Bars   Start  Length    Bars   Start  Length 
   ---- ------- ------- ------- ------- ------- ------- 
      1    2-#5    0.00   25.00    2-#5    5.91   13.53 
 
      2    2-#5    0.00   15.00     ---                 
 
      3    2-#5    0.00   20.00    1-#5    5.76    8.13 
 
Flexural Capacity: 
================== 
   Units: From, To (ft), As (in^2), PhiMn (k-ft)  
   Span      From        To AsTop AsBot       PhiMn-       PhiMn+ 
   ---- --------- --------- ----- ----- ------------ ------------ 
      1     0.000     0.667  1.55  0.62       -91.01        38.31 
            0.667     3.717  1.55  0.62       -91.01        38.31 
            3.717     5.401  0.93  0.62       -56.51        38.31 
            5.401     5.905  0.93  0.62       -56.51        38.31 
            5.905     6.793  0.93  0.62       -56.51        38.31 
            6.793     7.214  0.00  0.62         0.00        38.31 
            7.214     8.477  0.00  1.24         0.00        74.08 
            8.477     8.950  0.00  1.24         0.00        74.08 
            8.950    12.500  0.00  1.24         0.00        74.08 
           12.500    16.050  0.00  1.24         0.00        74.08 
           16.050    16.523  0.00  1.24         0.00        74.08 
           16.523    18.045  0.00  1.24         0.00        74.08 
           18.045    18.128  0.93  1.24       -56.51        74.08 
           18.128    19.437  0.93  0.62       -56.51        38.31 
           19.437    19.599  0.93  0.62       -56.51        38.31 
           19.599    21.121  0.93  0.62       -56.51        38.31 
           21.121    24.333  1.55  0.62       -91.01        38.31 
           24.333    25.000  1.55  0.62       -91.01        38.31 
 
      2     0.000     0.667  1.55  0.62       -91.01        38.31 
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            0.667     2.401  1.55  0.62       -91.01        38.31 
            2.401     3.401  0.93  0.62       -56.51        38.31 
            3.401     4.177  0.93  0.62       -56.51        38.31 
            4.177     5.177  0.00  0.62         0.00        38.31 
            5.177     5.450  0.00  0.62         0.00        38.31 
            5.450     7.500  0.00  0.62         0.00        38.31 
            7.500     9.550  0.00  0.62         0.00        38.31 
            9.550     9.823  0.00  0.62         0.00        38.31 
            9.823    10.823  0.00  0.62         0.00        38.31 
           10.823    11.599  0.62  0.62       -38.31        38.31 
           11.599    12.599  0.62  0.62       -38.31        38.31 
           12.599    14.333  0.93  0.62       -56.51        38.31 
           14.333    15.000  0.93  0.62       -56.51        38.31 
 
      3     0.000     0.667  0.93  0.62       -56.51        38.31 
            0.667     3.401  0.93  0.62       -56.51        38.31 
            3.401     4.401  0.62  0.62       -38.31        38.31 
            4.401     5.755  0.62  0.62       -38.31        38.31 
            5.755     5.827  0.62  0.62       -38.31        38.31 
            5.827     6.755  0.00  0.62         0.00        38.31 
            6.755     6.827  0.00  0.93         0.00        56.51 
            6.827     7.200  0.00  0.93         0.00        56.51 
            7.200    10.000  0.00  0.93         0.00        56.51 
           10.000    12.800  0.00  0.93         0.00        56.51 
           12.800    12.883  0.00  0.93         0.00        56.51 
           12.883    13.173  0.00  0.62         0.00        38.31 
           13.173    13.883  0.00  0.62         0.00        38.31 
           13.883    14.190  0.00  0.62         0.00        38.31 
           14.190    15.599  0.62  0.62       -38.31        38.31 
           15.599    16.617  0.62  0.62       -38.31        38.31 
           16.617    19.333  0.93  0.62       -56.51        38.31 
           19.333    20.000  0.93  0.62       -56.51        38.31 
 
Longitudinal Beam Shear Reinforcement Required: 
=============================================== 
   Units: d (in), Start, End, Xu (ft), PhiVc, Vu (kip), Av/s (in^2/in)  
   Span        d    PhiVc    Start      End       Vu       Xu     Av/s 
   ---- -------- -------- -------- -------- -------- -------- -------- 
      1    14.00    15.94    1.833    4.881    22.99    1.833   0.0112 
                             4.881    7.929    16.53    4.881   0.0100 
                             7.929   10.976    10.07    7.929   0.0100 
                            10.976   14.024     3.61   10.976   0.0000 
                            14.024   17.071     9.41   17.071   0.0100 
                            17.071   20.119    15.87   20.119   0.0100 
                            20.119   23.167    22.34   23.167   0.0102 
 
      2    14.00    15.94    1.833    3.452    12.91    1.833   0.0100 
                             3.452    5.071     9.47    3.452   0.0100 
                             5.071    6.690     6.04    5.071   0.0000 
                             6.690    8.310     2.61    6.690   0.0000 
                             8.310    9.929     5.12    9.929   0.0000 
                             9.929   11.548     8.55   11.548   0.0100 
                            11.548   13.167    11.98   13.167   0.0100 
 
      3    14.00    15.94    1.833    4.167    17.08    1.833   0.0100 
                             4.167    6.500    12.13    4.167   0.0100 
                             6.500    8.833     7.18    6.500   0.0000 
                             8.833   11.167     2.86   11.167   0.0000 
                            11.167   13.500     7.80   13.500   0.0000 
                            13.500   15.833    12.75   15.833   0.0100 
                            15.833   18.167    17.70   18.167   0.0100 
 
 
Longitudinal Beam Shear Reinforcement Details: 
============================================== 
   Units: spacing & distance (in). 
   Span Size Stirrups (2 legs each unless otherwise noted) 
   ---- ---- --------------------------------------------- 



 

6-16  Examples 

      1   #3 19 @ 6.7 + <-- 36.6 --> + 19 @ 6.7  
      2   #3 9 @ 6.2 + <-- 58.3 --> + 9 @ 6.2  
      3   #3 11 @ 6.7 + <-- 84.0 --> + 11 @ 6.7  
 
Beam Shear Capacity: 
==================== 
   Units: d, Sp (in), Start, End, Xu (ft), PhiVc, PhiVn, Vu (kip), Av/s (in^2/in)  
   Span        d    PhiVc    Start      End     Av/s       Sp    PhiVn       Vu       Xu 
   ---- -------- -------- -------- -------- -------- -------- -------- -------- -------- 
      1    14.00    15.94    0.000    0.917    -----    -----    36.60    26.88    0.000 
                             0.917   10.976   0.0328      6.7    36.60    22.99    1.833 
                            10.976   14.024    -----    -----     7.97     3.61   10.976 
                            14.024   24.083   0.0328      6.7    36.60    22.34   23.167 
                            24.083   25.000    -----    -----    36.60    26.22   25.000 
 
      2    14.00    15.94    0.000    0.917    -----    -----    38.18    16.79    0.000 
                             0.917    5.071   0.0353      6.2    38.18    12.91    1.833 
                             5.071    9.929    -----    -----     7.97     6.04    5.071 
                             9.929   14.083   0.0353      6.2    38.18    11.98   13.167 
                            14.083   15.000    -----    -----    38.18    15.87   15.000 
 
      3    14.00    15.94    0.000    0.917    -----    -----    36.62    20.96    0.000 
                             0.917    6.500   0.0328      6.7    36.62    17.08    1.833 
                             6.500   13.500    -----    -----     7.97     7.80   13.500 
                            13.500   19.083   0.0328      6.7    36.62    17.70   18.167 
                            19.083   20.000    -----    -----    36.62    21.59   20.000 
 
 
Slab Shear Capacity: 
==================== 
   Units: b, d (in), Xu (ft), PhiVc, Vu(kip) 
   Span        b        d   Vratio        PhiVc           Vu           Xu 
   ---- -------- -------- -------- ------------ ------------ ------------ 
      1 --- Not checked --- 
      2 --- Not checked --- 
      3 --- Not checked --- 
 
Maximum Deflections: 
==================== 
   Units: Dz (in) 
   Span Dz(DEAD) Dz(LIVE) Dz(TOTAL) 
   ---- -------- -------- --------- 
      1   -0.401   -0.171    -0.572 
      2   -0.009   -0.005    -0.013 
      3   -0.143   -0.099    -0.241 
  
Material Takeoff: 
================= 
   Reinforcement in the Direction of Analysis 
   ------------------------------------------ 
   Top Bars:      150.9 lb   <=>   2.51 lb/ft   <=>   2.515 lb/ft^2 
   Bottom Bars:   161.9 lb   <=>   2.70 lb/ft   <=>   2.698 lb/ft^2 
   Stirrups:      322.6 lb   <=>   5.38 lb/ft   <=>   5.377 lb/ft^2 
   Total Steel:   635.4 lb   <=>  10.59 lb/ft   <=>  10.589 lb/ft^2 
   Concrete:       80.0 ft^3 <=>   1.33 ft^3/ft <=>   1.333 ft^3/ft^2 
  
  
 
============================================================================================= 
[3] REDISTRIBUTED COLUMN AXIAL FORCES AND MOMENTS 
============================================================================================= 
  
   Units: P (kip), M (k-ft) 
   Supp Case/Patt     P (axial)      Mb[top]   Ma[bottom] 
   ---- ---------- ------------ ------------ ------------ 
      1 SELF               2.53        -4.71        -4.71 
        Dead              14.75       -27.48       -27.48 
        Live/All           5.69       -10.60       -10.60 
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        Live/Odd           5.74       -10.81       -10.81 
        Live/Even         -0.05         0.22         0.22 
        Live/S1            5.73       -10.78       -10.78 
        Live/S2            5.68       -10.56       -10.56 
        Live/S3           -0.04         0.18         0.18 
        Live/S4            0.01        -0.03        -0.03 
 
      2 SELF               4.02         2.45         2.45 
        Dead              23.49        14.32        14.32 
        Live/All           9.06         5.52         5.52 
        Live/Odd           5.63         8.15         8.15 
        Live/Even          3.42        -2.63        -2.63 
        Live/S1            5.87         7.74         7.74 
        Live/S2            9.27         5.12         5.12 
        Live/S3            3.21        -2.22        -2.22 
        Live/S4           -0.23         0.51         0.51 
 
      3 SELF               3.42        -1.16        -1.16 
        Dead              19.97        -6.75        -6.75 
        Live/All           7.70        -2.60        -2.60 
        Live/Odd           4.25        -5.19        -5.19 
        Live/Even          3.45         2.59         2.59 
        Live/S1           -0.37        -0.79        -0.79 
        Live/S2            3.10         1.96         1.96 
        Live/S3            8.05        -1.97        -1.97 
        Live/S4            4.61        -4.56        -4.56 
 
      4 SELF               2.03         2.92         2.92 
        Dead              11.82        17.04        17.04 
        Live/All           4.56         6.57         6.57 
        Live/Odd           4.63         6.83         6.83 
        Live/Even         -0.07        -0.26        -0.26 
        Live/S1            0.02         0.06         0.06 
        Live/S2           -0.05        -0.19        -0.19 
        Live/S3            4.54         6.51         6.51 
        Live/S4            4.61         6.77         6.77 
 
   Sum  SELF              12.00        -0.49        -0.49 
        Dead              70.02        -2.86        -2.86 
        Live/All          27.00        -1.10        -1.10 
        Live/Odd          20.25        -1.03        -1.03 
        Live/Even          6.75        -0.08        -0.08 
        Live/S1           11.25        -3.76        -3.76 
        Live/S2           18.00        -3.68        -3.68 
        Live/S3           15.75         2.50         2.50 
        Live/S4            9.00         2.68         2.68 
  
============================================================================================= 
[3a] NON-REDISTRIBUTED COLUMN AXIAL FORCES AND MOMENTS 
============================================================================================= 
  
   Units: P (kip), M (k-ft) 
   Supp Case/Patt     P (axial)      Mb[top]   Ma[bottom] 
   ---- ---------- ------------ ------------ ------------ 
      1 SELF               2.46        -4.71        -4.71 
        Dead              14.38       -27.48       -27.48 
        Live/All           5.55       -10.60       -10.60 
        Live/Odd           5.60       -10.81       -10.81 
        Live/Even         -0.06         0.22         0.22 
        Live/S1            5.59       -10.78       -10.78 
        Live/S2            5.54       -10.56       -10.56 
        Live/S3           -0.05         0.18         0.18 
        Live/S4            0.01        -0.03        -0.03 
 
      2 SELF               4.10         2.76         2.76 
        Dead              23.93        16.12        16.12 
        Live/All           9.23         6.22         6.22 
        Live/Odd           5.80         9.53         9.53 
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        Live/Even          3.43        -3.31        -3.31 
        Live/S1            6.07         9.02         9.02 
        Live/S2            9.50         5.70         5.70 
        Live/S3            3.16        -2.80        -2.80 
        Live/S4           -0.27         0.51         0.51 
 
      3 SELF               3.48        -1.45        -1.45 
        Dead              20.28        -8.43        -8.43 
        Live/All           7.82        -3.25        -3.25 
        Live/Odd           4.36        -6.49        -6.49 
        Live/Even          3.46         3.24         3.24 
        Live/S1           -0.43        -0.79        -0.79 
        Live/S2            3.03         2.45         2.45 
        Live/S3            8.25        -2.46        -2.46 
        Live/S4            4.79        -5.70        -5.70 
 
      4 SELF               1.96         2.92         2.92 
        Dead              11.43        17.04        17.04 
        Live/All           4.41         6.57         6.57 
        Live/Odd           4.49         6.83         6.83 
        Live/Even         -0.08        -0.26        -0.26 
        Live/S1            0.02         0.06         0.06 
        Live/S2           -0.06        -0.19        -0.19 
        Live/S3            4.39         6.51         6.51 
        Live/S4            4.47         6.77         6.77 
 
   Sum  SELF              12.00        -0.47        -0.47 
        Dead              70.02        -2.75        -2.75 
        Live/All          27.00        -1.06        -1.06 
        Live/Odd          20.25        -0.95        -0.95 
        Live/Even          6.75        -0.11        -0.11 
        Live/S1           11.25        -2.49        -2.49 
        Live/S2           18.00        -2.60        -2.60 
        Live/S3           15.75         1.43         1.43 
        Live/S4            9.00         1.54         1.54 
  
 
============================================================================================= 
[6] REDISTRIBUTED SEGMENTAL MOMENT AND SHEAR - ENVELOPES 
============================================================================================= 
  
   Span   x (ft)    M- (k-ft) Comb    M+ (k-ft) Comb     V- (kip) Comb     V+ (kip) Comb 
   ---- -------- ------------ ---- ------------ ---- ------------ ---- ------------ ---- 
      1    0.000      -100.54 U1           0.00 U1           0.00 U1          26.88 U1   
           0.222       -94.62 U1           0.00 U1           0.00 U1          26.41 U1   
           0.444       -88.81 U1           0.00 U1           0.00 U1          25.94 U1   
           0.667       -83.10 U1           0.00 U1           0.00 U1          25.47 U1   
           0.667       -83.10 U1           0.00 U1           0.00 U1          25.47 U1   
           0.916       -76.82 U1           0.00 U1           0.00 U1          24.94 U1   
           1.165       -70.67 U1           0.00 U1           0.00 U1          24.41 U1   
           1.414       -64.66 U1           0.00 U1           0.00 U1          23.88 U1   
           1.663       -58.77 U1           0.00 U1           0.00 U1          23.35 U1   
           1.912       -53.02 U1           0.00 U1           0.00 U1          22.82 U1   
           2.161       -47.40 U1           0.00 U1           0.00 U1          22.30 U1   
           2.411       -41.91 U1           0.00 U1           0.00 U1          21.77 U1   
           2.660       -36.55 U1           0.00 U1           0.00 U1          21.24 U1   
           2.909       -31.33 U1           0.00 U1           0.00 U1          20.71 U1   
           3.158       -26.23 U1           0.00 U1           0.00 U1          20.18 U1   
           3.407       -21.27 U1           0.00 U1           0.00 U1          19.66 U1   
           3.656       -16.44 U1           0.00 U1           0.00 U1          19.13 U1   
           3.905       -11.74 U1           0.00 U1           0.00 U1          18.60 U1   
           4.154        -7.17 U1           0.00 U1           0.00 U1          18.07 U1   
           4.404        -2.74 U1           0.00 U1           0.00 U1          17.54 U1   
           4.653         0.00 U1           1.94 U1           0.00 U1          17.01 U1   
           4.902         0.00 U1           6.09 U1           0.00 U1          16.49 U1   
           5.151         0.00 U1          10.10 U1           0.00 U1          15.96 U1   
           5.400         0.00 U1          13.99 U1           0.00 U1          15.43 U1   
           5.649         0.00 U1          17.75 U1           0.00 U1          14.90 U1   
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           5.898         0.00 U1          21.37 U1           0.00 U1          14.37 U1   
           6.147         0.00 U1          24.86 U1           0.00 U1          13.84 U1   
           6.396         0.00 U1          28.22 U1           0.00 U1          13.32 U1   
           6.646         0.00 U1          31.45 U1           0.00 U1          12.79 U1   
           6.895         0.00 U1          34.55 U1           0.00 U1          12.26 U1   
           7.144         0.00 U1          37.51 U1           0.00 U1          11.73 U1   
           7.393         0.00 U1          40.35 U1           0.00 U1          11.20 U1   
           7.642         0.00 U1          43.05 U1           0.00 U1          10.68 U1   
           7.891         0.00 U1          45.62 U1           0.00 U1          10.15 U1   
           8.140         0.00 U1          48.06 U1           0.00 U1           9.62 U1   
           8.389         0.00 U1          50.37 U1           0.00 U1           9.09 U1   
           8.639         0.00 U1          52.54 U1           0.00 U1           8.56 U1   
           8.888         0.00 U1          54.61 U1           0.00 U1           8.03 U1   
           9.137         0.00 U1          56.54 U1           0.00 U1           7.51 U1   
           9.386         0.00 U1          58.35 U1           0.00 U1           6.98 U1   
           9.635         0.00 U1          60.02 U1           0.00 U1           6.45 U1   
           9.884         0.00 U1          61.56 U1           0.00 U1           5.92 U1   
          10.133         0.00 U1          62.97 U1           0.00 U1           5.39 U1   
          10.382         0.00 U1          64.25 U1           0.00 U1           4.86 U1   
          10.632         0.00 U1          65.39 U1           0.00 U1           4.34 U1   
          10.881         0.00 U1          66.41 U1           0.00 U1           3.81 U1   
          11.130         0.00 U1          67.29 U1           0.00 U1           3.28 U1   
          11.379         0.00 U1          68.04 U1           0.00 U1           2.75 U1   
          11.628         0.00 U1          68.66 U1           0.00 U1           2.22 U1   
          11.877         0.00 U1          69.15 U1           0.00 U1           1.70 U1   
          12.126         0.00 U1          69.51 U1           0.00 U1           1.17 U1   
          12.375         0.00 U1          69.73 U1           0.00 U1           0.64 U1   
          12.625         0.00 U1          69.82 U1          -0.06 U1           0.11 U1   
          12.874         0.00 U1          69.79 U1          -0.51 U1           0.00 U1   
          13.123         0.00 U1          69.62 U1          -1.04 U1           0.00 U1   
          13.372         0.00 U1          69.32 U1          -1.57 U1           0.00 U1   
          13.621         0.00 U1          68.88 U1          -2.09 U1           0.00 U1   
          13.870         0.00 U1          68.32 U1          -2.62 U1           0.00 U1   
          14.119         0.00 U1          67.62 U1          -3.15 U1           0.00 U1   
          14.368         0.00 U1          66.79 U1          -3.68 U1           0.00 U1   
          14.618         0.00 U1          65.83 U1          -4.21 U1           0.00 U1   
          14.867         0.00 U1          64.74 U1          -4.74 U1           0.00 U1   
          15.116         0.00 U1          63.52 U1          -5.26 U1           0.00 U1   
          15.365         0.00 U1          62.17 U1          -5.79 U1           0.00 U1   
          15.614         0.00 U1          60.68 U1          -6.32 U1           0.00 U1   
          15.863         0.00 U1          59.06 U1          -6.85 U1           0.00 U1   
          16.112         0.00 U1          57.31 U1          -7.38 U1           0.00 U1   
          16.361         0.00 U1          55.43 U1          -7.91 U1           0.00 U1   
          16.611         0.00 U1          53.42 U1          -8.43 U1           0.00 U1   
          16.860         0.00 U1          51.28 U1          -8.96 U1           0.00 U1   
          17.109         0.00 U1          49.00 U1          -9.49 U1           0.00 U1   
          17.358         0.00 U1          46.59 U1         -10.02 U1           0.00 U1   
          17.607         0.00 U1          44.06 U1         -10.55 U1           0.00 U1   
          17.856         0.00 U1          41.39 U1         -11.07 U1           0.00 U1   
          18.105         0.00 U1          38.58 U1         -11.60 U1           0.00 U1   
          18.354         0.00 U1          35.65 U1         -12.13 U1           0.00 U1   
          18.604         0.00 U1          32.59 U1         -12.66 U1           0.00 U1   
          18.853         0.00 U1          29.39 U1         -13.19 U1           0.00 U1   
          19.102         0.00 U1          26.06 U1         -13.72 U1           0.00 U1   
          19.351         0.00 U1          22.60 U1         -14.24 U1           0.00 U1   
          19.600         0.00 U1          19.01 U1         -14.77 U1           0.00 U1   
          19.849         0.00 U1          15.29 U1         -15.30 U1           0.00 U1   
          20.098         0.00 U1          11.43 U1         -15.83 U1           0.00 U1   
          20.347         0.00 U1           7.45 U1         -16.36 U1           0.00 U1   
          20.596         0.00 U1           3.33 U1         -16.89 U1           0.00 U1   
          20.846        -2.22 U1           0.00 U1         -17.41 U1           0.00 U1   
          21.095        -6.45 U1           0.00 U1         -17.94 U1           0.00 U1   
          21.344       -10.98 U1           0.00 U1         -18.47 U1           0.00 U1   
          21.593       -15.65 U1           0.00 U1         -19.00 U1           0.00 U1   
          21.842       -20.45 U1           0.00 U1         -19.53 U1           0.00 U1   
          22.091       -25.38 U1           0.00 U1         -20.05 U1           0.00 U1   
          22.340       -30.44 U1           0.00 U1         -20.58 U1           0.00 U1   
          22.589       -35.63 U1           0.00 U1         -21.11 U1           0.00 U1   
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          22.839       -40.96 U1           0.00 U1         -21.64 U1           0.00 U1   
          23.088       -46.42 U1           0.00 U1         -22.17 U1           0.00 U1   
          23.337       -52.00 U1           0.00 U1         -22.70 U1           0.00 U1   
          23.586       -57.72 U1           0.00 U1         -23.22 U1           0.00 U1   
          23.835       -63.58 U1           0.00 U1         -23.75 U1           0.00 U1   
          24.084       -69.56 U1           0.00 U1         -24.28 U1           0.00 U1   
          24.333       -75.67 U1           0.00 U1         -24.81 U1           0.00 U1   
          24.333       -75.67 U1           0.00 U1         -24.81 U1           0.00 U1   
          24.556       -81.24 U1           0.00 U1         -25.28 U1           0.00 U1   
          24.778       -86.91 U1           0.00 U1         -25.75 U1           0.00 U1   
          25.000       -92.68 U1           0.00 U1         -26.22 U1           0.00 U1   
 
============================================================================================= 
[6a] NON-REDISTRIBUTED SEGMENTAL MOMENT AND SHEAR - ENVELOPES 
============================================================================================= 
  
   Span   x (ft)    M- (k-ft) Comb    M+ (k-ft) Comb     V- (kip) Comb     V+ (kip) Comb 
   ---- -------- ------------ ---- ------------ ---- ------------ ---- ------------ ---- 
      1    0.000      -100.54 U1           0.00 U1           0.00 U1          26.22 U1   
           0.222       -94.77 U1           0.00 U1           0.00 U1          25.75 U1   
           0.444       -89.10 U1           0.00 U1           0.00 U1          25.28 U1   
           0.667       -83.53 U1           0.00 U1           0.00 U1          24.81 U1   
           0.667       -83.53 U1           0.00 U1           0.00 U1          24.81 U1   
           0.916       -77.42 U1           0.00 U1           0.00 U1          24.28 U1   
           1.165       -71.44 U1           0.00 U1           0.00 U1          23.75 U1   
           1.414       -65.58 U1           0.00 U1           0.00 U1          23.22 U1   
           1.663       -59.86 U1           0.00 U1           0.00 U1          22.70 U1   
           1.912       -54.28 U1           0.00 U1           0.00 U1          22.17 U1   
           2.161       -48.82 U1           0.00 U1           0.00 U1          21.64 U1   
           2.411       -43.49 U1           0.00 U1           0.00 U1          21.11 U1   
           2.660       -38.30 U1           0.00 U1           0.00 U1          20.58 U1   
           2.909       -33.24 U1           0.00 U1           0.00 U1          20.05 U1   
           3.158       -28.31 U1           0.00 U1           0.00 U1          19.53 U1   
           3.407       -23.51 U1           0.00 U1           0.00 U1          19.00 U1   
           3.656       -18.84 U1           0.00 U1           0.00 U1          18.47 U1   
           3.905       -14.31 U1           0.00 U1           0.00 U1          17.94 U1   
           4.154        -9.90 U1           0.00 U1           0.00 U1          17.41 U1   
           4.404        -5.63 U1           0.00 U1           0.00 U1          16.89 U1   
           4.653        -1.49 U1           0.00 U1           0.00 U1          16.36 U1   
           4.902         0.00 U1           2.81 U1           0.00 U1          15.83 U1   
           5.151         0.00 U1           6.66 U1           0.00 U1          15.30 U1   
           5.400         0.00 U1          10.39 U1           0.00 U1          14.77 U1   
           5.649         0.00 U1          13.97 U1           0.00 U1          14.24 U1   
           5.898         0.00 U1          17.43 U1           0.00 U1          13.72 U1   
           6.147         0.00 U1          20.76 U1           0.00 U1          13.19 U1   
           6.396         0.00 U1          23.95 U1           0.00 U1          12.66 U1   
           6.646         0.00 U1          27.01 U1           0.00 U1          12.13 U1   
           6.895         0.00 U1          29.94 U1           0.00 U1          11.60 U1   
           7.144         0.00 U1          32.74 U1           0.00 U1          11.07 U1   
           7.393         0.00 U1          35.41 U1           0.00 U1          10.55 U1   
           7.642         0.00 U1          37.95 U1           0.00 U1          10.02 U1   
           7.891         0.00 U1          40.36 U1           0.00 U1           9.49 U1   
           8.140         0.00 U1          42.66 U1           0.00 U1           8.96 U1   
           8.389         0.00 U1          44.83 U1           0.00 U1           8.43 U1   
           8.639         0.00 U1          46.87 U1           0.00 U1           7.91 U1   
           8.888         0.00 U1          48.77 U1           0.00 U1           7.38 U1   
           9.137         0.00 U1          50.54 U1           0.00 U1           6.85 U1   
           9.386         0.00 U1          52.18 U1           0.00 U1           6.32 U1   
           9.635         0.00 U1          53.69 U1           0.00 U1           5.79 U1   
           9.884         0.00 U1          55.07 U1           0.00 U1           5.26 U1   
          10.133         0.00 U1          56.31 U1           0.00 U1           4.74 U1   
          10.382         0.00 U1          57.43 U1           0.00 U1           4.21 U1   
          10.632         0.00 U1          58.41 U1           0.00 U1           3.68 U1   
          10.881         0.00 U1          59.26 U1           0.00 U1           3.15 U1   
          11.130         0.00 U1          59.98 U1           0.00 U1           2.62 U1   
          11.379         0.00 U1          60.57 U1           0.00 U1           2.09 U1   
          11.628         0.00 U1          61.02 U1           0.00 U1           1.57 U1   
          11.877         0.00 U1          61.35 U1           0.00 U1           1.04 U1   
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          12.126         0.00 U1          61.54 U1           0.00 U1           0.51 U1   
          12.375         0.00 U1          61.60 U1          -0.16 U1           0.00 U1   
          12.625         0.00 U1          61.53 U1          -0.65 U1           0.00 U1   
          12.874         0.00 U1          61.33 U1          -1.18 U1           0.00 U1   
          13.123         0.00 U1          61.00 U1          -1.71 U1           0.00 U1   
          13.372         0.00 U1          60.53 U1          -2.23 U1           0.00 U1   
          13.621         0.00 U1          59.93 U1          -2.76 U1           0.00 U1   
          13.870         0.00 U1          59.21 U1          -3.29 U1           0.00 U1   
          14.119         0.00 U1          58.35 U1          -3.82 U1           0.00 U1   
          14.368         0.00 U1          57.35 U1          -4.35 U1           0.00 U1   
          14.618         0.00 U1          56.23 U1          -4.88 U1           0.00 U1   
          14.867         0.00 U1          54.98 U1          -5.40 U1           0.00 U1   
          15.116         0.00 U1          53.59 U1          -5.93 U1           0.00 U1   
          15.365         0.00 U1          52.07 U1          -6.46 U1           0.00 U1   
          15.614         0.00 U1          50.42 U1          -6.99 U1           0.00 U1   
          15.863         0.00 U1          48.64 U1          -7.52 U1           0.00 U1   
          16.112         0.00 U1          46.73 U1          -8.04 U1           0.00 U1   
          16.361         0.00 U1          44.69 U1          -8.57 U1           0.00 U1   
          16.611         0.00 U1          42.51 U1          -9.10 U1           0.00 U1   
          16.860         0.00 U1          40.20 U1          -9.63 U1           0.00 U1   
          17.109         0.00 U1          37.76 U1         -10.16 U1           0.00 U1   
          17.358         0.00 U1          35.19 U1         -10.69 U1           0.00 U1   
          17.607         0.00 U1          32.49 U1         -11.21 U1           0.00 U1   
          17.856         0.00 U1          29.66 U1         -11.74 U1           0.00 U1   
          18.105         0.00 U1          26.69 U1         -12.27 U1           0.00 U1   
          18.354         0.00 U1          23.59 U1         -12.80 U1           0.00 U1   
          18.604         0.00 U1          20.37 U1         -13.33 U1           0.00 U1   
          18.853         0.00 U1          17.00 U1         -13.86 U1           0.00 U1   
          19.102         0.00 U1          13.51 U1         -14.38 U1           0.00 U1   
          19.351         0.00 U1           9.89 U1         -14.91 U1           0.00 U1   
          19.600         0.00 U1           6.13 U1         -15.44 U1           0.00 U1   
          19.849        -0.31 U1           2.25 U1         -15.97 U1           0.00 U1   
          20.098        -3.04 U1           0.00 U1         -16.50 U1           0.00 U1   
          20.347        -7.22 U1           0.00 U1         -17.02 U1           0.00 U1   
          20.596       -11.52 U1           0.00 U1         -17.55 U1           0.00 U1   
          20.846       -15.96 U1           0.00 U1         -18.08 U1           0.00 U1   
          21.095       -20.53 U1           0.00 U1         -18.61 U1           0.00 U1   
          21.344       -25.23 U1           0.00 U1         -19.14 U1           0.00 U1   
          21.593       -30.07 U1           0.00 U1         -19.67 U1           0.00 U1   
          21.842       -35.03 U1           0.00 U1         -20.19 U1           0.00 U1   
          22.091       -40.13 U1           0.00 U1         -20.72 U1           0.00 U1   
          22.340       -45.36 U1           0.00 U1         -21.25 U1           0.00 U1   
          22.589       -50.72 U1           0.00 U1         -21.78 U1           0.00 U1   
          22.839       -56.21 U1           0.00 U1         -22.31 U1           0.00 U1   
          23.088       -61.83 U1           0.00 U1         -22.84 U1           0.00 U1   
          23.337       -67.59 U1           0.00 U1         -23.36 U1           0.00 U1   
          23.586       -73.47 U1           0.00 U1         -23.89 U1           0.00 U1   
          23.835       -79.49 U1           0.00 U1         -24.42 U1           0.00 U1   
          24.084       -85.64 U1           0.00 U1         -24.95 U1           0.00 U1   
          24.333       -91.92 U1           0.00 U1         -25.48 U1           0.00 U1   
          24.333       -91.92 U1           0.00 U1         -25.48 U1           0.00 U1   
          24.556       -97.64 U1           0.00 U1         -25.95 U1           0.00 U1   
          24.778      -103.45 U1           0.00 U1         -26.42 U1           0.00 U1   
          25.000      -109.38 U1           0.00 U1         -26.89 U1           0.00 U1   
 
============================================================================================= 
[7] SEGMENTAL DEFLECTIONS 
============================================================================================= 
  
   Units: x (ft), Dz (in) 
   Span        x    Dz (DEAD)    Dz (LIVE)   Dz (TOTAL) 
   ---- -------- ------------ ------------ ------------ 
      1    0.000       -0.000       -0.000       -0.000 
           0.222       -0.002       -0.001       -0.002 
           0.444       -0.004       -0.001       -0.005 
           0.667       -0.006       -0.002       -0.009 
           0.667       -0.006       -0.002       -0.009 
           0.916       -0.010       -0.003       -0.013 
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           1.165       -0.015       -0.005       -0.020 
           1.414       -0.020       -0.007       -0.027 
           1.663       -0.026       -0.010       -0.036 
           1.912       -0.034       -0.013       -0.046 
           2.161       -0.042       -0.016       -0.058 
           2.411       -0.050       -0.020       -0.070 
           2.660       -0.060       -0.023       -0.083 
           2.909       -0.069       -0.028       -0.097 
           3.158       -0.080       -0.032       -0.112 
           3.407       -0.090       -0.037       -0.127 
           3.656       -0.102       -0.041       -0.143 
           3.905       -0.113       -0.046       -0.159 
           4.154       -0.125       -0.051       -0.176 
           4.404       -0.137       -0.056       -0.193 
           4.653       -0.149       -0.061       -0.210 
           4.902       -0.161       -0.067       -0.228 
           5.151       -0.173       -0.072       -0.246 
           5.400       -0.186       -0.077       -0.263 
           5.649       -0.198       -0.083       -0.281 
           5.898       -0.210       -0.088       -0.298 
           6.147       -0.222       -0.093       -0.316 
           6.396       -0.234       -0.098       -0.333 
           6.646       -0.246       -0.104       -0.350 
           6.895       -0.258       -0.109       -0.366 
           7.144       -0.269       -0.114       -0.383 
           7.393       -0.280       -0.118       -0.399 
           7.642       -0.291       -0.123       -0.414 
           7.891       -0.301       -0.128       -0.429 
           8.140       -0.311       -0.132       -0.443 
           8.389       -0.321       -0.136       -0.457 
           8.639       -0.330       -0.140       -0.470 
           8.888       -0.339       -0.144       -0.482 
           9.137       -0.347       -0.147       -0.494 
           9.386       -0.354       -0.151       -0.505 
           9.635       -0.361       -0.154       -0.515 
           9.884       -0.368       -0.157       -0.525 
          10.133       -0.374       -0.159       -0.533 
          10.382       -0.379       -0.162       -0.541 
          10.632       -0.384       -0.164       -0.548 
          10.881       -0.388       -0.166       -0.554 
          11.130       -0.392       -0.167       -0.559 
          11.379       -0.395       -0.169       -0.564 
          11.628       -0.397       -0.170       -0.567 
          11.877       -0.399       -0.170       -0.570 
          12.126       -0.400       -0.171       -0.571 
          12.375       -0.401       -0.171       -0.572 
          12.625       -0.400       -0.171       -0.572 
          12.874       -0.400       -0.171       -0.570 
          13.123       -0.398       -0.170       -0.568 
          13.372       -0.396       -0.169       -0.565 
          13.621       -0.393       -0.168       -0.561 
          13.870       -0.390       -0.167       -0.556 
          14.119       -0.386       -0.165       -0.551 
          14.368       -0.381       -0.163       -0.544 
          14.618       -0.376       -0.161       -0.536 
          14.867       -0.370       -0.158       -0.528 
          15.116       -0.364       -0.155       -0.519 
          15.365       -0.357       -0.152       -0.509 
          15.614       -0.349       -0.149       -0.498 
          15.863       -0.341       -0.146       -0.487 
          16.112       -0.333       -0.142       -0.475 
          16.361       -0.324       -0.138       -0.462 
          16.611       -0.315       -0.134       -0.448 
          16.860       -0.305       -0.130       -0.434 
          17.109       -0.294       -0.125       -0.420 
          17.358       -0.284       -0.121       -0.405 
          17.607       -0.273       -0.116       -0.389 
          17.856       -0.262       -0.111       -0.373 
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          18.105       -0.250       -0.106       -0.356 
          18.354       -0.239       -0.101       -0.340 
          18.604       -0.227       -0.096       -0.322 
          18.853       -0.214       -0.091       -0.305 
          19.102       -0.202       -0.085       -0.288 
          19.351       -0.190       -0.080       -0.270 
          19.600       -0.178       -0.075       -0.252 
          19.849       -0.165       -0.069       -0.235 
          20.098       -0.153       -0.064       -0.217 
          20.347       -0.141       -0.059       -0.200 
          20.596       -0.129       -0.054       -0.182 
          20.846       -0.117       -0.049       -0.166 
          21.095       -0.105       -0.044       -0.149 
          21.344       -0.094       -0.039       -0.133 
          21.593       -0.083       -0.034       -0.117 
          21.842       -0.073       -0.030       -0.102 
          22.091       -0.063       -0.025       -0.088 
          22.340       -0.053       -0.021       -0.075 
          22.589       -0.044       -0.018       -0.062 
          22.839       -0.036       -0.014       -0.050 
          23.088       -0.029       -0.011       -0.040 
          23.337       -0.022       -0.008       -0.030 
          23.586       -0.016       -0.006       -0.022 
          23.835       -0.011       -0.004       -0.015 
          24.084       -0.007       -0.003       -0.010 
          24.333       -0.004       -0.002       -0.006 
          24.333       -0.004       -0.002       -0.006 
          24.556       -0.003       -0.001       -0.004 
          24.778       -0.001       -0.000       -0.002 
          25.000       -0.000       -0.000       -0.000 
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Grpahical Output 

Loads 

pcaBeam v1.50. Licenced to: pcaStructurePoint. Licence ID: 00000-0000000-4-238E7-238E7

File: C:\Data\pcaBeam\PCA Notes on ACI 318-02 Example 8-2.slb

Project: PCA Notes on ACI 318-02

Frame: Example 8-2 Engineer: pcaStructurePoint

CASE: SELF

CASE: Dead

CASE: Live

200 200 200

1167 1167 1167

450 450 450
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Internal Forces 

pcaBeam v1.50. Licenced to: pcaStructurePoint. Licence ID: 00000-0000000-4-238E7-238E7

File: C:\Data\pcaBeam\PCA Notes on ACI 318-02 Example 8-2.slb

Project: PCA Notes on ACI 318-02

Frame: Example 8-2 Engineer: pcaStructurePoint

M
om

en
t D

ia
gr

am
 - 

k-
ft

-120.0

120.0

S
he

ar
 D

ia
gr

am
 - 

ki
p

30.0

-30.0

LEGEND:
 Envelope (Redist.)

-100.54 -92.68

69.82

-41.95 -34.46

25.96

-56.96 -62.76

47.12

26.88

-26.22

16.79

-15.87

20.96

-21.59
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Moment Capacity 

pcaBeam v1.50. Licenced to: pcaStructurePoint. Licence ID: 00000-0000000-4-238E7-238E7

File: C:\Data\pcaBeam\PCA Notes on ACI 318-02 Example 8-2.slb

Project: PCA Notes on ACI 318-02

Frame: Example 8-2 Engineer: pcaStructurePoint

M
om

en
t C

ap
ac

ity
 - 

k-
ft

-120.0

120.0

LEGEND:
 Envelope Curve
 Capacity Curve
 Support Centerline
 Face of Support
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Shear Capacity 

pcaBeam v1.50. Licenced to: pcaStructurePoint. Licence ID: 00000-0000000-4-238E7-238E7

File: C:\Data\pcaBeam\PCA Notes on ACI 318-02 Example 8-2.slb

Project: PCA Notes on ACI 318-02

Frame: Example 8-2 Engineer: pcaStructurePoint

B
ea

m
 S

he
ar

 C
ap

ac
ity

 - 
ki

p

40.0

-40.0

LEGEND:
 Envelope Curve
 Capacity Curve
 Support Centerline
 Face of Support
 Critical Section

 22.99

-22.34 

 12.91

-11.98 

 17.08

-17.70 
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Deflection 

pcaBeam v1.50. Licenced to: pcaStructurePoint. Licence ID: 00000-0000000-4-238E7-238E7

File: C:\Data\pcaBeam\PCA Notes on ACI 318-02 Example 8-2.slb

Project: PCA Notes on ACI 318-02

Frame: Example 8-2 Engineer: pcaStructurePoint

D
ef

le
ct

io
n 

D
ia

gr
am

 - 
in

0.572

-0.572

LEGEND:
 Dead Load
 Live Load
 Total Deflection
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Reinforcement 

pcaBeam v1.50. Licenced to: pcaStructurePoint. Licence ID: 00000-0000000-4-238E7-238E7

File: C:\Data\pcaBeam\PCA Notes on ACI 318-02 Example 8-2.slb

Project: PCA Notes on ACI 318-02

Frame: Example 8-2 Engineer: pcaStructurePoint

Flexural and Transverse Rebars
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Example 2 Spandrel beam with torsion  

Problem description 
Design a precast, nonprestressed concrete spandrel beam for combined shear and 
torsion. Roof members are simply supported on spandrel ledge. Spandrel beams 
are connected to columns to transfer torsion. Continuity between spandrel beams is 
not provided. This example refers to Example 13-1 from PCA Notes on ACI 318-
02 Building Code Requirements for Structural Concrete, Portland Cement 
Association, 2002. 

 

30' - 0" 30' - 0" 30' - 0" 30' - 0"

60' - 0"

A

A

16" × 16"
P/C cols

16" × 16"
P/C cols

“L” spandrel beam

10' - 0" × 24"
double tee (typ)

Interior ledge beam

Partial plan of precast roof system

R
oo

f s
pa

n

 
Design Criteria: 
Live load  =  30 lb/ft2 
Dead Load =  64 lb/ft2 
f′c =  5000 psi (wc = 150 pcf) 
fy  =  60,000 psi 

Roof members are 10 ft wide double tee units, 24 in. deep. Design of these units is 
not included in this design example. For lateral support, alternate ends of roof 
members are fixed to supporting beams. 
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32"

6"

16"

8"

3"

11"

Section A-A
CL col

24" TT

3/8" welded pad
(reverse ends on alternate TT’s)

3/8" elastomeric pad

 

Program input 
1. From the Input menu, select General Information. A dialog box appears. 

• In the LABELS section, input the names of the project, frame, and 
engineer.  

• In the FRAME section, input 2 for NO OF SUPPORTS.  

• In the FLOOR SYSTEM section, click the radial button next to ONE WAY / 
BEAM.  

• Leave all other options in the General Information tab to their default 
settings of ACI 318-02 design code, ASTM A615 reinforcement, and 
DESIGN run mode option.  

• In the Solve Options tab, click the check box next to TORSION ANALYSIS 
AND DESIGN. 

• Under TORSION TYPE, click the radial button next to EQUILIBRIUM.  

• Under the heading STIRRUPS IN FLANGES, click the radial button next to 
YES. 
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• Press OK.  

   
2. From the Input menu, select Material Properties. A dialog box appears. 

• Input 5 for Comp. strength for both Slabs and Beams and Columns.  

• Press OK.  

 
 

3. From the Input menu, select Spans. A dialog box appears. 
• Under the Slabs/Flanges tab, input 30 for LENGTH, 8 for THICKNESS, 

and 0.667 for WIDTH LEFT and 1.167 WIDTH RIGHT. Press MODIFY.  
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• Select the Longitudinal Beams tab. Input 16 for WIDTH and 32 for 
DEPTH. Press MODIFY. 

• Press OK. 

 

 
4. From the Input menu, select Supports. A dialog box appears. 

• Under the Columns tab, input 0 for STIFFNESS SHARE %. 
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• Next, input 16 for both the C1 and C2 values in both the ABOVE and 
BELOW rows. Press MODIFY. (Note: the default HEIGHT ABOVE and 
HEIGHT BELOW values of 10 are correct.)   

• Press COPY. Press the CHECK ALL button. Press OK.  

• Press OK again. 

 
5. 5. From the Input menu, select Reinforcement. A dialog box appears.  

• Under the Slabs and Ribs tab, change the CLEAR COVER for both TOP 
and BOTTOM BARS to 1.75. 

• Under the Beams tab, change the CLEAR COVER for both TOP and 
BOTTOM BARS again to 1.75. 

• Use the drop down arrow for MINIMUM STIRRUP BAR SIZE to select #4.  

• Press OK. 
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6.  6. From the Input menu, select Load Cases. A dialog box 

appears. 
• Since we are not considering lateral forces, click on WIND in the LABEL 

column on the list in the bottom half of the LOAD CASES dialog box and 
press the DELETE button. 

• Click on EQ in the LABEL column and press the DELETE button. 

• Press OK. 
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7. 7. From the Input menu, select Load Combinations. A dialog box 

appears.  
• Delete all the load combinations by clicking anywhere on the list in the 

bottom half of the LOAD COMBINATIONS dialog box and pressing the 
DELETE button. Repeat this procedure until all the load combinations are 
gone.  

• Input 0 in the SELF field, 1.2 in the DEAD field, and 1.6 in the LIVE 
field. Press ADD. 

• Press OK. 

 
8. 8. From the Input menu, select Span Loads. A dialog box appears. 

• Press the drop down arrow next to TYPE, and select LINE LOAD. 
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• Input 2500 for both the START and END MAGNITUDE. (Note: this value 
was obtained by converting the area loads on the roof and the beam’s self 
weight into line loads.)  

Dead Load = Superimposed Load + Self Weight of Spandrel Beam =  

( )[ ] ft/kip5.2pcf150)ft67.0ft5.0(ft67.2ft33.1
2
ft60psf64 =××+×+⎟

⎠
⎞

⎜
⎝
⎛ ×  

 
• Input 30 for the END LOCATION. Press ADD. 

• Use the drop down arrow next to TYPE, and select LINE TORSION. 

• Input 1.76 for both the START and END MAGNITUDE. (Note: this value 
was obtained by multiplying the superimposed line load by the moment 
arm of 11 in.) 

Torsion Line Load (Dead) = ft/ftkip76.1
ft/in12

in11
2
ft60psf64 ⋅=×⎟

⎠
⎞

⎜
⎝
⎛ ×  

• Keep the END LOCATION of 30 and press ADD.  

 
9. In the top left corner of the SPAN LOADS dialog box, there is a section called 

CURRENT CASE. Click on LIVE. 
• Use the drop down arrow next to TYPE to select LINE LOAD. I 



 

6-38  Examples 

• Input 900 for both the START and END MAGNITUDE. (Note: this value 
was obtained by converting the area loads on the roof to line loads on the 
beam.) 

Live Load = ft/lb900
2
ft60psf30 =⎟

⎠
⎞

⎜
⎝
⎛×  

 
• Input 30 for the END LOCATION. Press ADD. 

• Use the drop down arrow next to TYPE, and select LINE TORSION. 

• Input 0.825 for both the START and END MAGNITUDE. (Note: this value 
was obtained by multiplying the live line load by the moment arm of 11 
in.) 

 ft/ftkip825.0
ft/in12

in11
2
ft60psf30 ⋅=×⎥

⎦

⎤
⎢
⎣

⎡
⎟
⎠
⎞

⎜
⎝
⎛×  

• Input 30 for the END LOCATION. Press ADD. 

• Press OK.  

 
10. From the Solve menu, select Execute. Press CLOSE. 
11. From the Solve menu, select Results Report. 

• Use the scroll bars to scroll through the results file.  
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• Use the ARROW keys or the mouse wheel to browse through different 
parts of the results quickly. Press the CLOSE button to close the RESULTS 
REPORT dialog box and return to pcaBeam. 

12. To view diagrams, select Loads, Internal Forces, Moment Capacity, Shear 
Capacity, Deflection, or Reinforcement from the View menu. Right click in 
any of these diagrams to get new copy, printing, or display options.  

13. You may print the results file by selecting Print Results from the File menu. 
To print any of the diagrams you selected to view, use the Print Preview 
command found by right clicking in the diagram’s window. After viewing the 
results, you may decide to investigate the input beams under the same loads 
but with a modified reinforcement configuration.  

14. From the Input menu, select General Information. In the General 
Information dialog box change the RUN MODE option to INVESTIGATION. Do 
not change any of the other options. Press OK 

15. From the Input menu, select the different commands under Reinforcement 
Criteria and Reinforcing Bars to modify the reinforcement configuration 
computed by the program. 

16. Repeat steps 10 and subsequent to perform the investigation and view the 
results.  
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Text Output 
                         ooooooo      oooooo      ooooo               
                         oooooooo    oooooooo    ooooooo              
                         oo    oo    oo    oo    oo   oo              
                         oo    oo    oo          oo   oo              
                         oooooooo    oo          ooooooo   ooooo      
                         ooooooo     oo    oo    ooooooo   ooooo      
                         oo          oo    oo    oo   oo              
                         oo          oooooooo    oo   oo              
                         oo           oooooo     oo   oo              
  
  
                      OOOOO    OOOOOO   OOOOO   OO       OO           
                      OO   OO  OO      OO   OO  OOO     OOO           
                      OO   OO  OO      OO   OO  OO O   O OO           
                      OO   OO  OO      OO   OO  OO  O O  OO           
                      OOOOO    OOOOO   OOOOOOO  OO   O   OO           
                      OO   OO  OO      OO   OO  OO       OO           
                      OO   OO  OO      OO   OO  OO       OO           
                      OO   OO  OO      OO   OO  OO       OO           
                      OOOOO    OOOOOO  OO   OO  OO       OO           
  
      =============================================================================  
                                  pcaBeam v1.50 (TM) 
              A Computer Program for Analysis, Design, and Investigation of 
              Reinforced Concrete Continuous Beam and One-Way Slab Systems  
      =============================================================================  
                  Copyright © 1992-2005, Portland Cement Association  
                                  All rights reserved  
  
             Licensee stated above acknowledges that Portland Cement Association  
         (PCA) is not and  cannot  be  responsible for  either the  accuracy  or  
         adequacy of  the material supplied  as input  for  processing   by  the  
         pcaBeam  computer program.  Furthermore, PCA neither makes any warranty  
         expressed nor implied with respect  to  the  correctness of the  output  
         prepared by the  pcaBeam   program.  Although  PCA  has  endeavored  to  
         produce pcaBeam  error free the  program is not and cannot be certified  
         infallible.  The final and only responsibility for analysis, design and  
         engineering documents is the licensees. Accordingly, PCA disclaims  all  
         responsibility in contract, negligence or other tort for any  analysis,  
         design  or engineering documents prepared in connection with the use of  
         the pcaBeam  program.  
  
  
============================================================================================= 
[1] INPUT ECHO 
============================================================================================= 
  
General Information: 
==================== 
   File name: C:\Data\pcaBeam\PCA Notes on ACI 318-02 Example 13-1.slb 
   Project: PCA Notes on ACI 318-02 
   Frame: Example 13-1                             Engineer: pcaStructurePoint 
   Code: ACI 318-02       Mode: Design             Reinforcement Database: ASTM A615 
   Number of supports = 2 
   Floor System: One-Way/Beam 
  
   Live load pattern ratio = 100% 
   Deflections are based on cracked section properties. 
   In negative moment regions, Igr and Mcr DO NOT include flange/slab contribution (if available) 
   Compression reinforcement calculations NOT selected. 
   Moment redistribution NOT selected. 
   Effective flange width calculations NOT selected. 
   Rigid beam-column joint NOT selected. 
   Torsion analysis and design selected. 
   Stirrups in flanges (if available) selected. 
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   Compatibility torsion NOT selected. 
  
Material Properties: 
==================== 
            Slabs|Beams       Columns 
           ------------   ------------ 
   wc    =          150            150 lb/ft3 
   f'c   =            5              5 ksi 
   Ec    =       4286.8         4286.8 ksi 
   fr    =      0.53033        0.53033 ksi 
  
   fy    =           60 ksi, Bars are not epoxy-coated 
   fyv   =           60 ksi 
   Es    =        29000 ksi 
  
Reinforcement Database: 
=============== 
   Units: Db (in), Ab (in^2), Wb (lb/ft) 
   Size       Db      Ab        Wb    Size       Db      Ab        Wb 
   ---- -------- -------- --------    ---- -------- -------- -------- 
     #3     0.38     0.11     0.38      #4     0.50     0.20     0.67     
     #5     0.63     0.31     1.04      #6     0.75     0.44     1.50     
     #7     0.88     0.60     2.04      #8     1.00     0.79     2.67     
     #9     1.13     1.00     3.40     #10     1.27     1.27     4.30     
    #11     1.41     1.56     5.31     #14     1.69     2.25     7.65     
    #18     2.26     4.00    13.60     
  
Span Data: 
========== 
   Slabs: L1, wL, wR (ft); t, Hmin (in) 
   Span Loc        L1        t       wL       wR     Hmin 
   ---- ---- -------- -------- -------- -------- --------  
      1 Int    30.000     8.00    0.667    1.167     0.00     
  
   Ribs and Longitudinal Beams: b, h, Sp (in) 
        __________Ribs____________    _______Beams_____    __Span__ 
   Span        b        h       Sp           b        h        Hmin 
   ---- -------- -------- --------    -------- --------    -------- 
      1     0.00     0.00     0.00       16.00    32.00       22.50 
  
Support Data: 
============= 
   Columns: c1a, c2a, c1b, c2b (in); Ha, Hb (ft) 
   Supp      c1a      c2a       Ha        c1b      c2b       Hb  Red% 
   ---- -------- -------- --------   -------- -------- --------  ---- 
      1    16.00    16.00   10.000      16.00    16.00   10.000     0  
      2    16.00    16.00   10.000      16.00    16.00   10.000     0  
  
   Boundary Conditions: Kz (kip/in); Kry (kip-in/rad) 
   Supp    Spring Kz   Spring Kry Far End A Far End B 
   ---- ------------ ------------ --------- --------- 
      1            0            0     Fixed     Fixed 
      2            0            0     Fixed     Fixed 
  
Load Data: 
========== 
   Load Cases and Combinations: 
   Case     SELF     Dead     Live  
   Type     DEAD     DEAD     LIVE  
   U1      0.000    1.200    1.600  
  
   Span Loads: 
   Span Case               Wa           La           Wb           Lb 
   ---- -------- ------------ ------------ ------------ ------------ 
   Line Loads - Wa | Wb (lb/ft), La | Lb (ft): 
      1 Dead             2500            0         2500           30 
      1 Live              900            0          900           30 
   Line Torsion - Wa | Wb (k-ft/ft), La | Lb (ft): 
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      1 Dead             1.76            0         1.76           30 
      1 Live            0.825            0        0.825           30 
  
   Support Loads:   --- NONE --- 
  
   Support Displacements:   --- NONE --- 
  
Reinforcement Criteria: 
======================= 
                 _____Top bars___  ___Bottom bars__  ____Stirrups____ 
                   Min      Max      Min      Max      Min      Max   
                 -------  -------  -------  -------  -------  ------- 
   Slabs and Ribs: 
     Bar Size         #5       #8       #5       #8 
     Bar spacing    1.00    18.00     1.00    18.00 in 
     Reinf ratio    0.14     5.00     0.14     5.00 % 
     Cover          1.50              1.50          in 
  
   Beams: 
     Bar Size         #5       #8       #5       #8       #4       #5 
     Bar spacing    1.00    18.00     1.00    18.00     6.00    18.00 in 
     Reinf ratio    0.14     5.00     0.14     5.00 % 
     Cover          1.75              1.75          in 
  
 
============================================================================================= 
[2] DESIGN RESULTS 
============================================================================================= 
  
Top Reinforcement: 
================== 
   Units: Width (ft), Mmax (k-ft), Xmax (ft), As (in^2), Sp (in) 
   Span Zone      Width         Mmax     Xmax    AsMin    AsMax    SpReq    AsReq    Bars 
   ---- ------ -------- ------------ -------- -------- -------- -------- -------- ------- 
      1 Left       1.83         0.00    0.667    0.671   10.179    8.990    0.000    3-#5  
        Middle     1.83         0.00   15.000    0.000   10.179    0.000    0.000     ---  
        Right      1.83         0.00   29.333    0.671   10.179    8.990    0.000    3-#5  
 
Top Bar Details: 
================ 
   Units: Length (ft) 
        _____________Left______________  ___Continuous__  _____________Right_____________ 
   Span    Bars  Length    Bars  Length     Bars  Length     Bars  Length    Bars  Length 
   ---- ------- ------- ------- -------  ------- -------  ------- ------- ------- ------- 
      1    3-#5   10.13     ---              ---             3-#5   10.13     ---         
 
Bottom Reinforcement: 
===================== 
   Units: Width (ft), Mmax (k-ft), Xmax (ft), As (in^2), Sp (in)  
   Span    Width         Mmax     Xmax    AsMin    AsMax    SpReq    AsReq    Bars 
   ---- -------- ------------ -------- -------- -------- -------- -------- ------- 
      1     1.33       499.50   15.000    1.686   13.541    1.966    3.882    7-#7  
 
Bottom Bar Details: 
=================== 
   Units: Start (ft), Length (ft) 
        _______Long Bars_______ ______Short Bars_______ 
   Span    Bars   Start  Length    Bars   Start  Length 
   ---- ------- ------- ------- ------- ------- ------- 
      1    4-#7    0.00   30.00    3-#7    0.00   30.00 
 
Flexural Capacity: 
================== 
   Units: From, To (ft), As (in^2), PhiMn (k-ft)  
   Span      From        To AsTop AsBot       PhiMn-       PhiMn+ 
   ---- --------- --------- ----- ----- ------------ ------------ 
      1     0.000     0.667  0.93  4.20      -124.62       542.72 
            0.667     9.127  0.93  4.20      -124.62       542.72 
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            9.127    10.127  0.00  4.20         0.00       542.72 
           10.127    10.700  0.00  4.20         0.00       542.72 
           10.700    15.000  0.00  4.20         0.00       542.72 
           15.000    19.300  0.00  4.20         0.00       542.72 
           19.300    19.873  0.00  4.20         0.00       542.72 
           19.873    20.873  0.00  4.20         0.00       542.72 
           20.873    29.333  0.93  4.20      -124.62       542.72 
           29.333    30.000  0.93  4.20      -124.62       542.72 
 
Longitudinal Beam Shear And Torsion Reinforcement Required: 
=========================================================== 
   Section properties: 
   Units: d, pcp, pch (in), Acp, Ach, Ao (in^2) 
          PhiVc (kip), PhiTcr (k-ft), PhiSvt (ksi) 
   Span        d      pcp       ph        Acp        Aoh         Ao    PhiVc   PhiTcr   PhiSvt 
   ---- -------- -------- -------- ---------- ---------- ---------- -------- -------- -------- 
      1    29.75   108.02    96.02    560.064    407.040    345.984    50.49    51.33    0.530 
 
   Required transverse reinforcement: 
   Units: Start, End, Xu (ft), Vu (kip), Tu (k-ft), vf (ksi) 
          Av/s, Av/s, A(v+2t)/s (in^2/in)  
   Span    Start      End       Vu       Tu       vf       Xu Case/Patt     Av/s     At/s A(v+2t)/s 
   ---- -------- -------- -------- -------- -------- -------- --------- -------- -------- --------- 
      1    3.146    6.533    52.63    40.68    0.200     3.15    U1/All   0.0016   0.0157    0.0330 
           6.533    9.920    37.59    29.06    0.143     6.53    U1/All   0.0000   0.0112    0.0224 
*5 
           9.920   13.307    22.56    17.44    0.086     9.92    U1/All   0.0000   0.0067    0.0141 
*5 
          13.307   16.693     7.52     5.81    0.029    13.31    U1/All   0.0000   0.0000    0.0000 
*2 
          16.693   20.080    22.56    17.44    0.086    20.08    U1/All   0.0000   0.0067    0.0141 
*5 
          20.080   23.467    37.59    29.06    0.143    23.47    U1/All   0.0000   0.0112    0.0224 
*5 
          23.467   26.854    52.63    40.68    0.200    26.85    U1/All   0.0016   0.0157    0.0330 
   NOTES: 
   *2 - Torsion ignored (Tu < PhiTcr/4). 
   *5 - Minimum transverse (stirrup) reinforcement required. 
 
   Required longitudinal reinforcement: 
   Units: Start, End, Xu (ft), Tu (k-ft), Al (in^2) 
   Span    Start      End       Tu       Xu Case/Patt       Al 
   ---- -------- -------- -------- -------- --------- -------- 
      1    3.146    6.533    29.06     6.53    U1/All    2.225 *5 
           6.533    9.920    17.44     9.92    U1/All    2.655 *5 
           9.920   13.307    16.73    10.13    U1/All    2.660 *5 
          13.307   16.693     5.81    13.31    U1/All    0.000 *2 
          16.693   20.080    13.77    19.01    U1/All    2.660 *5 
          20.080   23.467    17.44    20.08    U1/All    2.655 *5 
          23.467   26.854    29.06    23.47    U1/All    2.225 *5 
   NOTES: 
   *2 - Torsion ignored (Tu < PhiTcr/4). 
   *5 - Minimum longitudinal reinforcement required. 
 
Longitudinal Beam Shear Reinforcement Details: 
============================================== 
   Units: spacing & distance (in). 
   Span Size Stirrups (2 legs each unless otherwise noted) 
   ---- ---- --------------------------------------------- 
      1   #4 14 @ 11.4 + <-- 40.6 --> + 14 @ 11.4  
 
Longitudinal Torsional Reinforcement Details: 
============================================== 
   Units: Start (ft), Length (ft) 
        _______Long Bars_______ ______Short Bars_______ 
   Span    Bars   Start  Length    Bars   Start  Length 
   ---- ------- ------- ------- ------- ------- ------- 
      1     ---                   12-#5    0.00   12.27 
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            ---                   12-#5   17.73   12.27 
  
Beam Shear And Torsion Capacity: 
================================ 
   Section properties: 
   Units: d, pcp, pch (in), Acp, Ach, Ao (in^2) 
          PhiVc (kip), PhiTcr (k-ft), PhiSvt (ksi) 
   Span        d      pcp       ph        Acp        Aoh         Ao    PhiVc   PhiTcr   PhiSvt 
   ---- -------- -------- -------- ---------- ---------- ---------- -------- -------- -------- 
      1    29.75   108.02    96.02    560.064    407.040    345.984    50.49    51.33    0.530 
 
   Beam shear and torsion transverse reinforcement capacity in terms of provided and required area: 
   Units: Start, End, Xu (ft), Sp (in), A(v+2t)/s (in^2/in) 
          Vu (kip), Tu (k-ft), vf (ksi) 
        ___________________Provided__________________ 
_______________________Required________________________ 
   Span    Start      End  A(v+2t)       Sp A(v+2t)/s       Xu       Vu       Tu Case/Patt       vf 
A(v+2t)/s 
   ---- -------- -------- -------- -------- --------- -------- -------- -------- --------- -------- 
--------- 
      1    0.000    0.917    -----    -----    ------     0.00    66.60    51.48    U1/All     0.25    
0.0517 
           0.917   11.273    0.400    11.44    0.0350     3.15    52.63    40.68    U1/All     0.20    
0.0330 *5 
          11.273   13.307    0.400    11.44    0.0350    11.27    16.55    12.79    U1/All     0.06    
0.0000 *2 
          13.307   16.693    -----    -----    ------    13.31     7.52     5.81    U1/All     0.03    
0.0000 *2 
          16.693   18.727    0.400    11.44    0.0350    18.73    16.55    12.79    U1/All     0.06    
0.0000 *2 
          18.727   29.083    0.400    11.44    0.0350    26.85    52.63    40.68    U1/All     0.20    
0.0330 *5 
          29.083   30.000    -----    -----    ------    30.00    66.60    51.48    U1/All     0.25    
0.0517 
   NOTES: 
   *2 - Torsion ignored (Tu < PhiTcr/4). 
   *5 - Minimum transverse (stirrup) reinforcement required. 
 
   Beam torsion longitudinal reinforcement capacity in terms of provided and required area: 
   Units: Start, End, Xu (ft), Al (in^2), Tu (kip) 
        _________Provided_________ _____________Required_______________ 
   Span    Start      End       Al       Xu       Tu Case/Patt       Al 
   ---- -------- -------- -------- -------- -------- --------- -------- 
      1    0.000    0.917    -----     0.00    51.48    U1/All    1.905 
           0.917   11.273    3.720    10.13    16.73    U1/All    2.660 *5 
          11.273   13.307    -----    11.27    12.79    U1/All    0.000 *2 
          13.307   16.693    -----    13.31     5.81    U1/All    0.000 *2 
          16.693   18.727    -----    16.69     5.81    U1/All    0.000 *2 
          18.727   29.083    3.720    19.01    13.77    U1/All    2.660 *5 
          29.083   30.000    -----    30.00    51.48    U1/All    1.905 
   NOTES: 
   *2 - Torsion ignored (Tu < PhiTcr/4). 
   *5 - Minimum longitudinal reinforcement required. 
 
Slab Shear Capacity: 
==================== 
   Units: b, d (in), Xu (ft), PhiVc, Vu(kip) 
   Span        b        d   Vratio        PhiVc           Vu           Xu 
   ---- -------- -------- -------- ------------ ------------ ------------ 
      1 --- Not checked --- 
 
Maximum Deflections: 
==================== 
   Units: Dz (in) 
   Span Dz(DEAD) Dz(LIVE) Dz(TOTAL) 
   ---- -------- -------- --------- 
      1   -0.496   -0.161    -0.658 
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Material Takeoff: 
================= 
   Reinforcement in the Direction of Analysis 
   ------------------------------------------ 
   Top Bars:        63.4 lb   <=>   2.11 lb/ft   <=>   1.152 lb/ft^2 
   Bottom Bars:    429.2 lb   <=>  14.31 lb/ft   <=>   7.802 lb/ft^2 
   Torsion Bars:   307.2 lb   <=>  10.24 lb/ft   <=>   5.584 lb/ft^2 
   Stirrups:       392.8 lb   <=>  13.09 lb/ft   <=>   7.139 lb/ft^2 
   Total Steel:   1192.6 lb   <=>  39.75 lb/ft   <=>  21.676 lb/ft^2 
   Concrete:       116.7 ft^3 <=>   3.89 ft^3/ft <=>   2.121 ft^3/ft^2 
  
  
 
============================================================================================= 
[3] COLUMN AXIAL FORCES AND MOMENTS 
============================================================================================= 
  
   Units: P (kip), M (k-ft) 
   Supp Case/Patt     P (axial)      Mb[top]   Ma[bottom] 
   ---- ---------- ------------ ------------ ------------ 
      1 SELF               8.75         0.00         0.00 
        Dead              37.50         0.00         0.00 
        Live/All          13.50         0.00         0.00 
        Live/Odd          13.50         0.00         0.00 
        Live/Even          0.00         0.00         0.00 
        Live/S1           13.50         0.00         0.00 
        Live/S2           13.50         0.00         0.00 
 
      2 SELF               8.75         0.00        -0.00 
        Dead              37.50         0.00         0.00 
        Live/All          13.50         0.00         0.00 
        Live/Odd          13.50         0.00         0.00 
        Live/Even          0.00         0.00         0.00 
        Live/S1           13.50         0.00         0.00 
        Live/S2           13.50         0.00         0.00 
 
   Sum  SELF              17.50         0.00        -0.00 
        Dead              75.00         0.00         0.00 
        Live/All          27.00         0.00         0.00 
        Live/Odd          27.00         0.00         0.00 
        Live/Even          0.00         0.00         0.00 
        Live/S1           27.00         0.00         0.00 
        Live/S2           27.00         0.00         0.00 
  
 
============================================================================================= 
[6] SEGMENTAL MOMENT AND SHEAR - ENVELOPES 
============================================================================================= 
  
   Span   x (ft)    M- (k-ft) Comb    M+ (k-ft) Comb     V- (kip) Comb     V+ (kip) Comb 
   ---- -------- ------------ ---- ------------ ---- ------------ ---- ------------ ---- 
      1    0.000         0.00 U1           0.00 U1           0.00 U1          66.60 U1   
           0.222         0.00 U1          14.69 U1           0.00 U1          65.61 U1   
           0.444         0.00 U1          29.16 U1           0.00 U1          64.63 U1   
           0.667         0.00 U1          43.41 U1           0.00 U1          63.64 U1   
           0.667         0.00 U1          43.41 U1           0.00 U1          63.64 U1   
           0.953         0.00 U1          61.47 U1           0.00 U1          62.37 U1   
           1.240         0.00 U1          79.17 U1           0.00 U1          61.09 U1   
           1.527         0.00 U1          96.50 U1           0.00 U1          59.82 U1   
           1.813         0.00 U1         113.47 U1           0.00 U1          58.55 U1   
           2.100         0.00 U1         130.07 U1           0.00 U1          57.28 U1   
           2.387         0.00 U1         146.31 U1           0.00 U1          56.00 U1   
           2.673         0.00 U1         162.18 U1           0.00 U1          54.73 U1   
           2.960         0.00 U1         177.69 U1           0.00 U1          53.46 U1   
           3.247         0.00 U1         192.83 U1           0.00 U1          52.18 U1   
           3.533         0.00 U1         207.60 U1           0.00 U1          50.91 U1   
           3.820         0.00 U1         222.02 U1           0.00 U1          49.64 U1   
           4.107         0.00 U1         236.06 U1           0.00 U1          48.37 U1   
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           4.393         0.00 U1         249.75 U1           0.00 U1          47.09 U1   
           4.680         0.00 U1         263.06 U1           0.00 U1          45.82 U1   
           4.967         0.00 U1         276.02 U1           0.00 U1          44.55 U1   
           5.253         0.00 U1         288.61 U1           0.00 U1          43.28 U1   
           5.540         0.00 U1         300.83 U1           0.00 U1          42.00 U1   
           5.827         0.00 U1         312.69 U1           0.00 U1          40.73 U1   
           6.113         0.00 U1         324.18 U1           0.00 U1          39.46 U1   
           6.400         0.00 U1         335.31 U1           0.00 U1          38.18 U1   
           6.687         0.00 U1         346.07 U1           0.00 U1          36.91 U1   
           6.973         0.00 U1         356.47 U1           0.00 U1          35.64 U1   
           7.260         0.00 U1         366.50 U1           0.00 U1          34.37 U1   
           7.547         0.00 U1         376.17 U1           0.00 U1          33.09 U1   
           7.833         0.00 U1         385.48 U1           0.00 U1          31.82 U1   
           8.120         0.00 U1         394.42 U1           0.00 U1          30.55 U1   
           8.407         0.00 U1         402.99 U1           0.00 U1          29.27 U1   
           8.693         0.00 U1         411.20 U1           0.00 U1          28.00 U1   
           8.980         0.00 U1         419.05 U1           0.00 U1          26.73 U1   
           9.267         0.00 U1         426.53 U1           0.00 U1          25.46 U1   
           9.553         0.00 U1         433.64 U1           0.00 U1          24.18 U1   
           9.840         0.00 U1         440.39 U1           0.00 U1          22.91 U1   
          10.127         0.00 U1         446.78 U1           0.00 U1          21.64 U1   
          10.413         0.00 U1         452.80 U1           0.00 U1          20.36 U1   
          10.700         0.00 U1         458.45 U1           0.00 U1          19.09 U1   
          10.987         0.00 U1         463.74 U1           0.00 U1          17.82 U1   
          11.273         0.00 U1         468.67 U1           0.00 U1          16.55 U1   
          11.560         0.00 U1         473.23 U1           0.00 U1          15.27 U1   
          11.847         0.00 U1         477.43 U1           0.00 U1          14.00 U1   
          12.133         0.00 U1         481.26 U1           0.00 U1          12.73 U1   
          12.420         0.00 U1         484.72 U1           0.00 U1          11.46 U1   
          12.707         0.00 U1         487.82 U1           0.00 U1          10.18 U1   
          12.993         0.00 U1         490.56 U1           0.00 U1           8.91 U1   
          13.280         0.00 U1         492.93 U1           0.00 U1           7.64 U1   
          13.567         0.00 U1         494.94 U1           0.00 U1           6.36 U1   
          13.853         0.00 U1         496.58 U1           0.00 U1           5.09 U1   
          14.140         0.00 U1         497.86 U1           0.00 U1           3.82 U1   
          14.427         0.00 U1         498.77 U1           0.00 U1           2.55 U1   
          14.713         0.00 U1         499.32 U1           0.00 U1           1.27 U1   
          15.000         0.00 U1         499.50 U1           0.00 U1           0.00 U1   
          15.287         0.00 U1         499.32 U1          -1.27 U1           0.00 U1   
          15.573         0.00 U1         498.77 U1          -2.55 U1           0.00 U1   
          15.860         0.00 U1         497.86 U1          -3.82 U1           0.00 U1   
          16.147         0.00 U1         496.58 U1          -5.09 U1           0.00 U1   
          16.433         0.00 U1         494.94 U1          -6.36 U1           0.00 U1   
          16.720         0.00 U1         492.93 U1          -7.64 U1           0.00 U1   
          17.007         0.00 U1         490.56 U1          -8.91 U1           0.00 U1   
          17.293         0.00 U1         487.82 U1         -10.18 U1           0.00 U1   
          17.580         0.00 U1         484.72 U1         -11.46 U1           0.00 U1   
          17.867         0.00 U1         481.26 U1         -12.73 U1           0.00 U1   
          18.153         0.00 U1         477.43 U1         -14.00 U1           0.00 U1   
          18.440         0.00 U1         473.23 U1         -15.27 U1           0.00 U1   
          18.727         0.00 U1         468.67 U1         -16.55 U1           0.00 U1   
          19.013         0.00 U1         463.74 U1         -17.82 U1           0.00 U1   
          19.300         0.00 U1         458.45 U1         -19.09 U1           0.00 U1   
          19.587         0.00 U1         452.80 U1         -20.36 U1           0.00 U1   
          19.873         0.00 U1         446.78 U1         -21.64 U1           0.00 U1   
          20.160         0.00 U1         440.39 U1         -22.91 U1           0.00 U1   
          20.447         0.00 U1         433.64 U1         -24.18 U1           0.00 U1   
          20.733         0.00 U1         426.53 U1         -25.46 U1           0.00 U1   
          21.020         0.00 U1         419.05 U1         -26.73 U1           0.00 U1   
          21.307         0.00 U1         411.20 U1         -28.00 U1           0.00 U1   
          21.593         0.00 U1         402.99 U1         -29.27 U1           0.00 U1   
          21.880         0.00 U1         394.42 U1         -30.55 U1           0.00 U1   
          22.167         0.00 U1         385.48 U1         -31.82 U1           0.00 U1   
          22.453         0.00 U1         376.18 U1         -33.09 U1           0.00 U1   
          22.740         0.00 U1         366.51 U1         -34.37 U1           0.00 U1   
          23.027         0.00 U1         356.47 U1         -35.64 U1           0.00 U1   
          23.313         0.00 U1         346.07 U1         -36.91 U1           0.00 U1   
          23.600         0.00 U1         335.31 U1         -38.18 U1           0.00 U1   



 

Examples  6-47 

          23.887         0.00 U1         324.18 U1         -39.46 U1           0.00 U1   
          24.173         0.00 U1         312.69 U1         -40.73 U1           0.00 U1   
          24.460         0.00 U1         300.83 U1         -42.00 U1           0.00 U1   
          24.747         0.00 U1         288.61 U1         -43.28 U1           0.00 U1   
          25.033         0.00 U1         276.02 U1         -44.55 U1           0.00 U1   
          25.320         0.00 U1         263.07 U1         -45.82 U1           0.00 U1   
          25.607         0.00 U1         249.75 U1         -47.09 U1           0.00 U1   
          25.893         0.00 U1         236.07 U1         -48.37 U1           0.00 U1   
          26.180         0.00 U1         222.02 U1         -49.64 U1           0.00 U1   
          26.467         0.00 U1         207.61 U1         -50.91 U1           0.00 U1   
          26.753         0.00 U1         192.83 U1         -52.18 U1           0.00 U1   
          27.040         0.00 U1         177.69 U1         -53.46 U1           0.00 U1   
          27.327         0.00 U1         162.18 U1         -54.73 U1           0.00 U1   
          27.613         0.00 U1         146.31 U1         -56.00 U1           0.00 U1   
          27.900         0.00 U1         130.07 U1         -57.28 U1           0.00 U1   
          28.187         0.00 U1         113.47 U1         -58.55 U1           0.00 U1   
          28.473         0.00 U1          96.50 U1         -59.82 U1           0.00 U1   
          28.760         0.00 U1          79.17 U1         -61.09 U1           0.00 U1   
          29.047         0.00 U1          61.48 U1         -62.37 U1           0.00 U1   
          29.333         0.00 U1          43.42 U1         -63.64 U1           0.00 U1   
          29.333         0.00 U1          43.42 U1         -63.64 U1           0.00 U1   
          29.556         0.00 U1          29.16 U1         -64.63 U1           0.00 U1   
          29.778         0.00 U1          14.69 U1         -65.61 U1           0.00 U1   
          30.000        -0.00 U1           0.00 U1         -66.60 U1           0.00 U1   
 
  
 
============================================================================================= 
[6b] SEGMENTAL TORSION - ENVELOPES 
============================================================================================= 
  
   Span   x (ft)    T+ (k-ft) Comb    T- (k-ft) Comb 
   ---- -------- ------------ ---- ------------ ---- 
      1    0.000        51.48 U1           0.00 U1   
           0.222        50.72 U1           0.00 U1   
           0.444        49.95 U1           0.00 U1   
           0.667        49.19 U1           0.00 U1   
           0.667        49.19 U1           0.00 U1   
           0.953        48.21 U1           0.00 U1   
           1.240        47.22 U1           0.00 U1   
           1.527        46.24 U1           0.00 U1   
           1.813        45.26 U1           0.00 U1   
           2.100        44.27 U1           0.00 U1   
           2.387        43.29 U1           0.00 U1   
           2.673        42.31 U1           0.00 U1   
           2.960        41.32 U1           0.00 U1   
           3.247        40.34 U1           0.00 U1   
           3.533        39.35 U1           0.00 U1   
           3.820        38.37 U1           0.00 U1   
           4.107        37.39 U1           0.00 U1   
           4.393        36.40 U1           0.00 U1   
           4.680        35.42 U1           0.00 U1   
           4.967        34.43 U1           0.00 U1   
           5.253        33.45 U1           0.00 U1   
           5.540        32.47 U1           0.00 U1   
           5.827        31.48 U1           0.00 U1   
           6.113        30.50 U1           0.00 U1   
           6.400        29.52 U1           0.00 U1   
           6.687        28.53 U1           0.00 U1   
           6.973        27.55 U1           0.00 U1   
           7.260        26.56 U1           0.00 U1   
           7.547        25.58 U1           0.00 U1   
           7.833        24.60 U1           0.00 U1   
           8.120        23.61 U1           0.00 U1   
           8.407        22.63 U1           0.00 U1   
           8.693        21.64 U1           0.00 U1   
           8.980        20.66 U1           0.00 U1   
           9.267        19.68 U1           0.00 U1   
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           9.553        18.69 U1           0.00 U1   
           9.840        17.71 U1           0.00 U1   
          10.127        16.73 U1           0.00 U1   
          10.413        15.74 U1           0.00 U1   
          10.700        14.76 U1           0.00 U1   
          10.987        13.77 U1           0.00 U1   
          11.273        12.79 U1           0.00 U1   
          11.560        11.81 U1           0.00 U1   
          11.847        10.82 U1           0.00 U1   
          12.133         9.84 U1           0.00 U1   
          12.420         8.85 U1           0.00 U1   
          12.707         7.87 U1           0.00 U1   
          12.993         6.89 U1           0.00 U1   
          13.280         5.90 U1           0.00 U1   
          13.567         4.92 U1           0.00 U1   
          13.853         3.94 U1           0.00 U1   
          14.140         2.95 U1           0.00 U1   
          14.427         1.97 U1           0.00 U1   
          14.713         0.98 U1           0.00 U1   
          15.000         0.00 U1          -0.00 U1   
          15.287         0.00 U1          -0.98 U1   
          15.573         0.00 U1          -1.97 U1   
          15.860         0.00 U1          -2.95 U1   
          16.147         0.00 U1          -3.94 U1   
          16.433         0.00 U1          -4.92 U1   
          16.720         0.00 U1          -5.90 U1   
          17.007         0.00 U1          -6.89 U1   
          17.293         0.00 U1          -7.87 U1   
          17.580         0.00 U1          -8.85 U1   
          17.867         0.00 U1          -9.84 U1   
          18.153         0.00 U1         -10.82 U1   
          18.440         0.00 U1         -11.81 U1   
          18.727         0.00 U1         -12.79 U1   
          19.013         0.00 U1         -13.77 U1   
          19.300         0.00 U1         -14.76 U1   
          19.587         0.00 U1         -15.74 U1   
          19.873         0.00 U1         -16.73 U1   
          20.160         0.00 U1         -17.71 U1   
          20.447         0.00 U1         -18.69 U1   
          20.733         0.00 U1         -19.68 U1   
          21.020         0.00 U1         -20.66 U1   
          21.307         0.00 U1         -21.64 U1   
          21.593         0.00 U1         -22.63 U1   
          21.880         0.00 U1         -23.61 U1   
          22.167         0.00 U1         -24.60 U1   
          22.453         0.00 U1         -25.58 U1   
          22.740         0.00 U1         -26.56 U1   
          23.027         0.00 U1         -27.55 U1   
          23.313         0.00 U1         -28.53 U1   
          23.600         0.00 U1         -29.52 U1   
          23.887         0.00 U1         -30.50 U1   
          24.173         0.00 U1         -31.48 U1   
          24.460         0.00 U1         -32.47 U1   
          24.747         0.00 U1         -33.45 U1   
          25.033         0.00 U1         -34.43 U1   
          25.320         0.00 U1         -35.42 U1   
          25.607         0.00 U1         -36.40 U1   
          25.893         0.00 U1         -37.39 U1   
          26.180         0.00 U1         -38.37 U1   
          26.467         0.00 U1         -39.35 U1   
          26.753         0.00 U1         -40.34 U1   
          27.040         0.00 U1         -41.32 U1   
          27.327         0.00 U1         -42.31 U1   
          27.613         0.00 U1         -43.29 U1   
          27.900         0.00 U1         -44.27 U1   
          28.187         0.00 U1         -45.26 U1   
          28.473         0.00 U1         -46.24 U1   
          28.760         0.00 U1         -47.22 U1   
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          29.047         0.00 U1         -48.21 U1   
          29.333         0.00 U1         -49.19 U1   
          29.333         0.00 U1         -49.19 U1   
          29.556         0.00 U1         -49.95 U1   
          29.778         0.00 U1         -50.72 U1   
          30.000         0.00 U1         -51.48 U1   
 
  
============================================================================================= 
[7] SEGMENTAL DEFLECTIONS 
============================================================================================= 
  
   Units: x (ft), Dz (in) 
   Span        x    Dz (DEAD)    Dz (LIVE)   Dz (TOTAL) 
   ---- -------- ------------ ------------ ------------ 
      1    0.000       -0.000       -0.000       -0.000 
           0.222       -0.012       -0.004       -0.016 
           0.444       -0.023       -0.008       -0.031 
           0.667       -0.035       -0.011       -0.047 
           0.667       -0.035       -0.011       -0.047 
           0.953       -0.050       -0.016       -0.067 
           1.240       -0.065       -0.021       -0.087 
           1.527       -0.080       -0.026       -0.107 
           1.813       -0.095       -0.031       -0.126 
           2.100       -0.110       -0.036       -0.146 
           2.387       -0.125       -0.041       -0.165 
           2.673       -0.139       -0.045       -0.185 
           2.960       -0.154       -0.050       -0.204 
           3.247       -0.168       -0.055       -0.223 
           3.533       -0.182       -0.059       -0.241 
           3.820       -0.196       -0.064       -0.260 
           4.107       -0.210       -0.068       -0.278 
           4.393       -0.223       -0.073       -0.296 
           4.680       -0.237       -0.077       -0.314 
           4.967       -0.250       -0.081       -0.331 
           5.253       -0.263       -0.085       -0.348 
           5.540       -0.275       -0.089       -0.365 
           5.827       -0.287       -0.093       -0.381 
           6.113       -0.300       -0.097       -0.397 
           6.400       -0.311       -0.101       -0.412 
           6.687       -0.323       -0.105       -0.428 
           6.973       -0.334       -0.109       -0.442 
           7.260       -0.345       -0.112       -0.457 
           7.547       -0.355       -0.115       -0.471 
           7.833       -0.366       -0.119       -0.484 
           8.120       -0.375       -0.122       -0.497 
           8.407       -0.385       -0.125       -0.510 
           8.693       -0.394       -0.128       -0.522 
           8.980       -0.403       -0.131       -0.534 
           9.267       -0.411       -0.134       -0.545 
           9.553       -0.420       -0.136       -0.556 
           9.840       -0.427       -0.139       -0.566 
          10.127       -0.435       -0.141       -0.576 
          10.413       -0.442       -0.143       -0.585 
          10.700       -0.448       -0.146       -0.594 
          10.987       -0.454       -0.148       -0.602 
          11.273       -0.460       -0.149       -0.609 
          11.560       -0.465       -0.151       -0.617 
          11.847       -0.470       -0.153       -0.623 
          12.133       -0.475       -0.154       -0.629 
          12.420       -0.479       -0.156       -0.634 
          12.707       -0.482       -0.157       -0.639 
          12.993       -0.486       -0.158       -0.644 
          13.280       -0.489       -0.159       -0.647 
          13.567       -0.491       -0.160       -0.650 
          13.853       -0.493       -0.160       -0.653 
          14.140       -0.494       -0.161       -0.655 
          14.427       -0.495       -0.161       -0.657 
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          14.713       -0.496       -0.161       -0.657 
          15.000       -0.496       -0.161       -0.658 
          15.287       -0.496       -0.161       -0.657 
          15.573       -0.495       -0.161       -0.657 
          15.860       -0.494       -0.161       -0.655 
          16.147       -0.493       -0.160       -0.653 
          16.433       -0.491       -0.160       -0.650 
          16.720       -0.489       -0.159       -0.647 
          17.007       -0.486       -0.158       -0.644 
          17.293       -0.482       -0.157       -0.639 
          17.580       -0.479       -0.156       -0.634 
          17.867       -0.475       -0.154       -0.629 
          18.153       -0.470       -0.153       -0.623 
          18.440       -0.465       -0.151       -0.617 
          18.727       -0.460       -0.149       -0.609 
          19.013       -0.454       -0.148       -0.602 
          19.300       -0.448       -0.146       -0.594 
          19.587       -0.442       -0.143       -0.585 
          19.873       -0.435       -0.141       -0.576 
          20.160       -0.427       -0.139       -0.566 
          20.447       -0.420       -0.136       -0.556 
          20.733       -0.411       -0.134       -0.545 
          21.020       -0.403       -0.131       -0.534 
          21.307       -0.394       -0.128       -0.522 
          21.593       -0.385       -0.125       -0.510 
          21.880       -0.375       -0.122       -0.497 
          22.167       -0.366       -0.119       -0.484 
          22.453       -0.355       -0.115       -0.471 
          22.740       -0.345       -0.112       -0.457 
          23.027       -0.334       -0.109       -0.442 
          23.313       -0.323       -0.105       -0.428 
          23.600       -0.311       -0.101       -0.412 
          23.887       -0.300       -0.097       -0.397 
          24.173       -0.287       -0.093       -0.381 
          24.460       -0.275       -0.089       -0.365 
          24.747       -0.263       -0.085       -0.348 
          25.033       -0.250       -0.081       -0.331 
          25.320       -0.237       -0.077       -0.314 
          25.607       -0.223       -0.073       -0.296 
          25.893       -0.210       -0.068       -0.278 
          26.180       -0.196       -0.064       -0.260 
          26.467       -0.182       -0.059       -0.241 
          26.753       -0.168       -0.055       -0.223 
          27.040       -0.154       -0.050       -0.204 
          27.327       -0.139       -0.045       -0.185 
          27.613       -0.125       -0.041       -0.165 
          27.900       -0.110       -0.036       -0.146 
          28.187       -0.095       -0.031       -0.126 
          28.473       -0.080       -0.026       -0.107 
          28.760       -0.065       -0.021       -0.087 
          29.047       -0.050       -0.016       -0.067 
          29.333       -0.035       -0.011       -0.047 
          29.333       -0.035       -0.011       -0.047 
          29.556       -0.023       -0.008       -0.031 
          29.778       -0.012       -0.004       -0.016 
          30.000       -0.000       -0.000       -0.000 
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Graphical Output 

Loads 

pcaBeam v1.50. Licenced to: pcaStructurePoint. Licence ID: 00000-0000000-4-238E7-238E7

File: C:\Data\pcaBeam\PCA Notes on ACI 318-02 Example 13-1.slb

Project: PCA Notes on ACI 318-02

Frame: Example 13-1 Engineer: pcaStructurePoint

CASE: SELF

CASE: Dead

CASE: Live

100

400

2500

900

1.76

0.825
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Internal Forces 

pcaBeam v1.50. Licenced to: pcaStructurePoint. Licence ID: 00000-0000000-4-238E7-238E7

File: C:\Data\pcaBeam\PCA Notes on ACI 318-02 Example 13-1.slb

Project: PCA Notes on ACI 318-02

Frame: Example 13-1 Engineer: pcaStructurePoint

M
om

en
t D

ia
gr

am
 - 

k-
ft

-500.0

500.0

Sh
ea

r D
ia

gr
am

 - 
ki

p

70.0

-70.0

To
rs

io
n 

D
ia

gr
am

 - 
k-

ft

60.0

-60.0

LEGEND:
 Envelope

499.50

66.60

-66.60

51.48

-51.48
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Moment Capacity 

pcaBeam v1.50. Licenced to: pcaStructurePoint. Licence ID: 00000-0000000-4-238E7-238E7

File: C:\Data\pcaBeam\PCA Notes on ACI 318-02 Example 13-1.slb

Project: PCA Notes on ACI 318-02

Frame: Example 13-1 Engineer: pcaStructurePoint

M
om

en
t C

ap
ac

ity
 - 

k-
ft

-600.0

600.0

LEGEND:
 Envelope Curve
 Capacity Curve
 Support Centerline
 Face of Support
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Shear Capacity 

pcaBeam v1.50. Licenced to: pcaStructurePoint. Licence ID: 00000-0000000-4-238E7-238E7

File: C:\Data\pcaBeam\PCA Notes on ACI 318-02 Example 13-1.slb

Project: PCA Notes on ACI 318-02

Frame: Example 13-1 Engineer: pcaStructurePoint

Beam Shear and Torsion Capacity: Longitudinal Bar Area - in^2

Beam Shear and Torsion Capacity: Stirrup Intensity - in^2/in

0.06

4.0

LEGEND:
 Demand - (Av+2At)/s
 Demand - At/s
 Demand - Av/s
 Demand - Al
 Provided - (Av+2At)/s

 Provided - Al
 Support Centerline
 Face of Support
 Critical Section

 0.033

 1.8

0.033 

 1.8
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Deflection 

pcaBeam v1.50. Licenced to: pcaStructurePoint. Licence ID: 00000-0000000-4-238E7-238E7

File: C:\Data\pcaBeam\PCA Notes on ACI 318-02 Example 13-1.slb

Project: PCA Notes on ACI 318-02

Frame: Example 13-1 Engineer: pcaStructurePoint

D
ef

le
ct

io
n 

D
ia

gr
am

 - 
in

0.658

-0.658

LEGEND:
 Dead Load
 Live Load
 Total Deflection
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Reinforcement 

pcaBeam v1.50. Licenced to: pcaStructurePoint. Licence ID: 00000-0000000-4-238E7-238E7

File: C:\Data\pcaBeam\PCA Notes on ACI 318-02 Example 13-1.slb

Project: PCA Notes on ACI 318-02

Frame: Example 13-1 Engineer: pcaStructurePoint

Flexural and Transverse Rebars

3-
#5

(1
21

.5
)

3-
#5

(1
21

.5
)

4-
#7

(3
60

.0
)c

3-
#7

(3
60

.0
)

 1
4-

#4
@

11
.4

 1
4-

#4
@

11
.4
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Example 3 One-way slab system 

Problem description 
The system shown in the following figure consists of five spans symmetric about 
the centerline. We will be designing beam ABCD assuming that the other half of 
the beam will be loaded and designed the same way. All beams have a width of 12 
in. and a depth of 22 in. – including the 5 in. thick deck. Span length and widths 
are shown in the figure. Columns have a 12 in. × 12in. cross-section and a length 
equal to a typical story height of 13 ft. The system will be analyzed and designed 
under a uniform live load of 130 psf and a dead load that consists of the slab 
system’s own weight plus 80 psf. Use f’c = 4 ksi, fy = 60 ksi, and γconcrete = 150 pcf. 
This exemple refers to example 16.1 from Structural Concrete: Theory and Design 
by Hassoun and Al-Manaseer, Third Edition, 2005. 

24'

26'

12' 12' 12' 12'

13'

A

B

C

Symmetrical 
about

CL CL

CL
D

 

Program Input 
1. From the Input menu, select General Information. A dialog box appears. 
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• In the LABELS section, input the names of the project, frame, and 
engineer.  

• In the FRAME section, input 6 for NO OF SUPPORTS.  

• In the FLOOR SYSTEM section, click the radial button next to ONE-WAY / 
BEAM.  

• Leave all other options in the General Information tab to their default 
settings of ACI 318-02 design code, ASTM A615 reinforcement, and 
DESIGN run mode option.  

• In the Solve Options tab, keep the default settings. Press OK. 

   
2. Nothing needs to be changed in the Material Properties menu.  
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3. From the Input menu, select Spans. A dialog box appears. 

• Under the Slabs/Flanges tab, input 24 for LENGTH, 5 for THICKNESS, 
and 0 for WIDTH LEFT and WIDTH RIGHT. Press MODIFY. (Note: Since 
the slab has no width, we must convert the area loads to line loads along 
the beam and also add the self-weight of the slab to the dead load. This 
calculation will be shown in Step 8.) 

• Press COPY. Select the check box next to Span 5. Press OK. This will give 
Span 5 the same geometry as Span 1. 

• Press the drop down arrow next to SPAN and select Span 2. Input 26 for 
LENGTH, 5 for THICKNESS, and 0 for WIDTH LEFT and WIDTH RIGHT. 
Press MODIFY.  

• Press COPY. Unselect the check box next to Span 1 and select the check 
boxes next to Spans 3 and 4. Press OK. 

• Select the Longitudinal Beams tab. Input 12 for WIDTH and 22 for 
DEPTH. Press MODIFY. 

• Press COPY. Press the CHECK ALL button. Press OK. 

• Press OK again. 
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4. From the Input menu, select Supports. A dialog box appears. 

• Under the Columns tab, input 13 for both HEIGHT ABOVE and HEIGHT 
BELOW. Press MODIFY. (Note: the default C1 and C2 values for both the 
column above and below the support can be left alone since all the 
columns’ cross sections are 12 in. × 12 in.) 

• Press COPY. Press the CHECK ALL button. Press OK. 

• Press OK again. 
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5. From the Input menu, select Reinforcement Criteria. A dialog box appears. 

• Under the Beams tab, use the drop down arrows to change both the MIN 
and MAX BAR SIZE for TOP BARS to #9.  

• Use the drop down arrows to change both the MIN and MAX BAR SIZE for 
BOTTOM BARS to #8. Press OK. 

 
6. From the Input menu, select Load Cases. A dialog box appears. 
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• Since we are not considering lateral forces, click on WIND in the LABEL 
column on the list in the bottom half of the LOAD CASES dialog box and 
press the DELETE button. 

• Click on EQ in the LABEL column and press the DELETE button. Press 
OK. 

 
7. From the Input menu, select Load Combinations. A dialog box appears.  

• Delete all the load combinations by clicking anywhere on the list in the 
bottom half of the LOAD COMBINATIONS dialog box and pressing the 
DELETE button. Repeat this procedure until all the load combinations are 
gone.  

• Input 1.2 in the SELF field, 1.2 in the DEAD field, and 1.6 in the LIVE 
field. Press ADD. 

• Press OK. 
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8. From the Input menu, select Span Loads. A dialog box appears. 

• Press the drop down arrow next to TYPE, and select LINE LOAD. 

• Input 1647.5 for both the START and END MAGNITUDE. (Note: This 
value was obtained by converting the area loads of the of the slab’s self 
weight (without the beam) and superimposed dead load into a line load.) 

Dead Load =  

ft/lb5.1647

)pcf150
ftin144
in12in5()ft12*psf80()ft12pcf150ft

12
5( 22

=

=×
×

−+××
 

• Input 24 for the END LOCATION. Press ADD. 

• Click on SPAN 1 on the list in the bottom half of the SPAN LOADS dialog 
box. Press the COPY button. (Note: there is a CASE COPY button that 
should not be pressed.) 

• Click the check box next to SPAN 5 and press OK. 

• Back in the SPAN LOADS dialog box, use the drop down arrow next to 
SPAN to select SPAN 2. Keep the START and END MAGNITUDES of 
1647.5 lb/ft but change the END LOCATION to 26. Click the ADD 
button. 

• Click on SPAN 2 in the list at the bottom half of the SPAN LOADS dialog 
box. Press the COPY button. 

• Click the check boxes next to SPAN 3 and 4. Press OK. 
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9. In the top left corner of the SPAN LOADS dialog box, there is a section called 

CURRENT CASE. Click on LIVE. 
• Use the drop down arrow next to SPAN to select SPAN 1. 

• Making sure that LINE LOAD is still the selected LOAD TYPE, input 1560 
for both the START and END MAGNITUDE. 

Live Load = ft/lb1560)ft12psf130( =×  
• Input 24 for the END LOCATION. Press ADD. 

• Click on SPAN 1 on the list in the bottom half of the SPAN LOADS dialog 
box. Press the COPY button. (Note: the CASE COPY button should not be 
pressed.) 

• Click the check box next to SPAN 5 and press OK. 

• Back in the SPAN LOADS dialog box, use the drop down arrow next to 
SPANS to select SPAN 2. Keep the START and END MAGNITUDES of 1560 
lb/ft but change the END LOCATION to 26. Click the ADD button. 

• Click on SPAN 2 in the list at the bottom half of the SPAN LOADS dialog 
box. Press the COPY button. 

• Click the check boxes next to SPAN 3 AND 4. Press OK. 

• Press OK again. 
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10. From the Solve menu, select Execute. Press CLOSE. 
11. From the Solve menu, select Results Report. 

• Use the scroll bars to scroll through the results file.  

• Use the ARROW keys or the mouse wheel to browse through different 
parts of the results quickly. Press the CLOSE button to close the RESULTS 
REPORT dialog box and return to pcaBeam. 

12. To view diagrams, select Loads, Internal Forces, Moment Capacity, Shear 
Capacity, Deflection, or Reinforcement from the View menu. Right click in 
any of these diagrams to get new copy, printing, or display options.  

13. You may print the results file by selecting Print Results from the File menu. 
To print any of the diagrams you selected to view, use the Print Preview 
command found by right clicking in the diagram’s window. After viewing the 
results, you may decide to investigate the input beams under the same loads 
but with a modified reinforcement configuration.  

14. From the Input menu, select General Information. In the General 
Information dialog box change the RUN MODE option to INVESTIGATION. Do 
not change any of the other options. Press OK 

15. From the Input menu, select the different commands under Reinforcement 
Criteria and Reinforcing Bars to modify the reinforcement configuration 
computed by the program. 

16. Repeat steps 10 and subsequent to perform the investigation and view the 
results.  
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Text Output (abbreviated) 
                         ooooooo      oooooo      ooooo               
                         oooooooo    oooooooo    ooooooo              
                         oo    oo    oo    oo    oo   oo              
                         oo    oo    oo          oo   oo              
                         oooooooo    oo          ooooooo   ooooo      
                         ooooooo     oo    oo    ooooooo   ooooo      
                         oo          oo    oo    oo   oo              
                         oo          oooooooo    oo   oo              
                         oo           oooooo     oo   oo              
  
  
                      OOOOO    OOOOOO   OOOOO   OO       OO           
                      OO   OO  OO      OO   OO  OOO     OOO           
                      OO   OO  OO      OO   OO  OO O   O OO           
                      OO   OO  OO      OO   OO  OO  O O  OO           
                      OOOOO    OOOOO   OOOOOOO  OO   O   OO           
                      OO   OO  OO      OO   OO  OO       OO           
                      OO   OO  OO      OO   OO  OO       OO           
                      OO   OO  OO      OO   OO  OO       OO           
                      OOOOO    OOOOOO  OO   OO  OO       OO           
  
      =============================================================================  
                                  pcaBeam v1.50 (TM) 
              A Computer Program for Analysis, Design, and Investigation of 
              Reinforced Concrete Continuous Beam and One-Way Slab Systems  
      =============================================================================  
                  Copyright © 1992-2005, Portland Cement Association  
                                  All rights reserved  
  
             Licensee stated above acknowledges that Portland Cement Association  
         (PCA) is not and  cannot  be  responsible for  either the  accuracy  or  
         adequacy of  the material supplied  as input  for  processing   by  the  
         pcaBeam  computer program.  Furthermore, PCA neither makes any warranty  
         expressed nor implied with respect  to  the  correctness of the  output  
         prepared by the  pcaBeam   program.  Although  PCA  has  endeavored  to  
         produce pcaBeam  error free the  program is not and cannot be certified  
         infallible.  The final and only responsibility for analysis, design and  
         engineering documents is the licensees. Accordingly, PCA disclaims  all  
         responsibility in contract, negligence or other tort for any  analysis,  
         design  or engineering documents prepared in connection with the use of  
         the pcaBeam  program.  
  
  
============================================================================================= 
[1] INPUT ECHO 
============================================================================================= 
  
General Information: 
==================== 
   File name: C:\Data\pcaBeam\Hassoun Ex 16.1.slb 
   Project: Example 16.1 Hassoun and Al-Manaseer 
   Frame: Structural Concrete                      Engineer: pcaStructurePoint 
   Code: ACI 318-02       Mode: Design             Reinforcement Database: ASTM A615 
   Number of supports = 6 
   Floor System: One-Way/Beam 
  
   Live load pattern ratio = 100% 
   Deflections are based on cracked section properties. 
   In negative moment regions, Igr and Mcr DO NOT include flange/slab contribution (if available) 
   Compression reinforcement calculations NOT selected. 
   Moment redistribution NOT selected. 
   Effective flange width calculations NOT selected. 
   Rigid beam-column joint NOT selected. 
   Torsion analysis and design NOT selected. 
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Material Properties: 
==================== 
            Slabs|Beams       Columns 
           ------------   ------------ 
   wc    =          150            150 lb/ft3 
   f'c   =            4              4 ksi 
   Ec    =       3834.3         3834.3 ksi 
   fr    =      0.47434        0.47434 ksi 
  
   fy    =           60 ksi, Bars are not epoxy-coated 
   fyv   =           60 ksi 
   Es    =        29000 ksi 
  
Reinforcement Database: 
=============== 
   Units: Db (in), Ab (in^2), Wb (lb/ft) 
   Size       Db      Ab        Wb    Size       Db      Ab        Wb 
   ---- -------- -------- --------    ---- -------- -------- -------- 
     #3     0.38     0.11     0.38      #4     0.50     0.20     0.67     
     #5     0.63     0.31     1.04      #6     0.75     0.44     1.50     
     #7     0.88     0.60     2.04      #8     1.00     0.79     2.67     
     #9     1.13     1.00     3.40     #10     1.27     1.27     4.30     
    #11     1.41     1.56     5.31     #14     1.69     2.25     7.65     
    #18     2.26     4.00    13.60     
  
Span Data: 
========== 
   Slabs: L1, wL, wR (ft); t, Hmin (in) 
   Span Loc        L1        t       wL       wR     Hmin 
   ---- ---- -------- -------- -------- -------- --------  
      1 Int    24.000     5.00    0.500    0.500     0.00     
      2 Int    26.000     5.00    0.500    0.500     0.00     
      3 Int    26.000     5.00    0.500    0.500     0.00     
      4 Int    26.000     5.00    0.500    0.500     0.00     
      5 Int    24.000     5.00    0.500    0.500     0.00     
  
   Ribs and Longitudinal Beams: b, h, Sp (in) 
        __________Ribs____________    _______Beams_____    __Span__ 
   Span        b        h       Sp           b        h        Hmin 
   ---- -------- -------- --------    -------- --------    -------- 
      1     0.00     0.00     0.00       12.00    22.00       15.57 
      2     0.00     0.00     0.00       12.00    22.00       14.86 
      3     0.00     0.00     0.00       12.00    22.00       14.86 
      4     0.00     0.00     0.00       12.00    22.00       14.86 
      5     0.00     0.00     0.00       12.00    22.00       15.57 
  
Support Data: 
============= 
   Columns: c1a, c2a, c1b, c2b (in); Ha, Hb (ft) 
   Supp      c1a      c2a       Ha        c1b      c2b       Hb  Red% 
   ---- -------- -------- --------   -------- -------- --------  ---- 
      1    12.00    12.00   13.000      12.00    12.00   13.000   100  
      2    12.00    12.00   13.000      12.00    12.00   13.000   100  
      3    12.00    12.00   13.000      12.00    12.00   13.000   100  
      4    12.00    12.00   13.000      12.00    12.00   13.000   100  
      5    12.00    12.00   13.000      12.00    12.00   13.000   100  
      6    12.00    12.00   13.000      12.00    12.00   13.000   100  
  
   Boundary Conditions: Kz (kip/in); Kry (kip-in/rad) 
   Supp    Spring Kz   Spring Kry Far End A Far End B 
   ---- ------------ ------------ --------- --------- 
      1            0            0     Fixed     Fixed 
      2            0            0     Fixed     Fixed 
      3            0            0     Fixed     Fixed 
      4            0            0     Fixed     Fixed 
      5            0            0     Fixed     Fixed 
      6            0            0     Fixed     Fixed 
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Load Data: 
========== 
   Load Cases and Combinations: 
   Case     SELF     Dead     Live  
   Type     DEAD     DEAD     LIVE  
   U1      1.200    1.200    1.600  
  
   Span Loads: 
   Span Case               Wa           La           Wb           Lb 
   ---- -------- ------------ ------------ ------------ ------------ 
   Line Loads - Wa | Wb (lb/ft), La | Lb (ft): 
      1 Dead           1647.5            0       1647.5           24 
      2 Dead           1647.5            0       1647.5           26 
      3 Dead           1647.5            0       1647.5           26 
      4 Dead           1647.5            0       1647.5           26 
      5 Dead           1647.5            0       1647.5           24 
      1 Live             1560            0         1560           24 
      2 Live             1560            0         1560           26 
      3 Live             1560            0         1560           26 
      4 Live             1560            0         1560           26 
      5 Live             1560            0         1560           24 
  
   Support Loads:   --- NONE --- 
  
   Support Displacements:   --- NONE --- 
  
Reinforcement Criteria: 
======================= 
                 _____Top bars___  ___Bottom bars__  ____Stirrups____ 
                   Min      Max      Min      Max      Min      Max   
                 -------  -------  -------  -------  -------  ------- 
   Slabs and Ribs: 
     Bar Size         #9       #9       #8       #8 
     Bar spacing    1.00    18.00     1.00    18.00 in 
     Reinf ratio    0.14     5.00     0.14     5.00 % 
     Cover          1.50              1.50          in 
  
   Beams: 
     Bar Size         #9       #9       #8       #8       #3       #5 
     Bar spacing    1.00    18.00     1.00    18.00     6.00    18.00 in 
     Reinf ratio    0.14     5.00     0.14     5.00 % 
     Cover          1.50              1.50          in 
  
 
============================================================================================= 
[2] DESIGN RESULTS 
============================================================================================= 
  
Top Reinforcement: 
================== 
   Units: Width (ft), Mmax (k-ft), Xmax (ft), As (in^2), Sp (in) 
   Span Zone      Width         Mmax     Xmax    AsMin    AsMax    SpReq    AsReq    Bars 
   ---- ------ -------- ------------ -------- -------- -------- -------- -------- ------- 
      1 Left       1.00       120.04    0.500    0.797    4.321    7.617    1.412    2-#9  
        Middle     1.00         0.00   12.000    0.000    4.321    0.000    0.000     ---  
        Right      1.00       252.46   23.500    0.797    4.321    2.539    3.189    4-#9  
 
      2 Left       1.00       256.82    0.500    0.797    4.321    2.539    3.253    4-#9  
        Middle     1.00         0.00   13.000    0.000    4.321    0.000    0.000     ---  
        Right      1.00       259.21   25.500    0.797    4.321    2.539    3.288    4-#9  
 
      3 Left       1.00       259.63    0.500    0.797    4.321    2.539    3.294    4-#9  
        Middle     1.00         0.00   13.000    0.000    4.321    0.000    0.000     ---  
        Right      1.00       259.63   25.500    0.797    4.321    2.539    3.294    4-#9  
 
      4 Left       1.00       259.21    0.500    0.797    4.321    2.539    3.288    4-#9  
        Middle     1.00         0.00   13.000    0.000    4.321    0.000    0.000     ---  
        Right      1.00       256.82   25.500    0.797    4.321    2.539    3.253    4-#9  
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      5 Left       1.00       252.46    0.500    0.797    4.321    2.539    3.189    4-#9  
        Middle     1.00         0.00   12.000    0.000    4.321    0.000    0.000     ---  
        Right      1.00       120.04   23.500    0.797    4.321    7.617    1.412    2-#9  
 
Top Bar Details: 
================ 
   Units: Length (ft) 
        _____________Left______________  ___Continuous__  _____________Right_____________ 
   Span    Bars  Length    Bars  Length     Bars  Length     Bars  Length    Bars  Length 
   ---- ------- ------- ------- -------  ------- -------  ------- ------- ------- ------- 
      1    1-#9    8.09    1-#9    5.10      ---             2-#9   12.24    2-#9    6.72 
 
      2    2-#9   12.08    2-#9    6.88      ---             2-#9   12.39    2-#9    6.97 
 
      3    2-#9   12.39    2-#9    6.99      ---             2-#9   12.39    2-#9    6.99 
 
      4    2-#9   12.39    2-#9    6.97      ---             2-#9   12.08    2-#9    6.88 
 
      5    2-#9   12.24    2-#9    6.72      ---             1-#9    8.09    1-#9    5.10 
 
Bottom Reinforcement: 
===================== 
   Units: Width (ft), Mmax (k-ft), Xmax (ft), As (in^2), Sp (in)  
   Span    Width         Mmax     Xmax    AsMin    AsMax    SpReq    AsReq    Bars 
   ---- -------- ------------ -------- -------- -------- -------- -------- ------- 
      1     1.00       159.13   11.250    0.800    4.335    3.853    1.899    3-#8  
 
      2     1.00       161.64   13.000    0.800    4.335    3.853    1.925    3-#8  
 
      3     1.00       164.05   13.000    0.800    4.335    3.853    1.964    3-#8  
 
      4     1.00       161.64   13.000    0.800    4.335    3.853    1.925    3-#8  
 
      5     1.00       159.13   12.750    0.800    4.335    3.853    1.899    3-#8  
 
Bottom Bar Details: 
=================== 
   Units: Start (ft), Length (ft) 
        _______Long Bars_______ ______Short Bars_______ 
   Span    Bars   Start  Length    Bars   Start  Length 
   ---- ------- ------- ------- ------- ------- ------- 
      1    2-#8    0.00   24.00    1-#8    5.58   11.41 
 
      2    2-#8    0.00   26.00    1-#8    7.20   11.79 
 
      3    2-#8    0.00   26.00    1-#8    6.91   12.18 
 
      4    2-#8    0.00   26.00    1-#8    7.01   11.79 
 
      5    2-#8    0.00   24.00    1-#8    7.01   11.41 
 
Flexural Capacity: 
================== 
   Units: From, To (ft), As (in^2), PhiMn (k-ft)  
   Span      From        To AsTop AsBot       PhiMn-       PhiMn+ 
   ---- --------- --------- ----- ----- ------------ ------------ 
      1     0.000     0.500  2.00  1.58      -166.19       133.94 
            0.500     2.521  2.00  1.58      -166.19       133.94 
            2.521     5.101  1.00  1.58       -86.40       133.94 
            5.101     5.511  1.00  1.58       -86.40       133.94 
            5.511     5.578  0.00  1.58         0.00       133.94 
            5.578     8.044  0.00  1.58         0.00       133.94 
            8.044     8.090  0.00  2.37         0.00       194.71 
            8.090     8.550  0.00  2.37         0.00       194.71 
            8.550    11.761  0.00  2.37         0.00       194.71 
           11.761    12.000  0.00  2.37         0.00       194.71 
           12.000    14.520  0.00  2.37         0.00       194.71 
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           14.520    15.450  0.00  1.58         0.00       133.94 
           15.450    16.500  0.00  1.58         0.00       133.94 
           16.500    16.986  2.00  1.58      -166.19       133.94 
           16.986    17.277  2.00  1.58      -166.19       133.94 
           17.277    22.015  2.00  1.58      -166.19       133.94 
           22.015    23.500  4.00  1.58      -305.91       133.94 
           23.500    24.000  4.00  1.58      -305.91       133.94 
 
      2     0.000     0.500  4.00  1.58      -305.91       133.94 
            0.500     2.047  4.00  1.58      -305.91       133.94 
            2.047     6.881  2.00  1.58      -166.19       133.94 
            6.881     7.201  2.00  1.58      -166.19       133.94 
            7.201     7.250  2.00  1.58      -166.19       133.94 
            7.250     9.250  0.00  1.58         0.00       133.94 
            9.250     9.701  0.00  1.58         0.00       133.94 
            9.701    12.083  0.00  2.37         0.00       194.71 
           12.083    13.000  0.00  2.37         0.00       194.71 
           13.000    13.615  0.00  2.37         0.00       194.71 
           13.615    16.494  0.00  2.37         0.00       194.71 
           16.494    16.750  0.00  1.58         0.00       133.94 
           16.750    18.500  0.00  1.58         0.00       133.94 
           18.500    18.994  2.00  1.58      -166.19       133.94 
           18.994    19.025  2.00  1.58      -166.19       133.94 
           19.025    23.911  2.00  1.58      -166.19       133.94 
           23.911    25.500  4.00  1.58      -305.91       133.94 
           25.500    26.000  4.00  1.58      -305.91       133.94 
 
      3     0.000     0.500  4.00  1.58      -305.91       133.94 
            0.500     2.094  4.00  1.58      -305.91       133.94 
            2.094     6.910  2.00  1.58      -166.19       133.94 
            6.910     6.989  2.00  1.58      -166.19       133.94 
            6.989     7.500  2.00  1.58      -166.19       133.94 
            7.500     9.250  0.00  1.58         0.00       133.94 
            9.250     9.460  0.00  1.58         0.00       133.94 
            9.460    12.395  0.00  2.37         0.00       194.71 
           12.395    13.000  0.00  2.37         0.00       194.71 
           13.000    13.605  0.00  2.37         0.00       194.71 
           13.605    16.540  0.00  2.37         0.00       194.71 
           16.540    16.750  0.00  1.58         0.00       133.94 
           16.750    18.500  0.00  1.58         0.00       133.94 
           18.500    19.011  2.00  1.58      -166.19       133.94 
           19.011    19.090  2.00  1.58      -166.19       133.94 
           19.090    23.906  2.00  1.58      -166.19       133.94 
           23.906    25.500  4.00  1.58      -305.91       133.94 
           25.500    26.000  4.00  1.58      -305.91       133.94 
 
      4     0.000     0.500  4.00  1.58      -305.91       133.94 
            0.500     2.089  4.00  1.58      -305.91       133.94 
            2.089     6.975  2.00  1.58      -166.19       133.94 
            6.975     7.006  2.00  1.58      -166.19       133.94 
            7.006     7.500  2.00  1.58      -166.19       133.94 
            7.500     9.250  0.00  1.58         0.00       133.94 
            9.250     9.506  0.00  1.58         0.00       133.94 
            9.506    12.385  0.00  2.37         0.00       194.71 
           12.385    13.000  0.00  2.37         0.00       194.71 
           13.000    13.917  0.00  2.37         0.00       194.71 
           13.917    16.299  0.00  2.37         0.00       194.71 
           16.299    16.750  0.00  1.58         0.00       133.94 
           16.750    18.750  0.00  1.58         0.00       133.94 
           18.750    18.799  2.00  1.58      -166.19       133.94 
           18.799    19.119  2.00  1.58      -166.19       133.94 
           19.119    23.953  2.00  1.58      -166.19       133.94 
           23.953    25.500  4.00  1.58      -305.91       133.94 
           25.500    26.000  4.00  1.58      -305.91       133.94 
 
      5     0.000     0.500  4.00  1.58      -305.91       133.94 
            0.500     1.985  4.00  1.58      -305.91       133.94 
            1.985     6.723  2.00  1.58      -166.19       133.94 
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            6.723     7.014  2.00  1.58      -166.19       133.94 
            7.014     7.500  2.00  1.58      -166.19       133.94 
            7.500     8.550  0.00  1.58         0.00       133.94 
            8.550     9.480  0.00  1.58         0.00       133.94 
            9.480    12.000  0.00  2.37         0.00       194.71 
           12.000    12.239  0.00  2.37         0.00       194.71 
           12.239    15.450  0.00  2.37         0.00       194.71 
           15.450    15.910  0.00  2.37         0.00       194.71 
           15.910    15.956  0.00  2.37         0.00       194.71 
           15.956    18.422  0.00  1.58         0.00       133.94 
           18.422    18.489  0.00  1.58         0.00       133.94 
           18.489    18.899  1.00  1.58       -86.40       133.94 
           18.899    21.479  1.00  1.58       -86.40       133.94 
           21.479    23.500  2.00  1.58      -166.19       133.94 
           23.500    24.000  2.00  1.58      -166.19       133.94 
 
Longitudinal Beam Shear Reinforcement Required: 
=============================================== 
   Units: d (in), Start, End, Xu (ft), PhiVc, Vu (kip), Av/s (in^2/in)  
   Span        d    PhiVc    Start      End       Vu       Xu     Av/s 
   ---- -------- -------- -------- -------- -------- -------- -------- 
      1    19.94    22.70    2.161    4.972    43.81    2.161   0.0235 
                             4.972    7.783    30.31    4.972   0.0100 
                             7.783   10.594    16.80    7.783   0.0100 
                            10.594   13.406    13.20   13.406   0.0100 
                            13.406   16.217    26.70   16.217   0.0100 
                            16.217   19.028    40.20   19.028   0.0195 
                            19.028   21.839    53.70   21.839   0.0346 
 
      2    19.94    22.70    2.161    5.258    54.33    2.161   0.0353 
                             5.258    8.355    39.45    5.258   0.0187 
                             8.355   11.452    24.58    8.355   0.0100 
                            11.452   14.548     9.78   14.548   0.0000 
                            14.548   17.645    24.65   17.645   0.0100 
                            17.645   20.742    39.52   20.742   0.0188 
                            20.742   23.839    54.40   23.839   0.0353 
 
      3    19.94    22.70    2.161    5.258    54.49    2.161   0.0354 
                             5.258    8.355    39.61    5.258   0.0189 
                             8.355   11.452    24.74    8.355   0.0100 
                            11.452   14.548     9.87   14.548   0.0000 
                            14.548   17.645    24.74   17.645   0.0100 
                            17.645   20.742    39.61   20.742   0.0189 
                            20.742   23.839    54.49   23.839   0.0354 
 
      4    19.94    22.70    2.161    5.258    54.40    2.161   0.0353 
                             5.258    8.355    39.52    5.258   0.0188 
                             8.355   11.452    24.65    8.355   0.0100 
                            11.452   14.548     9.78   11.452   0.0000 
                            14.548   17.645    24.58   17.645   0.0100 
                            17.645   20.742    39.45   20.742   0.0187 
                            20.742   23.839    54.33   23.839   0.0353 
 
      5    19.94    22.70    2.161    4.972    53.70    2.161   0.0346 
                             4.972    7.783    40.20    4.972   0.0195 
                             7.783   10.594    26.70    7.783   0.0100 
                            10.594   13.406    13.20   10.594   0.0100 
                            13.406   16.217    16.80   16.217   0.0100 
                            16.217   19.028    30.31   19.028   0.0100 
                            19.028   21.839    43.81   21.839   0.0235 
 
 
Longitudinal Beam Shear Reinforcement Details: 
============================================== 
   Units: spacing & distance (in). 
   Span Size Stirrups (2 legs each unless otherwise noted) 
   ---- ---- --------------------------------------------- 
      1   #3 6 @ 8.4 + 17 @ 9.9 + 10 @ 5.6  
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      2   #3 10 @ 5.4 + 9 @ 9.3 + <-- 37.2 --> + 8 @ 9.3 + 11 @ 5.4  
      3   #3 10 @ 5.4 + 9 @ 9.3 + <-- 37.2 --> + 8 @ 9.3 + 11 @ 5.4  
      4   #3 10 @ 5.4 + 9 @ 9.3 + <-- 37.2 --> + 8 @ 9.3 + 11 @ 5.4  
      5   #3 9 @ 5.6 + 17 @ 9.9 + 7 @ 8.4  
 
Beam Shear Capacity: 
==================== 
   Units: d, Sp (in), Start, End, Xu (ft), PhiVc, PhiVn, Vu (kip), Av/s (in^2/in)  
   Span        d    PhiVc    Start      End     Av/s       Sp    PhiVn       Vu       Xu 
   ---- -------- -------- -------- -------- -------- -------- -------- -------- -------- 
      1    19.94    22.70    0.000    0.750    -----    -----    46.07    54.19    0.000 
                             0.750    4.972   0.0261      8.4    46.07    43.81    2.161 
                             4.972   19.028   0.0222      9.9    42.59    40.20   19.028 
                            19.028   23.250   0.0391      5.6    57.75    53.70   21.839 
                            23.250   24.000    -----    -----    57.75    64.08   24.000 
 
      2    19.94    22.70    0.000    0.750    -----    -----    59.18    64.71    0.000 
                             0.750    5.258   0.0407      5.4    59.18    54.33    2.161 
                             5.258   11.452   0.0237      9.3    43.94    39.45    5.258 
                            11.452   14.548    -----    -----    11.35     9.78   14.548 
                            14.548   20.742   0.0237      9.3    43.94    39.52   20.742 
                            20.742   25.250   0.0407      5.4    59.18    54.40   23.839 
                            25.250   26.000    -----    -----    59.18    64.78   26.000 
 
      3    19.94    22.70    0.000    0.750    -----    -----    59.18    64.87    0.000 
                             0.750    5.258   0.0407      5.4    59.18    54.49    2.161 
                             5.258   11.452   0.0237      9.3    43.94    39.61    5.258 
                            11.452   14.548    -----    -----    11.35     9.87   14.548 
                            14.548   20.742   0.0237      9.3    43.94    39.61   20.742 
                            20.742   25.250   0.0407      5.4    59.18    54.49   23.839 
                            25.250   26.000    -----    -----    59.18    64.87   26.000 
 
      4    19.94    22.70    0.000    0.750    -----    -----    59.18    64.78    0.000 
                             0.750    5.258   0.0407      5.4    59.18    54.40    2.161 
                             5.258   11.452   0.0237      9.3    43.94    39.52    5.258 
                            11.452   14.548    -----    -----    11.35     9.78   11.452 
                            14.548   20.742   0.0237      9.3    43.94    39.45   20.742 
                            20.742   25.250   0.0407      5.4    59.18    54.33   23.839 
                            25.250   26.000    -----    -----    59.18    64.71   26.000 
 
      5    19.94    22.70    0.000    0.750    -----    -----    57.75    64.08    0.000 
                             0.750    4.972   0.0391      5.6    57.75    53.70    2.161 
                             4.972   19.028   0.0222      9.9    42.59    40.20    4.972 
                            19.028   23.250   0.0261      8.4    46.07    43.81   21.839 
                            23.250   24.000    -----    -----    46.07    54.19   24.000 
 
 
Slab Shear Capacity: 
==================== 
   Units: b, d (in), Xu (ft), PhiVc, Vu(kip) 
   Span        b        d   Vratio        PhiVc           Vu           Xu 
   ---- -------- -------- -------- ------------ ------------ ------------ 
      1 --- Not checked --- 
      2 --- Not checked --- 
      3 --- Not checked --- 
      4 --- Not checked --- 
      5 --- Not checked --- 
 
Maximum Deflections: 
==================== 
   Units: Dz (in) 
   Span Dz(DEAD) Dz(LIVE) Dz(TOTAL) 
   ---- -------- -------- --------- 
      1   -0.276   -0.273    -0.549 
      2   -0.268   -0.239    -0.506 
      3   -0.269   -0.238    -0.507 
      4   -0.268   -0.239    -0.506 
      5   -0.276   -0.273    -0.549 



 

Examples  6-73 

  
Material Takeoff: 
================= 
   Reinforcement in the Direction of Analysis 
   ------------------------------------------ 
   Top Bars:      1132.4 lb   <=>   8.99 lb/ft   <=>   8.987 lb/ft^2 
   Bottom Bars:    829.3 lb   <=>   6.58 lb/ft   <=>   6.581 lb/ft^2 
   Stirrups:       947.5 lb   <=>   7.52 lb/ft   <=>   7.520 lb/ft^2 
   Total Steel:   2909.2 lb   <=>  23.09 lb/ft   <=>  23.089 lb/ft^2 
   Concrete:       178.5 ft^3 <=>   1.42 ft^3/ft <=>   1.417 ft^3/ft^2 
  
  
 
============================================================================================= 
[3] COLUMN AXIAL FORCES AND MOMENTS 
============================================================================================= 
  
   Units: P (kip), M (k-ft) 
   Supp Case/Patt     P (axial)      Mb[top]   Ma[bottom] 
   ---- ---------- ------------ ------------ ------------ 
      1 SELF               2.95        -3.76        -3.76 
        Dead              17.68       -22.50       -22.50 
        Live/All          16.74       -21.31       -21.31 
        Live/Odd          18.40       -26.10       -26.10 
        Live/Even         -1.66         4.80         4.80 
        Live/S1           18.15       -25.38       -25.38 
        Live/S2           16.52       -20.69       -20.69 
        Live/S3           -1.38         3.99         3.99 
        Live/S4            0.21        -0.60        -0.60 
        Live/S5           -0.03         0.09         0.09 
        Live/S6            0.00        -0.01        -0.01 
 
      2 SELF               7.23         0.12         0.12 
        Dead              43.33         0.74         0.74 
        Live/All          41.03         0.70         0.70 
        Live/Odd          18.84        22.75        22.75 
        Live/Even         22.19       -22.05       -22.05 
        Live/S1           20.65        19.45        19.45 
        Live/S2           42.57        -2.11        -2.11 
        Live/S3           20.15       -18.33       -18.33 
        Live/S4           -1.50         2.75         2.75 
        Live/S5            0.23        -0.42        -0.42 
        Live/S6           -0.04         0.06         0.06 
 
      3 SELF               7.14        -0.02        -0.02 
        Dead              42.78        -0.13        -0.13 
        Live/All          40.51        -0.12        -0.12 
        Live/Odd          20.48       -25.18       -25.18 
        Live/Even         20.03        25.06        25.06 
        Live/S1           -1.56        -2.92        -2.92 
        Live/S2           20.22        18.87        18.87 
        Live/S3           43.58        -0.03        -0.03 
        Live/S4           20.06       -18.55       -18.55 
        Live/S5           -1.51         2.83         2.83 
        Live/S6            0.23        -0.44        -0.44 
 
      4 SELF               7.14         0.02         0.02 
        Dead              42.78         0.13         0.13 
        Live/All          40.51         0.12         0.12 
        Live/Odd          20.48        25.18        25.18 
        Live/Even         20.03       -25.06       -25.06 
        Live/S1            0.23         0.44         0.44 
        Live/S2           -1.51        -2.83        -2.83 
        Live/S3           20.06        18.55        18.55 
        Live/S4           43.58         0.03         0.03 
        Live/S5           20.22       -18.87       -18.87 
        Live/S6           -1.56         2.92         2.92 
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      5 SELF               7.23        -0.12        -0.12 
        Dead              43.33        -0.74        -0.74 
        Live/All          41.03        -0.70        -0.70 
        Live/Odd          18.84       -22.75       -22.75 
        Live/Even         22.19        22.05        22.05 
        Live/S1           -0.04        -0.06        -0.06 
        Live/S2            0.23         0.42         0.42 
        Live/S3           -1.50        -2.75        -2.75 
        Live/S4           20.15        18.33        18.33 
        Live/S5           42.57         2.11         2.11 
        Live/S6           20.65       -19.45       -19.45 
 
      6 SELF               2.95         3.76         3.76 
        Dead              17.68        22.50        22.50 
        Live/All          16.74        21.31        21.31 
        Live/Odd          18.40        26.10        26.10 
        Live/Even         -1.66        -4.80        -4.80 
        Live/S1            0.00         0.01         0.01 
        Live/S2           -0.03        -0.09        -0.09 
        Live/S3            0.21         0.60         0.60 
        Live/S4           -1.38        -3.99        -3.99 
        Live/S5           16.52        20.69        20.69 
        Live/S6           18.15        25.38        25.38 
 
   Sum  SELF              34.65         0.00         0.00 
        Dead             207.59         0.00         0.00 
        Live/All         196.56         0.00         0.00 
        Live/Odd         115.44         0.00         0.00 
        Live/Even         81.12        -0.00        -0.00 
        Live/S1           37.44        -8.47        -8.47 
        Live/S2           78.00        -6.44        -6.44 
        Live/S3           81.12         2.03         2.03 
        Live/S4           81.12        -2.03        -2.03 
        Live/S5           78.00         6.44         6.44 
        Live/S6           37.44         8.47         8.47 
  
 
============================================================================================= 
[6] SEGMENTAL MOMENT AND SHEAR - ENVELOPES 
============================================================================================= 
  
   Span   x (ft)    M- (k-ft) Comb    M+ (k-ft) Comb     V- (kip) Comb     V+ (kip) Comb 
   ---- -------- ------------ ---- ------------ ---- ------------ ---- ------------ ---- 
      1    0.000      -146.54 U1           0.00 U1           0.00 U1          54.19 U1   
           0.250      -133.14 U1           0.00 U1           0.00 U1          52.99 U1   
           0.500      -120.04 U1           0.00 U1           0.00 U1          51.79 U1   
           0.500      -120.04 U1           0.00 U1           0.00 U1          51.79 U1   
           0.750      -107.25 U1           0.00 U1           0.00 U1          50.59 U1   
           1.000       -94.75 U1           0.00 U1           0.00 U1          49.38 U1   
           1.250       -82.56 U1           0.00 U1           0.00 U1          48.18 U1   
           1.500       -70.66 U1           0.00 U1           0.00 U1          46.98 U1   
           1.750       -59.06 U1           0.00 U1           0.00 U1          45.78 U1   
           2.000       -47.77 U1           0.00 U1           0.00 U1          44.58 U1   
           2.250       -36.77 U1           0.00 U1           0.00 U1          43.38 U1   
           2.500       -26.08 U1           0.36 U1           0.00 U1          42.18 U1   
           2.750       -15.68 U1           4.37 U1           0.00 U1          40.98 U1   
           3.000        -5.59 U1           8.23 U1           0.00 U1          39.78 U1   
           3.250         0.00 U1          11.95 U1           0.00 U1          38.58 U1   
           3.500         0.00 U1          20.52 U1           0.00 U1          37.38 U1   
           3.750         0.00 U1          28.97 U1           0.00 U1          36.18 U1   
           4.000         0.00 U1          37.11 U1           0.00 U1          34.98 U1   
           4.250         0.00 U1          44.95 U1           0.00 U1          33.77 U1   
           4.500         0.00 U1          52.50 U1           0.00 U1          32.57 U1   
           4.750         0.00 U1          59.74 U1           0.00 U1          31.37 U1   
           5.000         0.00 U1          66.69 U1           0.00 U1          30.17 U1   
           5.250         0.00 U1          73.33 U1           0.00 U1          28.97 U1   
           5.500         0.00 U1          79.68 U1           0.00 U1          27.77 U1   
           5.750         0.00 U1          85.72 U1           0.00 U1          26.57 U1   
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           6.000         0.00 U1          92.13 U1           0.00 U1          25.37 U1   
           6.250         0.00 U1          98.33 U1           0.00 U1          24.17 U1   
           6.500         0.00 U1         104.22 U1           0.00 U1          22.97 U1   
           6.750         0.00 U1         109.81 U1           0.00 U1          21.77 U1   
           7.000         0.00 U1         115.10 U1           0.00 U1          20.57 U1   
           7.250         0.00 U1         120.09 U1           0.00 U1          19.37 U1   
           7.500         0.00 U1         124.78 U1           0.00 U1          18.16 U1   
           7.750         0.00 U1         129.18 U1           0.00 U1          16.96 U1   
           8.000         0.00 U1         133.27 U1           0.00 U1          15.76 U1   
           8.250         0.00 U1         137.06 U1           0.00 U1          14.56 U1   
           8.500         0.00 U1         140.55 U1           0.00 U1          13.36 U1   
           8.750         0.00 U1         143.74 U1           0.00 U1          12.16 U1   
           9.000         0.00 U1         146.63 U1           0.00 U1          10.96 U1   
           9.250         0.00 U1         149.22 U1           0.00 U1           9.76 U1   
           9.500         0.00 U1         151.51 U1           0.00 U1           8.56 U1   
           9.750         0.00 U1         153.50 U1          -0.40 U1           7.36 U1   
          10.000         0.00 U1         155.19 U1          -0.98 U1           6.16 U1   
          10.250         0.00 U1         156.58 U1          -1.55 U1           4.96 U1   
          10.500         0.00 U1         157.67 U1          -2.13 U1           3.76 U1   
          10.750         0.00 U1         158.45 U1          -2.71 U1           2.56 U1   
          11.000         0.00 U1         158.94 U1          -3.28 U1           1.35 U1   
          11.250         0.00 U1         159.13 U1          -3.86 U1           0.15 U1   
          11.500         0.00 U1         159.02 U1          -4.44 U1           0.00 U1   
          11.750         0.00 U1         158.61 U1          -5.24 U1           0.00 U1   
          12.000         0.00 U1         157.90 U1          -6.44 U1           0.00 U1   
          12.250         0.00 U1         156.88 U1          -7.65 U1           0.00 U1   
          12.500         0.00 U1         155.57 U1          -8.85 U1           0.00 U1   
          12.750         0.00 U1         153.96 U1         -10.05 U1           0.00 U1   
          13.000         0.00 U1         152.05 U1         -11.25 U1           0.00 U1   
          13.250         0.00 U1         149.83 U1         -12.45 U1           0.00 U1   
          13.500         0.00 U1         147.32 U1         -13.65 U1           0.00 U1   
          13.750         0.00 U1         144.51 U1         -14.85 U1           0.00 U1   
          14.000         0.00 U1         141.39 U1         -16.05 U1           0.00 U1   
          14.250         0.00 U1         137.98 U1         -17.25 U1           0.00 U1   
          14.500         0.00 U1         134.27 U1         -18.45 U1           0.00 U1   
          14.750         0.00 U1         130.25 U1         -19.65 U1           0.00 U1   
          15.000         0.00 U1         125.94 U1         -20.85 U1           0.00 U1   
          15.250         0.00 U1         121.32 U1         -22.05 U1           0.00 U1   
          15.500         0.00 U1         116.41 U1         -23.26 U1           0.00 U1   
          15.750         0.00 U1         111.19 U1         -24.46 U1           0.00 U1   
          16.000         0.00 U1         105.68 U1         -25.66 U1           0.00 U1   
          16.250         0.00 U1          99.86 U1         -26.86 U1           0.00 U1   
          16.500         0.00 U1          93.75 U1         -28.06 U1           0.00 U1   
          16.750        -1.21 U1          87.33 U1         -29.26 U1           0.00 U1   
          17.000        -5.42 U1          80.62 U1         -30.46 U1           0.00 U1   
          17.250        -9.77 U1          73.60 U1         -31.66 U1           0.00 U1   
          17.500       -14.27 U1          66.28 U1         -32.86 U1           0.00 U1   
          17.750       -18.91 U1          58.67 U1         -34.06 U1           0.00 U1   
          18.000       -23.70 U1          50.75 U1         -35.26 U1           0.00 U1   
          18.250       -28.63 U1          42.53 U1         -36.46 U1           0.00 U1   
          18.500       -33.70 U1          34.02 U1         -37.66 U1           0.00 U1   
          18.750       -38.92 U1          25.20 U1         -38.86 U1           0.00 U1   
          19.000       -44.28 U1          16.08 U1         -40.07 U1           0.00 U1   
          19.250       -49.79 U1           6.67 U1         -41.27 U1           0.00 U1   
          19.500       -55.44 U1           0.00 U1         -42.47 U1           0.00 U1   
          19.750       -61.23 U1           0.00 U1         -43.67 U1           0.00 U1   
          20.000       -67.17 U1           0.00 U1         -44.87 U1           0.00 U1   
          20.250       -77.37 U1           0.00 U1         -46.07 U1           0.00 U1   
          20.500       -89.04 U1           0.00 U1         -47.27 U1           0.00 U1   
          20.750      -101.01 U1           0.00 U1         -48.47 U1           0.00 U1   
          21.000      -113.27 U1           0.00 U1         -49.67 U1           0.00 U1   
          21.250      -125.84 U1           0.00 U1         -50.87 U1           0.00 U1   
          21.500      -138.71 U1           0.00 U1         -52.07 U1           0.00 U1   
          21.750      -151.88 U1           0.00 U1         -53.27 U1           0.00 U1   
          22.000      -165.35 U1           0.00 U1         -54.47 U1           0.00 U1   
          22.250      -179.11 U1           0.00 U1         -55.68 U1           0.00 U1   
          22.500      -193.18 U1           0.00 U1         -56.88 U1           0.00 U1   
          22.750      -207.55 U1           0.00 U1         -58.08 U1           0.00 U1   



 

6-76  Examples 

          23.000      -222.22 U1           0.00 U1         -59.28 U1           0.00 U1   
          23.250      -237.19 U1           0.00 U1         -60.48 U1           0.00 U1   
          23.500      -252.46 U1           0.00 U1         -61.68 U1           0.00 U1   
          23.500      -252.46 U1           0.00 U1         -61.68 U1           0.00 U1   
          23.750      -268.03 U1           0.00 U1         -62.88 U1           0.00 U1   
          24.000      -283.90 U1           0.00 U1         -64.08 U1           0.00 U1   
============================================================================================= 
[7] SEGMENTAL DEFLECTIONS 
============================================================================================= 
  
   Units: x (ft), Dz (in) 
   Span        x    Dz (DEAD)    Dz (LIVE)   Dz (TOTAL) 
   ---- -------- ------------ ------------ ------------ 
      1    0.000       -0.000       -0.000       -0.000 
           0.250       -0.006       -0.006       -0.012 
           0.500       -0.013       -0.012       -0.025 
           0.500       -0.013       -0.012       -0.025 
           0.750       -0.020       -0.018       -0.038 
           1.000       -0.027       -0.025       -0.052 
           1.250       -0.035       -0.032       -0.067 
           1.500       -0.043       -0.039       -0.082 
           1.750       -0.051       -0.047       -0.098 
           2.000       -0.060       -0.055       -0.115 
           2.250       -0.068       -0.063       -0.131 
           2.500       -0.077       -0.071       -0.148 
           2.750       -0.085       -0.080       -0.165 
           3.000       -0.094       -0.088       -0.183 
           3.250       -0.103       -0.097       -0.200 
           3.500       -0.112       -0.106       -0.218 
           3.750       -0.121       -0.115       -0.235 
           4.000       -0.129       -0.123       -0.253 
           4.250       -0.138       -0.132       -0.270 
           4.500       -0.147       -0.140       -0.287 
           4.750       -0.155       -0.149       -0.304 
           5.000       -0.164       -0.157       -0.321 
           5.250       -0.172       -0.166       -0.337 
           5.500       -0.180       -0.174       -0.353 
           5.750       -0.188       -0.181       -0.369 
           6.000       -0.195       -0.189       -0.384 
           6.250       -0.202       -0.196       -0.399 
           6.500       -0.209       -0.204       -0.413 
           6.750       -0.216       -0.211       -0.427 
           7.000       -0.223       -0.217       -0.440 
           7.250       -0.229       -0.223       -0.452 
           7.500       -0.235       -0.229       -0.464 
           7.750       -0.240       -0.235       -0.475 
           8.000       -0.245       -0.240       -0.486 
           8.250       -0.250       -0.245       -0.495 
           8.500       -0.254       -0.250       -0.504 
           8.750       -0.258       -0.254       -0.512 
           9.000       -0.262       -0.258       -0.520 
           9.250       -0.265       -0.261       -0.526 
           9.500       -0.268       -0.264       -0.532 
           9.750       -0.270       -0.267       -0.537 
          10.000       -0.272       -0.269       -0.541 
          10.250       -0.274       -0.271       -0.545 
          10.500       -0.275       -0.272       -0.547 
          10.750       -0.276       -0.273       -0.549 
          11.000       -0.276       -0.273       -0.549 
          11.250       -0.276       -0.273       -0.549 
          11.500       -0.275       -0.273       -0.548 
          11.750       -0.275       -0.272       -0.547 
          12.000       -0.273       -0.271       -0.544 
          12.250       -0.271       -0.269       -0.541 
          12.500       -0.269       -0.267       -0.536 
          12.750       -0.267       -0.265       -0.531 
          13.000       -0.264       -0.262       -0.525 
          13.250       -0.260       -0.258       -0.518 
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          13.500       -0.256       -0.255       -0.511 
          13.750       -0.252       -0.250       -0.503 
          14.000       -0.248       -0.246       -0.494 
          14.250       -0.243       -0.241       -0.484 
          14.500       -0.238       -0.236       -0.474 
          14.750       -0.232       -0.230       -0.463 
          15.000       -0.226       -0.225       -0.451 
          15.250       -0.220       -0.218       -0.439 
          15.500       -0.214       -0.212       -0.426 
          15.750       -0.207       -0.205       -0.412 
          16.000       -0.200       -0.198       -0.398 
          16.250       -0.193       -0.191       -0.384 
          16.500       -0.185       -0.184       -0.369 
          16.750       -0.178       -0.176       -0.354 
          17.000       -0.170       -0.168       -0.339 
          17.250       -0.162       -0.160       -0.323 
          17.500       -0.154       -0.152       -0.307 
          17.750       -0.146       -0.144       -0.290 
          18.000       -0.138       -0.136       -0.274 
          18.250       -0.130       -0.128       -0.257 
          18.500       -0.122       -0.119       -0.241 
          18.750       -0.113       -0.111       -0.224 
          19.000       -0.105       -0.103       -0.208 
          19.250       -0.097       -0.095       -0.192 
          19.500       -0.089       -0.087       -0.175 
          19.750       -0.081       -0.079       -0.160 
          20.000       -0.073       -0.071       -0.144 
          20.250       -0.066       -0.063       -0.129 
          20.500       -0.058       -0.056       -0.114 
          20.750       -0.051       -0.049       -0.100 
          21.000       -0.044       -0.042       -0.086 
          21.250       -0.038       -0.036       -0.074 
          21.500       -0.032       -0.030       -0.062 
          21.750       -0.026       -0.024       -0.050 
          22.000       -0.021       -0.019       -0.040 
          22.250       -0.016       -0.014       -0.031 
          22.500       -0.012       -0.010       -0.022 
          22.750       -0.008       -0.007       -0.015 
          23.000       -0.005       -0.004       -0.010 
          23.250       -0.003       -0.002       -0.005 
          23.500       -0.001       -0.001       -0.002 
          23.500       -0.001       -0.001       -0.002 
          23.750       -0.000       -0.000       -0.001 
          24.000       -0.000       -0.000       -0.000 
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Graphical Output 

Loads 

pcaBeam v1.50. Licenced to: pcaStructurePoint. Licence ID: 00000-0000000-4-238E7-238E7

File: C:\Data\pcaBeam\Hassoun Ex 16.1.slb

Project: Example 16.1 Hassoun and Al-Manaseer

Frame: Structural Concrete Engineer: pcaStructurePoint

CASE: SELF

CASE: Dead

CASE: Live

62.5 62.5 62.5 62.5 62.5

212.5 212.5 212.5 212.5 212.5

1647.5 1647.5 1647.5 1647.5 1647.5

1560 1560 1560 1560 1560
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Internal Forces 

pcaBeam v1.50. Licenced to: pcaStructurePoint. Licence ID: 00000-0000000-4-238E7-238E7

File: C:\Data\pcaBeam\Hassoun Ex 16.1.slb

Project: Example 16.1 Hassoun and Al-Manaseer

Frame: Structural Concrete Engineer: pcaStructurePoint

M
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am
 - 
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ft

-300.0

300.0
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he
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-70.0

LEGEND:
 Envelope

-146.54

-283.90

159.13

-288.58 -291.00

161.64

-291.47 -291.47

164.05

-291.00 -288.58

161.64

-283.90

-146.54

159.13

54.19

-64.08

64.71

-64.78

64.87

-64.87

64.78

-64.71

64.08

-54.19
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Moment Capacity 
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pcaBeam v1.50. Licenced to: pcaStructurePoint. Licence ID: 00000-0000000-4-238E7-238E7

File: C:\Data\pcaBeam\Hassoun Ex 16.1.slb

Project: Example 16.1 Hassoun and Al-Manaseer

Frame: Structural Concrete Engineer: pcaStructurePoint

M
om

en
t C

ap
ac

ity
 - 

k-
ft

-350.0

350.0

LEGEND:
 Envelope Curve
 Capacity Curve
 Support Centerline
 Face of Support
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Shear Capacity 

pcaBeam v1.50. Licenced to: pcaStructurePoint. Licence ID: 00000-0000000-4-238E7-238E7

File: C:\Data\pcaBeam\Hassoun Ex 16.1.slb

Project: Example 16.1 Hassoun and Al-Manaseer

Frame: Structural Concrete Engineer: pcaStructurePoint

B
ea

m
 S

he
ar

 C
ap

ac
ity

 - 
ki

p

70.0

-70.0

LEGEND:
 Envelope Curve
 Capacity Curve
 Support Centerline
 Face of Support
 Critical Section

 43.81

-53.70 

 54.33

-54.40 

 54.49

-54.49 

 54.40

-54.33 

 53.70

-43.81 
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Deflection 

pcaBeam v1.50. Licenced to: pcaStructurePoint. Licence ID: 00000-0000000-4-238E7-238E7

File: C:\Data\pcaBeam\Hassoun Ex 16.1.slb

Project: Example 16.1 Hassoun and Al-Manaseer

Frame: Structural Concrete Engineer: pcaStructurePoint

D
ef

le
ct

io
n 

D
ia

gr
am

 - 
in

0.549

-0.549

LEGEND:
 Dead Load
 Live Load
 Total Deflection
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Flexural Rebar 

pcaBeam v1.50. Licenced to: pcaStructurePoint. Licence ID: 00000-0000000-4-238E7-238E7

File: C:\Data\pcaBeam\Hassoun Ex 16.1.slb

Project: Example 16.1 Hassoun and Al-Manaseer

Frame: Structural Concrete Engineer: pcaStructurePoint
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Transverse Rebar 

pcaBeam v1.50. Licenced to: pcaStructurePoint. Licence ID: 00000-0000000-4-238E7-238E7

File: C:\Data\pcaBeam\Hassoun Ex 16.1.slb

Project: Example 16.1 Hassoun and Al-Manaseer

Frame: Structural Concrete Engineer: pcaStructurePoint

Transverse Rebars
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Example 4 Flat Plate Floor System  

Problem description 
An office building is planned using a flat plate floor system with the column 
layout as shown in figure below. No beams, drop panels, or column capitals are 
permitted. Specified live load is 100 psf and dead load will include the weight of 
the slab plus an allowance of 20 psf for finish floor plus suspended loads. The 
columns will be 18 in. square, and the floor-to-floor height of the structure will be 
12 ft. The slab thickness will be 8.5 in. according to ACI Code. Design the interior 
panel C, using material strengths fy = 60,000 psi and f’c = 4000 psi. Straight-bar 
reinforcement will be used. This example refers to Example 13-3 from Design of 
Concrete Structures by Nilson, Darwin, and Dolan, Thirteenth Edition, 2004  

22'-0"22'-0"22'-0"9"

22'-0"

22'-0"

22'-0"

9"

9"

9"

All columns 18" × 18"

A B

B C
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Program Input 
1. From the Input menu, select General Information. A dialog box appears.  

• In the LABELS section, input the names of the project, frame, and 
engineer.  

• In the FRAME section, input 4 for NO OF SUPPORTS.  

• In the FLOOR SYSTEM section, click the radial button next to TWO-WAY.  

• Leave all other options in the General Information tab to their default 
settings of ACI 318-02 design code, ASTM A615 reinforcement, and 
DESIGN run mode option.  

 
2. Nothing needs to be changed in the Material Properties menu.  

 



 

6-88  Examples 

 
3. From the Input menu, select Spans. A dialog box appears. 

• Under the Slabs/Flanges tab, input 22 for LENGTH, 8.5 for THICKNESS, 
and 11 for WIDTH LEFT and WIDTH RIGHT. Press MODIFY.  

• Press COPY. Press the CHECK ALL button. Press OK. 

• Press OK again. 

 
4. From the Input menu, select Supports. A dialog box appears. 

• Under the Columns tab, input 12 for the HEIGHT in both the ABOVE and 
BELOW rows. 
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• Input 18 for both the C1 and C2 values in both the ABOVE and BELOW 
rows. Press MODIFY.  

• Press COPY. Press the CHECK ALL button. Press OK.  

• Press OK again. 

 
5. From the Input menu, select Reinforcement Criteria.  

• Use the drop down arrow next to MAX BAR SIZE for both TOP BARS and 
BOTTOM BARS to select #6 bars.  

• Press OK.  
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6. From the Input menu, select Load Cases. A dialog box appears. 
• Since we are not considering lateral forces, click on WIND in the LABEL 

column on the list in the bottom half of the LOAD CASES dialog box and 
press the DELETE button. 

• Click on EQ in the LABEL column and press the DELETE button. Press 
OK. 

 
7. From the Input menu, select Load Combinations. A dialog box appears.  

• Delete all the load combinations by clicking anywhere on the list in the 
bottom half of the LOAD COMBINATIONS dialog box and pressing the 
DELETE button. Repeat this procedure until all the load combinations are 
gone.  

• Input 1.2 in the SELF field, 1.2 in the DEAD field, and 1.6 in the LIVE 
field. Press ADD. 

• Press OK. 
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8. From the Input menu, select Span Loads. A dialog box appears. 

• Input 20 for the MAGNITUDE. Press ADD.  

• Press COPY. Press the CHECK ALL button. Press OK. 

• In the top left corner of the SPAN LOADS dialog box, there is a section 
called CURRENT CASE. Click on LIVE. 

• Input 100 for MAGNITUDE. Press ADD. 

• Press COPY. Press the CHECK ALL button. Press OK. 

• Press OK again. 
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9. From the Solve menu, select Execute. Press CLOSE. 
10. From the Solve menu, select Results Report. 

• Use the scroll bars to scroll through the results file.  

• Use the ARROW keys or the mouse wheel to browse through different 
parts of the results quickly. Press the CLOSE button to close the RESULTS 
REPORT dialog box and return to pcaBeam. 

11. To view diagrams, select Loads, Internal Forces, Moment Capacity, Shear 
Capacity, Deflection, or Reinforcement from the View menu. Right click in 
any of these diagrams to get new copy, printing, or display options.  

12. You may print the results file by selecting Print Results from the File menu. 
To print any of the diagrams you selected to view, use the Print Preview 
command found by right clicking in the diagram’s window. After viewing the 
results, you may decide to investigate the input beams under the same loads 
but with a modified reinforcement configuration.  

13. From the Input menu, select General Information. In the General 
Information dialog box change the RUN MODE option to INVESTIGATION. Do 
not change any of the other options. Press OK 

14. From the Input menu, select the different commands under Reinforcement 
Criteria and Reinforcing Bars to modify the reinforcement configuration 
computed by the program. 

15. Repeat steps 10 and subsequent to perform the investigation and view the 
results.  
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Text Output (abbreviated) 
                         ooooooo      oooooo      ooooo               
                         oooooooo    oooooooo    ooooooo              
                         oo    oo    oo    oo    oo   oo              
                         oo    oo    oo          oo   oo              
                         oooooooo    oo          ooooooo   ooooo      
                         ooooooo     oo    oo    ooooooo   ooooo      
                         oo          oo    oo    oo   oo              
                         oo          oooooooo    oo   oo              
                         oo           oooooo     oo   oo              
  
  
                       oooooo      o                    o             
                      oooooooo    oo        ooooo      oo             
                      oo          oo       o    oo     oo             
                      oooo        oo       o    oo     oo             
                       oooooo     oo        oooooo     oooooo         
                          oooo    oo       oo   oo     oo   oo        
                            oo    oo       oo   oo     oo   oo        
                      oooooooo    oo  o    oo   oo     oo   oo        
                       oooooo      ooo      ooooo o     ooooo         
  
      =============================================================================  
                                  pcaSlab v1.50 (TM) 
               A Computer Program Analysis, Design, and Investigation of 
                 Reinforced Concrete Slab and Continuous Beam Systems 
      =============================================================================  
                  Copyright © 2000-2005, Portland Cement Association  
                                  All rights reserved  
  
             Licensee stated above acknowledges that Portland Cement Association  
         (PCA) is not and  cannot  be  responsible for  either the  accuracy  or  
         adequacy of  the material supplied  as input  for  processing   by  the  
         pcaSlab  computer program.  Furthermore, PCA neither makes any warranty  
         expressed nor implied with respect  to  the  correctness of the  output  
         prepared by the  pcaSlab   program.  Although  PCA  has  endeavored  to  
         produce pcaSlab  error free the  program is not and cannot be certified  
         infallible.  The final and only responsibility for analysis, design and  
         engineering documents is the licensees. Accordingly, PCA disclaims  all  
         responsibility in contract, negligence or other tort for any  analysis,  
         design  or engineering documents prepared in connection with the use of  
         the pcaSlab  program.  
  
  
============================================================================================= 
[1] INPUT ECHO 
============================================================================================= 
  
General Information: 
==================== 
   File name: C:\Data\pcaSlab\Nilson Example 13.3.slb 
   Project: Example 13.3 by Nilson, Darwin, and Dolan 
   Frame: Design of Concrete Structures            Engineer: pcaStructurePoint 
   Code: ACI 318-02       Mode: Design             Reinforcement Database: ASTM A615 
   Number of supports = 4 
   Floor System: Two-Way 
  
   Live load pattern ratio = 75% 
   Minimum free edge for punching shear = 10 times slab thickness 
   Deflections are based on cracked section properties. 
   In negative moment regions, Igr and Mcr DO NOT include flange/slab contribution (if available) 
   Compression reinforcement calculations NOT selected. 
  
Material Properties: 
==================== 
            Slabs|Beams       Columns 
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           ------------   ------------ 
   wc    =          150            150 lb/ft3 
   f'c   =            4              4 ksi 
   Ec    =      3834.25        3834.25 ksi 
   fr    =     0.474342       0.474342 ksi 
  
   fy    =           60 ksi, Bars are not epoxy-coated 
   fyv   =           60 ksi 
   Es    =        29000 ksi 
  
Reinforcement Database: 
=============== 
   Units: Db (in), Ab (in^2), Wb (lb/ft) 
   Size       Db      Ab        Wb    Size       Db      Ab        Wb 
   ---- -------- -------- --------    ---- -------- -------- -------- 
     #3     0.38     0.11     0.38      #4     0.50     0.20     0.67     
     #5     0.63     0.31     1.04      #6     0.75     0.44     1.50     
     #7     0.88     0.60     2.04      #8     1.00     0.79     2.67     
     #9     1.13     1.00     3.40     #10     1.27     1.27     4.30     
    #11     1.41     1.56     5.31     #14     1.69     2.25     7.65     
    #18     2.26     4.00    13.60     
  
Span Data: 
========== 
   Slabs: L1, wL, wR (ft); t, Hmin (in) 
   Span Loc        L1        t       wL       wR     Hmin 
   ---- ---- -------- -------- -------- -------- --------  
      1 Int    22.000     8.50   11.000   11.000     8.20     
      2 Int    22.000     8.50   11.000   11.000     7.45     
      3 Int    22.000     8.50   11.000   11.000     8.20     
  
Support Data: 
============= 
   Columns: c1a, c2a, c1b, c2b (in); Ha, Hb (ft) 
   Supp      c1a      c2a       Ha        c1b      c2b       Hb  Red% 
   ---- -------- -------- --------   -------- -------- --------  ---- 
      1    18.00    18.00   12.000      18.00    18.00   12.000   100  
      2    18.00    18.00   12.000      18.00    18.00   12.000   100  
      3    18.00    18.00   12.000      18.00    18.00   12.000   100  
      4    18.00    18.00   12.000      18.00    18.00   12.000   100  
  
   Boundary Conditions: Kz (kip/in); Kry (kip-in/rad) 
   Supp    Spring Kz   Spring Kry Far End A Far End B 
   ---- ------------ ------------ --------- --------- 
      1            0            0     Fixed     Fixed 
      2            0            0     Fixed     Fixed 
      3            0            0     Fixed     Fixed 
      4            0            0     Fixed     Fixed 
  
Load Data: 
========== 
   Load Cases and Combinations: 
   Case     SELF     Dead     Live  
   Type     DEAD     DEAD     LIVE  
   U1      1.200    1.200    1.600  
  
   Span Loads: 
   Span Case               Wa 
   ---- -------- ------------ 
   Area Loads - Wa (lb/ft2): 
      1 Dead               20 
      2 Dead               20 
      3 Dead               20 
      1 Live              100 
      2 Live              100 
      3 Live              100 
  
   Support Loads:   --- NONE --- 
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   Support Displacements:   --- NONE --- 
  
Reinforcement Criteria: 
======================= 
                 _____Top bars___  ___Bottom bars__  ____Stirrups____ 
                   Min      Max      Min      Max      Min      Max   
                 -------  -------  -------  -------  -------  ------- 
   Slabs and Ribs: 
     Bar Size         #5       #6       #5       #6 
     Bar spacing    1.00    18.00     1.00    18.00 in 
     Reinf ratio    0.14     5.00     0.14     5.00 % 
     Cover          1.50              1.50          in 
  
   Beams: 
     Bar Size         #5       #8       #5       #8       #3       #5 
     Bar spacing    1.00    18.00     1.00    18.00     6.00    18.00 in 
     Reinf ratio    0.14     5.00     0.14     5.00 % 
     Cover          1.50              1.50          in 
  
 
============================================================================================= 
[2] DESIGN RESULTS 
============================================================================================= 
  
Top Reinforcement: 
================== 
   Units: Width (ft), Mmax (k-ft), Xmax (ft), As (in^2), Sp (in) 
   Span Strip  Zone      Width         Mmax     Xmax    AsMin    AsMax    SpReq    AsReq    Bars 
   ---- ------ ------ -------- ------------ -------- -------- -------- -------- -------- ------- 
      1 Column Left      11.00        21.63    0.750    2.020   15.945   16.500    0.724    8-#5  *5 
               Middle    11.00         0.00   11.000    0.000   15.945    0.000    0.000     ---  
               Right     11.00       211.61   21.250    2.020   15.945    5.280    7.610   25-#5  
 
        Middle Left      11.00        -0.00    0.750    2.020   15.945   16.500    0.000    8-#5  *5 
               Middle    11.00         0.00   11.000    0.000   15.945    0.000    0.000     ---  
               Right     11.00        70.54   21.250    2.020   15.945   16.500    2.402    8-#5  
 
      2 Column Left      11.00       188.13    0.750    2.020   15.945    5.280    6.700   25-#5  
               Middle    11.00         0.17    7.925    2.020   15.945   16.500    0.006    8-#5  *5 
               Right     11.00       188.13   21.250    2.020   15.945    5.280    6.700   25-#5  
 
        Middle Left      11.00        62.71    0.750    2.020   15.945   16.500    2.129    8-#5  *5 
               Middle    11.00         0.06    7.925    2.020   15.945   16.500    0.002    8-#5  *5 
               Right     11.00        62.71   21.250    2.020   15.945   16.500    2.129    8-#5  *5 
 
      3 Column Left      11.00       211.61    0.750    2.020   15.945    5.280    7.610   25-#5  
               Middle    11.00         0.00   11.000    0.000   15.945    0.000    0.000     ---  
               Right     11.00        21.63   21.250    2.020   15.945   16.500    0.724    8-#5  *5 
 
        Middle Left      11.00        70.54    0.750    2.020   15.945   16.500    2.402    8-#5  
               Middle    11.00         0.00   11.000    0.000   15.945    0.000    0.000     ---  
               Right     11.00        -0.00   21.250    2.020   15.945   16.500    0.000    8-#5  *5 
   NOTES: 
   *5 - Number of bars governed by maximum allowable spacing. 
 
Top Bar Details: 
================ 
   Units: Length (ft) 
               _____________Left______________  ___Continuous__  _____________Right_____________ 
   Span Strip     Bars  Length    Bars  Length     Bars  Length     Bars  Length    Bars  Length 
   ---- ------ ------- ------- ------- -------  ------- -------  ------- ------- ------- ------- 
      1 Column    7-#5    7.52    1-#5    4.85      ---            13-#5    7.53   12-#5    4.85 
        Middle    8-#5    5.26     ---              ---             8-#5    7.53     ---         
 
      2 Column    9-#5    7.52    8-#5    4.85     8-#5   22.00     9-#5    7.52    8-#5    4.85 
        Middle     ---             ---             8-#5   22.00      ---             ---         
 
      3 Column   13-#5    7.53   12-#5    4.85      ---             7-#5    7.52    1-#5    4.85 
        Middle    8-#5    7.53     ---              ---             8-#5    5.26     ---         
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Bottom Reinforcement: 
===================== 
   Units: Width (ft), Mmax (k-ft), Xmax (ft), As (in^2), Sp (in)  
   Span Strip     Width         Mmax     Xmax    AsMin    AsMax    SpReq    AsReq    Bars 
   ---- ------ -------- ------------ -------- -------- -------- -------- -------- ------- 
      1 Column    11.00       132.42    9.250    2.020   15.945    8.800    4.613   15-#5  
        Middle    11.00        88.28    9.250    2.020   15.945   13.200    3.025   10-#5  
 
      2 Column    11.00        78.82   11.000    2.020   15.945   14.667    2.692    9-#5  
        Middle    11.00        52.55   11.000    2.020   15.945   16.500    1.778    8-#5  *5 
 
      3 Column    11.00       132.42   12.750    2.020   15.945    8.800    4.613   15-#5  
        Middle    11.00        88.28   12.750    2.020   15.945   13.200    3.025   10-#5  
   NOTES: 
   *5 - Number of bars governed by maximum allowable spacing. 
 
Bottom Bar Details: 
=================== 
   Units: Start (ft), Length (ft) 
                _______Long Bars_______ ______Short Bars_______ 
   Span Strip      Bars   Start  Length    Bars   Start  Length 
   ---- ------- ------- ------- ------- ------- ------- ------- 
      1 Column    15-#5    0.00   22.00     ---                 
        Middle     7-#5    0.00   22.00    3-#5    3.30   15.40 
 
      2 Column     9-#5    0.00   22.00     ---                 
        Middle     7-#5    0.00   22.00    1-#5    3.30   15.40 
 
      3 Column    15-#5    0.00   22.00     ---                 
        Middle     7-#5    0.00   22.00    3-#5    3.30   15.40 
 
Flexural Capacity: 
================== 
   Units: From, To (ft), As (in^2), PhiMn (k-ft)  
   Span Strip       From        To AsTop AsBot       PhiMn-       PhiMn+ 
   ---- ------ --------- --------- ----- ----- ------------ ------------ 
      1 Column     0.000     0.750  2.48  4.65       -72.78       133.43 
                   0.750     3.851  2.48  4.65       -72.78       133.43 
                   3.851     4.851  2.17  4.65       -63.89       133.43 
                   4.851     6.515  2.17  4.65       -63.89       133.43 
                   6.515     7.515  0.00  4.65         0.00       133.43 
                   7.515     7.925  0.00  4.65         0.00       133.43 
                   7.925    11.000  0.00  4.65         0.00       133.43 
                  11.000    14.075  0.00  4.65         0.00       133.43 
                  14.075    14.469  0.00  4.65         0.00       133.43 
                  14.469    15.633  0.00  4.65         0.00       133.43 
                  15.633    17.149  4.03  4.65      -116.39       133.43 
                  17.149    18.314  4.03  4.65      -116.39       133.43 
                  18.314    21.250  7.75  4.65      -215.16       133.43 
                  21.250    22.000  7.75  4.65      -215.16       133.43 
        Middle     0.000     0.750  2.48  2.17       -72.78        63.89 
                   0.750     3.300  2.48  2.17       -72.78        63.89 
                   3.300     4.261  2.48  2.17       -72.78        63.89 
                   4.261     4.457  0.00  2.17         0.00        63.89 
                   4.457     5.261  0.00  3.10         0.00        90.40 
                   5.261     7.925  0.00  3.10         0.00        90.40 
                   7.925    11.000  0.00  3.10         0.00        90.40 
                  11.000    14.075  0.00  3.10         0.00        90.40 
                  14.075    14.469  0.00  3.10         0.00        90.40 
                  14.469    15.617  0.00  3.10         0.00        90.40 
                  15.617    17.543  2.48  3.10       -72.78        90.40 
                  17.543    18.700  2.48  2.17       -72.78        63.89 
                  18.700    21.250  2.48  2.17       -72.78        63.89 
                  21.250    22.000  2.48  2.17       -72.78        63.89 
 
      2 Column     0.000     0.750  7.75  2.79      -215.16        81.62 
                   0.750     3.825  7.75  2.79      -215.16        81.62 
                   3.825     4.851  5.27  2.79      -150.24        81.62 
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                   4.851     6.490  5.27  2.79      -150.24        81.62 
                   6.490     7.515  2.48  2.79       -72.78        81.62 
                   7.515     7.925  2.48  2.79       -72.78        81.62 
                   7.925    11.000  2.48  2.79       -72.78        81.62 
                  11.000    14.075  2.48  2.79       -72.78        81.62 
                  14.075    14.485  2.48  2.79       -72.78        81.62 
                  14.485    15.510  2.48  2.79       -72.78        81.62 
                  15.510    17.149  5.27  2.79      -150.24        81.62 
                  17.149    18.175  5.27  2.79      -150.24        81.62 
                  18.175    21.250  7.75  2.79      -215.16        81.62 
                  21.250    22.000  7.75  2.79      -215.16        81.62 
        Middle     0.000     0.750  2.48  2.17       -72.78        63.89 
                   0.750     3.300  2.48  2.17       -72.78        63.89 
                   3.300     4.300  2.48  2.17       -72.78        63.89 
                   4.300     7.925  2.48  2.48       -72.78        72.78 
                   7.925    11.000  2.48  2.48       -72.78        72.78 
                  11.000    14.075  2.48  2.48       -72.78        72.78 
                  14.075    17.700  2.48  2.48       -72.78        72.78 
                  17.700    18.700  2.48  2.17       -72.78        63.89 
                  18.700    21.250  2.48  2.17       -72.78        63.89 
                  21.250    22.000  2.48  2.17       -72.78        63.89 
 
      3 Column     0.000     0.750  7.75  4.65      -215.16       133.43 
                   0.750     3.686  7.75  4.65      -215.16       133.43 
                   3.686     4.851  4.03  4.65      -116.39       133.43 
                   4.851     6.367  4.03  4.65      -116.39       133.43 
                   6.367     7.531  0.00  4.65         0.00       133.43 
                   7.531     7.925  0.00  4.65         0.00       133.43 
                   7.925    11.000  0.00  4.65         0.00       133.43 
                  11.000    14.075  0.00  4.65         0.00       133.43 
                  14.075    14.485  0.00  4.65         0.00       133.43 
                  14.485    15.485  0.00  4.65         0.00       133.43 
                  15.485    17.149  2.17  4.65       -63.89       133.43 
                  17.149    18.149  2.17  4.65       -63.89       133.43 
                  18.149    21.250  2.48  4.65       -72.78       133.43 
                  21.250    22.000  2.48  4.65       -72.78       133.43 
        Middle     0.000     0.750  2.48  2.17       -72.78        63.89 
                   0.750     3.300  2.48  2.17       -72.78        63.89 
                   3.300     4.457  2.48  2.17       -72.78        63.89 
                   4.457     6.383  2.48  3.10       -72.78        90.40 
                   6.383     7.531  0.00  3.10         0.00        90.40 
                   7.531     7.925  0.00  3.10         0.00        90.40 
                   7.925    11.000  0.00  3.10         0.00        90.40 
                  11.000    14.075  0.00  3.10         0.00        90.40 
                  14.075    16.739  0.00  3.10         0.00        90.40 
                  16.739    17.543  0.00  3.10         0.00        90.40 
                  17.543    17.739  0.00  2.17         0.00        63.89 
                  17.739    18.700  2.48  2.17       -72.78        63.89 
                  18.700    21.250  2.48  2.17       -72.78        63.89 
                  21.250    22.000  2.48  2.17       -72.78        63.89 
 
Slab Shear Capacity: 
==================== 
   Units: b, d (in), Xu (ft), PhiVc, Vu(kip) 
   Span        b        d   Vratio        PhiVc           Vu           Xu 
   ---- -------- -------- -------- ------------ ------------ ------------ 
      1   264.00     6.69    1.000       167.49        79.20        20.69  
      2   264.00     6.69    1.000       167.49        66.42         1.31  
      3   264.00     6.69    1.000       167.49        79.20         1.31  
 
Flexural Transfer of Negative Unbalanced Moment at Supports: 
============================================================ 
   Units: Width (in), Munb (k-ft), As (in^2) 
   Supp    Width  GammaF*Munb Comb Pat     AsReq   AsProv Additional Bars 
   ---- -------- ------------ ---- ---- -------- -------- --------------- 
      1    43.50        44.32 U1   All     1.545    0.817     3-#5  
      2    43.50        45.11 U1   Odd     1.574    2.554      ---  
      3    43.50        45.11 U1   Odd     1.574    2.554      ---  
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      4    43.50        44.32 U1   All     1.545    0.817     3-#5  
 
Punching Shear Around Columns: 
============================== 
   Units: Vu (kip), Munb (k-ft), vu (psi), Phi*vc (psi) 
   Supp           Vu       vu         Munb Comb Pat  GammaV       vu   Phi*vc 
   ---- ------------ -------- ------------ ---- ---- ------ -------- -------- 
      1        61.95    177.9        20.55 U1   All   0.320    216.4    189.7 *EXCEEDED 
      2       162.23    248.6       -40.89 U1   All   0.400    284.6    189.7 *EXCEEDED 
      3       162.23    248.6        40.89 U1   All   0.400    284.6    189.7 *EXCEEDED 
      4        61.95    189.9       -17.54 U1   All   0.320    226.0    189.7 *EXCEEDED 
 
Maximum Deflections: 
==================== 
   Units: Dz (in) 
        __________Frame____________  _______Column Strip________  ________Middle Strip_______ 
   Span Dz(DEAD) Dz(LIVE) Dz(TOTAL)  Dz(DEAD) Dz(LIVE) Dz(TOTAL)  Dz(DEAD) Dz(LIVE) Dz(TOTAL) 
   ---- -------- -------- ---------  -------- -------- ---------  -------- -------- --------- 
      1   -0.122   -0.185    -0.306    -0.180   -0.272    -0.452    -0.064   -0.097    -0.161 
      2   -0.032   -0.057    -0.089    -0.044   -0.076    -0.120    -0.021   -0.037    -0.058 
      3   -0.122   -0.185    -0.306    -0.180   -0.272    -0.452    -0.064   -0.097    -0.161 
  
Material Takeoff: 
================= 
   Reinforcement in the Direction of Analysis 
   ------------------------------------------ 
   Top Bars:      1248.2 lb   <=>  18.91 lb/ft   <=>  0.860 lb/ft^2 
   Bottom Bars:   1489.2 lb   <=>  22.56 lb/ft   <=>  1.026 lb/ft^2 
   Stirrups:         0.0 lb   <=>   0.00 lb/ft   <=>  0.000 lb/ft^2 
   Total Steel:   2737.3 lb   <=>  41.47 lb/ft   <=>  1.885 lb/ft^2 
   Concrete:      1028.5 ft^3 <=>  15.58 ft^3/ft <=>  0.708 ft^3/ft^2 
  
  
 
============================================================================================= 
[3] COLUMN AXIAL FORCES AND MOMENTS 
============================================================================================= 
  
   Units: P (kip), M (k-ft) 
   Supp Case/Patt     P (axial)      Mb[top]   Ma[bottom] 
   ---- ---------- ------------ ------------ ------------ 
      1 SELF              21.35       -11.12       -11.12 
        Dead               4.02        -2.09        -2.09 
        Live/All          20.10       -10.47       -10.47 
        Live/Odd          16.42        -9.62        -9.62 
        Live/Even         -1.35         1.77         1.77 
        Live/S1           16.11        -9.21        -9.21 
        Live/S2           14.76        -7.44        -7.44 
        Live/S3           -1.04         1.36         1.36 
        Live/S4            0.31        -0.41        -0.41 
 
      2 SELF              55.78         6.97         6.97 
        Dead              10.50         1.31         1.31 
        Live/All          52.50         6.56         6.56 
        Live/Odd          19.88        17.28        17.28 
        Live/Even         19.50       -12.36       -12.36 
        Live/S1           22.29        14.42        14.42 
        Live/S2           41.79         2.06         2.06 
        Live/S3           17.09        -9.50        -9.50 
        Live/S4           -2.41         2.86         2.86 
 
      3 SELF              55.78        -6.97        -6.97 
        Dead              10.50        -1.31        -1.31 
        Live/All          52.50        -6.56        -6.56 
        Live/Odd          19.88       -17.28       -17.28 
        Live/Even         19.50        12.36        12.36 
        Live/S1           -2.41        -2.86        -2.86 
        Live/S2           17.09         9.50         9.50 
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        Live/S3           41.79        -2.06        -2.06 
        Live/S4           22.29       -14.42       -14.42 
 
      4 SELF              21.35        11.12        11.12 
        Dead               4.02         2.09         2.09 
        Live/All          20.10        10.47        10.47 
        Live/Odd          16.42         9.62         9.62 
        Live/Even         -1.35        -1.77        -1.77 
        Live/S1            0.31         0.41         0.41 
        Live/S2           -1.04        -1.36        -1.36 
        Live/S3           14.76         7.44         7.44 
        Live/S4           16.11         9.21         9.21 
 
   Sum  SELF             154.28         0.00         0.00 
        Dead              29.04         0.00         0.00 
        Live/All         145.20         0.00         0.00 
        Live/Odd          72.60         0.00         0.00 
        Live/Even         36.30        -0.00        -0.00 
        Live/S1           36.30         2.76         2.76 
        Live/S2           72.60         2.76         2.76 
        Live/S3           72.60        -2.76        -2.76 
        Live/S4           36.30        -2.76        -2.76 
  
 
============================================================================================= 
[6] SEGMENTAL MOMENT AND SHEAR - ENVELOPES 
============================================================================================= 
  
   Span   x (ft)    M- (k-ft) Comb    M+ (k-ft) Comb     V- (kip) Comb     V+ (kip) Comb 
   ---- -------- ------------ ---- ------------ ---- ------------ ---- ------------ ---- 
      1    0.000       -65.21 U1           0.00 U1           0.00 U1          62.60 U1   
           0.250       -49.78 U1           0.00 U1           0.00 U1          60.89 U1   
           0.500       -34.88 U1           0.00 U1           0.00 U1          59.18 U1   
           0.750       -21.63 U1           0.00 U1           0.00 U1          57.46 U1   
           0.750       -21.63 U1           0.00 U1           0.00 U1          57.46 U1   
           1.000        -8.76 U1           0.56 U1           0.00 U1          55.75 U1   
           1.250         0.00 U1           7.69 U1           0.00 U1          54.04 U1   
           1.500         0.00 U1          20.98 U1           0.00 U1          52.33 U1   
           1.750         0.00 U1          33.85 U1           0.00 U1          50.61 U1   
           2.000         0.00 U1          46.29 U1           0.00 U1          48.90 U1   
           2.250         0.00 U1          58.30 U1           0.00 U1          47.19 U1   
           2.500         0.00 U1          69.88 U1           0.00 U1          45.47 U1   
           2.750         0.00 U1          81.04 U1           0.00 U1          43.76 U1   
           3.000         0.00 U1          91.76 U1           0.00 U1          42.05 U1   
           3.250         0.00 U1         102.06 U1           0.00 U1          40.33 U1   
           3.500         0.00 U1         111.93 U1           0.00 U1          38.62 U1   
           3.750         0.00 U1         121.37 U1           0.00 U1          36.91 U1   
           4.000         0.00 U1         130.38 U1           0.00 U1          35.19 U1   
           4.250         0.00 U1         138.96 U1           0.00 U1          33.48 U1   
           4.500         0.00 U1         147.12 U1           0.00 U1          31.77 U1   
           4.750         0.00 U1         154.85 U1           0.00 U1          30.05 U1   
           5.000         0.00 U1         162.15 U1           0.00 U1          28.34 U1   
           5.250         0.00 U1         169.02 U1           0.00 U1          26.63 U1   
           5.500         0.00 U1         175.46 U1           0.00 U1          24.91 U1   
           5.750         0.00 U1         181.47 U1           0.00 U1          23.20 U1   
           6.000         0.00 U1         187.06 U1           0.00 U1          21.49 U1   
           6.250         0.00 U1         192.22 U1           0.00 U1          19.77 U1   
           6.500         0.00 U1         196.95 U1           0.00 U1          18.06 U1   
           6.750         0.00 U1         201.25 U1           0.00 U1          16.41 U1   
           7.000         0.00 U1         205.12 U1           0.00 U1          14.92 U1   
           7.250         0.00 U1         208.56 U1           0.00 U1          13.42 U1   
           7.500         0.00 U1         211.58 U1           0.00 U1          11.93 U1   
           7.750         0.00 U1         214.17 U1           0.00 U1          10.44 U1   
           8.000         0.00 U1         216.33 U1           0.00 U1           8.94 U1   
           8.250         0.00 U1         218.06 U1           0.00 U1           7.45 U1   
           8.500         0.00 U1         219.36 U1          -0.04 U1           5.96 U1   
           8.750         0.00 U1         220.23 U1          -0.88 U1           4.46 U1   
           9.000         0.00 U1         220.68 U1          -1.71 U1           2.97 U1   
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           9.250         0.00 U1         220.70 U1          -2.54 U1           1.48 U1   
           9.500         0.00 U1         220.29 U1          -3.38 U1           0.00 U1   
           9.750         0.00 U1         219.45 U1          -4.21 U1           0.00 U1   
          10.000         0.00 U1         218.18 U1          -5.93 U1           0.00 U1   
          10.250         0.00 U1         216.49 U1          -7.64 U1           0.00 U1   
          10.500         0.00 U1         214.36 U1          -9.35 U1           0.00 U1   
          10.750         0.00 U1         211.81 U1         -11.07 U1           0.00 U1   
          11.000         0.00 U1         208.83 U1         -12.78 U1           0.00 U1   
          11.250         0.00 U1         205.42 U1         -14.49 U1           0.00 U1   
          11.500         0.00 U1         201.58 U1         -16.20 U1           0.00 U1   
          11.750         0.00 U1         197.32 U1         -17.92 U1           0.00 U1   
          12.000         0.00 U1         192.63 U1         -19.63 U1           0.00 U1   
          12.250         0.00 U1         187.50 U1         -21.34 U1           0.00 U1   
          12.500         0.00 U1         181.95 U1         -23.06 U1           0.00 U1   
          12.750         0.00 U1         175.97 U1         -24.77 U1           0.00 U1   
          13.000         0.00 U1         170.23 U1         -26.48 U1           0.00 U1   
          13.250         0.00 U1         164.82 U1         -28.20 U1           0.00 U1   
          13.500         0.00 U1         159.02 U1         -29.91 U1           0.00 U1   
          13.750         0.00 U1         152.86 U1         -31.62 U1           0.00 U1   
          14.000         0.00 U1         146.32 U1         -33.34 U1           0.00 U1   
          14.250         0.00 U1         139.41 U1         -35.05 U1           0.00 U1   
          14.500         0.00 U1         132.13 U1         -36.76 U1           0.00 U1   
          14.750         0.00 U1         124.47 U1         -38.48 U1           0.00 U1   
          15.000         0.00 U1         116.44 U1         -40.19 U1           0.00 U1   
          15.250         0.00 U1         108.04 U1         -41.90 U1           0.00 U1   
          15.500         0.00 U1          99.26 U1         -43.62 U1           0.00 U1   
          15.750         0.00 U1          90.11 U1         -45.33 U1           0.00 U1   
          16.000        -0.09 U1          80.59 U1         -47.04 U1           0.00 U1   
          16.250        -6.46 U1          70.69 U1         -48.76 U1           0.00 U1   
          16.500       -13.03 U1          60.42 U1         -50.47 U1           0.00 U1   
          16.750       -19.81 U1          49.78 U1         -52.18 U1           0.00 U1   
          17.000       -26.80 U1          38.76 U1         -53.90 U1           0.00 U1   
          17.250       -34.00 U1          27.37 U1         -55.61 U1           0.00 U1   
          17.500       -41.41 U1          15.61 U1         -57.32 U1           0.00 U1   
          17.750       -49.02 U1           3.47 U1         -59.04 U1           0.00 U1   
          18.000       -56.84 U1           0.00 U1         -60.75 U1           0.00 U1   
          18.250       -64.87 U1           0.00 U1         -62.46 U1           0.00 U1   
          18.500       -79.75 U1           0.00 U1         -64.18 U1           0.00 U1   
          18.750       -96.01 U1           0.00 U1         -65.89 U1           0.00 U1   
          19.000      -112.69 U1           0.00 U1         -67.60 U1           0.00 U1   
          19.250      -129.81 U1           0.00 U1         -69.32 U1           0.00 U1   
          19.500      -147.35 U1           0.00 U1         -71.03 U1           0.00 U1   
          19.750      -165.32 U1           0.00 U1         -72.74 U1           0.00 U1   
          20.000      -183.72 U1           0.00 U1         -74.46 U1           0.00 U1   
          20.250      -202.55 U1           0.00 U1         -76.17 U1           0.00 U1   
          20.500      -221.81 U1           0.00 U1         -77.88 U1           0.00 U1   
          20.750      -241.49 U1           0.00 U1         -79.60 U1           0.00 U1   
          21.000      -261.60 U1           0.00 U1         -81.31 U1           0.00 U1   
          21.250      -282.15 U1           0.00 U1         -83.02 U1           0.00 U1   
          21.250      -282.15 U1           0.00 U1         -83.02 U1           0.00 U1   
          21.500      -303.11 U1           0.00 U1         -84.73 U1           0.00 U1   
          21.750      -324.51 U1           0.00 U1         -86.45 U1           0.00 U1   
          22.000      -346.34 U1           0.00 U1         -88.16 U1           0.00 U1   
 
============================================================================================= 
[7] SEGMENTAL DEFLECTIONS 
============================================================================================= 
  
   Units: x (ft), Dz (in) 
   Span        x    Dz (DEAD)    Dz (LIVE)   Dz (TOTAL) 
   ---- -------- ------------ ------------ ------------ 
      1    0.000       -0.000       -0.000       -0.000 
           0.250       -0.005       -0.007       -0.011 
           0.500       -0.009       -0.013       -0.022 
           0.750       -0.014       -0.020       -0.034 
           0.750       -0.014       -0.020       -0.034 
           1.000       -0.019       -0.026       -0.045 
           1.250       -0.023       -0.033       -0.057 
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           1.500       -0.028       -0.040       -0.068 
           1.750       -0.033       -0.047       -0.080 
           2.000       -0.037       -0.054       -0.091 
           2.250       -0.042       -0.061       -0.102 
           2.500       -0.046       -0.068       -0.114 
           2.750       -0.051       -0.074       -0.125 
           3.000       -0.055       -0.081       -0.136 
           3.250       -0.060       -0.088       -0.147 
           3.500       -0.064       -0.094       -0.158 
           3.750       -0.068       -0.100       -0.168 
           4.000       -0.072       -0.107       -0.179 
           4.250       -0.076       -0.113       -0.189 
           4.500       -0.080       -0.119       -0.198 
           4.750       -0.083       -0.124       -0.208 
           5.000       -0.087       -0.130       -0.217 
           5.250       -0.090       -0.135       -0.225 
           5.500       -0.094       -0.140       -0.234 
           5.750       -0.097       -0.145       -0.242 
           6.000       -0.100       -0.150       -0.249 
           6.250       -0.102       -0.154       -0.256 
           6.500       -0.105       -0.158       -0.263 
           6.750       -0.107       -0.162       -0.269 
           7.000       -0.110       -0.165       -0.275 
           7.250       -0.112       -0.169       -0.280 
           7.500       -0.114       -0.172       -0.285 
           7.750       -0.115       -0.174       -0.290 
           8.000       -0.117       -0.177       -0.293 
           8.250       -0.118       -0.179       -0.297 
           8.500       -0.119       -0.181       -0.300 
           8.750       -0.120       -0.182       -0.302 
           9.000       -0.121       -0.183       -0.304 
           9.250       -0.121       -0.184       -0.305 
           9.500       -0.122       -0.184       -0.306 
           9.750       -0.122       -0.185       -0.306 
          10.000       -0.122       -0.184       -0.306 
          10.250       -0.121       -0.184       -0.305 
          10.500       -0.121       -0.183       -0.304 
          10.750       -0.120       -0.182       -0.303 
          11.000       -0.120       -0.181       -0.300 
          11.250       -0.119       -0.179       -0.298 
          11.500       -0.117       -0.177       -0.294 
          11.750       -0.116       -0.175       -0.291 
          12.000       -0.114       -0.172       -0.287 
          12.250       -0.113       -0.170       -0.282 
          12.500       -0.111       -0.167       -0.277 
          12.750       -0.109       -0.163       -0.272 
          13.000       -0.107       -0.160       -0.266 
          13.250       -0.104       -0.156       -0.260 
          13.500       -0.102       -0.152       -0.253 
          13.750       -0.099       -0.147       -0.247 
          14.000       -0.096       -0.143       -0.239 
          14.250       -0.093       -0.138       -0.232 
          14.500       -0.090       -0.133       -0.224 
          14.750       -0.087       -0.128       -0.216 
          15.000       -0.084       -0.123       -0.207 
          15.250       -0.081       -0.118       -0.199 
          15.500       -0.077       -0.113       -0.190 
          15.750       -0.074       -0.107       -0.181 
          16.000       -0.070       -0.102       -0.172 
          16.250       -0.067       -0.096       -0.163 
          16.500       -0.063       -0.090       -0.153 
          16.750       -0.060       -0.084       -0.144 
          17.000       -0.056       -0.079       -0.135 
          17.250       -0.052       -0.073       -0.125 
          17.500       -0.049       -0.067       -0.116 
          17.750       -0.045       -0.062       -0.107 
          18.000       -0.041       -0.056       -0.098 
          18.250       -0.038       -0.051       -0.089 
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          18.500       -0.034       -0.046       -0.080 
          18.750       -0.031       -0.041       -0.071 
          19.000       -0.028       -0.036       -0.063 
          19.250       -0.024       -0.031       -0.055 
          19.500       -0.021       -0.026       -0.048 
          19.750       -0.018       -0.022       -0.040 
          20.000       -0.015       -0.018       -0.034 
          20.250       -0.013       -0.015       -0.027 
          20.500       -0.010       -0.012       -0.022 
          20.750       -0.008       -0.009       -0.017 
          21.000       -0.006       -0.006       -0.012 
          21.250       -0.004       -0.004       -0.008 
          21.250       -0.004       -0.004       -0.008 
          21.500       -0.003       -0.003       -0.005 
          21.750       -0.001       -0.001       -0.002 
          22.000       -0.000       -0.000       -0.000 
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Graphical Output 

Loads 

pcaSlab v1.50. Licenced to: pcaStructurePoint. Licence ID: 00000-0000000-4-238E7-238E7

File: C:\Data\pcaSlab\Nilson Example 13.3.slb

Project: Example 13.3 by Nilson, Darwin, and Dolan

Frame: Design of Concrete Structures Engineer: pcaStructurePoint

CASE: SELF

CASE: Dead

CASE: Live

106.25 106.25 106.25

20 20 20

100 100 100
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Internal Forces 

pcaSlab v1.50. Licenced to: pcaStructurePoint. Licence ID: 00000-0000000-4-238E7-238E7

File: C:\Data\pcaSlab\Nilson Example 13.3.slb

Project: Example 13.3 by Nilson, Darwin, and Dolan

Frame: Design of Concrete Structures Engineer: pcaStructurePoint

M
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t D
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gr

am
 - 

k-
ft

-350.0

350.0

S
he

ar
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ia
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am
 - 

ki
p

90.0

-90.0

LEGEND:
 Envelope

-65.21

-346.34

220.70

-305.45 -305.45

131.37

-346.34

-65.21

220.70

62.60

-88.16

75.38

-75.38

88.16

-62.60
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Moment Capacity 

pcaSlab v1.50. Licenced to: pcaStructurePoint. Licence ID: 00000-0000000-4-238E7-238E7

File: C:\Data\pcaSlab\Nilson Example 13.3.slb

Project: Example 13.3 by Nilson, Darwin, and Dolan

Frame: Design of Concrete Structures Engineer: pcaStructurePoint

C
ol

um
n 
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tri

p 
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en

t C
ap
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ft

-350.0

350.0

M
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dl
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LEGEND:
 Envelope Curve
 Capacity Curve
 Support Centerline
 Face of Support
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Shear Capacity 

pcaSlab v1.50. Licenced to: pcaStructurePoint. Licence ID: 00000-0000000-4-238E7-238E7

File: C:\Data\pcaSlab\Nilson Example 13.3.slb

Project: Example 13.3 by Nilson, Darwin, and Dolan

Frame: Design of Concrete Structures Engineer: pcaStructurePoint

S
la

b 
S

he
ar

 C
ap

ac
ity

 - 
ki

p

180.0

-180.0

LEGEND:
 Envelope Curve
 Capacity Curve
 Support Centerline
 Face of Support
 Critical Section

 53.65

-79.20 

 66.42

-66.42 

 79.20

-53.65 
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Deflection 

pcaSlab v1.50. Licenced to: pcaStructurePoint. Licence ID: 00000-0000000-4-238E7-238E7

File: C:\Data\pcaSlab\Nilson Example 13.3.slb

Project: Example 13.3 by Nilson, Darwin, and Dolan

Frame: Design of Concrete Structures Engineer: pcaStructurePoint

D
ef

le
ct

io
n 

D
ia

gr
am

 - 
in

0.306

-0.306

LEGEND:
 Dead Load
 Live Load
 Total Deflection
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Reinforcement 

pcaSlab v1.50. Licenced to: pcaStructurePoint. Licence ID: 00000-0000000-4-238E7-238E7

File: C:\Data\pcaSlab\Nilson Example 13.3.slb

Project: Example 13.3 by Nilson, Darwin, and Dolan

Frame: Design of Concrete Structures Engineer: pcaStructurePoint

Column Strip Flexural Reinforcement

Middle Strip Flexural Reinforcement
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Example 5 Two-way slab system  

Problem description 
Using the Equivalent Frame Method, determine design moments for the slab 
system in the direction shown, for an intermediate floor. This example refers to 
Example 20-2 from PCA Notes on ACI 318-02 Building Code Requirements for 
Structural Concrete, Portland Cement Association, 2002. 

22'-0" 22'-0"

17'-6"

17'-6"

17'-6"

design strip

N

S

EW

 
 

Story height = 12 ft 
Edge beam dimensions = 14 × 27 in. 
Interior beam dimensions = 14 × 20 in. 
Column dimensions = 18 × 18 in.  
Service live load = 100 psf 
Dead load = self weight 
f′c = 4000 psi (for all members), normal weight concrete 
fy  = 60,000 psi 

Program Input 
1. From the Input menu, select General Information. A dialog box appears.  

• In the LABELS section, input the names of the project, frame, and 
engineer.  

• In the FRAME section, input 4 for NO OF SUPPORTS.  
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• In the FLOOR SYSTEM section, click the radial button next to TWO-WAY.  

• Leave all other options in the General Information tab to their default 
settings of ACI 318-02 design code, ASTM A615 reinforcement, and 
DESIGN run mode option.  

 
2. Nothing needs to be changed in the Material Properties menu.  

 
3. From the Input menu, select Spans. A dialog box appears. 

• Under the Slabs/Flanges tab, input 17.5 for LENGTH, 6 for THICKNESS, 
and 11 for WIDTH LEFT and WIDTH RIGHT. Press MODIFY.  

• Press COPY. Press the CHECK ALL button. Press OK. 
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• Select the Longitudinal Beams tab. Input 14 for WIDTH and 20 for 
DEPTH. Press MODIFY. 

• Press COPY. Press the CHECK ALL button. Press OK. 

• Press OK again. 

 

 
4. From the Input menu, select Supports. A dialog box appears. 

• Under the Columns tab, input 12 for the HEIGHT in both the ABOVE and 
BELOW rows. 
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• Input 18 for both the C1 and C2 values in both the ABOVE and BELOW 
rows. Press MODIFY.  

• Press COPY. Press the CHECK ALL button. Press OK. 

• Under the Transverse Beams tab, input 14 for WIDTH and 27 for 
DEPTH. Press MODIFY. 

• Press COPY. Click the check box next to SUPPORT 4. Press OK.  

• Use the drop down arrow next to SUPPORT to select SUPPORT 2.  

• Input 14 for WIDTH and 20 for DEPTH. Press MODIFY.  

• Press COPY. Click the check box next to SUPPORT 3 and unclick the check 
box next to SUPPORT 1. Press OK.  

• Press OK again. 
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5. Nothing needs to be changed in the Reinforcement menu.  
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6. From the Input menu, select Load Cases. A dialog box appears. 

• Since we are not considering lateral forces, click on WIND in the LABEL 
column on the list in the bottom half of the LOAD CASES dialog box and 
press the DELETE button. 

• Click on EQ in the LABEL column and press the DELETE button. Press 
OK. 

 
7. From the Input menu, select Load Combinations. A dialog box appears.  

• Delete all the load combinations by clicking anywhere on the list in the 
bottom half of the LOAD COMBINATIONS dialog box and pressing the 
DELETE button. Repeat this procedure until all the load combinations are 
gone.  



 

Examples  6-115 

• Input 1.2 in the SELF field, 1.2 in the DEAD field, and 1.6 in the LIVE 
field. Press ADD. 

• Press OK. 

 
8. From the Input menu, select Span Loads. A dialog box appears. 

• In the top left corner of the SPAN LOADS dialog box, there is a section 
called CURRENT CASE. Click on LIVE. 

• Input 100 for MAGNITUDE. Press ADD. 

• Press COPY. Press the CHECK ALL button. Press OK. 

• Press OK again. 
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9. From the Solve menu, select Execute. Press CLOSE. 
10. From the Solve menu, select Results Report. 

• Use the scroll bars to scroll through the results file.  

• Use the ARROW keys or the mouse wheel to browse through different 
parts of the results quickly. Press the CLOSE button to close the RESULTS 
REPORT dialog box and return to pcaBeam. 

11. To view diagrams, select Loads, Internal Forces, Moment Capacity, Shear 
Capacity, Deflection, or Reinforcement from the View menu. Right click in 
any of these diagrams to get new copy, printing, or display options.  

12. You may print the results file by selecting Print Results from the File menu. 
To print any of the diagrams you selected to view, use the Print Preview 
command found by right clicking in the diagram’s window. After viewing the 
results, you may decide to investigate the input beams under the same loads 
but with a modified reinforcement configuration.  

13. From the Input menu, select General Information. In the General 
Information dialog box change the RUN MODE option to INVESTIGATION. Do 
not change any of the other options. Press OK 

14. From the Input menu, select the different commands under Reinforcement 
Criteria and Reinforcing Bars to modify the reinforcement configuration 
computed by the program. 

15. Repeat steps 10 and subsequent to perform the investigation and view the 
results.  
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Text Output (abbreviated) 
                         ooooooo      oooooo      ooooo               
                         oooooooo    oooooooo    ooooooo              
                         oo    oo    oo    oo    oo   oo              
                         oo    oo    oo          oo   oo              
                         oooooooo    oo          ooooooo   ooooo      
                         ooooooo     oo    oo    ooooooo   ooooo      
                         oo          oo    oo    oo   oo              
                         oo          oooooooo    oo   oo              
                         oo           oooooo     oo   oo              
  
  
                       oooooo      o                    o             
                      oooooooo    oo        ooooo      oo             
                      oo          oo       o    oo     oo             
                      oooo        oo       o    oo     oo             
                       oooooo     oo        oooooo     oooooo         
                          oooo    oo       oo   oo     oo   oo        
                            oo    oo       oo   oo     oo   oo        
                      oooooooo    oo  o    oo   oo     oo   oo        
                       oooooo      ooo      ooooo o     ooooo         
  
      =============================================================================  
                                  pcaSlab v1.50 (TM) 
               A Computer Program Analysis, Design, and Investigation of 
                 Reinforced Concrete Slab and Continuous Beam Systems 
      =============================================================================  
                  Copyright © 2000-2005, Portland Cement Association  
                                  All rights reserved  
  
             Licensee stated above acknowledges that Portland Cement Association  
         (PCA) is not and  cannot  be  responsible for  either the  accuracy  or  
         adequacy of  the material supplied  as input  for  processing   by  the  
         pcaSlab  computer program.  Furthermore, PCA neither makes any warranty  
         expressed nor implied with respect  to  the  correctness of the  output  
         prepared by the  pcaSlab   program.  Although  PCA  has  endeavored  to  
         produce pcaSlab  error free the  program is not and cannot be certified  
         infallible.  The final and only responsibility for analysis, design and  
         engineering documents is the licensees. Accordingly, PCA disclaims  all  
         responsibility in contract, negligence or other tort for any  analysis,  
         design  or engineering documents prepared in connection with the use of  
         the pcaSlab  program.  
 
============================================================================================= 
[1] INPUT ECHO 
============================================================================================= 
  
General Information: 
==================== 
   File name: C:\Data\pcaBeam\PCA Notes on ACI 318-02 Example 20-2.slb 
   Project: PCA Notes on ACI 318-02 
   Frame: Example 20-2                             Engineer: pcaStructurePoint 
   Code: ACI 318-02       Mode: Design             Reinforcement Database: ASTM A615 
   Number of supports = 4 
   Floor System: Two-Way 
  
   Live load pattern ratio = 75% 
   Minimum free edge for punching shear = 10 times slab thickness 
   Deflections are based on cracked section properties. 
   In negative moment regions, Igr and Mcr DO NOT include flange/slab contribution (if available) 
   Compression reinforcement calculations NOT selected. 
  
Material Properties: 
==================== 
            Slabs|Beams       Columns 
           ------------   ------------ 
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   wc    =          150            150 lb/ft3 
   f'c   =            4              4 ksi 
   Ec    =      3834.25        3834.25 ksi 
   fr    =     0.474342       0.474342 ksi 
  
   fy    =           60 ksi, Bars are not epoxy-coated 
   fyv   =           60 ksi 
   Es    =        29000 ksi 
  
Reinforcement Database: 
=============== 
   Units: Db (in), Ab (in^2), Wb (lb/ft) 
   Size       Db      Ab        Wb    Size       Db      Ab        Wb 
   ---- -------- -------- --------    ---- -------- -------- -------- 
     #3     0.38     0.11     0.38      #4     0.50     0.20     0.67     
     #5     0.63     0.31     1.04      #6     0.75     0.44     1.50     
     #7     0.88     0.60     2.04      #8     1.00     0.79     2.67     
     #9     1.13     1.00     3.40     #10     1.27     1.27     4.30     
    #11     1.41     1.56     5.31     #14     1.69     2.25     7.65     
    #18     2.26     4.00    13.60     
  
Span Data: 
========== 
   Slabs: L1, wL, wR (ft); t, Hmin (in) 
   Span Loc        L1        t       wL       wR     Hmin 
   ---- ---- -------- -------- -------- -------- --------  
      1 Int    17.500     6.00   11.000   11.000     4.44     
      2 Int    17.500     6.00   11.000   11.000     4.44     
      3 Int    17.500     6.00   11.000   11.000     4.44     
  
   Ribs and Longitudinal Beams: b, h, Sp (in) 
        __________Ribs____________    _______Beams_____ 
   Span        b        h       Sp           b        h 
   ---- -------- -------- --------    -------- -------- 
      1     0.00     0.00     0.00       14.00    20.00 
      2     0.00     0.00     0.00       14.00    20.00 
      3     0.00     0.00     0.00       14.00    20.00 
  
Support Data: 
============= 
   Columns: c1a, c2a, c1b, c2b (in); Ha, Hb (ft) 
   Supp      c1a      c2a       Ha        c1b      c2b       Hb  Red% 
   ---- -------- -------- --------   -------- -------- --------  ---- 
      1    18.00    18.00   12.000      18.00    18.00   12.000   100  
      2    18.00    18.00   12.000      18.00    18.00   12.000   100  
      3    18.00    18.00   12.000      18.00    18.00   12.000   100  
      4    18.00    18.00   12.000      18.00    18.00   12.000   100  
  
   Transverse Beams: b, h, Ecc (in) 
   Supp        b        h      Ecc 
   ---- -------- -------- -------- 
      1    14.00    27.00     0.00 
      2    14.00    20.00     0.00 
      3    14.00    20.00     0.00 
      4    14.00    27.00     0.00 
  
   Boundary Conditions: Kz (kip/in); Kry (kip-in/rad) 
   Supp    Spring Kz   Spring Kry Far End A Far End B 
   ---- ------------ ------------ --------- --------- 
      1            0            0     Fixed     Fixed 
      2            0            0     Fixed     Fixed 
      3            0            0     Fixed     Fixed 
      4            0            0     Fixed     Fixed 
  
Load Data: 
========== 
   Load Cases and Combinations: 
   Case     SELF     Dead     Live  
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   Type     DEAD     DEAD     LIVE  
   U1      1.200    1.200    1.600  
  
   Span Loads: 
   Span Case               Wa 
   ---- -------- ------------ 
   Area Loads - Wa (lb/ft2): 
      1 Live              100 
      2 Live              100 
      3 Live              100 
  
   Support Loads - Fz (kip), My (k-ft): 
   Supp Case               Fz           My  
   ---- -------- ------------ ------------  
      1 SELF                0            0 
      2 SELF                0            0 
      3 SELF                0            0 
      4 SELF                0            0 
      1 Dead                0            0 
      2 Dead                0            0 
      3 Dead                0            0 
      4 Dead                0            0 
      1 Live                0            0 
      2 Live                0            0 
      3 Live                0            0 
      4 Live                0            0 
  
   Support Displacements - Dz (in), Ry (rad): 
   Supp Case               Dz           Ry  
   ---- -------- ------------ ------------  
      1 SELF                0            0 
      2 SELF                0            0 
      3 SELF                0            0 
      4 SELF                0            0 
      1 Dead                0            0 
      2 Dead                0            0 
      3 Dead                0            0 
      4 Dead                0            0 
      1 Live                0            0 
      2 Live                0            0 
      3 Live                0            0 
      4 Live                0            0 
  
Reinforcement Criteria: 
======================= 
                 _____Top bars___  ___Bottom bars__  ____Stirrups____ 
                   Min      Max      Min      Max      Min      Max   
                 -------  -------  -------  -------  -------  ------- 
   Slabs and Ribs: 
     Bar Size         #5       #8       #5       #8 
     Bar spacing    1.00    18.00     1.00    18.00 in 
     Reinf ratio    0.14     5.00     0.14     5.00 % 
     Cover          1.50              1.50          in 
  
   Beams: 
     Bar Size         #5       #8       #5       #8       #3       #5 
     Bar spacing    1.00    18.00     1.00    18.00     6.00    18.00 in 
     Reinf ratio    0.14     5.00     0.14     5.00 % 
     Cover          1.50              1.50          in 
  
 
============================================================================================= 
[2] DESIGN RESULTS 
============================================================================================= 
  
Top Reinforcement: 
================== 
   Units: Width (ft), Mmax (k-ft), Xmax (ft), As (in^2), Sp (in) 
   Span Strip  Zone      Width         Mmax     Xmax    AsMin    AsMax    SpReq    AsReq    Bars 
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   ---- ------ ------ -------- ------------ -------- -------- -------- -------- -------- ------- 
      1 Column Left       7.58         5.48    0.750    0.983    6.883   11.375    0.293    8-#5  *5 
               Middle     7.58         0.00    8.750    0.000    6.883    0.000    0.000     ---  
               Right      7.58        14.51   16.750    0.983    6.883   11.375    0.784    8-#5  *5 
 
        Middle Left      13.25        17.06    0.750    1.717   12.026   11.357    0.917   14-#5  *5 
               Middle    13.25         0.00    8.750    0.000   12.026    0.000    0.000     ---  
               Right     13.25        47.02   16.750    1.717   12.026   11.357    2.584   14-#5  *5 
 
        Beam   Left       1.17        31.07    0.750    0.512    4.599    9.972    0.385    2-#5  
               Middle     1.17         0.00    8.750    0.000    4.599    0.000    0.000     ---  
               Right      1.17        82.21   16.750    0.849    4.599    3.324    1.042    4-#5  
 
      2 Column Left       7.58        13.03    0.750    0.983    6.883   11.375    0.703    8-#5  *5 
               Middle     7.58         0.28    6.350    0.983    6.883   11.375    0.015    8-#5  *5 
               Right      7.58        13.03   16.750    0.983    6.883   11.375    0.703    8-#5  *5 
 
        Middle Left      13.25        42.23    0.750    1.717   12.026   11.357    2.312   14-#5  *5 
               Middle    13.25         0.91    6.350    1.717   12.026   11.357    0.049   14-#5  *5 
               Right     13.25        42.23   16.750    1.717   12.026   11.357    2.312   14-#5  *5 
 
        Beam   Left       1.17        73.83    0.750    0.849    4.599    3.324    0.932    4-#5  
               Middle     1.17         1.60    6.350    0.356    4.599    9.972    0.020    2-#5  
               Right      1.17        73.83   16.750    0.849    4.599    3.324    0.932    4-#5  
 
      3 Column Left       7.58        14.51    0.750    0.983    6.883   11.375    0.784    8-#5  *5 
               Middle     7.58         0.00    8.750    0.000    6.883    0.000    0.000     ---  
               Right      7.58         5.41   16.750    0.983    6.883   11.375    0.289    8-#5  *5 
 
        Middle Left      13.25        47.02    0.750    1.717   12.026   11.357    2.584   14-#5  *5 
               Middle    13.25         0.00    8.750    0.000   12.026    0.000    0.000     ---  
               Right     13.25        17.54   16.750    1.717   12.026   11.357    0.942   14-#5  *5 
 
        Beam   Left       1.17        82.21    0.750    0.849    4.599    3.324    1.042    4-#5  
               Middle     1.17         0.00    8.750    0.000    4.599    0.000    0.000     ---  
               Right      1.17        30.66   16.750    0.505    4.599    9.972    0.380    2-#5  
   NOTES: 
   *5 - Number of bars governed by maximum allowable spacing. 
 
Top Bar Details: 
================ 
   Units: Length (ft) 
               _____________Left______________  ___Continuous__  _____________Right_____________ 
   Span Strip     Bars  Length    Bars  Length     Bars  Length     Bars  Length    Bars  Length 
   ---- ------ ------- ------- ------- -------  ------- -------  ------- ------- ------- ------- 
      1 Column    4-#5    6.03    4-#5    3.95      ---             4-#5    6.75    4-#5    3.95 
        Middle   14-#5    4.27     ---              ---            14-#5    6.75     ---         
        Beam      2-#5    4.02     ---              ---             3-#5    7.27    1-#5    2.56 
 
      2 Column     ---             ---             8-#5   17.50      ---             ---         
        Middle     ---             ---            14-#5   17.50      ---             ---         
        Beam      1-#5    3.25    1-#5    2.27     2-#5   17.50     1-#5    3.25    1-#5    2.27 
 
      3 Column    4-#5    6.75    4-#5    3.95      ---             4-#5    6.03    4-#5    3.95 
        Middle   14-#5    6.75     ---              ---            14-#5    4.27     ---         
        Beam      3-#5    7.27    1-#5    2.56      ---             2-#5    4.02     ---         
 
Bottom Reinforcement: 
===================== 
   Units: Width (ft), Mmax (k-ft), Xmax (ft), As (in^2), Sp (in)  
   Span Strip     Width         Mmax     Xmax    AsMin    AsMax    SpReq    AsReq    Bars 
   ---- ------ -------- ------------ -------- -------- -------- -------- -------- ------- 
      1 Column     7.58         8.87    7.750    0.983    6.883   11.375    0.476    8-#5  *5 
        Middle    13.25        28.76    7.750    1.717   12.026   11.357    1.559   14-#5  *5 
        Beam       1.17        50.29    7.750    0.835    4.599    4.986    0.628    3-#5  
 
      2 Column     7.58         6.45    8.750    0.983    6.883   11.375    0.345    8-#5  *5 
        Middle    13.25        20.90    8.750    1.717   12.026   11.357    1.126   14-#5  *5 
        Beam       1.17        36.54    8.750    0.603    4.599    9.972    0.454    2-#5  
 
      3 Column     7.58         8.87    9.750    0.983    6.883   11.375    0.476    8-#5  *5 
        Middle    13.25        28.76    9.750    1.717   12.026   11.357    1.559   14-#5  *5 
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        Beam       1.17        50.29    9.750    0.835    4.599    4.986    0.628    3-#5  
   NOTES: 
   *5 - Number of bars governed by maximum allowable spacing. 
 
Bottom Bar Details: 
=================== 
   Units: Start (ft), Length (ft) 
                _______Long Bars_______ ______Short Bars_______ 
   Span Strip      Bars   Start  Length    Bars   Start  Length 
   ---- ------- ------- ------- ------- ------- ------- ------- 
      1 Column     8-#5    0.00   17.50     ---                 
        Middle     7-#5    0.00   17.50    7-#5    2.63   12.25 
        Beam       3-#5    0.00   17.50     ---                 
 
      2 Column     8-#5    0.00   17.50     ---                 
        Middle     7-#5    0.00   17.50    7-#5    2.63   12.25 
        Beam       2-#5    0.00   17.50     ---                 
 
      3 Column     8-#5    0.00   17.50     ---                 
        Middle     7-#5    0.00   17.50    7-#5    2.63   12.25 
        Beam       3-#5    0.00   17.50     ---                 
 
Flexural Capacity: 
================== 
   Units: From, To (ft), As (in^2), PhiMn (k-ft)  
   Span Strip       From        To AsTop AsBot       PhiMn-       PhiMn+ 
   ---- ------ --------- --------- ----- ----- ------------ ------------ 
      1 Column     0.000     0.750  2.48  2.48       -44.05        44.05 
                   0.750     2.951  2.48  2.48       -44.05        44.05 
                   2.951     3.951  1.24  2.48       -22.70        44.05 
                   3.951     5.030  1.24  2.48       -22.70        44.05 
                   5.030     6.030  0.00  2.48         0.00        44.05 
                   6.030     6.350  0.00  2.48         0.00        44.05 
                   6.350     8.750  0.00  2.48         0.00        44.05 
                   8.750    10.750  0.00  2.48         0.00        44.05 
                  10.750    11.150  0.00  2.48         0.00        44.05 
                  11.150    11.750  0.00  2.48         0.00        44.05 
                  11.750    13.549  1.24  2.48       -22.70        44.05 
                  13.549    14.549  1.24  2.48       -22.70        44.05 
                  14.549    16.750  2.48  2.48       -44.05        44.05 
                  16.750    17.500  2.48  2.48       -44.05        44.05 
        Middle     0.000     0.750  4.34  2.17       -77.08        39.72 
                   0.750     2.625  4.34  2.17       -77.08        39.72 
                   2.625     3.271  4.34  2.17       -77.08        39.72 
                   3.271     3.625  0.00  2.17         0.00        39.72 
                   3.625     4.271  0.00  4.34         0.00        77.08 
                   4.271     6.350  0.00  4.34         0.00        77.08 
                   6.350     8.750  0.00  4.34         0.00        77.08 
                   8.750    10.750  0.00  4.34         0.00        77.08 
                  10.750    11.150  0.00  4.34         0.00        77.08 
                  11.150    11.750  0.00  4.34         0.00        77.08 
                  11.750    13.875  4.34  4.34       -77.08        77.08 
                  13.875    14.875  4.34  2.17       -77.08        39.72 
                  14.875    16.750  4.34  2.17       -77.08        39.72 
                  16.750    17.500  4.34  2.17       -77.08        39.72 
        Beam       0.000     0.750  0.62  0.93       -49.65        73.66 
                   0.750     3.016  0.62  0.93       -49.65        73.66 
                   3.016     4.016  0.00  0.93         0.00        73.66 
                   4.016     6.350  0.00  0.93         0.00        73.66 
                   6.350     8.750  0.00  0.93         0.00        73.66 
                   8.750    10.234  0.00  0.93         0.00        73.66 
                  10.234    11.150  0.00  0.93         0.00        73.66 
                  11.150    11.234  0.00  0.93         0.00        73.66 
                  11.234    14.939  0.93  0.93       -73.66        73.66 
                  14.939    15.939  0.93  0.93       -73.66        73.66 
                  15.939    16.750  1.24  0.93       -97.13        73.66 
                  16.750    17.500  1.24  0.93       -97.13        73.66 
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      2 Column     0.000     0.750  2.48  2.48       -44.05        44.05 
                   0.750     6.350  2.48  2.48       -44.05        44.05 
                   6.350     8.750  2.48  2.48       -44.05        44.05 
                   8.750    11.150  2.48  2.48       -44.05        44.05 
                  11.150    16.750  2.48  2.48       -44.05        44.05 
                  16.750    17.500  2.48  2.48       -44.05        44.05 
        Middle     0.000     0.750  4.34  2.17       -77.08        39.72 
                   0.750     2.625  4.34  2.17       -77.08        39.72 
                   2.625     3.625  4.34  2.17       -77.08        39.72 
                   3.625     6.350  4.34  4.34       -77.08        77.08 
                   6.350     8.750  4.34  4.34       -77.08        77.08 
                   8.750    11.150  4.34  4.34       -77.08        77.08 
                  11.150    13.875  4.34  4.34       -77.08        77.08 
                  13.875    14.875  4.34  2.17       -77.08        39.72 
                  14.875    16.750  4.34  2.17       -77.08        39.72 
                  16.750    17.500  4.34  2.17       -77.08        39.72 
        Beam       0.000     0.750  1.24  0.62       -97.13        49.65 
                   0.750     1.272  1.24  0.62       -97.13        49.65 
                   1.272     2.246  0.93  0.62       -73.66        49.65 
                   2.246     2.272  0.62  0.62       -49.65        49.65 
                   2.272     3.246  0.62  0.62       -49.65        49.65 
                   3.246     6.350  0.62  0.62       -49.65        49.65 
                   6.350     8.750  0.62  0.62       -49.65        49.65 
                   8.750    11.150  0.62  0.62       -49.65        49.65 
                  11.150    14.254  0.62  0.62       -49.65        49.65 
                  14.254    15.228  0.62  0.62       -49.65        49.65 
                  15.228    15.254  0.62  0.62       -49.65        49.65 
                  15.254    16.228  0.93  0.62       -73.66        49.65 
                  16.228    16.750  1.24  0.62       -97.13        49.65 
                  16.750    17.500  1.24  0.62       -97.13        49.65 
 
      3 Column     0.000     0.750  2.48  2.48       -44.05        44.05 
                   0.750     2.951  2.48  2.48       -44.05        44.05 
                   2.951     3.951  1.24  2.48       -22.70        44.05 
                   3.951     5.750  1.24  2.48       -22.70        44.05 
                   5.750     6.350  0.00  2.48         0.00        44.05 
                   6.350     6.750  0.00  2.48         0.00        44.05 
                   6.750     8.750  0.00  2.48         0.00        44.05 
                   8.750    11.150  0.00  2.48         0.00        44.05 
                  11.150    11.470  0.00  2.48         0.00        44.05 
                  11.470    12.470  0.00  2.48         0.00        44.05 
                  12.470    13.549  1.24  2.48       -22.70        44.05 
                  13.549    14.549  1.24  2.48       -22.70        44.05 
                  14.549    16.750  2.48  2.48       -44.05        44.05 
                  16.750    17.500  2.48  2.48       -44.05        44.05 
        Middle     0.000     0.750  4.34  2.17       -77.08        39.72 
                   0.750     2.625  4.34  2.17       -77.08        39.72 
                   2.625     3.625  4.34  2.17       -77.08        39.72 
                   3.625     5.750  4.34  4.34       -77.08        77.08 
                   5.750     6.350  0.00  4.34         0.00        77.08 
                   6.350     6.750  0.00  4.34         0.00        77.08 
                   6.750     8.750  0.00  4.34         0.00        77.08 
                   8.750    11.150  0.00  4.34         0.00        77.08 
                  11.150    13.229  0.00  4.34         0.00        77.08 
                  13.229    13.875  0.00  4.34         0.00        77.08 
                  13.875    14.229  0.00  2.17         0.00        39.72 
                  14.229    14.875  4.34  2.17       -77.08        39.72 
                  14.875    16.750  4.34  2.17       -77.08        39.72 
                  16.750    17.500  4.34  2.17       -77.08        39.72 
        Beam       0.000     0.750  1.24  0.93       -97.13        73.66 
                   0.750     1.561  1.24  0.93       -97.13        73.66 
                   1.561     2.561  0.93  0.93       -73.66        73.66 
                   2.561     6.266  0.93  0.93       -73.66        73.66 
                   6.266     6.350  0.00  0.93         0.00        73.66 
                   6.350     7.266  0.00  0.93         0.00        73.66 
                   7.266     8.750  0.00  0.93         0.00        73.66 
                   8.750    11.150  0.00  0.93         0.00        73.66 
                  11.150    13.484  0.00  0.93         0.00        73.66 



 

Examples  6-123 

                  13.484    14.484  0.00  0.93         0.00        73.66 
                  14.484    16.750  0.62  0.93       -49.65        73.66 
                  16.750    17.500  0.62  0.93       -49.65        73.66 
 
Longitudinal Beam Shear Reinforcement Required: 
=============================================== 
   Units: d (in), Start, End, Xu (ft), PhiVc, Vu (kip), Av/s (in^2/in)  
   Span        d    PhiVc    Start      End       Vu       Xu     Av/s 
   ---- -------- -------- -------- -------- -------- -------- -------- 
      1    18.19    24.16    2.266    4.118    31.62    2.266   0.0117 
                             4.118    5.971    20.98    4.118   0.0117 
                             5.971    7.824    10.76    5.971   0.0000 
                             7.824    9.676    10.95    9.676   0.0000 
                             9.676   11.529    21.60   11.529   0.0117 
                            11.529   13.382    32.24   13.382   0.0117 
                            13.382   15.234    42.89   15.234   0.0229 
 
      2    18.19    24.16    2.266    4.118    37.25    2.266   0.0160 
                             4.118    5.971    26.61    4.118   0.0117 
                             5.971    7.824    15.97    5.971   0.0117 
                             7.824    9.676     6.88    7.824   0.0000 
                             9.676   11.529    15.97   11.529   0.0117 
                            11.529   13.382    26.61   13.382   0.0117 
                            13.382   15.234    37.25   15.234   0.0160 
 
      3    18.19    24.16    2.266    4.118    42.89    2.266   0.0229 
                             4.118    5.971    32.24    4.118   0.0117 
                             5.971    7.824    21.60    5.971   0.0117 
                             7.824    9.676    10.95    7.824   0.0000 
                             9.676   11.529    10.76   11.529   0.0000 
                            11.529   13.382    20.98   13.382   0.0117 
                            13.382   15.234    31.62   15.234   0.0117 
 
 
Longitudinal Beam Shear Reinforcement Details: 
============================================== 
   Units: spacing & distance (in). 
   Span Size Stirrups (2 legs each unless otherwise noted) 
   ---- ---- --------------------------------------------- 
      1   #3 8 @ 8.5 + <-- 44.5 --> + 5 @ 8.9 + 6 @ 7.5  
      2   #3 11 @ 8.2 + <-- 22.2 --> + 11 @ 8.2  
      3   #3 5 @ 7.5 + 6 @ 8.9 + <-- 44.5 --> + 8 @ 8.5  
 
Beam Shear Capacity: 
==================== 
   Units: d, Sp (in), Start, End, Xu (ft), PhiVc, PhiVn, Vu (kip), Av/s (in^2/in)  
   Span        d    PhiVc    Start      End     Av/s       Sp    PhiVn       Vu       Xu 
   ---- -------- -------- -------- -------- -------- -------- -------- -------- -------- 
      1    18.19    24.16    0.000    1.000    -----    -----    45.29    48.46    0.000 
                             1.000    5.971   0.0258      8.5    45.29    31.62    2.266 
                             5.971    9.676    -----    -----    12.08    10.95    9.676 
                             9.676   13.382   0.0247      8.9    44.40    32.24   13.382 
                            13.382   16.500   0.0294      7.5    48.21    42.89   15.234 
                            16.500   17.500    -----    -----    48.21    58.45   17.500 
 
      2    18.19    24.16    0.000    1.000    -----    -----    46.15    52.82    0.000 
                             1.000    7.824   0.0269      8.2    46.15    37.25    2.266 
                             7.824    9.676    -----    -----    12.08     6.88    7.824 
                             9.676   16.500   0.0269      8.2    46.15    37.25   15.234 
                            16.500   17.500    -----    -----    46.15    52.82   17.500 
 
      3    18.19    24.16    0.000    1.000    -----    -----    48.21    58.45    0.000 
                             1.000    4.118   0.0294      7.5    48.21    42.89    2.266 
                             4.118    7.824   0.0247      8.9    44.40    32.24    4.118 
                             7.824   11.529    -----    -----    12.08    10.95    7.824 
                            11.529   16.500   0.0258      8.5    45.29    31.62   15.234 
                            16.500   17.500    -----    -----    45.29    48.46   17.500 
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Slab Shear Capacity: 
==================== 
   Units: b, d (in), Xu (ft), PhiVc, Vu(kip) 
   Span        b        d   Vratio        PhiVc           Vu           Xu 
   ---- -------- -------- -------- ------------ ------------ ------------ 
      1   250.00     4.19    0.000        99.32         0.00        16.40  
      2   250.00     4.19    0.000        99.32         0.00         1.10  
      3   250.00     4.19    0.000        99.32         0.00         1.10  
 
Flexural Transfer of Negative Unbalanced Moment at Supports: 
============================================================ 
   Units: Width (in), Munb (k-ft), As (in^2) 
   Supp    Width  GammaF*Munb Comb Pat     AsReq   AsProv Additional Bars 
   ---- -------- ------------ ---- ---- -------- -------- --------------- 
      1    36.00        58.85 U1   All     4.113    0.981    11-#5  
      2    36.00        28.78 U1   Odd     1.696    0.981     3-#5  
      3    36.00        28.74 U1   Odd     1.693    0.981     3-#5  
      4    36.00        58.88 U1   All     4.116    0.981    11-#5  
 
Punching Shear Around Columns: 
============================== 
   Units: Vu (kip), Munb (k-ft), vu (psi), Phi*vc (psi) 
   Supp           Vu       vu         Munb Comb Pat  GammaV       vu   Phi*vc 
   ---- ------------ -------- ------------ ---- ---- ------ -------- -------- 
      1        47.98     91.0        58.82 U1   All   0.320    139.3    177.4  
      2       110.33    128.9       -18.90 U1   All   0.400    142.1    181.1  
      3       110.33    128.9        18.84 U1   All   0.400    142.0    181.1  
      4        47.98    100.6       -55.95 U1   All   0.320    144.4    181.1  
 
Maximum Deflections: 
==================== 
   Units: Dz (in) 
        __________Frame____________  _______Column Strip________  ________Middle Strip_______ 
   Span Dz(DEAD) Dz(LIVE) Dz(TOTAL)  Dz(DEAD) Dz(LIVE) Dz(TOTAL)  Dz(DEAD) Dz(LIVE) Dz(TOTAL) 
   ---- -------- -------- ---------  -------- -------- ---------  -------- -------- --------- 
      1   -0.014   -0.017    -0.032    -0.012   -0.015    -0.027    -0.041   -0.050    -0.091 
      2   -0.007   -0.008    -0.015    -0.006   -0.007    -0.013    -0.020   -0.024    -0.044 
      3   -0.014   -0.017    -0.032    -0.012   -0.015    -0.027    -0.042   -0.050    -0.092 
  
Material Takeoff: 
================= 
   Reinforcement in the Direction of Analysis 
   ------------------------------------------ 
   Top Bars:      1011.5 lb   <=>  19.27 lb/ft   <=>  0.876 lb/ft^2 
   Bottom Bars:   1235.7 lb   <=>  23.54 lb/ft   <=>  1.070 lb/ft^2 
   Stirrups:       315.8 lb   <=>   6.02 lb/ft   <=>  0.273 lb/ft^2 
   Total Steel:   2563.1 lb   <=>  48.82 lb/ft   <=>  2.219 lb/ft^2 
   Concrete:       798.7 ft^3 <=>  15.21 ft^3/ft <=>  0.691 ft^3/ft^2 
  
  
 
============================================================================================= 
[3] COLUMN AXIAL FORCES AND MOMENTS 
============================================================================================= 
  
   Units: P (kip), M (k-ft) 
   Supp Case/Patt     P (axial)      Mb[top]   Ma[bottom] 
   ---- ---------- ------------ ------------ ------------ 
      1 SELF              17.58       -17.11       -11.14 
        Dead               0.00         0.00         0.00 
        Live/All          17.11       -19.94       -12.99 
        Live/Odd          14.09       -18.32       -11.93 
        Live/Even         -1.26         3.36         2.19 
        Live/S1           13.83       -17.63       -11.48 
        Live/S2           12.57       -14.27        -9.29 
        Live/S3           -1.00         2.67         1.74 
        Live/S4            0.26        -0.69        -0.45 
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      2 SELF              38.54         3.75         2.44 
        Dead               0.00         0.00         0.00 
        Live/All          40.64         4.35         2.83 
        Live/Odd          14.78        15.35         9.99 
        Live/Even         15.70       -12.09        -7.87 
        Live/S1           16.52        12.87         8.38 
        Live/S2           32.22         0.78         0.51 
        Live/S3           13.96        -9.61        -6.26 
        Live/S4           -1.74         2.48         1.62 
 
      3 SELF              38.54        -3.72        -2.42 
        Dead               0.00         0.00         0.00 
        Live/All          40.64        -4.35        -2.83 
        Live/Odd          14.78       -15.35        -9.99 
        Live/Even         15.70        12.09         7.87 
        Live/S1           -1.74        -2.48        -1.62 
        Live/S2           13.96         9.61         6.26 
        Live/S3           32.22        -0.78        -0.51 
        Live/S4           16.52       -12.87        -8.38 
 
      4 SELF              17.58        17.13        11.16 
        Dead               0.00         0.00         0.00 
        Live/All          17.11        19.94        12.99 
        Live/Odd          14.09        18.32        11.93 
        Live/Even         -1.26        -3.36        -2.19 
        Live/S1            0.26         0.69         0.45 
        Live/S2           -1.00        -2.67        -1.74 
        Live/S3           12.57        14.27         9.29 
        Live/S4           13.83        17.63        11.48 
 
   Sum  SELF             112.23         0.05         0.03 
        Dead               0.00         0.00         0.00 
        Live/All         115.50        -0.00        -0.00 
        Live/Odd          57.75        -0.00        -0.00 
        Live/Even         28.87         0.00         0.00 
        Live/S1           28.88        -6.55        -4.27 
        Live/S2           57.75        -6.55        -4.27 
        Live/S3           57.75         6.55         4.27 
        Live/S4           28.88         6.55         4.27 
  
 
============================================================================================= 
[6] SEGMENTAL MOMENT AND SHEAR - ENVELOPES 
============================================================================================= 
  
   Span   x (ft)    M- (k-ft) Comb    M+ (k-ft) Comb     V- (kip) Comb     V+ (kip) Comb 
   ---- -------- ------------ ---- ------------ ---- ------------ ---- ------------ ---- 
      1    0.000       -86.59 U1           0.00 U1           0.00 U1          48.46 U1   
           0.250       -74.86 U1           0.00 U1           0.00 U1          45.39 U1   
           0.500       -63.89 U1           0.00 U1           0.00 U1          42.31 U1   
           0.750       -53.57 U1           0.00 U1           0.00 U1          40.33 U1   
           0.750       -53.61 U1           0.00 U1           0.00 U1          40.33 U1   
           1.000       -43.80 U1           0.00 U1           0.00 U1          38.89 U1   
           1.250       -35.22 U1           0.00 U1           0.00 U1          37.45 U1   
           1.500       -26.94 U1           0.00 U1           0.00 U1          36.02 U1   
           1.750       -18.96 U1           0.00 U1           0.00 U1          34.58 U1   
           2.000       -11.29 U1           2.13 U1           0.00 U1          33.15 U1   
           2.250        -3.92 U1           4.76 U1           0.00 U1          31.71 U1   
           2.500         0.00 U1           8.16 U1           0.00 U1          30.27 U1   
           2.750         0.00 U1          15.55 U1           0.00 U1          28.84 U1   
           3.000         0.00 U1          22.58 U1           0.00 U1          27.40 U1   
           3.250         0.00 U1          29.25 U1           0.00 U1          25.96 U1   
           3.500         0.00 U1          35.57 U1           0.00 U1          24.53 U1   
           3.750         0.00 U1          41.52 U1           0.00 U1          23.09 U1   
           4.000         0.00 U1          47.11 U1           0.00 U1          21.66 U1   
           4.250         0.00 U1          52.35 U1           0.00 U1          20.22 U1   
           4.500         0.00 U1          57.22 U1           0.00 U1          18.78 U1   
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           4.750         0.00 U1          61.74 U1           0.00 U1          17.35 U1   
           5.000         0.00 U1          65.89 U1           0.00 U1          15.91 U1   
           5.250         0.00 U1          69.69 U1           0.00 U1          14.47 U1   
           5.500         0.00 U1          73.13 U1           0.00 U1          13.05 U1   
           5.750         0.00 U1          76.21 U1           0.00 U1          11.83 U1   
           6.000         0.00 U1          78.93 U1           0.00 U1          10.62 U1   
           6.250         0.00 U1          81.29 U1           0.00 U1           9.40 U1   
           6.500         0.00 U1          83.30 U1           0.00 U1           8.19 U1   
           6.750         0.00 U1          84.94 U1           0.00 U1           6.97 U1   
           7.000         0.00 U1          86.23 U1          -0.33 U1           5.75 U1   
           7.250         0.00 U1          87.15 U1          -0.88 U1           4.54 U1   
           7.500         0.00 U1          87.72 U1          -1.44 U1           3.32 U1   
           7.750         0.00 U1          87.93 U1          -2.00 U1           2.10 U1   
           8.000         0.00 U1          87.77 U1          -2.55 U1           0.89 U1   
           8.250         0.00 U1          87.26 U1          -3.11 U1           0.00 U1   
           8.500         0.00 U1          86.39 U1          -4.20 U1           0.00 U1   
           8.750         0.00 U1          85.16 U1          -5.63 U1           0.00 U1   
           9.000         0.00 U1          83.58 U1          -7.07 U1           0.00 U1   
           9.250         0.00 U1          81.63 U1          -8.51 U1           0.00 U1   
           9.500         0.00 U1          79.32 U1          -9.94 U1           0.00 U1   
           9.750         0.00 U1          76.66 U1         -11.38 U1           0.00 U1   
          10.000         0.00 U1          73.66 U1         -12.81 U1           0.00 U1   
          10.250         0.00 U1          71.30 U1         -14.25 U1           0.00 U1   
          10.500         0.00 U1          68.63 U1         -15.69 U1           0.00 U1   
          10.750         0.00 U1          65.66 U1         -17.12 U1           0.00 U1   
          11.000         0.00 U1          62.38 U1         -18.56 U1           0.00 U1   
          11.250         0.00 U1          58.81 U1         -20.00 U1           0.00 U1   
          11.500         0.00 U1          54.92 U1         -21.43 U1           0.00 U1   
          11.750         0.00 U1          50.74 U1         -22.87 U1           0.00 U1   
          12.000        -1.16 U1          46.25 U1         -24.30 U1           0.00 U1   
          12.250        -4.09 U1          41.45 U1         -25.74 U1           0.00 U1   
          12.500        -7.16 U1          36.35 U1         -27.18 U1           0.00 U1   
          12.750       -10.37 U1          30.95 U1         -28.61 U1           0.00 U1   
          13.000       -13.72 U1          25.24 U1         -30.05 U1           0.00 U1   
          13.250       -17.21 U1          19.23 U1         -31.49 U1           0.00 U1   
          13.500       -20.84 U1          12.92 U1         -32.92 U1           0.00 U1   
          13.750       -24.61 U1           6.30 U1         -34.36 U1           0.00 U1   
          14.000       -28.51 U1           0.00 U1         -35.79 U1           0.00 U1   
          14.250       -32.71 U1           0.00 U1         -37.23 U1           0.00 U1   
          14.500       -42.20 U1           0.00 U1         -38.67 U1           0.00 U1   
          14.750       -52.04 U1           0.00 U1         -40.10 U1           0.00 U1   
          15.000       -62.25 U1           0.00 U1         -41.54 U1           0.00 U1   
          15.250       -72.81 U1           0.00 U1         -42.98 U1           0.00 U1   
          15.500       -83.74 U1           0.00 U1         -44.41 U1           0.00 U1   
          15.750       -95.02 U1           0.00 U1         -45.85 U1           0.00 U1   
          16.000      -106.66 U1           0.00 U1         -47.28 U1           0.00 U1   
          16.250      -118.66 U1           0.00 U1         -48.72 U1           0.00 U1   
          16.500      -131.02 U1           0.00 U1         -50.16 U1           0.00 U1   
          16.750      -143.74 U1           0.00 U1         -51.59 U1           0.00 U1   
          16.750      -143.74 U1           0.00 U1         -51.59 U1           0.00 U1   
          17.000      -156.86 U1           0.00 U1         -53.39 U1           0.00 U1   
          17.250      -170.53 U1           0.00 U1         -55.92 U1           0.00 U1   
          17.500      -184.83 U1           0.00 U1         -58.45 U1           0.00 U1   
 
============================================================================================= 
[7] SEGMENTAL DEFLECTIONS 
============================================================================================= 
    Units: x (ft), Dz (in) 
   Span        x    Dz (DEAD)    Dz (LIVE)   Dz (TOTAL) 
   ---- -------- ------------ ------------ ------------ 
      1    0.000       -0.000       -0.000       -0.000 
           0.250       -0.001       -0.001       -0.001 
           0.500       -0.001       -0.001       -0.002 
           0.750       -0.002       -0.002       -0.003 
           0.750       -0.002       -0.002       -0.003 
           1.000       -0.002       -0.002       -0.004 
           1.250       -0.003       -0.003       -0.006 
           1.500       -0.003       -0.004       -0.007 
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           1.750       -0.004       -0.004       -0.008 
           2.000       -0.004       -0.005       -0.010 
           2.250       -0.005       -0.006       -0.011 
           2.500       -0.006       -0.007       -0.012 
           2.750       -0.006       -0.007       -0.014 
           3.000       -0.007       -0.008       -0.015 
           3.250       -0.007       -0.009       -0.016 
           3.500       -0.008       -0.010       -0.018 
           3.750       -0.009       -0.010       -0.019 
           4.000       -0.009       -0.011       -0.020 
           4.250       -0.010       -0.012       -0.022 
           4.500       -0.010       -0.012       -0.023 
           4.750       -0.011       -0.013       -0.024 
           5.000       -0.011       -0.014       -0.025 
           5.250       -0.012       -0.014       -0.026 
           5.500       -0.012       -0.015       -0.027 
           5.750       -0.013       -0.015       -0.028 
           6.000       -0.013       -0.016       -0.029 
           6.250       -0.013       -0.016       -0.029 
           6.500       -0.014       -0.016       -0.030 
           6.750       -0.014       -0.017       -0.030 
           7.000       -0.014       -0.017       -0.031 
           7.250       -0.014       -0.017       -0.031 
           7.500       -0.014       -0.017       -0.031 
           7.750       -0.014       -0.017       -0.032 
           8.000       -0.014       -0.017       -0.032 
           8.250       -0.014       -0.017       -0.032 
           8.500       -0.014       -0.017       -0.031 
           8.750       -0.014       -0.017       -0.031 
           9.000       -0.014       -0.017       -0.031 
           9.250       -0.014       -0.017       -0.030 
           9.500       -0.014       -0.016       -0.030 
           9.750       -0.013       -0.016       -0.029 
          10.000       -0.013       -0.016       -0.029 
          10.250       -0.013       -0.015       -0.028 
          10.500       -0.012       -0.015       -0.027 
          10.750       -0.012       -0.014       -0.026 
          11.000       -0.011       -0.014       -0.025 
          11.250       -0.011       -0.013       -0.024 
          11.500       -0.010       -0.013       -0.023 
          11.750       -0.010       -0.012       -0.022 
          12.000       -0.009       -0.011       -0.021 
          12.250       -0.009       -0.011       -0.020 
          12.500       -0.008       -0.010       -0.018 
          12.750       -0.008       -0.009       -0.017 
          13.000       -0.007       -0.009       -0.016 
          13.250       -0.007       -0.008       -0.014 
          13.500       -0.006       -0.007       -0.013 
          13.750       -0.005       -0.006       -0.012 
          14.000       -0.005       -0.006       -0.010 
          14.250       -0.004       -0.005       -0.009 
          14.500       -0.004       -0.004       -0.008 
          14.750       -0.003       -0.004       -0.007 
          15.000       -0.003       -0.003       -0.006 
          15.250       -0.002       -0.003       -0.005 
          15.500       -0.002       -0.002       -0.004 
          15.750       -0.001       -0.002       -0.003 
          16.000       -0.001       -0.001       -0.002 
          16.250       -0.001       -0.001       -0.001 
          16.500       -0.000       -0.001       -0.001 
          16.750       -0.000       -0.000       -0.001 
          16.750       -0.000       -0.000       -0.001 
          17.000       -0.000       -0.000       -0.000 
          17.250       -0.000       -0.000       -0.000 
          17.500       -0.000       -0.000       -0.000 
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Graphical Output 

Loads 

pcaSlab v1.50. Licenced to: pcaStructurePoint. Licence ID: 00000-0000000-4-238E7-238E7

File: C:\Data\pcaSlab\PCA Notes on ACI 318-02 Example 20-2.slb

Project: PCA Notes on ACI 318-02

Frame: Example 20-2 Engineer: pcaStructurePoint

CASE: SELF

CASE: Dead

CASE: Live

75 75 75

100 100 100

204.167 204.167 204.167

5468.75

3645.83 3645.83

5468.75
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Internal Forces 

pcaSlab v1.50. Licenced to: pcaStructurePoint. Licence ID: 00000-0000000-4-238E7-238E7

File: C:\Data\pcaSlab\PCA Notes on ACI 318-02 Example 20-2.slb

Project: PCA Notes on ACI 318-02

Frame: Example 20-2 Engineer: pcaStructurePoint

M
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 - 
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ft

-200.0

200.0
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he
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 - 

ki
p

60.0

-60.0

LEGEND:
 Envelope

-86.59

-184.83

87.93

-165.92 -165.95

63.89

-184.80

-86.63

87.93

48.46

-58.45

52.82

-52.82

58.45

-48.46
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Moment Capacity 

pcaSlab v1.50. Licenced to: pcaStructurePoint. Licence ID: 00000-0000000-4-238E7-238E7

File: C:\Data\pcaSlab\PCA Notes on ACI 318-02 Example 20-2.slb

Project: PCA Notes on ACI 318-02

Frame: Example 20-2 Engineer: pcaStructurePoint

-200.0

200.0

Middle Strip Moment Capacity - k-ft

-200.0

200.0

Beam Strip Moment Capacity - k-ft

-200.0

200.0

LEGEND:
 Envelope Curve
 Capacity Curve
 Support Centerline
 Face of Support

Column Strip Moment Capacity - k-ft
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Shear Capacity 

pcaSlab v1.50. Licenced to: pcaStructurePoint. Licence ID: 00000-0000000-4-238E7-238E7

File: C:\Data\pcaSlab\PCA Notes on ACI 318-02 Example 20-2.slb

Project: PCA Notes on ACI 318-02

Frame: Example 20-2 Engineer: pcaStructurePoint

B
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ar
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 - 
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p

100.0

-100.0

LEGEND:
 Envelope Curve
 Capacity Curve
 Support Centerline
 Face of Support
 Critical Section

 31.62

-42.89 

 37.25

-37.25 

 42.89

-31.62 
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Deflection 

pcaSlab v1.50. Licenced to: pcaStructurePoint. Licence ID: 00000-0000000-4-238E7-238E7

File: C:\Data\pcaSlab\PCA Notes on ACI 318-02 Example 20-2.slb

Project: PCA Notes on ACI 318-02

Frame: Example 20-2 Engineer: pcaStructurePoint

D
ef
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 - 
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0.032

-0.032

LEGEND:
 Dead Load
 Live Load
 Total Deflection
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Beam Strip Flexural and Transverse Reinforcement 

pcaSlab v1.50. Licenced to: pcaStructurePoint. Licence ID: 00000-0000000-4-238E7-238E7

File: C:\Data\pcaSlab\PCA Notes on ACI 318-02 Example 20-2.slb

Project: PCA Notes on ACI 318-02

Frame: Example 20-2 Engineer: pcaStructurePoint

Beam Strip Flexural and Transverse Reinforcement
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Middle Strip Flexural Reinforcement 

pcaSlab v1.50. Licenced to: pcaStructurePoint. Licence ID: 00000-0000000-4-238E7-238E7

File: C:\Data\pcaSlab\PCA Notes on ACI 318-02 Example 20-2.slb

Project: PCA Notes on ACI 318-02

Frame: Example 20-2 Engineer: pcaStructurePoint

Middle Strip Flexural Reinforcement
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Column Strip Flexural Reinforcement 

pcaSlab v1.50. Licenced to: pcaStructurePoint. Licence ID: 00000-0000000-4-238E7-238E7

File: C:\Data\pcaSlab\PCA Notes on ACI 318-02 Example 20-2.slb

Project: PCA Notes on ACI 318-02

Frame: Example 20-2 Engineer: pcaStructurePoint

Column Strip Flexural Reinforcement
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Appendix 
Conversion Factors - English to SI 

 
To convert from  To  Multiply by 

in. m (1000 mm)  0.025400 
ft m  0.304800 
lb N (0.001 kN)  4.448222 

kip (1000 lbs)  kN  4.448222 
plf (lb/ft)  N/m  14.593904 

psi (lb/in.2)  kPa  6.894757 
ksi (kips/in.2)  MPa  6.894757 

psf (lb/ft2)  N/m2 (Pa)  47.88026 
pcf (lb/ft3)  kg/m3  16.018460 

ft-kips  kN • m  1.355818 
 

Conversion Factors - SI to English. 
 

To convert from To  Multiply by  
m (1000 mm) in  39.37008  

m ft  3.28084  
N (0.001 kN) lb  0.224809  

kN kip (1000 lbs)  0.224809  
kN/m Plf (lb/ft)  68.52601  
MPa Psi (lb/in2)  145.0377  
MPa ksi (kips/in2)  0.145038  

kN/m2 (kPa) Psf (lb/ft2)  20.88555  
kg/m3  Pcf (lb/ft3)  0.062428  
kN • m  ft-kips  0.737562  



 

A-2  Appendix 

Contact Information 
 

Web Site:  http://www.pcaStructurePoint.com 

E-mail:  info@pcaStructurePoint.com  
 support@pcaStructurePoint.com  

Ordering:  pcaStructurePoint  
 5420 Old Orchard Road  
 Skokie, IL 60077  
 USA  
Phone:  (847) 966-4357  
Fax:  (847) 581-0644  

Technical Support:  pcaStructurePoint  
 5420 Old Orchard Road  
 Skokie, IL 60077  
 USA  
Phone:  (847) 966-HELP / (847) 966-4357  
Fax:  (847) 581-0644  

 

http://www.pcastructurepoint.com/
mailto:info@pcaStructurePoint.com
mailto:support@pcaStructurePoint.com


 

Appendix  A-3 

Bug Report Form  
To help us improve our products please fax, mail or e-mail questions to:  

pcaStructurePoint 
5420 Old Orchard Road 
Skokie, IL 60077 
Fax: (847) 581-0644  
E-mail: support@pcaStructurePoint.com 
 

Program 
 Name  

 Company 
Name  

 

Program  
Version  

 Tester’s 
Name  

 

Program  
Release  

 Phone 
  

 

Operating  
System  

 Fax  
 

 

CPU /  
Memory  

 E-mail  
 

 

Network 
  

 Input File  
 

 

Bug No.  
 

 Output File  
 

 

Date  
 

 Screen Shot 
File  

 

Bug Priority  
Category  

   

 

mailto:support@pcaStructurePoint.com


 

A-4  Appendix 

 
Problem Title Please enter a brief, one-line description of the problem.  

Summary Information Restate the problem title and/or include more descriptive 
summary information.  

Error Messages If the problem causes any error messages, please list the exact error 
messages that you are receiving.  

Steps to Reproduce If the problem is reproducible, please list the steps required to 
cause it. If the problem is not reproducible (only happened once, or occasionally for 
no apparent reason), please describe the circumstances in which it occurred and the 
symptoms observed.  

Results Describe your results and how they differed from what you expected.  

Workaround If there is a workaround for the problem, please describe it in detail.  

Documentation & Notes Document any additional information that might be useful 
in resolving the problem.  
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